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 تمهيد

 

 بسم الله الرحمن الرحيم
 وبه نستعين

 الحمد لله رب العالمين، والصلاة والسلام على أشرف المرسلين سيدنا محمد وعلى آله وصحبه أجمعين.

 

تُعتبر البيانات، من وجهة نظر علم الإحصاء، الشكل المجرد أو الخام الذي تكون عليه المعلومات في 
المتغيرات، أي المشاهدات التي تنتج عن تجربة علمية أو تشخيص طبي أو تسجيل فهي نتاج قياسات الحياة، 

أي نتيجة يمكن  البيانات هي يمكننا القول إن ببساطةو  .لحركة واردات وصادرات في مؤسسة أو نتائج دراسية
الإحصائية للتعلم من وتحليل البيانات، هو ذلك العلم الذي يستخدم الأساليب  تغير رقمي.تسجيلها وتحويلها إلى م

. ويُقصد من التعلم هنا استخدام ((Statistical Learning) بالتعلم الإحصائي، )وهو ما يُعرف حديثا البيانات
 الحصول على المعرفة. بالتاليالبيانات في الاستكشاف والتحليل للوصول للمعلومات الكامنة، و 

حديد الهدف من استخدام تحليل البيانات، ثم الشروع في ويتحقق التعلم الإحصائي من خلال تعريف المشكلة أو ت
عملية جمع البيانات، ثم تلخيص واستكشاف وتحليل البيانات باستخدام الأساليب المناسبة، وأخيرا استخلاص النتائج 

 .المناسبة والاستشارات اتخاذ القرار أو تقديم التوصياتبما يتناسب مع  وعرضها وتفسيرها

لأفضل، يتحتم على الباحث استخدام البرامج الإحصائية التي توفر له ما يساعده في تحقيق وللوصول للنتيجة ا
البسيطة الاستخدام من البرامج المرنة والقوية، وفي نفس الوقت،  IBM SPSSأهداف الدراسة، ويُعتبر برنامج 

 لغير المتخصصين في علم الإحصاء.خاصة 

  برنامج نتعلم لماذاSPSS؟ 
(، أي Statistical Package for the Social Sciences) ل، والذي يمثل اختصارا SPSSبرنامج 

، يُعد البرنامج الإحصائي المفضل للطلبة والباحثين المتخصصين في العلوم الحزمة الإحصائية للعلوم الاجتماعية
، العلومة والمالية، وغيرها من والأدبية، وكذلك العلوم الاقتصاديوالبيولوجية، والعلوم الاجتماعية  والنفسية الطبية

حيث أنه يحتوي على العديد من الأساليب الإحصائية والمقاييس التي تتعلق بطبيعة هذه التخصصات وطرق تعاملها 
 (. Multivariate(، ومتعددة )Bivariate(، ثنائية )Univariateمع البيانات )المتغيرات( بصورة أحادية )
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، مقارنة ببعض البرامج أو الحزم الإحصائية الأخرى الشهيرة مثل SPSSومن ضمن المزايا التي يتمتع بها برنامج 
، )والذي يُعد من وجهة نظر معظم الإحصائيين البرنامج الأفضل حاليا للتحليل الإحصائي(، هي المرونة Rبرنامج 

 وتصدير متغيرات، وكذلك سهولة استيرادالطرق ترميز وتحوير  وتنوع ،الفائقة في إدخال البيانات وتعديلها ومعالجتها
لى البرامج الأخرى وعلى رأسها برنامج مايكروسوفت اكسل ملفات ، والذي يعتبر (MS Excel) البيانات من وا 

 .المتداولة برامج معالجة البياناتكافة القاسم المشترك بين 

انب المميزة فيه حيث أنها تتميز بالبساطة والاختصار من الجو  SPSSوتُعتبر طريقة عرض النتائج في برنامج 
الرسومات البيانية والجداول(، وتعدد طرق  نتائج والتدرج المنطقي في العرض إضافة لسهولة تعديلها، )وخاصة

 .(MS Power Point) وباوربوينت (MS Word) نسخها وتخزينها في برامج أخرى مثل مايكروسوفت وورد

  هذا الكتاب؟ يهُممن 
بالتدرج في طرح المواضيع والطرق الإحصائية بصورة بعيدة يتميز أولا، وكما يظهر من عنوانه،  الكتاب

، فهو يراعي الطلبة والباحثين الذين لديهم الجافة عن التعقيد والمبالغة في عرض النظريات والقوانين الإحصائية
الإحصائية لدى البعض، ويتدرج  قلة الخبرةار بعض الصعوبة في الجانب النظري الرياضي، وكذلك يأخذ في الاعتب

بطريقة غير معقدة لمن لديهم خبرة متواضعة في استخدام جهاز الحاسوب  SPSSفي شرح كيفية التعامل مع أيضا 
، إلا أنه يفترض أن القارئ لديه SPSSلا يشترط وجود أية خبرة سابقة في التعامل مع برنامج  الكتابو  في العموم.

ضافة لهذا كله،  .، ومفهوم تحليل البياناتوالاستدلالي ساسيات علم الإحصاء الوصفيالأدنى لأبالحد إلمام  فإن وا 
بيانات حقيقية وافتراضية تتعلق بالتخصصات  تعتمد علىالكتاب يُقدم مجموعة متنوعة من الأمثلة العملية التي 

 العلمية المختلفة؛ الطبية والاجتماعية والتربوية والأكاديمية والاقتصادية والصناعية وغيرها.

 لتعلم برنامج المطلوبة  ما هي التقنيات الإضافيةSPSS؟ 

 نظام تشغيلتحت  يعمل يُفضل استخدام جهاز حاسوب بصورة جيدة، الكتاب مواضيع للاستفادة من
 لا تتطلب مواضيع الكتابو  ،10و أ 8.1 ،8، 7إصدار من ويندوز  لأي (MS Windowsمايكروسوفت ويندوز )
، إلا أن 23والتي يُفضل أن تكون النسخة ، SPSSبعد الحصول على نسخة من برنامج  وجود اتصال بالإنترنت

 .وجود نسخ أقدم لا يمنع القارئ من الاستفادة المثلى من الكتاب

  الكتاب فصولتنظيم: 

طرق استخدام ، نقدم تعريف للبرنامج و (IBM SPSSمكونات برنامج ، )وهو بعنوان: الفصل الأولفي 
، ونوضح كيفية طلب المساعدة داخل البرنامج (GUI) طريقة واجهة المستخدم البيانيةفيه، خاصة باستخدام  الأوامر

. ثم نوضح كيفية إدخال البيانات داخل أمر المساعدة يوفره البرنامجفيما يختص بالمواضيع والتدريب العملي الذي 
 .SPSS برنامج عرض البيانات وعرض المتغيرات الذي يتميز به ت البرنامج مع توضيح مفصل لأسلوبيفي ملفا
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فإننا نبدأ بشرح (، SPSSالتعامل مع ملفات البيانات في برنامج )وهو بعنوان:  ،الفصل الثانيفي و 
وبالمقابل نوضح كيفية تصدير أو ، SPSSكيفية استيراد ملفات البيانات من برنامج اكسل وتعديلها ثم تخزينها في 

. بعدها يتم شرح كيفية ترتيب المتغيرات في ملفات البيانات SPSS داخل برنامج من تخزين الملفات بصيغة اكسل
سواء ترميز القيم في نفس المتغير أو في متغير جديد. وكذلك نسلط  ، وكيفية إعادة ترميز المتغيراتSPSSفي 

 دوال جديدة للمتغيرات. وحساب تعريفطريقة الضوء على طريقة إعادة الترميز التلقائي و 

تناول المقاييس ب(، SPSSالتحليل الاستكشافي للبيانات في بعنوان: وهو ، )الفصل الثالث نبدأ في
توضيح كيفية استخدامها نقوم بو  ،التي تندرج تحت مسمى التحليل الاستكشافي للبيانات والطرق الإحصائية المختلفة

ويتضمن الفصل تعريف أنواع البيانات، وتقسيم التعامل مع المتغيرات بحسب طبيعتها، واستخدام ، SPSSفي برنامج 
لك توضيح كيفية التعامل مع ما المتغيرات. وكذ طبيعةمقاييس النزعة المركزية والتشتت والرسومات البيانية بحسب 

ستخدام أسلوب استكشاف البيانات الشامل وفي نهاية الفصل الثالث يتعرض الكتاب لايعرف بالمتغيرات الوهمية، 
 ، إضافة لتقديم مثال تطبيقي لكيفية تقديم وعرض نتائج التحليل الاستكشافي للبيانات وتفسيرها.SPSSفي 

باستعراض الأساليب الإحصائية (، SPSSتحليل البيانات الاستدلالي في وان: بعنوهو ) ،الفصل الرابعونقوم في 
، الاستدلال حول الوسط الحسابي للمجتمعمثل  التي تتضمن طرق تقدير المعالم واختبارات الفروض المتعلقة بها،

، وكذلك نوضح كيفية تكوين جداول الاقتران في اختبار تباينات المجتمعلعينات المستقلة والمرتبطة، و والتعامل مع ا
SPSS  تنفيذ اختبار الاستقلالية وحساب معاملات الارتباط الخاصة به، وأيضا طريقة للمتغيرات الوصفية والكمية، و
 إجراء اختبارات تحليل التباين في اتجاه واتجاهين.طرق 

كيفية تنفيذ تحليل الارتباط والانحدار  نتناول (،خطيتحليل الارتباط والانحدار ال، )وهو بعنوان: الفصل الخامسفي 
ضمن المتغيرات في البيانات، وتحليلها، وتكوين النماذج  المتبادلة دراسة العلاقاتل SPSSالخطي باستخدام برنامج 

ويتضمن ذلك تنفيذ شكل الانتشار بين المتغيرات في بُعدين أو كمصفوفة، ات السببية بينها. التي تفسر العلاق
حساب معاملات الارتباط البسيط والجزئي، ثم شرح طريقة توفيق نموذج الانحدار الخطي البسيط والمتعدد وتمثيلها و 

فرضيات  أهم تقييم نستعرض طرق  الموفق، وأخيرا الخطي تقييم نموذج الانحدار طرق  نقدمبعد ذلك و ، ابياني
 المربعات الصغرى الاعتيادية وتحليل البواقي.

التطرق لموضوعين مهمين؛ فيه يتم ف(، الاختبارات اللامعلمية وتحليل الموثوقيةبعنوان: وهو )، السادسالفصل أما 
، وتتضمن لعينة واحدة، وعينتين أو أكثر )مستقلة أو مرتبطة( SPSSالأول هو تنفيذ الاختبارات اللامعلمية في 

-اختبار كولمجروفحدين، واختبار الدورات، و ، اختبار ذي الاختبار مربع كاي لجودة التوفيقاختبارات هامة مثل 
طرق وغيرها. وأما الموضوع الثاني، فيتناول  واختبار ولكوكسون ، والس-وتني، واختبار كروسكال-، ومانسميرنوف

وتحليل  وكيفية تطبيقها ،(الإجابات في الاستبيانات وبصورة خاصة)بيانات الدراسة،  التحقق من ثبات أو موثوقية
 .معامل ثبات جوتمان، و معامل ثبات التجزئة النصفية، و معامل ثبات كرونباخ الفا، ومن أهمها SPSSفي  النتائج
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ملحقا يحتوي على تعريف لكل ملفات البيانات المستخدمة بشكل متكرر في الشرح، لكي  في نهايته كتابويضم ال
 خلال فصول الكتاب ولا يضطر للبحث عنها داخل الصفحات. SPSSيتمكن القارئ من مواكبة تنفيذ الأوامر في 

 الكتب السابقة للمؤلف: 
 (.2015، )الإحصاء الاستكشافي والاحتمالات مقدمة في .1

 R( ،2016.)التحليل الإحصائي باستخدام لغة  .2

 واعتزاز شكر: 
الطلبة والباحثين في فع به تبتأليف هذا الكتاب، والذي أرجو أن ين وفقنيأشكر الله العليم الحكيم الذي 

 من بين العلوم أنه الأكثر ذكرابعتز الذي أ  ، علم الإحصاء،، وأحمده عز وجل على هذا العلمشتى التخصصات
(، (49)...، الكهف  أحصاهامال هذا الكتاب لا يغادر صغيرة ولا كبيرة إلا )...  ؛موضعي أكثر من ففي القرآن الكريم 

 .الكريمة (، وغيرها من الآيات(6)...، المجادلة  الله ونسوه أحصاه... (، )(94)، مريم وعدهم عدا أحصاهملقد )
 
 المؤلف
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 الفصل الأول

  IBM SPSSمكونات برنامج 

(Components of SPSS) 

 

 SPSS (What is SPSS?)تعريف برنامج  1.1

الحزمة (، ويعني Statistical Package for the Social Sciencesإلى ) SPSSيرمز الاختصار 
ل كوقد تم ابتكار البرنامج بصورته الأصلية البسيطة في نهاية الستينات عن طريق  ،الإحصائية للعلوم الاجتماعية

( من جامعة ستانفورد Dale Bent(، ودايل بنت )Hadlai Hull(، هاندلي هل )Norman Nie) نورمان نايمن 
بات اليدوية آنذاك، وبعد ذلك انتشر الأمريكية بغرض تحليل بيانات ذات حجم كبير يصعب التعامل معها بالحسا

، 2009التعامل بهذه الحزمة في عدة جامعات إلى أن خرج للتداول التجاري لاحقا في الثمانينيات. في عام 
للبرنامج  المعروف ليصبح بعدها الاسم الرسمي SPSSحزمة  على ( الأمريكيةIBMاستحوذت شركة آي بي إم )

 .IBM SPSS Statisticsهو 

صدار منها البرنامج بعدة إصداراتويتوفر  الطالب وخادم العميل  إصدار المستخدم المفرد والمتعدد وا 
(clientserverوغيرها. ويمكن للمستخدم زيارة الموقع الالكتروني ال ) وهو( ،رسمي للشركةwww.spss.com ،)

 .للمزيد من المعلومات

ذا ما كان لدى القارئ نسخة أقدم من ، IBM SPSS Statistics 23 أو الإصدار النسخة هذا الكتاب يستخدمو  وا 
طريقة استخدام البرنامج وتحليل وعرض  إلى أنفإننا نشير هنا  ،على جهازهمثبتة أو نسخة أحدث منها  23النسخة 

 من البرنامج. الأخرى عن النسخ  النتائج لن يكون فيها اختلاف كبير

 

 :ملاحظة
غالبا(، باسم  18كان يُعرف في فترة من الفترات )في الإصدار  SPSSتجدر الإشارة هنا إلى أن برنامج 

PASW Statistics ( وهي اختصارPredictive Analysis Software أي )برنامج التحليل التنبئي. 

 

http://www.spss.com/
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  (Methods of Commanding)طرق استخدام الأوامر  2.1

بحسب المهمة المطلوب إنجازها أو حتى بحسب ما يفضله  SPSSلاستخدام الأوامر في توجد عدة طرق 
 وهذه الطرق هي: حيث أنه من الممكن استخدام أكثر من طريقة في آن واحد، المستخدِم،

(، وهي واجهة البرنامج المتمثلة في Graphical User Interface (GUI)) واجهة المستخدم البيانية. طريقة 1
النافذة الأساسية التي يتم عن طريقها استخدام الفأرة واختيار الأوامر من القوائم المنسدلة تحت شريط الأوامر كما 
هو المتداول في كل البرامج تحت بيئة نظام ويندوز. وهذه الطريقة هي الأكثر تداولا بين مستخدمي البرنامج، 

ا تعتمد على إدخال الأوامر خطوة بخطوة، بمعنى أن المستخدِم وخاصة المبتدئين منهم، نظرا لبساطتها. وتتميز بأنه
وسنقوم في  لن يتمكن من الانتقال للخطوة التالية إلا بعد استكمال الإدخال في الخطوة السابقة بصورة صحيحة.

مة بصورة عاالتحليل الإحصائي واستخدام  طريقة التعامل مع البيانات باعتماد هذه الطريقة في شرحهذا الكتاب 
 مع الإشارة للطرق الأخرى عند الضرورة.

( الخاصة ببرنامج Command Language) لغة الأوامروهي (، Syntax) بناء جملة الأوامر. طريقة 2
SPSS ، حصائية عن والتي يمكن للمستخدِم من خلالها تنفيذ ما يحتاجه من عمليات حسابية ودوال رياضية وا 

البرنامج. ويمكن القول بأن استخدام النوافذ والقوائم في الطريقة الأولى، وهي طريقة طريق كتابة أوامر محددة بلغة 
وعادة ما يستخدم هذه الطريقة  واجهة المستخدم البيانية، هو في الواقع استخدام للغة الأوامر "في الخلفية".

ون هنالك حاجة لاستخدام أو في البرمجة بصورة عامة، وكذلك قد يك SPSSالأكثر خبرة في برنامج المستخدمون 
 هذه الطريقة عند تكوين أوامر أو دوال خاصة غير متوفرة بشكل مباشر في البرنامج.

، ويمكن SPSSبرمجة عامة تحتوي على مكونات خاصة ببرنامج (، وهي لغة Python) بايثون . طريقة 3
مع طريقة بناء جملة الأوامر . ويمكن أيضا استخدام لغة بايثون SPSSاستخدامها لكتابة برمجيات تعمل ضمن 

من برنامج ينفذ الدوال والنماذج الإحصائية العامة والخاصة. وتعد هذه طريقة إضافية للاستفادة  SPSSلجعل 
SPSS .للباحثين المتخصصين 

( الشهيرة، ويمكن كتابة هذه BASIC) البيسك(، وهي برامج مكتوبة بلغة Scripts) المخطوطات. طريقة 4
( بحيث يتم تنفيذها مباشرة عند الحصول على نتيجة معينة Auto-scriptبطريقة التنفيذ التلقائي )المخطوطات 
 .SPSSفي برنامج 

 SPSS (Add-on's)في برنامج  الملحقات 1.2.1

كما هو الحال في كثير من البرامج والحزم الإحصائية تحت بيئة ويندوز، فإنه عند تنصيب برنامج 
SPSS  النظام الأساسيالمستخدِم على على الحاسوب يحصل (Base System )الملحقات أو وربما بعض 

الإضافات بحسب طبيعة النسخة التي تم الحصول عليها. ويمكن للمستخدِم الحصول على أية مكونات إضافية 
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( الخاص CDأو من القرص المدمج ) ،سابقاالمذكور  سواء بتحميلها من الموقع الرسمي للشركة SPSSلبرنامج 
في هذا الكتاب مع التنويه  SPSSوسنقوم بصورة أساسية بتناول الأوامر المتوفرة في النظام الأساسي في  بالبرنامج.

نسخة من فترض الكتاب أن القارئ قد حصل مسبقا على ي  و  على المكونات الإضافية عند الحاجة لاستخدامها.
ه قد تم تنصيبها على جهاز الحاسوب، وسيتم أو أقدم منها أو أحدث(، وأن 23، )سواء النسخة SPSSبرنامج 

 مكونات البرنامج بحسب متطلبات المرحلة.شرح  خلال فصول الكتاب التدرج في

 SPSS (Getting Help)طلب المساعدة في برنامج  2.2.1

لتعرف على لفي العثور على أي موضوع أو  SPSSطلب المساعدة في برنامج يمكن للمستخدم دائما  
، وذلك عن طريق استخدام SPSSتصفح المواضيع بشكل متسلسل في لطريقة إدخال معينة للبيانات أو ببساطة 

( في شريط الأوامر العلوي في البرنامج، وعند استخدام أمر المساعدة، ستتوفر عدة خيارات Help) المساعدةأمر 
 :1ما يلي أهمها

 ( المواضيعTopics)وضوعات التي يوفرها برنامج : ويحتوي على كل المSPSS  متسلسلة بحسب التدرج
التعامل مع أوامر البرنامج، وتظهر نافذة المساعدة الخاصة بالموضوعات كما تسلسل المنطقي للموضوعات و 

(، حيث يمكنك التنقل ضمنها مستخدما عناوين المواضيع المعروضة على يسار النافذة، أو 1.1يبين الشكل )
 ( في أعلى النافذة إلى اليسار.Searchالموضوع البحث المطلوب في مربع البحث )عن طريق كتابة 

 
 .SPSS( لبرنامج Topicsطلب المساعدة في المواضيع ) نافذة: 1.1شكل 

 ( التدريب العمليTutorial) البيانات : ويوفر للمستخدم نوع من التدريب على استخدام البرنامج في التعامل مع
 بصورة عامة لتسهيل تنفيذ التحليل الإحصائي بصورة متدرجة.

                                                 
أو متصفح الانترنت الافتراضي الخاص  pdf لعند استخدام أمر المساعدة، فإن عرض المطلوب سيكون عادة في متصفح ملفات ا 1

 .بالإنترنتبجهازك، لكن بدون الحاجة للاتصال 
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 ( دراسات الحالةCase Studies)حيث أنه يتضمن : ويُعد أكثر تقدما من النوعين الأولين في طلب المساعدة ،
الإحصائية أمثلة تطبيقية لبيانات يوفرها البرنامج ويقوم بشرح كيفية استخدام الخيارات المختلفة لبعض الأساليب 

 بصورة عملية.

 SPSS (Starting SPSS)بدء التعامل مع برنامج  3.1

تُعتبر النافذة ((، والتي 2.1للمرة الأولى ستظهر النافذة التالية )شكل ) SPSSعند تشغيل برنامج 
أو  دفتح ملف بيانات جديالافتراضية التي يقوم البرنامج بعرضها مقدما فيها بعض الاقتراحات للمستخدم؛ مثل 

المكونات الموجودة وغير الموجودة في البرنامج، عرض ، عرض بعض التحليلات الإحصائية المقترحة، سابق
. وستجد في الزاوية اليسرى أسفل هذه النافذة خيار ، وغيرهاملاحظات إرشادية وتعليمية لاستخدام البرنامجعرض 

سنقوم باختيار هذا التعطيل لعدم حاجتنا لهذه نافذة عند فتح البرنامج مرة أخرى، و خاص بتعطيل ظهور هذه ال
زر  ، وذلك عن طريق الضغط على المربع الصغير بجانب الخيار ثم الضغط علىالنافذة خلال الفصول الأولى

 ( في النافذة.OK) موافق

 
 .SPSSبرنامج  عند تشغيل الافتراضية "الترحيب" نافذة :2.1شكل 

يوضح أهم المكونات الأساسية لهذه النافذة  (3.1شكل )وال، مفتوحة الرئيسية للبرنامجبعد تنفيذ ذلك، ستبقى النافذة 
( التي تكلمنا عنها سابقا في طرق استخدام الأوامر في البرنامج، وتسمى GUIالتي تُعد واجهة المستخدم البيانية )

التعامل مع البرنامج عن طريق إدخال (، وستكون بالنسبة لنا نافذة SPSS Data Editor) تحرير البياناتنافذة 
صدار الأوامر الخاصة بالتحليل الإحصائي من مقاييس ونماذج ورسومات بيانية وغيرها.البيانات وتعديلها  ، وا 
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 .SPSS: نافذة تحرير البيانات في برنامج 3.1شكل 

 ( نلاحظ أن نافذة تحرير البيانات مقسمة إلى:3.1في الشكل )

 إلى اليسار( اسم ملف البيانات ) :اسم ملف البيانات( حيث يظهرUntitled1 وهو الاسم الافتراضي )
الذي يعطيه البرنامج لملفات البيانات، ويقوم المستخدِم بتغييره لاحقا إلى الاسم الذي يرغب به بعد إدخال 

 البيانات.

 لضغط على أي من وهو الشكل العام لعرض الأوامر الأساسية في بيئة ويندوز، وعند ا: شريط الأوامر
هذه الأوامر ستنسدل قائمة تضم أوامر فرعية أو تضم قوائم تحوي بدورها أوامر فرعية. وسنقوم بالتعرف 

 على هذه الأوامر بالتدريج بحسب تقدم القارئ مع فصول الكتاب.

 الشريط : وهي رموز تنفيذية للأوامر وتعتبر بدائل أو اختصارات لها، ويمكن تعديل هذا أيقونات الأوامر
 ليضم الأيقونات المفضلة أو الأكثر استخداما بحسب رغبة المستخدِم.

 التحليل الإحصائي، فإن الشكل العام لملف البيانات الإحصائية : كما هو السائد في المتغيرات والمشاهدات
. ويُلاحظ في نافذة تحرير 1يتم تنظيمه بحيث تكون المتغيرات في الأعمدة والمشاهدات في الصفوف

 ( نظرا لأنه لم يتم تعريفها بعد.var) المختصر لبيانات أن المتغيرات كلها تأخذ الاسما

في نافذة تحرير البيانات والمتوفرتان في أسفل جدول البيانات  الرئيسيين العرض أسلوبيإلى  ويجب التنويه هنا
عرض أسلوب شكل السابق، و (، وهي الظاهرة في الData View) عرض البيانات أسلوب مباشرة إلى اليسار؛ وهما

(، والتي عند اختيارها سيتغير الشريط الذي يضم أسماء المتغيرات إلى تقسيم آخر Variable View)المتغيرات 
 .تاليا هذين الأسلوبين بالشرح وسنتناولخاص بتصنيف المتغيرات بحسب طبيعتها، 

                                                 
 سيتم تناول مفهوم المتغيرات والمشاهدات بمزيد من التفصيل في الفصل التالي. 1
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فيتغير  1في أسفل النافذة (Variable Viewعرض المتغيرات )في نافذة محرر البيانات، قم باختيار اسلوب 
(. عند إدخال البيانات لأول مرة في محرر البيانات، يتم 4.1إلى الأسلوب الموضح في الشكل ) في النافذة العرض

تعريف أسماء المتغيرات المطلوب إدخالها ونوعها والسمات التفصيلية الخاصة بها باستخدام اسلوب عرض 
 الرجوع إلى اسلوب عرض البيانات لإدخال القيم العددية لهذه المتغيرات. المتغيرات، بعد ذلك يتم

ولاحظ أن الصفوف في نافذة عرض المتغيرات تمثل في الواقع عدد المتغيرات، )وليس كما هو الحال في نافذة 
 عرض البيانات، حيث أنها تمثل عدد المشاهدات(.

 
 .SPSSلبيانات في : اسلوب عرض المتغيرات في نافذة محرر ا4.1شكل 

 وصف موجز لما تعنيه المصطلحات الخاصة بأسلوب عرض المتغيرات: نقدموفيما يلي، 

 اسم المتغير (Name وهو الاسم الذي يختاره المستخدِم للمتغير، ويمكن استخدام اللغة العربية أو :)
لإدخال أسماء المتغيرات، مع ملاحظة أنه لا يمكن استخدام المسافات بين الأحرف أو  2الإنجليزية

. وفي حال عدم كتابة 3استخدام بعض الرموز ضمن اسم المتغير مثل )&( أو ابتداء اسم المتغير برقم
ول، " للمتغير الأVAR00001اسم محدد للمتغير من قِبل المستخدِم، فإنه يتم إعطاء الاسم الافتراضي "

 " للمتغير الثاني، ...، وهكذا.VAR00002" والاسم

                                                 
أسلوب العرض المختار )وكذلك عند الضغط بالفأرة على أي أمر أو خيار( باللون الأصفر  ستضيئ خلفية SPSS 23في إصدار  1

 لتنبيه المستخدِم.
 من الموقع الالكتروني الرسمي للشركة. SPSSيمكن التعرف على اللغات التي يمكن استخدامها في الإدخال في برنامج  2
، وستلاحظ ظهور رسالة تنبيه من A&B، أو 3Y، أو X"مسافة"  5، أو 1"مسافة"  تغيرحاول مثلا ادخال أسماء المتغيرات التالية؛ م 3

 البرنامج بأن هذا الاسم غير مقبول للمتغير.
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  طبيعة المتغيرسمة أو (Type (: والذي يمكنك من اختيار سمة المتغير، )الذي سيأخذ على أية حال
( وهي السمة الافتراضية، Numeric) رقميالشكل الرقمي وليس النصي(، من ضمن عدة سمات مثل؛ 

"، 13.150.719( مثل "Dot) مصحوب بنقاط"، 13,150,719( مثل "Comma) مصحوب بفواصل
"، وغيرها من السمات التي 1.23×210" والذي يعني "1.23E+2( مثل "Scientific notation) علمي

 يمكن للمستخدِم الاختيار منها.

 عدد الخانات العشرية (Decimals ويتم فيها تحديد عدد الخانات العشرية المرغوبة للأعداد، وتكون :)
، والذي يمكنك تغيره من نافذة 2للأعداد الصحيحة، والعدد الافتراضي للخانات العشرية هو  0عادة 

 .العامة في البرنامج 1الإعدادات

 ( عرضمسافة) قيم المتغير (Width ويتم فيه تحديد قياس العرض المطلوب كمسافة لقيم المتغير :)
إلى جانب العدد  مطلوب كتابة خانتين عشريتينمع أخذ عدد الخانات العشرية بالاعتبار، فمثلا إذا كان ال

ويكون القياس الافتراضي لعرض قيم المتغير . 3يقل قياس عرض قيم المتغير عن  ألاالصحيح فيجب 
 .8هو 

 المتغير أو وصف طابع (Label والذي يمكنك من إعطاء وصف اسمي للمتغير للمساعدة في فهم ما :)
الوصف باللغة العربية، وأيضا يمكن هنا استخدام المسافات والرموز يمثله هذا المتغير. ويمكن أن يكون 

وهذا الوصف هو ما يتم عرضه كبديل عن اسم  بمعنى أنه يمكن للمستخدِم كتابة ما يريده بدون قيود.
 وفي حالة عدم إضافة تعريف للمتغير فإن هذه الخانة تبقى فارغة افتراضيا. المتغير في نتائج التحليل،

 المتغير  تصنيف قيم(Valuesفي هذه الخانة، يتم تعريف أو إعطاء وصف لمستويات :) أو تقسيمات 
، فمثلا إذا كان المتغير يمثل إجابة على سؤال معين فإنه يمكن تعريف "موافق" لقيمة 2المتغير الوصفي

في التعريف. ". ويمكن هنا أيضا استخدام المسافات والرموز 2"، و"غير موافق" لقيمة المتغير "1المتغير "
أو عند عدم تعريف أي تصنيف للمتغير الوصفي، فإن الخانة يظهر فيها  أما في حال كون المتغير كميا

 .(None) لا يوجد الوصف

 تعريف القيم المفقودة (Missing في بعض الأحيان قد يرغب المستخدِم بالتمييز بين قيم مفقودة فعليا :)
، كما هو الحال مثلا في بعض الاستبيانات؛ فأحيانا قد يتم فقد وأخرى ناتجة عن عدم الرغبة في الإجابة

بعض استمارات الاستبيان وهذا يندرج تحت مسمى القيم المفقودة فعليا، وأحيانا قد لا يرغب الشخص 
هذه الحالات،  مثل المستبين في الإجابة عن سؤال معين فتنتج قيمة مفقودة بسبب عدم الاستجابة. في

ستخدام هذه الخانة لتعريف القيم المفقودة كما يرغب. وفي حالة عدم وجود قيم مفقودة يمكن للمستخدِم ا
 .(None) لا يوجد في المتغير فإن الخانة يظهر فيها الوصف

                                                 
 (.5.1يمكنك التعرف على نافذة الإعدادات العامة في البند ) 1
 سيتم التطرق لمفهوم المتغيرات الكمية والوصفية بالتفصيل في الفصل القادم. 2
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 عرض العامود (Columns ويمثل المساحة التي ستشغلها قيم المتغير ضمن العامود، وهو خيار :)
 .8متغير. ويكون عرض العامود الافتراضي للمتغير هو شكلي فقط لا يؤثر تغييره في تغيير قيم ال

 محاذاة أو تراصف قيم المتغير (Align( وهو الخيار الخاص بمحاذاة قيم المتغير إلى اليمين :)Right )
(. علما بأن الوضع الافتراضي للمحاذاة يكون Center( أو المنتصف )Leftضمن العامود أو اليسار )

 إلى اليمين.

  المتغيرنوع أو قياس (Measure في هذه الخانة يتم تحديد نوع المتغير من بين ثلاثة خيارات؛ :)كمي 
(Scale أو )وصفي رتبي (Ordinal أو )وصفي اسمي (Nominal أما إذا لم يتم تحديد نوع المتغير .)

 بمعنى أن نوع المتغير غير محدد. (Unknown)من قِبل المستخدِم فسيظهر الوصف 

  المتغيروظيفة أو دور (Role في معظم الأساليب الإحصائية، يكون للمتغير أو المتغيرات دور معين :)
( Target( أو هدف )Input، فيمكن أن يكون دور المتغير مُدخل )1في الأسلوب أو النموذج الإحصائي

( أو None( أو ليس له دور محدد مسبقا )Bothأو يأخذ الدورين بحسب طبيعة الأسلوب الإحصائي )
(. وتعيين هذا الدور يكون Split( أو دور لتجزئة البيانات )Partition) 2دور تقسيمي أو تصنيفي له

سير مرحلة التحليل  فيدورها على عادة لدواعي تنظيمية فقط ولا يؤثر ترك المتغيرات بدون تعيين 
 الإحصائي في العموم. والتعيين الافتراضي لدور المتغير يكون كمُدخل.

 (Data Entry in SPSS Data Editor) نافذة تحرير البياناتإدخال البيانات في  4.1

في نافذة تحرير البيانات في هذا البند، سيتم التعرف على كيفية إدخال البيانات )أو تعريف المتغيرات( 
طرق لإدخال  بسيط يشمل إدخال بيانات جديدة بصورة مباشرة، علما بأنه توجد عدة افتراضي من خلال تناول مثال

 والتي سيتم التطرق إليها لاحقا. ،SPSSالبيانات أو استدعائها إلى برنامج 

الأكثر شيوعا بين المستخدمين  الطريقة ، وهي كما أسلفنالواجهة المستخدم البيانيةعند استخدام الطريقة التقليدية 
هي تعريف أسماء المتغيرات  الأولى المرحلةفي إدخال البيانات، فإن الإدخال يكون عادة على مرحلتين؛ الجدد 

هي  والمرحلة الثانية((، Variable Viewونوعها وخواصها )ويتم ذلك باستخدام نافذة أسلوب عرض المتغيرات )
 ((.Data Viewالتي يتم فيها إدخال قيم هذه المتغيرات التي تم تعريفها، )باستخدام نافذة أسلوب عرض البيانات )

 وسنقوم تاليا بالتدرب على تنفيذ هاتين المرحلتين.

  

                                                 
(، يتم تعريف دور أحد المتغيرات بأنه تابع في الفصل الخامستحليل الانحدار على سبيل المثال، )والذي سيتم تناوله في أسلوب  1

 وتعريف دور المتغير أو المتغيرات الأخرى بأنها توضيحية.
(، Testing Sampleبارية )(، وعينة اختTraining Sampleبمعنى أن يتم تقسييييم بيانات الدراسييية إلى ثلاثة أقسيييام؛ عينة للتحليل ) 2

 ( كما هو الحال في بعض الدراسات الإحصائية.Validationوعينة للتقييم )
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 (Variable View Window)عرض المتغيرات نافذة  1.4.1

إحدى المؤسسات التعليمية في عشرة أطفال في ب خاصة( هي بيانات افتراضية 1.1البيانات في الجدول )
وسنقوم بإدخال هذه  .وعمره وجنسه وتشمل ثلاثة متغيرات هي وزن الطفل، مرحلتي رياض الأطفال والابتدائية

 بالطريقة التقليدية المباشرة. SPSSالبيانات في ملف بيانات في برنامج 

 .إحدى المؤسسات التعليميةأطفال في  بعشرة: بيانات افتراضية خاصة 1.1جدول 
 14.8 21.6 13 16.4 18.9 20.1 15.2 9.5 12 10.2 كجم(بالوزن الطفل )
 6 9 5 6 7 8 6 4 5 4 سنة(بالعمر الطفل )
 ذكر أنثى أنثى ذكر أنثى أنثى ذكر أنثى ذكر ذكر جنس الطفل

 موضحكما هو  "الفارغة" في المرحلة الأولى، وبعد تشغيل البرنامج، تأكد أولا من ظهور نافذة المستخدِم البيانية
أسفل النافذة  ( منVariable View. قم بعد ذلك باختيار أسلوب عرض المتغيرات )السابق (2.1في الشكل )

. في هذه النافذة، قم بالضغط باستخدام الفأرة على أول السابق (4.1إلى اليسار فتظهر النافذة كما في الشكل )
 .وستلاحظ تغير لون الخلفية إلى اللون الأصفر (Nameمربع فارغ تحت اسم المتغير )

 :ملاحظة
في حال حدوث أي خطأ أثناء عملية 
الإدخال، يمكن للمستخدِم، كما هو الحال 
في معظم البرامج تحت بيئة ويندوز، أن 

( Undo) التراجعيستخدم أيقونة )أمر( 
( للرجوع عن 5.1المشار إليها في الشكل )

بالصورة  هذا الخطأ ثم إعادة الإدخال
 .الصحيحة

 
 

 .SPSS( في نافذة محرر البيانات في Undo: أمر التراجع )5.1شكل 

 الاسم المرغوببإدخال اسم المتغير الأول في هذا الموضع، وكما تمت الإشارة سابقا، يمكنك اختيار  الآن سنقوم
ضغط على اليكن اسم المتغير الأول هو "الوزن"، قم بكتابة هذا الاسم في المربع الأول، ثم . ضمن القيود المحددة

باقي الخانات في نفس الصف الأول قد (. ستلاحظ هنا أن ENTERفي لوحة مفاتيح حاسوبك ) 1مفتاح الإدخال
 ظهرت فيها قيم أو مصطلحات، وهي كما ذكرنا القيم الافتراضية المصاحبة لإدخال أي متغير جديد.

                                                 
 يمكنك أيضا بدلا من استخدام مفتاح الإدخال الضغط بالفأرة على أي مكان فارغ في النافذة لتنفيذ الإدخال. 1
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هنا يكون للمستخدِم الخيار إما بتعديل بعض أو حتى كل القيم والخيارات للمتغير الجديد بحسب ما يناسب هذا و 
المتغيرات الجديدة الأخرى في عامود الأسماء ومن ثمة يعود لتعديل الخيارات المتغير، أو أن يستمر بكتابة أسماء 

 .المتغيرات دخلة. سنقوم نحن باعتماد الخيار الأول، أي أنه سيتم تعديل الخيارات بحسب أولوية إدخالللمتغيرات المُ 
 سنقوم بتعديل الخيارات التالية:في الصف الأول، 

 ( الخانات العشريةDecimals قم :)أي اختيار خانة عشرية واحدةثم اضغط إدخال 1الرقم  1بكتابة ، 
 هذا المتغير.لحيث أن ذلك يتناسب مع طبيعة القيم العشرية 

 ( وصف المتغيرLabelيمكن كتابة :)3إدخال اضغط " ثموزن الطفل بالكجمالوصف التالي؛ " 2. 

 ( نوع المتغيرMeasure( قم باختيار نوع المتغير الكمي :)Scale )والذي يتناسب مع الطبيعة الكمية 
 لمتغير الوزن.

تصنيف إما لعدم الحاجة إليها )مثل قد تم تجاهلها  الخاصة بالمتغير باقي الخياراتأن  إلى نلفت انتباه القارئ هنا
 حالتهاعلى  أو لكونها خيارات ثانوية يمكن تعديلها أو تركها(، (Missing) القيم المفقودةو  (Valuesقيم المتغير )
 .الأخرى( مثل ما تبقى من الخيارات) الافتراضية

ننتقل الآن لتعريف المتغير الثاني، وهو عمر الطفل؛ قم بكتابة اسم المتغير "العمر" في الخانة الثانية في العامود 
الأول إلى اليسار، تحت اسم المتغير الأول "الوزن" مباشرة، وبالمثل ستجد أن خانات الخيارات في الصف الثاني 

 قد ظهرت بقيمها الافتراضية، وسنقوم بتعديل الخيارات التالية:

 ( الخانات العشريةDecimals قم بكتابة الرقم :)ثم اضغط إدخال، حيث أن هذا المتغير لا يتطلب  0
 أية خانات عشرية.

 وصف المتغير (Labelقم بكتابة الوصف التالي؛ "عمر :) لسنوات" ثم إدخال.الطفل با 

 المتغير نوع (Measure( قم باختيار نوع المتغير الكمي :)Scale والذي يتناسب مع الطبيعة الكمية )
 لمتغير العمر.

وأخيرا، في أسلوب عرض المتغيرات، نقوم بتعريف المتغير الثالث في البيانات، وهو جنس أو نوع الطالب بنفس 
ود الأول إلى اليسار، تحت اسم المتغير الثاني، الطريقة؛ قم بكتابة اسم المتغير "النوع" في الخانة الثالثة في العام

                                                 
ط مرتين بالفأرة لزيادة أو إنقاص العدد المطلوب، وهذين السهمين يمكنك أيضا استخدام السهمين اللذين سيظهران داخل الخانة عند الضغ 1

 .(Variable Viewالمتغيرات ) سيظهران في كل الخانات التي تضم قيم عددية في العموم في أسلوب عرض
( Copy)" يمكن أخذ نسخة منه txt( أو أي ملف بصيغة "Wordفي حال توفر وصف جاهز )مكتوب مسبقا( للمتغير في ملف وورد ) 2

 ( داخل الخانة المطلوبة.Pasteولصقها )
في هذه المرحلة من الكتاب نذكّر القارئ دائما بالضغط على مفتاح الإدخال بعد كل عملية كتابة للقيم والخيارات، إلا أننا سنترك هذا  3

 التذكير في المراحل القادمة بعد أن يكون القارئ قد اعتاد على عملية الإدخال.
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وبالمثل ستجد أن خانات الخيارات في الصف الثالث قد ظهرت بقيمها الافتراضية، وستكون تعديلات الخيارات 
 بالصورة التالية:

 ( الخانات العشريةDecimals قم بكتابة الرقم :)ثم اضغط إدخال، حيث أن هذا المتغير لا يتطلب  0
 ت عشرية.أية خانا

 وصف المتغير (Labelقم بكتابة الوصف التالي؛ "نوع أو جنس :) ثم إدخال.الطفل " 

 المتغير نوع (Measure قم باختيار نوع المتغير :)الوصفي الاسمي (Nominal والذي يتناسب مع )
 .النوعمتغير  1طبيعة

 تصنيف قيم المتغير (Values :) مربع صغير باللون الأزرق قم بالضغط مرتين على هذه الخانة فيظهر
في يمين الخانة، قم بالضغط عليه فتظهر نافذة صغيرة في وسط الشاشة كما هو موضح في الشكل 

في  1كرمز للإناث، فنبدأ بكتابة القيمة  2كرمز للذكور، والقيمة  1سنقوم الآن بإعطاء القيمة (. 6.1)
بدون استخدام ( أسفل منها Labelالوصف )وكتابة "ذكر" في خانة (، Valueالخانة المقابلة للقيمة )

 .في كتابة الوصف أقواس

أسفل منهما. قم  (Add)بمجرد الانتهاء من تعبئة هاتين الخانتين، سيضاء المربع الخاص بالأمر 
بأنها  1="ذكر"(، بمعنى أنه قد تم تعريف القيمة 1بالضغط عليه فيظهر في الخانة المقابلة له الوصف )

 .2في المتغير المسمى النوع "ذكر"تمثل أو تصف التصنيف 

لة في الخانة المقاب 2قم بكتابة القيمة ، بالمثل سنقوم بتعريف الوصف الثاني، وهو الإناث بنفس الطريقة
فيظهر في  (Add)( ثم الضغط على الأمر Label(، وكتابة "أنثى" في خانة الوصف )Valueللقيمة )

وبعد الانتهاء من تصنيف قيم المتغير،  .3="أنثى"( أسفل الوصف الأول2الخانة المقابلة له الوصف )
 في نفس النافذة لتأكيد الانتهاء من التصنيف. (OK) موافق نضغط أمر

                                                 
 كيفية التمييز بين أنواع المتغيرات الكمية منها والوصفية في الفصل التالي. سيتم توضيح 1
للإجراء التعديل المطلوب، أو  (Change)في حال حدوث أي خطأ أثناء تعريف القيم للمتغير، يمكنك استخدام المربع الخاص بالأمر  2

 لحذف الوصف الموجود وا عادة كتابة وصف جديد. (Remove)استخدام الأمر 
في حال وجود أكثر من تصنيف للمتغير الوصفي، يتم الاستمرار بإدخال القيم العددية بنفس التسلسل حتى استكمال كل التصنيفات  3

 التالية؛ ، مقبول، جيد، جيد جدا، ممتاز(، فإنه يتم تعريف القيم)راسب الموجودة، فمثلا إذا كان المتغير الوصفي يمثل تقديرات طلبة هي؛
 ( مقابل كل تصنيف.5، 4، 3، 2، 1)
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 .SPSS برنامج النافذة الخاصة بتعريف قيم المتغير الوصفي في نافذة محرر البيانات في: 6.1شكل 

وبهذا نكون قد انتهينا من تعريف المتغيرات الثلاثة، ويمكن البدء بإدخال قيم هذه المتغيرات في أسلوب عرض 
المضي قدما في إدخال قيم  دائما حفظ ما تم إنجازه حتى الآن قبل (، إلا أنه من الأفضلData Viewالبيانات )
 .، تجنبا لفقدان البيانات نتيجة حدوث خلل طارئ في جهاز الحاسوب أو غيرها من الأسبابالمتغيرات

 (Saving Data Files)حفظ ملفات البيانات  2.4.1

فتظهر  (،File) ملفأمر ، قم باختيار سابقا( (3.1المشار إليه في شكل ))في شريط الأوامر العلوي، 
، فتظهر نافذة الحفظ كما هو (Save) الحفظ قائمة أسفل منه تحتوي على بعض الأوامر الفرعية. قم باختيار أمر

 (.7.1موضح في الشكل )

 
 .SPSS برنامج : نافذة حفظ الملفات في7.1شكل 
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( في أعلى نافذة الحفظ، قم باختيار المسار أو الموقع الذي ترغب في حفظ Look in) مسار الحفظفي شريط 
نقترح على القارئ استخدام مسار  SPSSملف البيانات فيه، ولتسهيل حفظ واستدعاء الملفات الخاصة ببرنامج 

 ( حيث أنه المسار الأكثر استخداما تحت بيئة ويندوز في العموم.Desktop) سطح المكتب

(، يمكنك اختيار الاسم الذي ترغب به لملف البيانات وسنقوم نحن File name) اسم الملفار في شريط اختي
" لملفات البيانات فيه، كما يقوم بتعيين امتدادات sav.بتعيين الامتداد " SPSS". ويقوم برنامج 1باختيار الاسم "مثال

 أخرى للأنواع الأخرى من الملفات كما سنرى لاحقا.

( في يمين Save) حفظتحديد مسار الحفظ وكتابة اسم ملف البيانات، قم بالضغط على أمر البعد الانتهاء من 
 (.8.1نافذة الحفظ فتظهر لك نافذة جديدة كما في الشكل )

 
 .SPSS برنامج : نافذة المخرجات في8.1شكل 

م بمعنى أن المستخدِ ، وهي تظهر بشكل منفصل SPSS( في برنامج Output) بنافذة المخرجاتهذه النافذة تعرف 
( Taskbarسيتعامل مع هذه النافذة في إطار جديد منفصل عن إطار البرنامج الرئيسي كما يُشاهد في شريط المهام )

في عرض كل النتائج والمخرجات الناتجة عن  SPSSوهذا هو الأسلوب القياسي المتبع في برنامج  أسفل الشاشة.
"، وهو الاسم الافتراضي لملف المخرجات، ويمكن للمستخدِم Output1الاسم "وهذه النافذة ستأخذ  الأوامر المدخلة.

 بصورة مستقلة كما هو الحال مع ملف البيانات. المخرجات حفظ ملف

ظهور رسالة داخل نافذة المخرجات توضح ما تم من حفظ لملف البيانات في مسار سطح سيُلاحظ القارئ الآن 
عودة للنافذة قم بتصغير نافذة المخرجات للاحتفاظ بها أسفل الشاشة، والفي الوقت الحالي،  ".1مثال المكتب باسم "

 الرئيسية للبرنامج حيث ستلاحظ أن اسم ملف البيانات الجديد قد ظهر في الشريط العلوي للبرنامج.

 (Data View Window)نافذة عرض البيانات  3.4.1

، السابق (1.1قبل البدء بعملية الحفظ، كنا قد انتهينا من تعريف المتغيرات للمثال الافتراضي في جدول )
 نافذة باختيارمن أسفل النافذة الرئيسية . قم SPSSفي والآن ننتقل للمرحلة الثانية وهي إدخال قيم هذه المتغيرات 
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ثة الأولى إلى اليسار قد أخذت أسماؤها كما ، وستلاحظ أن المتغيرات الثلا(Data Viewاسلوب عرض البيانات )
 تم إدراجها في أسلوب عرض المتغيرات؛ الوزن، العمر، والنوع.

 12ثم  10.2(، أي ستبدأ بإدخال القيمة 1.1قم بإدخال قيم المتغير الأول، وهو الوزن بنفس ترتيبها في الجدول )
رة خاطئة في إحدى الخلايا )المربعات الفارغة( . وفي حل إدخال قيمة بصو 14.8وهكذا وصولا للقيمة الأخيرة 

 يمكنك العودة لتلك الخلية وا عادة كتابة القيمة الصحيحة.

وصولا للقيمة الأخيرة  5ثم  4بعد ذلك يتم إدخال قيم المتغير الثاني وهو العمر بنفس الكيفية، أي بداية من القيمة 
النوع، فإن قيمه يتم إدخالها بصورة رقمية وليس اسمية كما تم أما بالنسبة للمتغير الوصفي . 6في المتغير وهي 

 1( في أسلوب عرض المتغيرات في المرحلة الأولى، أي أننا سندخل القيمة Labelتعريفها في خانة الوصف )
البيانات لديك كما هو في ملف قيم المقابل كل نوع "أنثى". وفي النهاية ستكون  2مقابل كل نوع "ذكر" والقيمة 

 (.9.1وضح في الشكل )م

 
 ".1مثال"البيانات  المتغيرات في ملف : قيم9.1شكل 

 

في شريط أيقونات الأوامر للتغيير بين  ويمكن للمستخدِم الضغط على أيقونة عرض وصف المتغير 
 عرض قيم المتغير الرقمية أو قيم المتغير الاسمية.
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 :ملاحظة
بجانب اسم ملف البيانات في الشريط العلوي، وهذه هي طريقة البرنامج في  (*)لاحظ ظهور رمز النجمة 

لم يتم حفظها بعد، لذلك يمكنك و تنبيه المستخدِم إلى أنه قد تم إجراء تعديلات أو إضافات إلى ملف البيانات 
 ( في شريطFileملف )بمعنى الضغط على  File>Saveبعد إتمام إدخال البيانات حفظ الملف باستخدام 

فيتم حفظ  (، أو لمزيد من السرعة، يمكنك الضغط على أيقونة الحفظ Saveالأوامر ثم حفظ )
 التعديلات الأخيرة.

" يحتوي على ثلاثة متغيرات مُعرّفة بشكل واضح 1باسم "مثال SPSSالآن أصبح لدينا ملف بيانات في برنامج 
لبيانات على سطح المكتب بالصورة يكون شكل أيقونة ملف او وجاهزة للتحليل الإحصائي،   .

أما بالنسبة لنافذة المخرجات فيمكن تجاهلها )عدم حفظها( في المرحلة الحالية، وسيتم التعامل معها في أمثلة 
ملف المخرجات، للاستفهام عن رغبة المستخدِم في حفظ  رسالةقم بإغلاق نافذة المخرجات وستظهر لك  لاحقة.

، قم بإغلاق نافذة البرنامج SPSSفي برنامج  ولإنهاء الجلسة الحالية ( وستُغلق النافذة.Noقم عندها باختيار لا )
 (.Yesالرئيسية وستظهر لك رسالة تنبيه إلى أن البرنامج سيتم إغلاقه، قم عندها باختيار نعم )

الملف في مسار تخزينها، " أو أي ملف بيانات آخر، يمكنك إما النقر مرتين على أيقونة 1"مثالولفتح ملف البيانات 
في شريط أيقونات الأوامر ثم اختيار مسار  على أيقونة فتح الملفات  1ثم الضغط SPSS أو فتح برنامج

ولاحظ  (.Open" ثم اختيار فتح )1ثم اختيار الملف المرغوب وهو "مثالالتخزين )وهو سطح المكتب في مثالنا( 
 وح.نافذة المخرجات ستظهر أيضا مع الملف المفتأن 

 SPSS (General Settings)في برنامج  العامة الإعدادات 5.1

، كشأن كل البرامج تحت مظلة ويندوز، تغيير الكثير من الإعدادات الافتراضية SPSSيمكن في برنامج  
في البرنامج، مثل شكل النوافذ، أشكال وألوان الجداول والرسومات البيانية، حجم ونوع ولون الخطوط المستخدمة، 

. وهذه الإعدادات يمكن الوصول إليها من شريط الأوامر العلوي باختيار الأموركيفية عرض النتائج، وغيرها من 
آخر القائمة. عندها ستظهر نافذة الإعدادات أو الخيارات، ( في Options( ثم اختيار خيارات )Editالأمر تحرير )

في إعدادات البرنامج قبل أن يكونوا قد قطعوا شوطا جيدا  وهنا ننصح المستخدمين المبتدئين بعدم إجراء تغييرات
 في الالمام بالتعامل مع المخرجات من جداول ورسومات وغيرها.

                                                 
( ثم بيانات Open( في شريط الأوامر ثم فتح )Fileأمر ملف ) أو يمكن استخدام الطريقة التقليدية في فتح الملفات عن طريق اختيار 1
(Data.ومن ثمة اختيار ملف البيانات من المسار المحدد ) 
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إلا أننا سوف نقوم بتعديل واحد فقط هنا بُغية تسهيل الوصول للملفات المحفوظة. سنقوم بالدخول لنافذة الإعدادات 
 .(10.1( كما يظهر في الشكل )File Locations) مواقع الملفاتواختيار نافذة 

 

 .SPSS: نافذة الخيارات العامة في برنامج 10.1شكل 

( بشكل دائم، Desktopسنقوم في هذه النافذة بتغيير مسار فتح وحفظ ملفات البيانات إلى مسار سطح المكتب )
 تحت بيئة ويندوز في العموم كما وضحنا سابقا. المفضل للمستخدمينحيث أنه المسار 

 لنقر على خيار(، قم باStartup Folders for Open and Save Dialogsفي مربع المجلدات الافتتاحية )
(. الآن سنقوم باختيار مسار سطح المكتب في كلا المربعين؛ ملفات البيانات Specified Foldersالمجلد المحدد )

(Data files( والملفات الأخرى )Other filesوذلك إما عن طريق ك ،) تابة مسار سطح المكتب مباشرة، أو
 ( على اليمين واختيار المسار المطلوب.Browseالضغط على زر التصفح )

يحتوي على اسم جهاز الحاسوب ((، 10.1ويمكن للقارئ هنا ملاحظة أن مسار سطح المكتب، )في الشكل )
 ير المسار بالطبع.، والذي سيتضمن اسم جهاز المستخدم عند تغيSPSS برنامجالذي يعمل عليه  للمؤلف الحالي
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 الفصل الثاني

 SPSSبرنامج  التعامل مع ملفات البيانات في

(Dealing with Data Files in SPSS) 

 

 SPSS (Importing Files to SPSS)برنامج  استيراد الملفات إلى 1.2

واجهة المستخدم البيانية طريقة ب SPSSتناولنا في الفصل السابق طريقة إدخال البيانات في برنامج 
(Graphical User Interface (GUI)) وأوضحنا أن هذه الطريقة تعتبر الطريقة ، تحرير البيانات باستخدام نافذة

. إلا أنه في بعض الأحيان، قد تكون البيانات متوفرة SPSSفي إدخال البيانات في  والأكثر استخداما المباشرة
، S-plus ،Statistica ،R ،SAS(، MS Excelي ملفات بيانات ضمن برامج أخرى، مثل اكسل )مسبقا ف

 SPSSوغيرها، عندها وتوفيرا للوقت والجهد يمكن للمستخدِم استيراد هذه الملفات من مصدرها الأصلي إلى برنامج 
 والتعامل معها مباشرة.

 :ملاحظة
البرامج معظم  ه فيحيث أن 1في هذا البند، سيتم توضيح كيفية استيراد ملفات البيانات من برنامج اكسل فقط

 ائية الأخرى يمكن بسهولة حفظ أو تصدير ملف البيانات بصيغة اكسل.الإحص

لي خطوة بخطوة لتسهيل العملية لتوضيح طريقة استيراد ملفات البيانات من برنامج اكسل، سنقوم بتطبيق مثال عم
يد في برنامج ((، في ملف بيانات جد1.2للمستخدِم. قم أولا بإدخال البيانات الموجودة في الجدول التالي، )جدول )

 "..xlsxأي أنه سيأخذ الامتداد " ".بيانات الطلبةبالاسم " 3، وقم بحفظه2اكسل

طالبا جامعيا مقاسة لثمانية  35 ب( هي بيانات افتراضية تمثل المشاهدات الخاصة 1.2البيانات في جدول )
 بالصورة التالية. عرّفةمتغيرات م

  

                                                 
( في شريط الأوامر Helpللمزيد من المعلومات حول استيراد ملفات البيانات بصيغ أخرى غير صيغة اكسل، يمكن الرجوع للمساعدة ) 1

 .SPSSي في برنامج الرئيس
 في التطبيقات وقت إعداد الكتاب. Excel 2016و Excel 2010تم استخدام الإصدارات  2
 يُفضل حفظ ملف بيانات اكسل في مسار سطح المكتب لتسهيل استدعاؤه لاحقا. 3
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 في  1: درجة الطالب1مقرر
 .1المقرر

 2: درجة الطالب في المقرر2مقرر. 
 3: درجة الطالب في المقرر3مقرر. 
  (بالسنوات)العمر: عمر الطالب. 
 ( ذكر، 1النوع: جنس الطالب=

 =أنثى(.2و
  الفصل: ترتيب الفصل الدراسي

 للطالب.
 .الأسرة: عدد أفراد أسرة الطالب 
  المنزل: عدد الحجرات في منزل

 الطالب.

  

                                                 
 درجة. 100درجة الطالب في المقررات الثلاثة مقاسة من  1

 ."الطلبة بيانات": البيانات الخاصة بالملف 1.2جدول 
 المنزل الأسرة الفصل النوع العمر 3مقرر 2مقرر 1مقرر 
1 55 50 60 22 1 3 10 2 
2 49 52 50 19 1 8 11 2 
3 60 54 51 23 1 2 10 2 
4 65 70 54 20 2 3 8 3 
5 35 40 40 24 1 7 12 2 
6 71 70 45 22 1 4 9 3 
7 73 74 49 21 1 5 9 4 
8 90 91 61 22 2 4 3 6 
9 88 93 59 20 2 4 3 5 
10 75 77 60 22 1 3 6 4 
11 50 51 61 25 1 7 9 3 
12 77 79 59 24 1 2 6 4 
13 79 81 33 23 2 4 4 5 
14 66 70 60 21 1 6 5 4 
15 80 82 58 20 2 2 5 5 
16 40 44 60 24 1 8 12 2 
17 45 50 43 25 1 7 11 3 
18 51 55 94 24 2 6 9 3 
19 82 85 50 22 2 3 4 5 
20 75 77 27 22 1 5 4 4 
21 84 84 57 20 2 4 4 5 
22 86 87 52 23 2 8 4 4 
23 77 78 57 22 2 6 5 5 
24 88 90 62 19 2 7 3 5 
25 64 70 50 21 1 7 7 3 
26 89 91 53 23 2 4 3 5 
27 90 93 50 21 2 6 3 6 
28 63 66 51 25 1 5 5 4 
29 75 85 95 22 2 3 2 6 
30 69 70 44 23 1 5 6 4 
31 77 80 92 21 2 8 4 5 
32 68 69 54 22 1 6 5 5 
33 93 75 45 23 2 5 2 6 
34 73 75 52 24 1 6 5 4 
35 94 96 49 21 2 4 2 6 
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لذلك  1بعد إدخال بيانات الجدول السابق في اكسل وحفظها بالاسم المطلوب، سنحصل على ملف بيانات مشابه
 .(1.2الموضح في الشكل )

 

 في برنامج اكسل. "بيانات الطلبة": ملف البيانات 1.2شكل 

 :SPSSالآن سنقوم بتنفيذ الخطوات التالية لفتح )استيراد( ملف بيانات بصيغة اكسل في برنامج 

اختيار أمر )أو يمكن    أيقونة فتح الملفات في شريط أيقونات الأوامرقم باختيار  SPSSفي برنامج 
 (.(Data( ثم بيانات )Openالأوامر ثم فتح ) ( في شريطFileملف )

قم أولا باختيار مسار الملف المطلوب، وهو سطح  (،2.2كما هو موضح في الشكل ) في نافذة فتح الملفات،
وسيظهر الملف المكتب الذي تم حفظ الملف فيه، وثانيا قم باختيار نوع الملف المطلوب، وهو ملف اكسل، 

 (.Openثم اضغط أمر الفتح ) هاء في النافذة، قم باختيار المطلوب داخل المساحة البيض

                                                 
، أو إذا Excel 2016 ، أو Excel 2010القارئ يستخدم اصدار مختلف عن الإصدارين قد يختلف شكل الملف قليلا إذا ما كان  1

 كان يستخدم الواجهة الإنجليزية للبرنامج.
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 .SPSS: خطوات فتح ملف اكسل في نافذة فتح الملفات في برنامج 2.2شكل 

(، والتي تحتوي على بعض 3.2بعد الضغط على أمر الفتح، ستظهر نافذة جديدة، كما هو ظاهر في الشكل )
 ها كالتالي؛الخيارات التي يمكن للمستخدِم الاستفادة من

 
 .SPSS: الخيارات الخاصة بفتح ملف اكسل في برنامج 3.2شكل 

الخيار )أ( يتم اختياره عندما تكون أسماء المتغيرات في ملف البيانات موجودة في الصف الأول، )وهذا هو الحال 
ف اكسل الأصلي، )وفي في مثالنا الحالي(. أما الخيار )ب(، فهو لتحديد الورقة التي توجد فيها البيانات في مل

يمكن للمستخدِم اختيار مجموعة (. وفي الخيار الثالث )ج(، 1الأولى؛ ورقة 1مثالنا البيانات موجودة في الورقة

                                                 
 حيث أن برنامج اكسل يوفر افتراضيا ثلاثة ورقات لكل ملف بيانات. 1
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محددة من المتغيرات التي يرغب باستيرادها من داخل ملف اكسل إذا لم يرغب باستيراد كل المتغيرات، )وفي مثالنا 
 أن كل المتغيرات في الملف سيتم استيرادها(.تم ترك هذا الخيار فارغا بمعنى 

(، وسيتم فتح ملف البيانات المطلوب، وكذلك فتح نافذة OKبعد الانتهاء من خيارات الفتح اضغط موافق )
. وبالطبع، سنقوم SPSSالمخرجات كالمعتاد، وستجد أن كافة المتغيرات قد تم استيرادها بنفس الأسماء إلى برنامج 

، قبل الانتقال للخطوة التالية. وخطوات الحفظ ستكون مطابقة لما تم توضيحه في الفصل SPSSبحفظها بصيغة 
ثم اختيار مسار الحفظ، )وليكن كما هو  File>Saveأي أن المستخدِم سيقوم باختيار ((، 2.4.1الأول )في البند )

"(، بيانات الطلبةالمستخدَم " سطح المكتب(، ثم اختيار اسم الملف، )وليكن نفس الاسم الأصلي على الحال دائما
 (.Saveضغط حفظ )نثم 

 :ملاحظة
بنفس الاسم على سطح المكتب، الأول هو بصيغة اكسل  مختلفان لاحظ هنا أنه سيكون لديك الآن ملفان

 ".بيانات الطلبةsav.وهو بالامتداد " SPSSوالآخر بصيغة  ،"بيانات الطلبةxlsx."بالامتداد 

يمكنك ملاحظة أن خصائص المتغيرات بحاجة إلى بعض  "بيانات الطلبةsav." ؛SPSS الآن في ملف بيانات
 التعديل، وفيما يلي سنقوم بإجراء التغيرات التالية بهدف جعل الملف أكثر تنظيما للاستخدامات اللاحقة؛

  عمسافة تغيير( رض قيم المتغيرWidth) 8 الافتراضية القيمة لجميع المتغيرات إلى. 

  عدد الخاتغيير( نات العشريةDecimals) نظرا لطبيعة الأعداد الصحيحة  0 لجميع المتغيرات إلى
 للمتغيرات.

 اتمتغير لل إضافة الأوصاف التالية (Label)؛ 

 .1: درجة الطالب في المقرر1مقرر .1

 .2: درجة الطالب في المقرر2مقرر .2

 .3: درجة الطالب في المقرر3مقرر .3

 العمر: عمر الطالب بالسنوات. .4

 الطالب. النوع: جنس .5

 ترتيب الفصل الدراسي للطالب.الفصل:  .6

 الأسرة: عدد أفراد أسرة الطالب. .7

 المنزل: عدد الحجرات في منزل الطالب. .8

 إضافة ال( تصنيفValues) أنثى(.2= ذكر، و1) ؛النوع قيم متغيرل التالي = 

  تغيير( عرض العامودColumns)  8لجميع المتغيرات إلى القيمة الافتراضية. 
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 اتع المتغير ا و نإبقاء أ (Measure) العمر"، و"3مقرر"، "2مقرر"، "1مقرر"؛" ( كميةScale ومتغير ،)
(، Ordinalإلى وصفي ترتيبي ) "الفصل"(، وتغيير نوع المتغير؛ Nominalوصفي اسمي ) "النوع"

 (.Scaleإلى كمي ) "المنزل"و "الأسرة"وتغير نوع المتغيران؛ 

 الملف. نغلقثم  (.4.2الذي سيبدو كما هو موجود في الشكل )بعد ذلك بحفظ ملف البيانات، و  نقوم

 

 

 .SPSSفي  "بيانات الطلبة"لملف البيانات  )في الأسفل( وعرض البيانات )في الأعلى( : أسلوبي عرض المتغيرات4.2شكل 

 SPSS (Exporting Files from SPSS)برنامج  منالملفات  تصدير 2.2

تم تطبيقه مع برنامج اكسل(، فإنه  والذيلفات البيانات من البرامج الأخرى، )كما هو الحال مع استيراد م 
إلى البرامج الأخرى. وما سنقوم بتطبيقه في هذا  SPSSيمكن وبصورة أبسط، تصدير الملفات المحفوظة بصيغة 
 باعتباره، وهي صيغة برنامج اكسل ( بصيغة أخرى SPSSالبند، هو حفظ ملف البيانات )المتوفر مسبقا بصيغة 

يمكن للمستخدِم حفظ ملف . ومن أهم البرامج التي بين معظم البرامج الإحصائية والرياضية "الصيغة المشتركة"
، وكذلك يمكن dBase ،SAS ،Stataالبيانات بصيغتها المباشرة )بإصدارات مختلفة( هي البرامج التالية؛ اكسل، 

 (.txt.حفظ ملف البيانات بصورة نصية )بالامتداد 
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كمثال تطبيقي على  SPSS" في برنامج 1لنأخذ ملف البيانات الذي قمنا بتكوينه في الفصل الأول باسم "مثالو 
 كالتالي: تصدير الملف ستكون خطواتو  .حفظ الملفات بصيغة اكسل

 .SPSS" الموجود في مسار سطح المكتب في برنامج 1"مثالقم بفتح ملف البيانات  .1

(، فتظهر النافذة الخاصة Save As( ثم حفظ باسم )Fileختيار ملف )في شريط الأوامر العلوي، قم با .2
 (.5.2بالحفظ، كما يظهر في الشكل )

كما يوضح السهم  ،في هذه النافذة، قم بالضغط على الخيار الخاص بتحديد نوع الملف المطلوب حفظه .3
امج التي يمكن الموجود في الشكل. ستنسدل عند ذلك قائمة صغيرة تحتوي على أسماء البر  (1)رقم 

صدار( حفظ الملف بها. في مثالنا، سنقوم بحفظ الملف بصيغة اكسل )الإصدار  ( 2010اختيار صيغة )وا 
 في الشكل. (2)كما يشير السهم 

( في النافذة. وبذلك تكون عملية حفظ ملف البيانات )بنفس Saveبعد ذلك قم بالضغط على أمر حفظ ) .4
" على سطح 1مثالxlsx.ويمكنك بعدها مشاهدة ملف البيانات ""( بصيغة اكسل قد تمت، 1الاسم "مثال

بنفس  ؛ الوزن، العمر، والنوع موجودة فيهالمكتب. قم بفتحه وستجد البيانات المتعلقة بالمتغيرات الثلاثة
 .النسق

 

 .SPSSبصيغة اكسل بداخل برنامج  "1"مثال: خطوات حفظ ملف البيانات 5.2شكل 
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 (Data Manipulation)البيانات  معالجة 3.2

بعض  أو معالجة في كثير، إن لم يكن معظم الأحيان، قد يحتاج المستخدِم أو الباحث إلى إعادة ترتيب
أو  تعريف متغير جديد الإحصائيةتطلب الدراسة تأو قد  ،1بناء على تقسيم معين داخل ملف البيانات المتغيرات

رياضية  3أو ربما تعريف متغير جديد كدالة البيانات الأصلية، متغير أو أكثر في مع 2علاقته اعتمادا على أكثر
معالجة البيانات الأصلية لتحقيق أهداف معينة في الدراسة أو وغيرها من الحالات التي تستدعي  في متغير آخر،

 في هذه الحالة، يمكن استخدام الأدوات الخاصة بمعالجة أو ترتيب البيانات. ،التحليل الإحصائي

استخدام أداة ترتيب المشاهدات للمساعدة في إعادة ترتيب القيم تصاعديا أو تنازليا إما لتنظيمها بصورة  اأيض يمكنو 
 SPSS. ويمكن في برنامج الاحق البيانات أكثر وضوحا، أو لتقسيم البيانات المرتبة استعدادا لاستخدامها في تحليل

 حتى أكثر من ذلك. قيم متغير واحد أو متغيرين أو على تقسيم البيانات بناء

" 1، لنأخذ مثالا عمليا لترتيب البيانات الخاصة بملف البيانات "مثالSPSSترتيب البيانات في لتوضيح كيفية تنفيذ و 
 Dataثم اختر أسلوب عرض البيانات ) الذي تم إنشاؤه في الفصل الأول. قم بفتح الملف من مسار سطح المكتب

View،)  (.في الفصل الأول (9.1ح في الشكل )كما هو موض) ،البياناتفتظهر 

 "العمر"و "الوزن "سنقوم أولا في هذا المثال بترتيب أوزان الأطفال وأعمارهم بحسب جنس الطفل، أي أن متغيري 
سيتم إعادة ترتيب قيمهما بحسب جنس الطفل ذكرا كان أو أنثى. وحيث أن الذكور في هذه البيانات تم تعيينهم 

، فإن أوزان وأعمار الأطفال الذكور سيتم عرضها في الصفوف الأولى متبوعة بأوزان 2ة والإناث للقيم 1للقيمة 
 وأعمار الإناث. وسنقوم الآن بتنفيذ الخطوات التالية:

( من القائمة Sort Cases( ثم اختار ترتيب المشاهدات )Dataفي شريط الأوامر العلوي، قم باختيار بيانات ) .1
 (.6.2كما هو موضح في الشكل )المنسدلة، فتظهر نافذة جديدة 

كما هو  "النوع"، قم باختيار متغير الطالب نوع متغير بحسب "العمر"و "الوزن "حيث أننا سنقوم بتقسيم متغيري و  .2
(، فينتقل المتغير إلى الخانة 2( في الشكل. ثم اضغط على السهم المشار إليه في رقم )1مشار إليه في رقم )
 لتي تشير لمتغير التصنيف المحدد.(، وا3المشار إليها بالرقم )

                                                 
 كأن يتم ترتيب المتغيرات بناء على النوع أو الوزن أو المستوى التعليمي، وغيرها. 1

 مثل أن يتم تعريف متغير جديد يمثل مدخرات الأشخاص بناء على الراتب الشهري والدخل الإضافي والمصروف الشهري. 2

 مثل تعريف متغير كتلة الجسم كدالة في متغير الوزن. 3
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 ."1"مثال: نافذة ترتيب المشاهدات لملف البيانات 6.2شكل 
 

 :ملاحظة
( في النافذة، فسيتم تنفيذ إعادة الترتيب المطلوب في نفس ملف البيانات OKإذا ما قمت بالضغط على )

ية، لذلك يُفضل عادة حفظ " وهذا سيؤدي بدوره لتغيير ترتيب البيانات بصورة نهائ1الأصلي "مثال
التغييرات الجديدة في ملف بيانات جديد لتمكين المستخدم من العودة للبيانات الأصلية متى أراد ذلك. 

 وهذا ما سنقوم به في الخطوة التالية.

( المشار إليه Fileثم اضغط على أمر ملف )(، 6.2( في شكل )4قم باختيار الخيار المشار إليه في الرقم ) .3
ستظهر بالطبع  .( وذلك لتحديد مسار واسم الملف الجديد الذي سيحتوي على البيانات المُعاد ترتيبها5م )بالرق

" للملف الجديد واضغط 2نافذة حفظ البيانات المعتادة، قم باختيار مسار سطح المكتب ثم قم بتعيين الاسم "مثال
 (.Fileف واسمه بجانب أمر ملف )ستلاحظ بعد ذلك، في نفس النافذة، ظهور مسار المل (.Saveحفظ )

يمكن للمستخدِم ترتيب متغيري الوزن والعمر  ((،6.2( في الشكل )6)مشار إليها بالرقم ) كخطوة اختيارية، .4
لمتغير النوع، أي يمكن أن يكون ( Descending( أو التنازلي )Ascendingبحسب الترتيب التصاعدي )

في مثالنا،  .)تنازليا( 2)تصاعديا( أو للإناث المعرفات بالقيمة  1 التصنيف الأول هو للذكور المعرفين بالقيمة
وهو التصاعدي، كما هو بدون تغيير، وسننهي خطوات إعادة ترتيب المتغيرات سنبقي الترتيب الافتراضي، 

 (.7.2"، كما يظهر في الشكل )2ملف البيانات الجديد بالاسم "مثال 1في النافذة، فيظهر موافقبالضغط على 
حظ من الشكل كيف أن قيم مشاهدات الوزن والعمر للأطفال الذكور قد ظهرت في الصفوف الأولى متبوعة ولا

 بالقيم الخاصة بالأطفال الإناث.

                                                 
 " سيُغلق تلقائيا.1لاحظ أن ملف البيانات الأصلي "مثال 1
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 .("2"مثال البيانات ملف) ،: البيانات المصنفة بحسب جنس الطالب7.2شكل 

افترض  ،عمليا ، كما أشرنا سابقا. ولتنفيذ ذلكبدلا من متغير واحد متغيرينويمكن إعادة ترتيب البيانات بناء على 
ملف  1بفتح فنقوم " بناء على جنس الطفل أولا ثم عمر الطفل ثانيا،1أننا نريد ترتيب البيانات في الملف "مثال

 السابقة مع إجراء التغييرات التالية؛" من جديد، ثم إعادة تنفيذ الخطوات 1البيانات "مثال

 قم باختيار متغير (3ونقله للخانة المشار إليها بالرقم ) ختيار متغير النوعوبعد ا :في الخطوة الثانية ،
 (.3العمر ثم نقله للخانة )

 3في الخطوة الثالثة: قم بتعيين الاسم "مثال( للملف الجديد واضغط حفظ "Save)موافق ، ثم اضغط 
(OK( فيظهر ملف البيانات المطلوب كما يظهر في الشكل )8.2.) 

 

 .("3"مثالالبيانات  ملف) ،البيانات المصنفة بحسب جنس الطالب ثم عمره: 8.2شكل 

                                                 
 ا." سيبقى مفتوح2لاحظ هنا أن ملف البيانات "مثال 1
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" هي مرتبة بحسب جنس 3ولاحظ هنا الفرق في طريقة عرض البيانات في الملفين أن البيانات في الملف "مثال
ن ويلي ذلك الترتيب الثاني بحسب عمر الطفل تصاعديا ضمن كل جنس، بمعنى أالطفل أولا )ذكور ثم إناث(، 

في  1)المناظرة للقيمة  أوزان الأطفال ستكون موزعة أو مصنفة إلى قسمين؛ الذكور ثم الإناث، وأوزان الذكور
 2)المناظرة للقيمة  سنوات(، وأوزان الإناث أيضا 6إلى  4ستكون موزعة بحسب أعمارهم )بداية من  متغير النوع(

 سنوات(. 9إلى  4ستكون موزعة بحسب أعمارهن )بداية من  في متغير النوع(

 بناء على متغير آخر أو أكثر بنفس الطريقة السابقة.وهكذا، فإنه يمكن إعادة ترتيب أو تصنيف أي متغير أو أكثر 
" بحسب العمر أو الوزن فقط، أو بحسب العمر 1ويمكن للقارئ، كتمرين إضافي، إعادة ترتيب بيانات المثال "مثال

 .ت الجديدة بأسماء مختلفة، وتسمية البياناثم الجنس، ...، وهكذا

 (Counting Case Occurrence) حساب تكرار المشاهدات 4.2

( على Questionnaireفي كثير من الدراسات التي يعتمد جمع البيانات فيها على توزيع استبيان ) 
رأي  مجموعة من الأشخاص أو الهيئات وأخذ آراؤهم في مواضيع محددة، قد يحتاج الباحث إلى حساب )أي جمع(

كل مستبْين )مستهدف( لمجموعة من الأسئلة للخروج بقيمة عددية )كمية( تعكس مدى موافقة أو عدم موافقة 
حساب تكرار هذه الآراء وتعريفها  SPSSالمستبْين على هذه الأسئلة، وفي هذه الحالة يمكن باستخدام برنامج 

بتوضيح كيفية تنفيذ هذه المهمة باستخدام مثال تغير جديد يتم إضافته للبيانات الأصلية. وسنقوم فيما يلي كم
 توضيحي.

عيناااة  ( تمثااال آراء أو أجوباااة2.2البيااااناااات في الجااادول )
شاااااخص ردا على المطلوب التالي: "ضاااااع  12 مكونة من
شااااااارة  (√)إشااااااارة   (×)أمام التطبيقات التي تسااااااتخدمها وا 

طبيقات هي التهذه ي لا تساااااااتخدمها". و أمام التطبيقات الت
؛ تطبيقات في مجال التواصااااااااال الاجتماعي أشاااااااااهر أربعة

 فايبر، (WhatsApp) واتساب، ((Facebook فيسبوك
(Viber) نسااااااااااااااتجرام، و . وخلال مرحلاااة (Instagram) ا 

( 12، ...، م2، م1تفريغ الاسااااااااااااااتبيااان، تم إدراج القيم )م
وتم تعيين كمتغير يمثل أساااااااااماء الأشاااااااااخاص في العينة، 

للإجابة بلا  0وتعيين القيمة  (√)للإجابة بنعم  1القيمة 
فمثلا،  .وذلاااك لكااال تطبيق من التطبيقاااات الأربعاااة (×)

يسااااتخدم تطبيقي  كانت إجابته بأنه (1الشااااخص الأول )م
نستجرام، وهكذا.  فيسبوك وواتساب ولا يستخدم تطبيقي فايبر وا 

: الآراء الخاصة بعينة من الأشخاص حول 2.2جدول 
 استخدام بعض تطبيقات التواصل الاجتماعي.

 إنستجرام فايبر واتساب فيسبوك المستخدم 
 0 0 1 1 1م 1
 0 0 0 1 2م 2
 0 0 1 0 3م 3
 1 1 1 1 4م 4
 0 1 0 0 5م 5
 0 0 0 0 6م 6
 0 1 1 1 7م 7
 1 1 0 1 8م 8
 1 0 0 1 9م 9
 1 1 1 1 10م 10
 1 1 0 1 11م 11
 0 1 1 0 12م 12
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(، والذي سنتناوله Dummy Variable) بالمتغير الوهميحت ما يسمى وهذا النوع من الترميز للمتغيرات يندرج ت
 تحديدا(. 3.3.3بشرح أكثر تفصيلا في الفصل الثالث، )في البند 

ثم  ،"تطبيقات التواصل الاجتماعي"باسم  SPSS( في ملف بيانات جديد في 2.2قم أولا بإدخال بيانات الجدول )
 ((.9.2في الشكل التالي )شكل ) قم بإجراء التغييرات الخاصة كما هو موضح

 :ملاحظة
( Numeric( بدلا من )String( إلى )Typeبالنسبة للمتغير الأول؛ "المستخدم"، قم بتغيير طبيعة المتغير )

 سماء المستخدمين كقيم غير عددية للمتغير.لكي تتمكن من إدخال أ

لتطبيقات، أي تعريف متغير جديد يمثل ي المستخدم جابات بنعمالإ كل جمعفي هذا المثال هو  تنفيذه المطلوب
عدد التطبيقات التي يستخدمها كل شخص من بين هذه التطبيقات الأربعة، وبمعنى أبسط؛ المتغير الجديد سيكون 

 عبارة عن حاصل جمع كل صف في الأعمدة الأربعة الأخيرة.

 

 

 ."تطبيقات التواصل الاجتماعي"لأسفل( لملف البيانات : أسلوبي عرض المتغيرات )في الأعلى( وعرض البيانات )في ا9.2شكل 
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( في شريط Transform) تحويل أمر ، قم باختيار"تطبيقات التواصل الاجتماعي"في نافذة عرض البيانات لملف 
( من القائمة Count Values within Cases) د القيم ضمن المشاهداتع  أمر الأوامر العلوي، ثم اختر 

 (.10.2ك النافذة الخاصة بتنفيذ هذه العملية كما يُشاهد في الشكل )فتظهر لالمنسدلة. 

يتم إدخال اسم للمتغير الجديد الذي سيمثل  (،Target Variableوهو مربع المتغير المستهدَف ) (،1في الخانة )
وهو وصف  (،2ة )في مثالنا(، وليكن هذا الاسم هو "التطبيقات". وفي الخان 1تكرارات القيمة المطلوبة )وهي القيمة 

يكن الوصف هو "عدد ليتم كتابة وصف لما يمثله هذا المتغير الجديد، و  (،Target Labelالمتغير المستهدَف )
 التطبيقات المستخدمة".

 

 : النافذة الخاصة بتنفيذ عد تكرارات القيم ضمن المشاهدات.10.2شكل 

نا ستكون رغب المستخدم في جمع تكرارات قيمها، وفي مثالالمتغيرات التي ي 1(، يتم اختيار3بعد ذلك، وفي الخانة )
بعد اختيارها، اضغط على سهم نقل المتغيرات و  المتغيرات المطلوبة هي "فيسبوك"، "واتساب"، "فايبر"، و"إنستجرام".

 (.4الخانة )في  (Variablesمربع المتغيرات ) فتنتقل المتغيرات التي تم اختيارها إلى

في كل المتغيرات الأربعة(، ويتم ذلك  1كون تحديد القيمة المطلوب جمع تكراراتها، )وهي القيمة المرحلة التالية ست
(. فتظهر نافذة جديدة كما 5( المشار إليه بالسهم )Define Values) تعريف القيمعن طريق الضغط على خيار 

 ((.11.2يظهر في الشكل التالي، )شكل )

 :ملاحظة
(، فيمكن استخدامه إذا ما أراد المستخدم وضع قيد أو شرط If) إذادالة الشرطية وهو ال(، 6بالنسبة للخيار )

على عملية عد التكرارات ضمن المتغيرات بحيث يتم اعتبار أو استثناء قيم محددة بناء على الشرط أو الشروط 
 الموضوعة من قِبل المستخدم.

                                                 
 يمكن أن يتم اختيار كل متغير على حدة أو تظليل كل المتغيرات المطلوبة واختيارها معا. 1
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المطلوب عد تكراراتها في المتغيرات في الخانة )أ(، ((، يتم إدخال القيمة 11.2في هذه النافذة الجديدة، )شكل )
 في هذه الخانة. 1م إدخال القيمة وفي مثالنا سيت(، Valueوهو مربع القيمة )

( المشار إليه بالسهم )ب(، قم بالضغط عليه فتنتقل Add) إضافةسيضاء مربع خيار ، 1القيمة  1وبمجرد كتابة
. قم بعدها بإنهاء العملية عن (Values to countم التي سيتم عدها )، وهو مربع القيإلى الخانة )ج( 1القيمة 

 ( في أسفل النافذة.Continue) استمرارطريق الضغط على 

 :ملاحظة
(، فيُستخدَم عندما نرغب بِعَد تكرارات قيم تتراوح في مدى أو فترة Range) المدىبالنسبة للخيار )د(، وهو 

فقط من ضمن متغيرات  4إلى  2ا كان المطلوب هو عد تكرارات قيم من معينة وليس عَد قيم مفردة، فمثلا إذ
في  4في الخانة الأولى التي تليه وكتابة  2، فيتم اختيار الخيار )د( ثم كتابة 5إلى  1معينة تضم قيما من 

 Range, value( و)Range, LOWEST through valueالخانة الثانية. أما الخيارين الأخيرين؛ )

through HIGHEST ،فيُستخدمان عندما يكون المطلوب هو عد تكرارات قيم من قيمة معينة فأعلى منها )
 أو قيمة معينة فأدنى منها، على الترتيب.

 

 

 : النافذة الخاصة بتحديد قيم التكرارات المطلوب عدّها ضمن المشاهدات.11.2شكل 

                                                 
 ( في لوحة المفاتيح.Enterبدون الضغط على أمر الإدخال ) 1
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والتي ((، 10.2تم العودة للنافذة الأولى، )الشكل )( في النافذة السابقة، سيContinue) استمراربعد الضغط على 
 ((؛12.2ستبدو بالصورة التالية، )شكل )

 

 : النافذة الخاصة بتنفيذ عد تكرارات القيم ضمن المشاهدات بعد تطبيق الخيارات.12.2شكل 

يُشاهد في الشكل  ( لإنهاء العملية بالكامل، وستلاحظ ظهور متغير جديد، هو "التطبيقات"، كماOKاضغط موافق )
. من بين التطبيقات الأربعة (، والذي يمثل عدد التطبيقات التي يستخدمها كل شخص في عينة البيانات13.2)

 (.للبيانات ، للحصول على مظهر أفضل0)ويمكن للقارئ تغيير عدد الخانات العشرية للمتغير الجديد إلى 

 

 بعد تعريف متغير "التطبيقات". جتماعي""تطبيقات التواصل الا: عرض بيانات ملف 13.2شكل 
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 (Recoding Variables)إعادة ترميز المتغيرات  5.2

أيضا إمكانية إعادة ترميز أو تغيير قيم متغير أو أكثر في البيانات بحسب ما تتطلبه  SPSSيوفر برنامج   
يم المتغير بشكل تلقائي وليس أو كل ق ويُقصد بإعادة الترميز هنا تغيير بعض الدراسة أو التحليل الإحصائي.

 المقصود هو تصحيح بعض الأخطاء ضمن القيم؛

فمثلا عند اكتشاف وجود بعض الأخطاء في إدخال قيم أحد المتغيرات التي تمثل الحالة الاجتماعية بحيث أن 
فإن هذا يستدعي ، "دكتوراه"وهو في الحقيقة  "ماجستير"بعض الأشخاص قد تم تسجيل مستواهم الدراسي بأنه 

تصحيح هذا الخطأ يدويا أي تعديل القيم الخاصة بهؤلاء الأشخاص فقط، أما إذا كان المطلوب مثلا هو تغيير قيم 
المتغير الخاص بالمستوى الدراسي بحيث تتغير كل القيم المناظرة للقيمة "ماجستير" والقيمة "دكتوراه" إلى القيمة 

 خيار إعادة الترميز التلقائي."فوق الجامعي"، فهنا يمكن استخدام 

تنفيذ إعادة الترميز لنفس المتغير، )أي تغيير قيم المتغير الأصلي نفسه(، أو تغيير القيم  SPSS برنامج في يمكنو 
 وتعريفها باسم متغير جديد. وسنبدأ بتطبيق الخيار الأول وهو تغيير قيم المتغير نفسه.

 (Recode into Same Variable) إعادة ترميز القيم لنفس المتغير 1.5.2

، لذلك بالقيم الجديدة لقيم الأصليةا سيتم استبدالفي هذا الخيار، سيتم تغيير قيم المتغير نفسه بحيث أنه 
وكمثال تطبيقي، لنأخذ لا يتم استخدام هذا الخيار إلا عند التأكد من عدم احتياجنا للقيم الأصلية للمتغير لاحقا. 

 ".1نا باسم "مثالملف البيانات المحفوظ لدي

بدلا  1، وا عادة ترميز الإناث بالقيمة 1بدلا من القيمة الأصلية  0لنفرض أننا نرغب بإعادة ترميز الذكور بالقيمة 
 تحويلأمر "، ثم قم من شريط الأوامر العلوي باختيار 1، فنقوم بالآتي؛ قم بفتح الملف "مثال2من القيمة الأصلية 

(Transform ثم اختر )رميز في نفس المتغيراتإعادة ت (Recode into Same Variables.) 

 
 ."1للبيانات "مثال بإعادة الترميز في نفس المتغير: النافذة الخاصة 14.2شكل 
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قم في هذه النافذة باختيار المتغير المطلوب إعادة  (،14.2، كما يُشاهد في الشكل )جديدة ستظهر عندها نافذة
(. بعد 2المشار إليها بالرقم ) المتغيرات له إلى خانةقفي مثالنا، واضغط سهم النقل لنترميزه، وهو متغير "النوع" 

(، فتظهر 3( والمشار إليه بالرقم )Old and New Valuesوالجديدة ) ذلك اضغط على خيار تعريف القيم القديمة
 ((، والتي سيتم فيها إعادة ترميز القيم.15.2نافذة جديدة، )الشكل )

 :ملاحظة
(، فقد سبقت الإشارة إليه حيث يمكن If) إذاوهو الدالة الشرطية (، 14.2(، في الشكل )4سبة للخيار )بالن

استخدامه في وضع قيد أو شرط على عملية تغيير القيم ضمن المتغيرات بحيث يتم اعتبار أو استثناء قيم 
 محددة بناء على الشرط أو الشروط الموضوعة من قِبل المستخدم.

إلى  2والقيمة )القديمة(  0إلى )الجديدة(  1المطلوب في متغير "النوع" هو تغيير القيمة )القديمة(  غييرالت حيث أن
دخال القيمة  ب( المشار إليها Old Valueفي خانة القيمة القديمة ) 1فنقوم بإدخال القيمة ، 1)الجديدة(   0)أ(، وا 

( فيتم إعادة الترميز كما Add( ثم نضغط إضافة ))ب ب( المشار إليها New Valueفي خانة القيمة الجديدة )
في )ب(  1في )أ( والقيمة  2يُشاهد في الخانة )ج(. وبنفس الكيفية، يتم إدخال التغيير الثاني للمتغير؛ وهو القيمة 

 .1فيظهر الترميز الجديد في الخانة )ج( أسفل الترميز السابق

 

 .إعادة الترميز في نفس المتغيرللمتغير في خيار  ةالقيم القديمة والجديدتعريف  : نافذة15.2شكل 

 موافق((، وفيها اضغط 14.2( للعودة للنافذة السابقة )الشكل )Continue) استمرارقم بعد ذلك بالضغط على 
(OK للانتهاء. وبعدها ستلاحظ تنفيذ التغير المطلوب في قيم متغير "النوع". إلا أنه في ) هذا المثال، يجب تعديل

                                                 
الدور كما  يمكن بهذه الطريقة إعادة ترميز أكثر من قيمتين لأي متغير، وأما الخيارات الأخرى التي تظهر في النافذة، فيكون لها نفس 1

 (.11.2هو موضح في الشكل السابق )
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التصنيف ذكر  1و 0بحيث تناظر الرموز الجديدة  اسلوب عرض المتغيراتفي  (Valuesقيم المتغير ) تصنيف
 بإلغاءللتصنيف "أنثى" وقم بعدها  1للتصنيف "ذكر" والقيمة  0. لذلك قم بتعيين القيمة على الترتيب وأنثى

(Removeالتصنيفات القديمة ) موافق، ثم اضغط (OK). ملية إعادة ترميز القيم في نفس وبهذا نكون قد نفذنا ع
 متغير.

 (Recode into Different Variable) مختلف متغيرفي إعادة ترميز القيم  2.5.2

لذي تم باستخدام المتغير الأصلي، ا مطلوبفي هذه الحالة سيتم تعريف متغير جديد قيمه تمثل الترميز ال
"، 2ويمكن استخدام ملف البيانات "مثالالبيانات. بمعنى أنه سيتم تعريف متغير أو متغيرات إضافية في ملف 

 كمثال توضيحي لعملية إعادة الترميز.

"، بحيث يتم إعطاء 2لنفرض أننا نرغب بتعريف متغير جديد يمثل تصاااااااااااااانيف لأوزان الأطفال في البيانات "مثال
 10بين  ما تتراوح أوزانهمللأطفال الذين  2كجم، والقيمة  10للأطفال الذين تقل أوزانهم عن  1الرمز أو القيمة 

"، 2لتنفيذ ذلك، قم أولا بفتح ملف البيانات "مثال كجم. 20زيد أوزانهم عن تللأطفال الذين  3 كجم، والقيمة 20و
 متغير مختلفإعااادة ترميز في ( من شااااااااااااااريط الأوامر العلوي، ثم اختر Transform) تحويااالاختياااار أمر ثم 
(Recode into Different Variables.) تظهر عندها نافذة إعادة الترميز في متغير جديد، كما يُشاااهد في ساا

 (.16.2) الشكل

 

 ."2للبيانات "مثال : النافذة الخاصة بإعادة الترميز في متغير مختلف16.2شكل 

ل. ( باستخدام سهم النق2(، ثم ننقله إلى الخانة )1سنقوم باختيار المتغير المطلوب، وهو متغير "الوزن" من الخانة )
" 2(، سيتم اختيار الاسم المرغوب للمتغير الجديد ووصفه، ولنقم بتسمية المتغير الجديد بالاسم "الوزن 3في الخانة )و 

دها عنلاحظ نف(، Change) تغيير أمر ثم نضغط على، (Label) وكتابة "تصنيف الوزن" في مربع الوصف
 ".2لوزن ا >--( حيث سيظهر فيها النص "الوزن 2حدوث هذا التغيير في الخانة )



35 

 

بعد ذلك سنقوم بتعريف القيم التي نود إعادة كتابتها في المتغير الجديد باستخدام قيم متغير "الوزن"، فنقوم باختيار 
(، 16.2( في الشكل )4( والمشار إليه بالرقم )Old and New Valuesوالجديدة ) أمر تعريف القيم القديمة

 .(17.2فتظهر نافذة جديدة كما يُرى في الشكل )

 

 مختلف. إعادة الترميز في متغيرللمتغير في خيار  القيم القديمة والجديدة: نافذة تعريف 17.2شكل 

للتصنيفات الثلاثة؛ الأطفال الذين تقل أوزانهم عن  3، و2، 1((، سنقوم بتعيين القيم 17.2في هذه النافذة، )شكل )
كجم على  20، والأطفال الذين تزيد أوزانهم عن كجم 20و 10كجم، الأطفال الذين تتراوح أوزانهم ما بين  10

 الترتيب.

ة القيم ،مدىلاكجم، نحتاج لاستخدام الخيار  10أقل من  التي هي لتعيين القيمة الأولى، والتي تشمل كل الأوزان
في  1فنكتب أولا القيمة المحددة للتصنيف الأول وهي القيمة  (.Range, LOWEST through value)فأقل 

مباشرة في متغير كجم  10الأقل من  1، )وهي القيمة9.9(، ثم نكتب القيمة New Valueيمة الجديدة )خانة الق
إلى التصنيف الأول وهو  1(. وبهذا نكون قد قمنا بتعيين القيمة الأولى وهي Add) إضافةثم نضغط  الوزن(،

 يفات التالية.كجم. وبنفس الطريقة سيتم تعيين القيم التالية للتصن 10الأوزان الأقل من 

في  2نكتب القيمة  كجم، 20كجم إلى  10للتصنيف الثاني وهو الأوزان من  2لتعيين القيمة الثانية، وهي القيمة 
فتظهر خانتان فارغتان أسفل منه. ( Range) مدىالنضغط على الخيار  ثم (New Valueالقيمة الجديدة ) خانة

 (.Addفي الخانة السفلى والضغط على ) 20 في الخانة العليا والقيمة 10يتم إدخال القيمة 

                                                 
فإن هذا التصنيف سيشمل على الوزن  (Range, LOWEST through value)في خانة  10ننوه هنا إلى أنه إذا ما تم كتابة القيمة  1

 كجم ضمنه. 10
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القيمة  كجم، نكتب 20للتصنيف الثالث، وهم الأطفال الذين تزيد أوزانهم عن  3ولتعيين القيمة الثالثة، وهي القيمة 
 Range, value) من كبرأف ةالقيم ،مدىالثم نضغط على الخيار  (New Valueخانة القيمة الجديدة )في  3

through HIGHEST)  كجم هي ضمن نطاق التصنيف الثاني(، ثم  20، )لأن القيمة 20.1ونكتب فيه القيمة
وبعد الانتهاء من تعيين كل القيم المحددة للتصنيفات السابقة نضغط على استمرار  .إضافةنضغط على 

(Continue.) 

يظهر المتغير الجديد ( فOKنقوم بعدها بالضغط على )((، 16.2ستتم العودة بعد ذلك للنافذة السابقة، )شكل )
 (.18.2" كما هو موضح في الشكل )2" في نافذة عرض البيانات في الملف "مثال2"الوزن 

 

 ".2الوزن متغير "البعد تعريف  "2مثال": عرض بيانات ملف 18.2شكل 

 (Automatic Recoding) التلقائيترميز الإعادة  3.5.2

بحيث يأخذ تعيين قيم افتراضية مناظرة لقيم المتغير الأصلية  تلقائيا في هذا النوع من إعادة الترميز، يتم 
ويتم عادة استخدام هذا الأسلوب من إعادة الترميز عند الحاجة ، ...(. 3، 2، 1هي ) كل تصنيف قيمة تسلسلية

غير الحاجة لتعريف متغير جديد يكون نسخة رقمية من المتأو  دفعة واحدة لتغيير قيم مجموعة كبيرة من المتغيرات
((، 3.2جدول )الولاستخدام هذا الأسلوب، لنأخذ في الاعتبار المثال التالي، ) الأصلي أو لغير ذلك من الأسباب.

 والذي يتكون من المتغيرين "التقدير" و"القسم" واللذان يمثلان التقدير الدراسي للطالب والقسم العلمي الذي ينتمي له
وسنقوم بإعادة ترميز  ".4باسم "مثال 1في ملف جديد SPSS برنامج قم بإدخال البيانات في .طالب 15لعينة من 

 .إعادة الترميز التلقائيباستخدام  ؛ "التقدير" و"القسم"كلا من المتغيرين

                                                 
( لتستوعب أسماء الأقسام الطويلة، Widthعند إدخال أسماء الأقسام للمتغير "القسم" يجب زيادة عدد الخانات في عامود العرض ) 1
 كعدد خانات سيكون مناسبا(. 12)
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 ".4: البيانات الخاصة بملف البيانات "مثال3.2جدول 

دير
التق

 

B A B B C D A D C C C B A C B 

سم
الق

صاء 
لإح

ا
ات 

ضي
لريا
ا

 

صاء
لإح

ا
 

فيز 
ال

ياء
ياء 

كيم
ال

ات 
النب
لم 
ع

 

صاء
لإح

ا
 

لم 
ع

وان
لحي
ا

ات 
النب
لم 
ع

 

ات
ضي

لريا
ا

 

ياء
كيم
ال

صاء 
لإح

ا
 

صاء
لإح

ا
ات 

ضي
لريا
ا

 

ياء
كيم
ال

 

 Automatic) التلقائيترميز الإعادة ( ثم اختر Transform) تحويلأمر في شريط الأوامر العلوي، قم باختيار 

Recode)  في الخانة المشار لها . أدناه (19.2موضح في الشكل )فتظهر النافذة الخاصة بهذا الأمر كما هو
إلى  نقوم بنقله( سنقوم باختيار المتغير الأول الذي سيتم إعادة ترميزه تلقائيا، وهو متغير "التقدير"، ثم 1بالرقم )
سم ( بكتابة الا3الخانة ) (New Nameخانة الاسم الجديد ) نقوم في( باستخدام سهم النقل. بعد ذلك 2الخانة )

إضافة اسم  " ثم نضغط على أمر2المرغوب للمتغير الجديد )الذي سيحصل على الترميز التلقائي(، وليكن "التقدير
 ."2التقدير >--"التقدير  العبارة؛ (2ظهر لنا في الخانة )ت( فAdd New Name) جديد

( وتسميته، على سبيل المثال، 2نة )( ونقله إلى الخا1بنفس الكيفية يتم اختيار المتغير الثاني "القسم" من الخانة )
 (.2في الخانة ) "2القسم >--"القسم ( فتظهر العبارة؛ Add New Name" والضغط على أمر )2"القسم

إعادة الترميز  وننوه هنا إلى إمكانية اختيار الترتيب المطلوب لإعادة الترميز تصاعديا أو تنازليا باستخدام خيار
( للترتيب التصاعدي، Lowest value) القيمة الأقل (، حيث يستخدم خيارRecode Starting from) بداية من
 .( للترتيب التنازليHighest value) القيمة الأكبر وخيار

 

 ".4: النافذة الخاصة بإعادة الترميز التلقائي لملف البيانات "مثال19.2شكل 
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 :ملاحظة
مكن استخدام الخيار الخاص بحفظ وا عادة تطبيق نمط ((، ي19.2، )الشكل )إعادة الترميز التلقائيفي نافذة 

 ( الموجود في أسفل النافذة عند التعامل مع بيانات أخرى مستقبلا.Template) القالبإعادة الترميز أي 

فيتم التنفيذ ويظهر  (OKبعد الانتهاء من اختيار المتغيرات وتعريف أسماء المتغيرات الجديدة نضغط موافق )
ويمكنك رؤية نمط الترميز  .((20.2، )الشكل )"4" في ملف البيانات "مثال2" و"القسم2يدان "التقديرالمتغيران الجد

 (.Outputللمتغيرين من خلال نافذة المخرجات )

( في 4 ,3 ,2 ,1( تناظر القيم )A, B, C, Dلاحظ أن ترميز المتغير "التقدير" قد تم بحيث أن قيم المتغير )و 
( بحسب عدد 6إلى  1"، فقد تم تعيين القيم )من 2وأما في المتغير "القسم " على الترتيب.2رالمتغير الجديد "التقدي

 .6وانتهاء بقسم علم النبات ممثلا بالقيمة  1الأقسام أبجديا، بداية من قسم الإحصاء ممثلا بالقيمة 

 

 ".2" و"القسم2بعد تعريف المتغيران "التقدير "4مثال": عرض بيانات ملف 20.2شكل 

 ( Compute Variable)متغير ل جديدة تعريف دالة 4.5.2

حصائية في  SPSSيُعد هذا الأمر في برنامج   بمثابة الحالة العامة للترميز أو استخدام دوال حسابية وا 
تعريف متغير جديد اعتمادا على المتغير الأصلي. واستخدام هذا الأمر يتضمن مجالات واسعة تتدرج من تعريف 

الرياضية طة، )مثل العمليات الحسابية البسيطة؛ جمع، طرح، ضرب، قسمة(، إلى تعريف الدوال الدوال البسي
 الأكثر تعقيدا. والإحصائية
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((، 4.2من خلال البيانات في الجدول التالي، )جدول )وسنقوم هنا بتقديم بعض الأمثلة على استخدام هذا الأمر 
وسنقوم  لار الأمريكي لخمسة سنوات افتراضية.لمزيج برنت بالدو  الشهرية والذي يتضمن أسعار النفط العالمية

 باسم "أسعار النفط". SPSSبإدخال هذه البيانات في ملف بيانات جديد في برنامج 

 .أسعار النفط العالمية الشهرية لمزيج برنت بالدولار الأمريكي لخمسة سنوات: 4.2جدول 
  1السنة 2السنة 3السنة 4السنة 5السنة
61 58 48 45 42 1 
61 58 50 46 41 2 
62 56 51 45 42 3 
64 57 52 47 43 4 
64 58 52 47 42 5 
65 57 52 48 44 6 
63 59 54 47 43 7 
63 60 53 49 42 8 
62 60 55 47 40 9 
63 58 54 48 44 10 
64 60 55 46 45 11 
65 59 57 49 44 12 

اب المتغير كما فتظهر نافذة حس Transform>Compute Variableفي شريط الأوامر العلوي، قم باختيار 
 (.21.2يظهر في الشكل )

 

 تعريف دالة جديدة لمتغير، )حساب متغير(، لملف بيانات "أسعار النفط".: نافذة 21.2شكل 
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لنفرض الآن أننا نريد تعريف متغير جديد يمثل المجموع الشهري لأسعار النفط خلال السنوات الخمس، فنقوم في 
 Targetغير بكتابة اسم المتغير الجديد، وليكن "المجموع_الشهري"، في مربع المتغير المستهدف )نافذة حساب المت

Variable( ثم ندخل الدالة أو العملية الحسابية المطلوبة في مربع الدالة الحسابية ،)Numeric Expression )
سة، وهكذا فإن العملية المطلوبة وهي مجموع القيم لكل شهر )والذي يمثله صف المشاهدات( في المتغيرات الخم

 (.21.2كما هو ظاهر في الشكل ) كمجموع للمتغيرات الخمسة سيتم كتابتها

( من مربع المتغيرات في يسار النافذة ونقله بالسهم إلى 1ويتم تنفيذ ذلك عن طريق اختيار المتغير الأول )السنة
حة المفاتيح في وسط النافذة، ثم اختيار المتغير الثاني مربع الدالة الحسابية ثم الضغط على إشارة الجمع )+( في لو 

(. 5وهكذا حتى اختيار المتغير الخامس )السنة( ونقله إلى مربع الدالة الحسابية ثم الضغط على إشارة الجمع 2)السنة
سم ( للتنفيذ، وفي ملف البيانات الحالي، "أسعار النفط"، سيظهر المتغير الجديد باOKبعد ذلك نضغط موافق )

 "المجموع_الشهري".

من القيم  أعلىكمثال آخر، لنفرض أن الأسعار في السنة الخامسة كان بها خطأ في الرصد حيث أنها كانت 
عن طريق تعريف متغير جديد. لذلك نقوم في نافذة الصحيحة بمقدار دولارين، ونريد الآن تصحيح هذا الخطأ 

_مصحح"، في مربع المتغير المستهدف ثم نقوم باختيار 5"السنة حساب المتغير بكتابة اسم المتغير الجديد، وليكن
" من مربع المتغيرات وننقله إلى مربع الدالة الحسابية ثم نختار إشارة 5المتغير الذي سيتم التعامل معه، وهو "السنة

متغير بعدها، ثم نضغط موافق فنحصل على ال 2( في لوحة المفاتيح في وسط النافذة ونكتب القيمة -الطرح )
 الجديد المطلوب.

ويمكن استخدام بعض الدوال الإحصائية في تعريف متغير جديد، فمثلا إذا ما أردنا حساب متغير جديد يمثل قيمة 
لأسعار النفط الشهرية، )أي حساب الوسيط لأسعار النفط لكل شهر من أشهر السنة على ( Medianالوسيط )

في نافذة حساب المتغير بكتابة اسم المتغير الجديد، وليكن مدى السنوات الخمسة(، فإننا نقوم بالآتي؛ 
( من مربع Statisticalالدوال الإحصائية )"الوسيط_للسعر_الشهري"، في مربع المتغير المستهدف ثم نقوم باختيار 

دوال ( في يمين النافذة، فتظهر قائمة بالدوال الإحصائية المتوفرة في مربع الFunction groupمجموعات الدوال )
( Median( أسفل منها. قم باختيار دالة الوسيط )Functions and Special Variablesوالمتغيرات الخاصة )

 من بين تلك الدوال عن طريق النقر المزدوج عليها، )أو سحبها بالفأرة إلى المربع المرغوب(.

بإلغاء الأقواس وعلامتي الاستفهام عندها ستظهر دالة الوسيط في مربع الدالة الحسابية مع علامتي استفهام، قم 
_مصحح" بعد القوس 5"، و"السنة4"، "السنة3"، "السنة2"، "السنة1"السنة ثم قم بفتح قوس جديد وانقل المتغيرات

دخال فواصل بين المتغيرات، ثم  المفتوح مع مراعاة تغيير لغة لوحة المفاتيح في جهازك إلى اللغة الإنجليزية وا 
 بعد ذلك اضغط موافق للتنفيذ. ( لنافذة حساب المتغير.22.2، كما يوضح الشكل )إغلاق القوس بعد ذلك
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 : حساب الوسيط الشهري في نافذة تعريف دالة جديدة لمتغير، لملف بيانات "أسعار النفط".22.2شكل 

 (.23.2وبالتالي سيحتوي ملف بيانات "أسعار النفط" على المتغيرات التي تظهر في الشكل )

 

 : ملف بيانات "أسعار النفط" بعد تعريف المتغيرات الجديدة.23.2 شكل

بطرق عديدة  (Compute Variableتعريف دالة جديدة لمتغير )وهكذا، وكما ذكرنا أعلاه، يمكن استخدام أمر 
 يمكن أن تكون مفيدة جدا أثناء إجراء التحليل الإحصائي للبيانات.
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 (Binning) الترتيب في مجموعات 5.5.2

هذه الطريقة من إعادة الترميز للمتغيرات تشبه إعادة الترميز في متغير مختلف الذي تناولناه سابقا، إلا  
الفترات التي يرغب  المجموعات أو أنها تقوم "بقراءة" قيم مشاهدات المتغير وتعطي الخيار للمستخدِم بأن يحدد

 بتصنيف المتغير الأصلي اعتمادا عليها يدويا أو تلقائيا.

ات ((، لدينا بيان5.2في الجدول التالي، )جدول )
خاصااااااة بعدد من موظفي إحدى الشااااااركات وهي 
عبااااارة عن ثلاثااااة متغيرات هي مرتااااب الموظف 
والعلاوة والخصااام السااانوي بالدينار الليبي. قم أولا 

 SPSSباااااإدخاااااال هاااااذه البيااااااناااااات في ملف في 

 ."5وحفظها باسم "مثال

ولنفرض أننا نريد إعادة ترميز المتغير "المرتبات" 
حساااااااب مقدار إلى خمساااااااة مجموعات أو فترات ب

(، 600-401(، )400المرتاااب وهي )أقااال من 
(، و)أكاااثااار مااان 801-1000(، )601-800)

( وذلااك باااسااااااااااااااتخاادام طريقااة الترتيااب في 1000
 مجموعات فنقوم بالآتي؛

فااي شاااااااااااااااريااط الأواماار الااعاالااوي قاام 
 تااااااااحااااااااوياااااااالباااااااااخااااااااتاااااااايااااااااار أماااااااار 

(Transform ثم اختر ،) الترتيااب
 Visual) في مجموعات )المرئي(

Binning).  سااتظهر عندها النافذة
الخاصاااااااااة بتحديد المتغير المطلوب 
إعادة ترميزه، )كما يشاااهد في شااكل 

((، وهو في مثالنا "المرتبات" 24.2)
ساااااهم  فنقوم باختياره والضاااااغط على

 (.Continueالنقل، ثم استمرار )

 

: البيانات الخاصة بمرتبات وعلاوات وخصومات 5.2جدول 
 (.5الموظفين بالدينار الليبي. )الملف مثال

 الخصومات العلاوات المرتبات الموظف
1 480.500 120.050 25.000 

2 635.700 165.500 70.750 

3 390.550 95.050 15.500 

4 345.590 85.000 12.750 

5 730.600 170.750 75.750 

6 980.050 185.500 90.000 

7 1060.750 190.750 95.500 

8 510.650 155.500 60.500 

9 1150.500 195.750 100.500 

10 560.400 160.750 65.000 

11 490.900 110.050 20.500 

12 870.750 180.000 85.750 

13 910.950 190.500 95.000 

 

باستخدام طريقة  بتحديد المتغير المطلوب إعادة ترميزه: النافذة الخاصة 24.2شكل 
 ."5مثال"الترتيب في مجموعات لملف البيانات 
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((، والتي سيتم من خلالها تعريف المجموعات 25.2شكل )كما يظهر في النافذة أخرى، )لنا ستظهر  ذلك بعد
 المرغوب تكوينها من المتغير الأصلي.

 

 ".5: نافذة تعريف المجموعات للمتغير "المرتبات" في الملف "مثال25.2شكل 

( OKفذة صغيرة للتأكيد على أنه سيتم تكوين متغير واحد جديد، قم بالضغط على موافق )ستظهر نا ستظهربعد و 
رمز للمجموعة والتي ت 5إلى  1يأخذ القيم من والذي " 5" في ملف البيانات "مثال2فيظهر المتغير الجديد "المرتبات

ن شريط الأيقونات م  أيقونة عرض وصف المتغيرولاحظ أنه إذا ما تم استخدام  أو الفترة المناظرة.
" إلى 400وصف المجموعات التي تم تسميتها )بداية من "أقل من  في عامود المتغير الجديد ظهريفسالعلوي 

 "(.1000"أكثر من 
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 لثالثالفصل ا

 SPSSالتحليل الاستكشافي للبيانات في 

 (Exploratory Data Analysis (EDA) in SPSS) 

 
وتوضيح كيفية استخدامها في برنامج  1المختلفة الإحصائية والطرق المقاييس  سيتم تناولهذا الفصل،  في

SPSS. الإحصاء الوصفي هذه المقاييس، التي تندرج تحت مسمى (Descriptive Statistics ) مصحوبة ببعض
 Exploratory Data Analysis) التحليل الاستكشافي للبياناتبعرف حديثا التقديرات الاستدلالية البسيطة ت  

(EDA)) ، حيث أنها توفر للباحث أو المستخدِم للأساليب ت عد المدخل الرئيسي لبوابة علم الإحصاء التطبيقي، و
وللوصول للاستخدام الأمثل . الأولية التي تمكنه من استكشاف ما تمثله أو تصفه البياناتالإحصائية المعلومات 

لهذه المقاييس الإحصائية، لابد للقارئ أولا من التعرف على أنواع البيانات الأساسية المستخدمة في التحليل 
 .الإحصائي

 (Data Types)أنواع البيانات  1.3

بعد استخدام  المجتمع الذي جمعت منهتزودنا بالمعلومات حول  ام التي( المادة الخData) البيانات تمثل
لهذا، فإن البيانات منه.  2جمع. ونقصد بالمجتمع هنا المصدر الذي تم الأسلوب أو الأساليب الإحصائية المناسبة
 في التحليل الإحصائي الصحيح. الهامة تعد من المراحلمرحلة التعرف على البيانات في مصدرها 

يومية في العموم، وهو مصطلح ووسائل الإعلام والتعاملات ال والمنشورات الكتبفي ما يظهر لفظ "بيانات" كثيرا إن 
وغيرها  المستوى التعليمي، ، فالبيانات الشخصية التي تضم الاسم، العمر، النوع، الحالة الاجتماعية،مرن شامل

السكر، ضغط  ةنسب الخاصة به مثل الوزن، قراءاتال هي نوع من البيانات، والتاريخ الطبي للمريض والذي يضم
الدم، درجات الحرارة المسجلة، وغيرها هي بيانات، وكذلك المشاهدات الناتجة عن تجربة كيميائية لقياس التفاعل 

القول بأن أي ظاهرة أو دراسة أو تجربة أو  إنه يمكنفلذلك و  .دمج بعض المحاليل هي أيضا بياناتالناتج عن 
يصف أو ي عبّر عملية معينة يمكن أن ينتج عنها جميعا بيانات، فالبيانات هي المقياس الفعلي الذي  سيرل مراقبة

 .عما حدث في المجتمع أو الظاهرة

                                                 
 (،Descriptive Statistics) الأساسية لكل من الإحصاء الوصفي طرق الإحصائيةبالحد الأدنى للمفاهيم وال باعتبار أن القارئ م لم 1

 .(Inferential Statisticsوالإحصاء الاستدلالي )

حبت من Sample) عينةنشير هنا إلى أن معظم النظريات الإحصائية تتعامل مع البيانات على أنها  2  مجتمع( أو عينات قد س 
(Population أو مجتمعات محددة باستخدام أساليب متعددة )المعاينة العشوائية من (Random Sampling.) 
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قد يخلط البعض بين مفهوم "البيانات" ومفهوم "المعلومات"، وهما في الواقع مختلفان على وفي كثير من الأحيان، 
مع البيانات كما أسلفنا على أنها يتعامل  ورِه()في أبسط ص   فعلم الإحصاء، يةالأقل من وجهة النظر الإحصائ

الذي سنعرضه في ، كما نرى في المثال التوضيحي المدروسة المادة الخام التي ستصف و/أو تحلل الظاهرة
 :الخطوات التسلسلية التالية

، 59، 42، 33اللغة العربية: في مقرر درجة(  100من )طلبة ال مجموعة من )درجات ؛بياناتلدينا  .1
61 ،... ،25.) 

 درجة(. 54 أو الوسيط يساوي نستخدم الإحصاء الاستكشافي )مثلا: معدل الطلبة  .2

 )مستوى الطلبة في مقرر اللغة العربية يعتبر ضعيفا(. ؛معلوماتحصلنا على  .3

 يمكن طرح التساؤل: ماهي الأسباب؟ .4

إضافية  معلوماتالتحليلي الاستدلالي للحصول على استخدام الإحصاء و  البياناتجمع المزيد من  يمكن .5
 وتفسير ظاهرة ضعف الطلبة في هذا المقرر.

والبيانات الإحصائية، عادة ما تأخذ شكلا محددا يتألف من جدول )مكون من صفوف وأعمدة( بحيث تكون 
والمتغير هي مكونات الأعمدة.  (Variables) المتغيرات( هي مكونات الصفوف، وObservations) المشاهدات

ظاهرة تجربة أو فأي  ،وصفيةأو  بصورة كميةيشير إلى الصفة المميزة لشيء يمكن التعبير عنه  جدول البياناتفي 
فالطول  ؛يمكن أن يعبر عنها بمتغير م عرّفة أو تصنيفها )إلى مستويات محددة مسبقا(يمكن قياسها بوحدة قياس 

لجهاز )بالسنتيمتر أو القدم( لمجموعة من الأشخاص هو متغير، والعمر الاستهلاكي )بالأشهر أو السنوات( 
 ( تمثل أيضا متغير.مقبول، راسبطلبة )ممتاز، جيد جدا، جيد، الهو متغير، وتقديرات  كهربائي

)استدلالية( بصورة استكشافية أو تحليلية  البيانات هذه التعامل مع يتم المناسبة، الأساليب الإحصائيةوباستخدام 
 طرق التعاملو  أو بالرسومات التوضيحية. )المقاييس( بغية الحصول على المعلومات المطلوبة بلغة الأرقام

تلك البيانات،  ونوع مع البيانات واستخلاص المعلومات المباشرة وغير المباشرة منها يعتمد على طبيعة الإحصائي
تحديد الأسلوب الإحصائي المناسب للتعامل معها. ويمكن بهدف جيدا  مراعاة تلك الطبيعة على الباحثينبغي و 

 1البيانات الكميةإلى نوعين رئيسيين هما؛  )أي المتغيرات( من حيث الطبيعة أن نقسم أنواع البيانات
(Quantitative Data )الوصفيةأو  والبيانات النوعية (Qualitative Dataوالتي قد تسمى ،)  بالبيانات أيضا

 (.Categorical Data) التصنيفيةأو  القطاعية

                                                 
سب ي قصد بالبيانات أو المتغيرات الكمية تلك التي يمكن قياسها بوحدة قياس م عرّفة، )مثل العمر، الوزن، الزمن، السعر، درجة الحرارة، نِ  1

النجاح، ...(، وي فضّل استخدام مصطلح متغيرات كمية عن متغيرات رقمية لأن المتغيرات الوصفية التي لا يمكن قياسها بوحدات قياس، 
)مثل الجنس، اللون، آراء الناس، المشاعر الإنسانية، التقديرات الدراسية، ...(، يمكن التعبير عنها بقيم رقمية أيضا كما وضحنا في 

 ول، إلا أن ذلك لا يعني أنها أصبحت متغيرات كمية.الفصل الأ
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 وحدة قياسلها  قيمالبيانات الكمية هي تلك البيانات التي تحتوي على مشاهدات تم قياسها ورصدها مباشرة بصورة ف
بالساعات،  ، والمدة الزمنية المستغرقة لرحلة جوية، وأسعار النفط بالدولاردرجة 100كمية، مثل درجات الطلبة من 

 . وهذا النوع من البيانات تمثله متغيرات يمكن التعامل معها بواسطة العمليات الحسابية مباشرة.وغيرها

، مثل النوع )ذكر، أنثى(، أو حالة الطقس المتوقعة )صحو، أو تصنيفاتالتي يتم التعبير عنها بصفات أما البيانات 
فهذه البيانات تسمى  بأس به، سيئ(، لفزيوني معين )جيد، لاأو رأي الجمهور في برنامج ت غائم، ممطر، ...(،

 التعامل معها يتمقطاع محدد ولا  أو إلى نوع شاهدةبيانات نوعية أو قطاعية حيث أنها تأخذ قيما تحدد تصنيف الم
ن تم إعطاء هذه الصفات أو التصنيفات رموزا رقمية بالعمليات الحسابية المباشرة إحصائيا  .حتى وا 

 قسيم البيانات الكمية من حيث المقياس إلى نوعين أساسين هما:ويمكن ت

يسمح بترتيب المشاهدات على مقياس محدد بحيث  وهو الذي(: Interval Scale) المقياس الفئوي  .1
الصفر كقيمة. ومن الأمثلة على هذا النوع من  بدون اعتبار ،يمكن تحديد القيمة الفعلية لكل مشاهدة

 .أو قياس بعض الفترات الزمنية رارة عددياالبيانات قياس درجة الح

من ضمن درجات  عتبر الصفري   أنه لمقياس الفئوي إلال مشابه (: وهوRatio Scale) المقياس النسبي .2
. وهذا النوع من بين قيمتين ضمن المفردات 1النسبة حسابيمكن  القياس، لذلك فإنه في هذا المقياس

 والوزن والطول والزمن وغيرها. سعرالبيانات الكمية مثل الالمقاييس يكون شاملا للعديد من أنواع 

 :ملاحظة
 متصلة متغيرات(، و Discrete) منفصلة متغيراتإلى  الكمية من حيث طبيعة الأرقام المتغيراتتقسيم  يمكن

(Continuousفالمتغيرات .)  الكمية المنفصلة تأخذ قيما في مجموعات أعداد منتهية أو غير منتهية وقابلة
الكمية المتصلة فهي تأخذ قيما ضمن فترة من  لمتغيراتأما ا (.Integersللعد، مثل الأعداد الصحيحة )

 (.Real Numbers، وتشمل مجموعة الأعداد الحقيقية )عدادالأ

 إلى نوعين هما:تنقسم ف الوصفيةأما البيانات أو المتغيرات 

مثل تصنيف المشاهدات إلى مستويات أو قطاعات ي (: وهوNominal Scale) المقياس الاسمي .1
مختلفة، إلا أنه لا يمكن تحديد القيمة الفعلية لكل مستوى، ولا حتى ترتيب هذه المستويات بشكل تصاعدي 

الإجابة "نعم" هي أفضل من الإجابة "لا" فيما يتعلق بسؤال معين.  أو تنازلي. فمثلا، لا يمكن القول أن
 ومن أمثلة هذا النوع من البيانات نوع الشخص )ذكر، أنثى(، وأسماء الأشياء والألوان وما شابه ذلك.

                                                 
 .سنوات 5سنوات هو أكبر بمرتين من طفل عمره  10أن طفلا عمره  مثلا كأن نقول 1
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تسمح بترتيب  تهعلى عكس النوع السابق، فطبيع و(: وهOrdinal Scale) المقياس الترتيبي أو الرُتبي .2
وفق تدرج محدد من الأقل قيمة إلى الأكثر قيمة أو العكس، مثل تقديرات الطلبة )ممتاز، المشاهدات 

 جيد جدا، جيد، ...(، إلا أنه لا يمكن حساب الفرق في القيمة بين أي مستويين من المستويات المرتبة.

بشكل زاوية إحصائية من  هايمكن التعامل معفإنه ، أو مزيج بين الاثنين كمية أو وصفية وسواء كانت البيانات
(، أو التعامل مع Univariate Analysis) بالتحليل الأحاديمفرد، أي التعامل مع متغير واحد، وهو ما ي عرف 

(. والأساليب الإحصائية  AnalysisMultivariate) 1المتعدد بالتحليلعدة متغيرات في آن واحد، وهو ما ي عرف 
ن كانت لكل متغير على حدةتعني أنه سيتم حساب تلك المقاييس  التحليل الأحادي فيالتي ت ستخدم  ، حتى وا 

 مجموعة أو قاعدة البيانات متكونة من متغيرات عديدة.

كليات مختلفة، فإنه إذا ما  ثلاثةمتغيرات تمثل درجات طلبة في  ثلاثةومثال على ذلك؛ بافتراض وجود بيانات بها 
صائية(، مع درجات الطلبة لأي متغير بمفرده فإن ذلك يكون ضمن إطار تم التعامل، )أي استخدام الأساليب الإح

ن تم تنفيذ ذلك لكل المتغيرات. أما إذا ما تم استخدام أسلوب أو أساليب  التحليلالتعامل مع  الأحادي حتى وا 
حالة  أو أكثر في نفس الوقت فإن ذلك ي سمى تحليل ثنائي، )في 2إحصائية تحتوي على صيغ تتعامل مع متغيرين

وفيما يلي، سنقوم  .استخدام متغيرين(، أو تحليل متعدد إذا ما تم إدراج أكثر من متغيرين في التحليل الإحصائي
 .SPSSباستخدام برنامج  الأحادي والمتعدد تنفيذ تحليل البيانات الاستكشافيبإفراد مساحة لتوضيح كيفية 

 (Univariate EDA) الأحاديالتحليل الاستكشافي  2.3

الاجتماعية أو  أو الدراسات التي تتعلق بتحليل البيانات في معظم، إن لم يكن كل، الدراسات الإحصائية 
تشتمل على جانب ي ستخدم فيه التحليل الإحصائي للبيانات، ي فضل عادة التي و  الاقتصادية أو الطبية أو غيرها،

وفحصها  (Data Distribution) توزيع البياناتما ي عرف بالتحليل الاستكشافي للبيانات للتعرٌف على استخدام 
 وذلك لعدة أسباب نذكر منها ما يلي:

(، ابتعاد Outliers) المشاهدات المتطرفةكشف المشاكل والأخطاء التي قد توجد ضمن البيانات مثل  .1
 قيم مفقودةعن التوزيع الطبيعي، وجود أخطاء في ترميز البيانات، وجود  المتغيرات الكميةتوزيع 

(Missing Values) ، وجود أخطاء في إدخال البيانات، وغيرها من المشاكل التي قد تتسبب في حصول
 الباحث على نتائج خاطئة أو مضللة.

                                                 
 (.Analysis Bivariate) التحليل الثنائي التحليل المتعدد هووتوجد حالة خاصة من  1
 أكثر في آن واحد هي مقاييس التغاير والارتباط كما سنوضح لاحقا.من أشهر الأساليب الإحصائية التي تتعامل مع متغيرين أو  2
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طرق التحليل  معظمأو ملائمة البيانات للفرضيات التي قد يعتمد عليها استخدام  تبعيةلتأكد من مدى ا .2
 .1الإحصائي الاستدلالي

النمط أولية من البيانات ت عطي الباحث انطباعا عما تمثله الظاهرة محل الدراسة و الحصول على معلومات  .3
 السلوك الذي تسلكه البيانات. أو

التعرٌف على العلاقات البسيطة، إن و جدت، بين متغيرات الدراسة وذلك لبناء النموذج أو النماذج الأفضل  .4
 .و مشكلة البحثتطلٌبه الدراسة أملائمة لتمثيل تلك العلاقات بحسب ما ت

)مثل المدرج التكراري، وشكل  للبيانات على استخدام التمثيل البياني الإحصائيويعتمد التحليل الاستكشافي للبيانات 
إضافة لاستخدام مقاييس النزعة المركزية )ومن أهمها الوسط، والوسيط،  ،(، ...، وغيرهاالصندوق، والأعمدة البيانية

والربيعات، ...، وغيرها(، ومقاييس التشتت )ومن أهمها الانحراف المعياري، ومعامل الاختلاف، ...، وغيرها(، 
 .إضافة لاستخدام مقاييس الارتباط بين المتغيرات

أية دراسة أو  عند التعامل مع البيانات فيللبيانات  الاستكشافي ضرورة استخدام التحليلوتجدر الإشارة هنا إلى 
ن لم  د ذاته، وذلك لاستكشاف سلوك هذه البيانات من جهة، بح ذلك التحليل مطلوبا كنيمشكلة بحث حتى وا 

صلاحها إن وجدت من جهة أخرى.  واستكشاف الأخطاء أو العيوب التي قد تتعرض لها البيانات وا 

 بتناول كيفية تطبيق التحليل الاستكشافي للمتغيرات الوصفية أولا يليها المتغيرات الكمية؛وفيما يلي، سنقوم 

 (EDA for Categorical Variables) للمتغيرات الوصفيةالتحليل الاستكشافي  3.3

( الخاص بتعريف أنواع البيانات، فقد تم توضيح أن المتغيرات الوصفية 1.3كما تمت الإشارة في البند ) 
أهمها الأعمدة البيانية والقطاعات تم عادة استخدام أشكال محددة من التمثيل البياني، يسمية أو رتبية، و اتكون عادة 

وذلك لاستكشاف سلوك هذه الأنواع من المتغيرات. إلا أنه البيانية، إضافة لمقاييس محدودة، مثل النسبة والمنوال، 
التي تأخذ خمسة  الوصفية الرتبية بعض الإحصائيين يميلون للتعامل مع المتغيراتتجدر الإشارة هنا إلى أن 

 مستويات أو أكثر على أنها متغيرات شبه كمية، أي أنه يمكن استخدام المقاييس الكمية لدراسة سلوكها.

 Frequency) التوزيع التكراري  جدولب يعرف فيماتغيرات الوصفية، نقوم عادة بتلخيصها عامل مع المعند بدء الت

Distribution Table) ،حيث يتم تكوين  وهو يشبه إلى حد ما جدول التوزيع التكراري المعروف للمتغيرات الكمية
الوصفي فإنه يتم حساب التكرارات لكل فترات لقيم المتغير الكمي وحساب التكرارات لها، أما في حال المتغير 

                                                 
( تضع Parametric Estimation) بالتقدير المعلميمعظم الأساليب الإحصائية التقليدية التي تعتمد على تقدير المعالم أو ما يعرف  1

اليب مثل كونها بيانات كمية لها وحدة قياس معرٌفة، قيودا أو فرضيات صارمة تشترط توفرها في البيانات المستخدمة في تنفيذ هذه الأس
يب أو أنها تتبع توزيعا احتمالية محددا مثل التوزيع الطبيعي، أو أن تكون متغيرات الدراسة مستقلة، أو غير ذلك من الفرضيات. أما الأسال

 ودها أقل.( فعادة ما تكون قيNon-Parametric Estimation) التقدير غير المعلميالتي تعتمد على 
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يقوم بتكوين جدول  SPSSويجب الإشارة هنا إلى أن برنامج  تصنيف من التصنيفات التي يأخذها هذا المتغير.
توزيع تكراري للمتغيرات عن طريق حساب التكرار لكل "قيمة" من قيم المتغير الذي يتم تعريفه بغض النظر ما إذا 

و وصفية. وبالتالي، قد لا يكون من الملائم تكوين هذه الجداول للمتغيرات الكمية التي تحتوي كانت هذه القيم كمية أ
درجة قد يكون له  100رة الاختلاف فيما بينها؛ )فمثلا، المتغير الكمي الذي يمثل درجات طلبة من على قيم كثي

 100إلى  0لقيم المتغير على اعتبار أن الدرجات قد تتراوح من  مناظر تكرار 101جدول توزيع تكراري يضم 
 (.، ومثل هذه الجداول قد لا يكون تلخيصا جيدا لهذا المتغيردرجة للطالب

 (Frequency Distribution for Categorical Variables) ةالوصفي اتالتوزيع التكراري للمتغير  1.3.3

، لتوضيح SPSS برنامج ضمن قاعدة البيانات المدرجة فيملف بيانات متوفر باستخدام  الآن سنقوم
( في سطر الأوامر Fileولفتح هذه الملفات، نقوم بالضغط على أمر ملف ) تكوين جدول التوزيع التكراري.كيفية 

 1م باختيار المجلدو قنفتظهر النافذة الخاصة بفتح البيانات. (، Data( ثم بيانات )Openنختار فتح )العلوي ثم 
 الواحد تلو الآخر؛ التسلسلية الم تضم نة التالي عن طريق اختيار المجلدات

Program Files>IBM>SPSS>Statistics>23>Samples>English 

(. وسنقوم باختيار ملف البيانات 1.3كما يظهر في الشكل ) SPSS برنامج فنحصل على ملفات قاعدة البيانات في
 كما هو موضح في نفس النافذة. "car_insurance_claims.savالمسمى "

 

 .SPSSملفات قاعدة البيانات في : نافذة 1.3شكل 

                                                 
 .)C(:يكون في معظم أنظمة ويندوز ضمن المسار الأساسي وهو المسار  Program Filesمجلد  1
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 128تخص بيانات حول ((، 2.3بعد فتح الملف، ستلاحظ أن البيانات تحتوي على خمسة متغيرات، )شكل )
 شخصا في إحدى شركات التأمين على السيارات.

 

 .SPSS برنامج في "car_insurance_claims.sav"البيانات  ملف: نافذة 2.3شكل 

 وهذه المتغيرات معرّفة كالتالي؛
 holderage ّ(، ...، 21-24(، )17-20ن على السيارة بالسنوات، ضمن الفئات العمرية؛ ): عمر المؤم

 فأكثر(. 60)

 vehiclegroup فئة تصنيف السيارة، من ضمن الفئات؛ :A ،B ،C و ،D. 

 vehicleage 10(، و )8-9(، )4-7(، )0-3السيارة بالسنوات، من ضمن الفئات العمرية؛ ): عمر 
 فأكثر(.

 claimamt.معدل قيمة التأمين المدفوعة من قِبل الشركة بالدولار : 

 nclaims.عدد مبالغ التأمين المدفوعة : 

غير وصفي اسمي، أما ولاحظ أن المتغيرين الأول والثالث هما متغيران وصفيان رتبيان، والمتغير الثاني هو مت
جداول التوزيع التكراري للمتغيرات الثلاثة الأولى )الوصفية( وسنقوم الآن بتكوين  المتغيران الأخيران فهما كميان.

 على النحو التالي؛
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فتظهر  ،(Analyze> Descriptive Statistics> Frequenciesباختيار )من شريط الأوامر العلوي نقوم 
وفي  (.3.3م باختيار المتغيرات الثلاثة الأولى كما يظهر في الشكل )الجداول التكرارية فنقو النافذة الخاصة بتنفيذ 

وجود بعض الخيارات الفرعية التي يمكن للمستخدِم استخدامها للحصول على نتائج يمين هذه النافذة، نلاحظ 
(، وأما الخيار الأول فهو Chartsالثاني وهو الرسم البياني ) إضافية قد يرغب بها، وسنقوم هنا بالتطرق للخيار

خاص بطلب حساب بعض المقاييس الإحصائية )مثل الوسط الحسابي والوسيط والربيعات والانحراف المعياري 
في  1بصورة أكثر تعمقاوسيتم تناول استخدام هذه المقاييس لاحقا وغيرها من مقاييس النزعة المركزية والتشتت(، 

 .ا الفصلهذ

 

( لملف البيانات Frequencies: نافذة تنفيذ أمر تكرارات )3.3شكل 
"car_insurance_claims.sav". 

( في هذه النافذة فسنحصل على جداول التوزيع التكراري لكل متغير، OKالآن إذا ما ضغطنا على أمر موافق )
للمتغيرات للحصول على توضيح "مرئي" لتوزيع المتغيرات، إلا أننا في هذا المثال سنقوم باختيار تنفيذ الرسم البياني 

 أي الحصول على تمثيل بياني لما تمثله جداول التوزيع التكراري.

(( ستظهر نافذة فرعية كما يوضح 3.3( في النافذة الحالية )شكل )Chartsبالضغط على خيار الرسم البياني )
 Pie(، القطاعات البيانية )Bar Chartsلأعمدة البيانية )( تشتمل على ثلاثة أنواع من الرسم هي ا4.3الشكل )

Charts( والمدرجات التكرارية ،)Histograms وسنقوم باختيار رسم القطاعات البيانية لتمثيل المتغيرات في .)
 مثالنا.

                                                 
(، فالخياران الثالث والرابع هما للحصول على النتائج المطلوبة بترتيبات معينة 3.3بالنسبة للخيارات الثلاثة المتبقية في يمين الشكل ) 1

 (.Bootstrap) البوتسترابوأما الخيار الخامس فهو خاص بتطبيق أسلوب إعادة المعاينة أو 
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( يتوفر 4.3السممممممممممفلي من النافذة في الشممممممممممكل ) وفي القسممممممممممم
خمميممممممماران لممعممرض الممقمميممم عمملممى الممرسممممممممممممممممم همممممممممما الممتممكممرارات 

(Frequencies( والنسب )Percentages وسنختار في ،)
بعد الضمممممممممممممغط على اسمممممممممممممتمرار  .1مثالنا هنا خيار النسمممممممممممممب

(Continue( في الشمممممممممكل )سمممممممممتختفي النافذة الفرعية 4.3 )
فنقوم بالضمممممغط على موافق ( 3.3وتبقى النافذة في الشمممممكل )

(OK.) 

وسيتم ، (Outputستظهر النتائج المطلوبة في نافذة النتائج )
في  عليهالنسق الذي تظهر حسب ب عرضها بالترتيب التالي

 ؛SPSSبرنامج 

 128هو  (N) وعدد القيم المفقودة. ونلاحظ أن عدد المشاهدات ((1.3جدول ): عدد المشاهدات لكل متغير )أولا
لكل متغير من المتغيرات الثلاثة، وأنه لا توجد أي قيمة مفقودة في أي (( Validالمشار إليه بالفعلي ))مشاهدة 
 .((Missing)والمشار إليه بالمفقود ) متغير

: عدد المشاهدات لكل متغير في ملف البيانات 1.3جدول 
"car_insurance_claims.sav". 

Statistics 

 

Policyholder 

age Vehicle group Vehicle age 

N Valid 128 128 128 

Missing 0 0 0 

 

، )وهو جدول التوزيع التكراري لكل متغير، وسنقوم هنا بعرض جدول التوزيع التكراري للمتغير الأول فقط: ثانيا
في نافذة النتائج في برنامج  جوع لبقية الجداول( ويمكنك الر 2.3في جدول ) (،Policyholder ageالمتغير 
SPSS. 

  

                                                 
يم على القطاعات أو الأعمدة البيانية تلقائيا، بل يتم إظهارها على الشكل باستخدام قاللن تظهر النسب أو  SPSSفي الرسم البياني في  1

 ( كما سنوضح لاحقا.Chart Editorنافذة محرر الرسم )

 

( Charts: نافذة اختيار نوع الرسم البياني )4.3شكل 
 من نافذة تنفيذ الجدول التكراري.
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في ملف البيانات  Policyholder age متغيرلل جدول التوزيع التكراري : 2.3جدول 
"car_insurance_claims.sav". 

Policyholder age 

 Frequency Percent Valid Percent 

Cumulative 

Percent 

Valid 17-20 16 12.5 12.5 12.5 

21-24 16 12.5 12.5 25.0 

25-29 16 12.5 12.5 37.5 

30-34 16 12.5 12.5 50.0 

35-39 16 12.5 12.5 62.5 

40-49 16 12.5 12.5 75.0 

50-59 16 12.5 12.5 87.5 

60+ 16 12.5 12.5 100.0 

Total 128 100.0 100.0  

صنيف أو التقسيم للمتغير الوصفي )عمر المؤمّن ( أن العامود الأول من اليسار يمثل الت2.3لاحظ من الجدول )وي  
"Policyholder age")  وهو عبارة عن ثمانية تقسيمات تمثل ثمانية فئات عمرية، والعامود الثاني يمثل تكرارات

ضمن  والفعلية على التوالي 1الكلية ، والعامودين الثالث والرابع يمثلان نسب الأشخاصكل تقسيم أي كل فئة عمرية
كل فئة عمرية. أما العامود الأخير فيمثل النسب التراكمية، أي حاصل جمع نسبة كل فئة عمرية مع ما يسبقها. 

وكذلك الحال في  .12.5%ومن هذا الجدول نلاحظ أن نسب الأشخاص في كل فئة عمرية هو متساوي ويساوي 
المتغيرين الأخريين، فإننا نلاحظ تساوي نسب السيارات في التقسيمات الأربع أي أن نسبة السيارات في كل تقسيم 

تساوي نسب الأشخاص من حيث %، وكذلك 25هو 
 أعمار سياراتهم.

الرسم البياني، وقد تم اختيار القطاعات البيانية : ثالثا
للمتغير الأول البياني  سنقوم بعرض الرسمو في مثالنا، 

( ويمكن الرجوع لبقية الرسومات 5.3فقط في الشكل )
لاحظ من الرسم ي  و  .SPSSفي نافذة النتائج في برنامج 

البياني تساوي جميع القطاعات مما يدل على توزع عدد 
 في التقسيمات الثمانية.الأشخاص أعمار أو نسب 

لاحظ وكذلك الأمر بالنسبة للمتغيرين الآخرين حيث ي  
وكما  تساوي توزيع النسب في القطاعات أو التقسيمات.

                                                 
ي قصد بالنسب الكلية التي تحتوي على القيم الفعلية والمفقودة إن وجدت، وحيث أن المتغير لا يحتوي على قيم مفقودة فالنسب في  1

 ن الثالث والرابع تكون متساوية.العامودي

 

 Policyholder age القطاعات البيانية للمتغير :5.3شكل 
 ."car_insurance_claims.sav"في ملف البيانات 
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ذكرنا سابقا، فإن نسب القطاعات لم تظهر في الشكل، لذلك إذا ما أردنا إظهارها على القطاعات أو على أي رسم 
 بياني نقوم بالخطوات التالية:

للمثال السابق، قم بالنقر المزدوج )بالزر الإيسر للفأرة( على رسم القطاعات  SPSS( في Outputنافذة النتائج )في 
كما يوضح  (Chart Editorمحرر الرسم )( فتظهر نافذة فرعية هي نافذة Policyholder ageللمتغير )البيانية 
 (.أ 6.3الشكل )

  

 )ب( ) أ (
نافذة ( و)ب( Policyholder age)( لرسم القطاعات البيانية للمتغير Chart Editor: )أ( نافذة محرر الرسم )6.3شكل 

 خواص محرر الرسم الخاصة بها.

 (Show Data Labelقم بالضغط على الأيقونة المشار لها بالسهم في الشكل، والتي تمثل إظهار وسم البيانات )
الشكل  شكل المجاور،كما ي شاهد في التظهر نافذة فرعية أخرى، عندها س والتي تمثل في مثالنا نسب القطاعات،

قم بعدها بالضغط  .SPSSفي نافذة النتائج في  (، وفي نفس الوقت ستظهر تلك النسب على القطاعاتب 6.3)
وكذلك يمكنك إغلاق نافذة محرر الرسم إذا لم يكن هنالك تعديلات  ( في النافذة الأخيرةCloseعلى أمر الإغلاق )

 ظهور نسب الأعمار للمتغير المطلوب على القطاعات البيانية في نافذة النتائج. د ذلكبع وستلاحظ .تريد تنفيذها

أ، ب((، ستلاحظ وجود العديد من الخيارات التي يمكنك استخدامها للتعديل على  6.3في كلا النافذتين، )الشكل )و 
تعديل أسماء محاور الرسم، الرسم مثل حجم الرسم، حجم ونوع ولون الخطوط في الرسم، إضافة عنوان للرسم، 

 تغيير مواضع وسم البيانات، تغيير الألوان في الرسم، وغيرها من الخيارات التي سنتناول البعض منها لاحقا.



56 

 

 :ملاحظة
محرر الرسم، عند النقر المزدوج على أي جزء من الرسم ستظهر نافذة خواص ذلك الجزء بالتحديد نافذة في 

 يلات المطلوبة.ويمكنك من خلالها إجراء التعد

 (Bar plots of Frequency Distribution Tables) الأعمدة البيانية لجداول التوزيع التكراري  2.3.3

 ، من حيث الشكل العام، رسومات المدرج التكراري للمتغيرات الوصفية تشبه رسومات الأعمدة البيانية
 أن الأعمدة البيانية غالبا ما تستخدم لتمثيل وعرض . إلاوالتي تستخدم لتمثيل التوزيع التكراري للمتغيرات الكمية

 الوصفي المتغير مستويات أو تصنيفاتتوزيع  على الرسم يتمو . باستخدام تكراراتها البيانات الوصفية غير الرقمية
وفي هذه  المختلفة على أحد المحاور، )المحور الأفقي عادة(، وتكرار الحدوث أو النسبة على المحور الآخر.

رة، سيتم من خلال المثال القادم شرح طريقة إدخال البيانات للمتغير الوصفي التي تكون مجهزة مسبقا بصورة الفق
 .للبيانات سائد بشكل كبير في أوساط المتعاملين بالتحليل الإحصائي هو جدول توزيع تكراري كما

والإناث في خمسة أقسام في كلية العلوم ((، تمثل أعداد الطلبة الذكور 3.3جدول )الالبيانات في الجدول التالي، )
 عماتحويل" محتويات الجدول إلى "صورة" معبرة لاستخدام الأعمدة البيانية "سيتم . و 2012بجامعة بنغازي لعام 
 تمثله هذه البيانات.

 : توزيع أعداد الطلبة الذكور والإناث في أقسام كلية العلوم بجامعة بنغازي.3.3جدول 
 القسم 
 نبات كيمياء فيزياء إحصاء رياضيات ↓النوع 
 470 510 170 120 190 ذكور
 960 720 240 310 280 إناث

 1430 1230 410 430 470 المجموع

"، كما أقسام كلية العلوموليكن باسم " SPSSخطوة هنا هي إدخال البيانات في ملف بيانات جديد في ستكون أول 
ولاحظ هنا أنه تم تعريف ثلاثة متغيرات هي "الطلبة" وهو متغير كمي يمثل أعداد الطلبة،  (.7.3يظهر في الشكل )

و"النوع" وهو متغير وصفي اسمي يمثل نوع الطالب ذكر أو أنثى، و"القسم" وهو أيضا متغير وصفي اسمي يمثل 
 القسم الذي ينتمي إليه الطالب من بين خمسة أقسام.

((، عن طريق إدخال 3.3من الجدول السابق، )جدول )" أقسام كلية العلوم"البيانات وننوه هنا بأنه قد تكوين ملف 
( كقيم للمتغير 960، ...، 310، 280( متبوعة بقيم الصف الثاني )470، ...، 120، 190قيم الصف الأول )

النوع" و"القسم"(، الأول وهو "الطلبة"، ثم تم إدخال تصنيف نوع الطالب والقسم الذي يتبع له، )وهما المتغيران "
تمثل  120تمثل الطلبة الذكور في قسم الرياضيات، والقيمة  190بحسب ترتيب إدخال أعداد الطلبة، فمثلا القيمة 

 الطلبة الذكور في قسم الإحصاء، وهكذا.
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 ."أقسام كلية العلوم": عرض بيانات ملف 7.3شكل 

 Clusteredباستخدام الأعمدة البيانية المصنفة ) "أقسام كلية العلوم" ملف البيانات الآن سنقوم بتمثيل البيانات في 

Bar charts والذي سيتم من خلاله عرض أعداد الطلبة بحسب نوع الطالب والقسم التابع له. في شريط الأدوات ،)
 Graphs > Legacyقم باختيار  SPSSالعلوي في برنامج 

Dialogs > Bar التي تتيح  فتظهر النافذة الفرعية التالية
 ((.8.3؛ )شكل )اختيار نوع الأعمدة البيانية

قم باختيار الأعمدة البيانية المصنفة كما هو مشار إليه بالسهم 
(Clustered( ثم اضغط تعريف )Define.)  ستظهر بعد ذلك

من خلالها تعريف  ((، والتي سيتم9.3نافذة أخرى، )شكل )
ترتيب متغيرات التصنيف، )والتي هي في مثالنا الحالي تمثل 

 (.نوع الطالب والقسم التابع له

( Other statisticقم في تلك النافذة بالنقر على الخيار )
لسهم، ثم عرف المتغيرات الثلاثة في ملف والمشار إليه با

المتغير ( والمشار إليه بالأسهم، حيث أن 9.3ح في الشكل )بنفس الترتيب الموض "أقسام كلية العلوم"البيانات 
الكمي "الطلبة" سيكون هو المتغير الأساسي والمتغير "القسم" سيمثل التصنيف على المحور الأفقي، والمتغير 

 "النوع" سيكون ضمن تصنيف الأقسام.

 

 الأعمدة البيانيةنافذة اختيار نوع : 8.3شكل 
(Clustered). 
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 ."أقسام كلية العلوم": نافذة تعريف المتغيرات للأعمدة البيانية المصنفة لبيانات ملف 9.3شكل 

سنحصل مباشرة بعد ( في أسفل النافذة للتنفيذ. OK) موافق قم بالضغط على 1بعد الانتهاء من تعريف المتغيرات
ويمكن الوقوف (. 10.3كما هو في الشكل )ذلك على الأعمدة البيانية المصنفة لأعداد الطلبة في نافذة المخرجات، 

 على عدة ملاحظات من شكل الأعمدة البيانية من أهمها؛

 .تميز قسمي النبات والكيمياء بوجود أعداد أكبر من الطلبة من باقي الأقسام 

 .تفوق أعداد الطالبات على أعداد الطلبة في جميع أقسام الكلية وخاصة في قسمي النبات والكيمياء 

  في قسم الفيزياء.هو للطلبة أقل عدد 

                                                 
( في أعلى النافذة إلى اليمين. كما Titlesيمكنك إدراج عناوين أو ملاحظات خاصة بك ضمن الرسم عن طريق الدخول إلى العناوين ) 1

 (.Optionsيمكنك أيضا الحصول على بعض الخيارات الإضافية على الرسم، )مثل فترات الثقة وغيرها( بالدخول إلى الخيارات )
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 "أقسام كلية العلوم"البيانات : الأعمدة البيانية المصنفة للطلبة بحسب النوع والقسم لبيانات ملف 10.3شكل 

استخدام الأعمدة البيانية لتمثيل أعداد الطلبة  (،العلوم""أقسام كلية ، )ملف البيانات من جديد، يمكننا ولنفس المثال
نممماث. ولتنفيمممذ ذلمممكفي الأقسممممممممممممممممام بمممدون تصممممممممممممممنيفهم  ، قم في شممممممممممممممريط الأدوات العلوي قم بممماختيمممار إلى ذكور وا 

Graphs>Legacy Dialogs>Bar فتظهر النافذة الفرعية 
باختيار الأعمدة البيانية قم  (.11.3شمممممممممممممكل )ال في التي نراها
كما هو مشممممار إليه بالسممممهم ثم اضممممغط  (Simple) البسمممميطة
 (.Defineتعريف )

ستظهر بعد ذلك نافذة تعريف ترتيب المتغيرات التصنيف، 
، قم في تلك النافذة بالنقر السابق (9.3شكل )كما هو في ال
( والمشار Other statistic) إحصاءات أخرى  على الخيار

لقسم" بنفس إليه بالسهم، ثم عرف المتغيران "الطلبة" و"ا
ولكن بدون تعريف  الترتيب الموضح والمشار إليه بالأسهم

، حيث أن المتغير الكمي "الطلبة" المتغير الثالث وهو "النوع"
سيكون هو المتغير الأساسي والمتغير "القسم" سيمثل 

 التصنيف على المحور الأفقي.

أسفل النافذة وستحصل بعد ذلك على ( في OK) موافق بعد الانتهاء من تعريف المتغيرات قم بالضغط على
 (.12.3الأعمدة البيانية لأعداد الطلبة بحسب القسم فقط في نافذة المخرجات، كما هو في الشكل )

 

 البسيطة : نافذة اختيار نوع الأعمدة البيانية11.3شكل 
(Simple). 
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 ."أقسام كلية العلوم" البيانات : الأعمدة البيانية المصنفة للطلبة بحسب القسم لبيانات ملف12.3شكل 

( ملاحظة وجود أعداد أكبر من الطلبة في قسمي النبات والكيمياء، وكذلك انخفاض عدد 12.3ويمكننا من شكل )
 .( السابق أيضا10.3أمكن رؤيتها من الشكل )طلبة قسم الفيزياء مقارنة بباقي أقسام الكلية، وهذه الملاحظات 

( فإننا سنحصل على أعمدة بيانية 8.3( في الشكل )Stackedونشير هنا إلى أنه إذا ما تم اختيار الخيار الثالث )
 (.13.3مصنفة بحسب القسم والنوع كما يظهر في الشكل )

 
باستخدام خيار  "أقسام كلية العلوم"لبيانات ملف  والنوع : الأعمدة البيانية المصنفة للطلبة بحسب القسم13.3شكل 

(Stacked.) 
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 :ملاحظة
كما أوضحنا سابقا، مع بيانات المثال السابق لتمثيل أعداد الطلبة بحسب  ،يمكن استخدام القطاعات البيانية

 القسم )أو النوع( وسنحصل على نفس الملاحظات ولكن بتمثيل بياني مختلف.

 (Bar plots for Dummy Variables)الوهمية لمتغيرات لالأعمدة البيانية  3.3.3

تأخذ طابعا  البيانات ضمن عدة متغيرات وصفيةفي بعض الأحيان قد نحتاج لمقارنة تغير أو توزع 
بحيث يمكن للشخص المستجيب أن يعطي أكثر  حول موضوع معينبين آراء الناس  مثل أن يتم المقارنة خاصا

، في هذه أي أن يكون للشخص أكثر من خيار لكل إجابة بنعم أو لا ،من إجابة واحدة بنعم أو لا لنفس السؤال
من المتغيرات، والتي تسمى عندها بالمتغيرات الوهمية، بحيث أن كل متغير من هذه  يتم تعريف مجموعةالحالة 

وقد سبق التعرض للمتغير الوهمي في الفصل الثاني،  المتغيرات يمثل استجابة الشخص بنعم أو لا لكل خيار.
 ؛((، وسوف نقدم مثال آخر هنا للمزيد من التوضيح4.2)البند )

على مجموعة من الأشخاص لمعرفة آرائهم توزيع استبيان ب ختصة بعلاج السمنةقامت إحدى مراكز الصحية الم
 ((4.3، فكانت النتائج كما هو موضح في الجدول التالي، )جدول )المختلفة حول وجباتهم المفضلة من المطاعم

ول الدجاج " يدل على اختيار الشخص لنوع الطعام المفضل، فمثلا؛ الشخص الأول في الجدول يفضل تنا1والرقم "
 واللحوم الحمراء والمثلجات، وهكذا.

آراء عينة من الأشخاص حول مأكولاتهم  :4.3جدول 
 .المفضلة

لحوم  مثلجات
  بيتزا دجاج سلطات حمراء

1 1  1  1 
1 1   1 2 
1     3 

 1  1 1 4 
1 1 1 1 1 5 
1 1   1 6 
1     7 
1 1   1 8 
1  1   9 
1 1 1   10 

   1 1 11 
1 1    12 
1 1 1  1 13 

   1  14 
1 1  1  15 
1 1    16 
1 1   1 17 
1   1  18 
1   1 1 19 
1  1  1 20 
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"، كما نشاهد في المأكولات المفضلة، وليكن باسم "SPSSوبعد إدخال هذه البيانات في ملف جديد في برنامج 
 ( نقوم بالخطوات التالية؛14.3الشكل )

 

 ."المأكولات المفضلة": عرض بيانات ملف 14.3شكل 

وبعد ظهور النافذة الفرعية الخاصة  Graphs>Legacy Dialogs>Barفي شريط الأدوات العلوي قم باختيار 
بإبقاء اختيار ((، قم 15.3باختيار نوع الأعمدة البيانية، )شكل )

( ثم قم بالنقر على الخيار الثاني في Simpleالأعمدة البسيطة )
الجزء الأسفل من النافذة والمشار إليه بالسهم السفلي لاختيار 

 التعامل مع عدة متغيرات.

( فتظهر نافذة جديدة لتعريف المتغيرات Defineاضغط تعريف )
يوضح الشكل  المطلوب تمثيلها باستخدام الأعمدة البيانية كما

 (.(16.3التالي، )شكل )

في هذه النافذة، قم باختيار كل المتغيرات الخمسة كما هو مشار 
، ثم قم بنقلها إلى الخانة المشار إليها بالسهم 1إليه في السهم رقم 

الذي ( Options، )وهي خانة المتغيرات التي ستمثلها الأعمدة البيانية(، بعد ذلك انقر على زر الخيارات )2رقم 
 (.17.3جديدة كما يوضح الشكل )فتظهر نافذة فرعية  3يشير إليه السهم رقم 

  

 

: نافذة اختيار تمثيل الأعمدة البيانية  15.3شكل 
 لأكثر من متغير.
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 : نافذة اختيار المتغيرات في تمثيل الأعمدة البيانية المتعددة.16.3شكل 

(، قم بالضغط على الخيار المشار إليه بالسهم، )والخاص باستثناء القيم المفقودة ضمن كل 17.3في نافذة الشكل )
 (.Continueمتغير وليس باستثناء الصف(، ثم اضغط استمرار )

 

 متغيرات.الالقيم المفقودة ضمن اختيار تعديل : نافذة 17.3شكل 
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 Change) ة( السابق(، قم عندها بالضغط على خيار تغيير الإحصاء16.3ستعود الآن للنافذة السابقة )شكل )

Statistic نافذة فرعية جديدة كما يظهر في عندها ستظهرو  ،نقل المتغيرات إليها( والموجود أسفل الخانة التي تم 
 (.18.3الشكل )

 

 .تمثيل الأعمدة البيانية : نافذة اختيار الإحصاءة المطلوبة للمتغيرات في18.3شكل 

، وهي في مثالنا الحالي ستكون عبارة لكل متغير قم في هذه النافذة باختيار الإحصاءة الخاصة بعدد المشاهدات
بعد ذلك اضغط استمرار وستختفي النافذة الفرعية، اضغط لكل متغير،  1عن مجموع آراء الناس أي مجموع الرقم 

سنحصل بعدها على الأعمدة البيانية المطلوبة في نافذة المخرجات، وهذه الأعمدة موضحة  .( للتنفيذOKموافق )
 (.19.3في الشكل )

ذه الأعمدة يمكن بوضوح القول بأن الأشخاص الذين تم استبيانهم يفضلون تناول المثلجات كرغبة أولى من هو 
 يليها اللحوم الحمراء والبيتزا.
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المأكولات ": الأعمدة البيانية الممثلة لآراء الناس في الطعام المفضل لبيانات ملف 19.3شكل 
 ."المفضلة

 (EDA for Quantitative Variables) الكمية للمتغيراتالتحليل الاستكشافي  4.3

كما وضحنا في البند الخاص بأنواع البيانات، فإن البيانات الكمية تنقسم إلى فئوية ونسبية، إلا أن هذا  
التقسيم لن يتم أخذه بالاعتبار من الناحية العملية إلا عند التعليق على المعلومات المستخلصة من البيانات كما 

 خلال الأمثلة التي سنتناولها في هذا البند.سنلاحظ من 

توجد عدة طرق ومقاييس لاستكشاف البيانات الكمية وهي تندرج في مفهوم الإحصاء الوصفي التقليدي تحت و 
(، وهي تشمل أهم وأشهر المقاييس الإحصائية مثل Central Tendency) النزعة المركزيةمسميات مقاييس 

(. وأهمها المدى والانحراف Dispersion) الاختلافأو  التشتتال وغيرها، ومقاييس الوسط الحسابي والوسيط والمنو 
وكما هو الحال مع البيانات الوصفية، فإن التمثيل البياني الإحصائي ي عد أداة هامة جدا  وغيرها.والتباين المعياري 

 واستكشاف طبيعة وتوزيع البيانات كما سنرى.تستخدم لتوضيح 

، (الأحادي التحليل)، كمية كانت أو وصفية، بشكل مفرد متغيرات أية يمكن التعامل مع بأنه نذكر هنا من جديد،
. والأساليب الإحصائية التي ت ستخدم مع )التحليل المتعدد(آن واحد،  أو متعدد، أي التعامل مع عدة متغيرات في

ن كانت قاعدة البيانات متكونة تعني أنه سيتم حساب تلك المقاييس لكل متغير على حدة، حت الأحادي التحليل ى وا 
 وسنقوم بداية بحساب أهم المقاييس الإحصائية لاستكشاف البيانات من خلال الأمثلة التالية. من متغيرات عديدة.
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 35 ب)الذي تم تكوينه في الفصل الثاني(، والذي يمثل البيانات المتعلقة ، "بيانات الطلبة"البيانات باستخدام ملف 
 فيه؛حيث تمثل المتغيرات  في إحدى الأقسام العلمية،جامعيا طالبا 

: درجة الطالب 3مقرر، 2: درجة الطالب في المقرر2مقرر، 1درجة( في المقرر 100)من  : درجة الطالب1مقرر
فصل: ترتيب الفصل الأنثى(،  =2ذكر، و =1وع: جنس الطالب )الن، العمر: عمر الطالب بالسنوات، 3في المقرر

 المنزل: عدد الحجرات في منزل الطالب.، الأسرة: عدد أفراد أسرة الطالب، و )المرحلة( الدراسي للطالب
فنذهب لشريط الأدوات العلوي في برنامج سنقوم بحساب بعض المقاييس الإحصائية الهامة والوقوف على تفسيرها. 

SPSS  :ونختار التاليAnalyze>Descriptive Statistics>Frequencies دخال كما هو فتظهر نافذة الإ
 ((؛20.3مبين في الشكل التالي، )شكل )

 
 .(Frequenciesالتكرارات ) : نافذة الإدخال لأمر20.3شكل 

في هذه النافذة، يمكن للمستخدم اختيار المتغير أو المتغيرات التي يرغب في حساب المقاييس الإحصائية والرسومات 
المتغيرات الثمانية  1(، وسنقوم في مثالنا هذا باختيار جميع1بالسهم )البيانية لها من المربع الإيسر المشار إليه 

المتغيرات (، إلى مربع 2) بالرقمالمشار إليه  باستخدام السهم نقلهاب نقوموبعد اختيار كل المتغيرات المتوفرة. 
(Variables)الإحصاءات . الآن سنقوم باختيار المقاييس التي نرغب بحسابها من خيار (Statistics المشار )

 (.3إليه بالسهم )

((، قم في هذه النافذة الفرعية باختيار المقاييس المشار إليها 21.3عندها ستظهر نافذة فرعية جديدة، )الشكل )
(، Quartiles) الربيعات(، Mode) المنوال(، Median) الوسيط(، Mean) الوسط الحسابيوهي ( √)بالعلامة 

أما  (.Maximum)القيمة الكبرى (، وMinimum) القيمة الصغرى (، Std. Deviation) الانحراف المعياري 
                                                 

 Aوالحرف في لوحة المفاتيح  CTRLلاختيار جميع المتغيرات مرة واحدة يمكن بعد النقر بالفأرة على المربع الإيسر الضغط على زر  1
 في آن واحد فيتم اختيار كافة المتغيرات.
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( وغيرها(، فليس هنالك Variance) التباين( وSum) المجموعالمقاييس الأخرى المتوفرة ضمن الخيارات، )مثل 
 حاجة لاستخدامها حاليا في هذا المثال وسنتطرق لها لاحقا بحسب الحاجة.

 

 .(Frequenciesالتكرارات )ر المقاييس الإحصائية ضمن نافذة : نافذة اختيا21.3شكل 

ونقوم  ((،20.3)شمممكل ) ( فيتم العودة للنافذة السمممابقةContinueبعد اختيار المقاييس المطلوبة اضمممغط اسمممتمرار )
على خيمار الرسممممممممممممممومات البيمانيمة في تلمك النمافذة بالضممممممممممممممغط 

(Charts( المشممممممار إليه بالسممممممهم )لاختيار الرسممممممم البياني 4 )
((، 22.3المطلوب. ستظهر عندئذ نافذة فرعية أخرى، )شكل )

والتي يمكن من خلالها اختيار عدم اسممممممتخدام أي رسممممممم بياني 
(None( أو اختيممار الأعمممدة البيممانيممة ،)Bar Charts) أو ،

(، أو اختيار المدرج Pie Chartsلبيانية )اختيار القطاعات ا
(، وسممممممممممممممنقوم هنمممما بمممماختيممممار المممممدرج Histogramالتكراري )
 .في البند القادم تفسيرهوالذي سيتم  ،التكراري 

ونشير هنا في نفس النافذة إلى إمكانية اختيار إظهار منحنى 
تعليقا له باستخدامه حاليا حيث أننا سنفرد التوزيع الطبيعي على الرسم البياني للمدرج التكراري، إلا أننا لن نقوم 

 مطولا عند تناول موضوع التوزيع الطبيعي.

 :ملاحظة
( فإنه يمكن اختيار عرض التكرارات 22.3في الشكل ) القطاعات البيانية الأعمدة البيانية أوإذا ما تم اختيار 

(Frequencies( أو النسب )Percentages على الرسم من الخيار أسفل ).النافذة 

 

 : نافذة اختيار الرسم البياني ضمن نافذة22.3شكل 
 .(Frequenciesالتكرارات )
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ذا 20.3( فيتم العودة للنافذة السابقة )شكل )Continueاستمرار ) على لرسم المطلوب اضغطابعد اختيار  ((. وا 
( المشار إليه Display Frequency Tablesما قمنا في تلك النافذة بإبقاء اختيار عرض الجداول التكرارية )

سومات المطلوبة، إلا أننا في هذا المثال لن نكون بحاجة مع المقاييس والر (، فإن سنحصل عليها 5)رقم  بالسهم
( 20.3( في نافذة الشكل )OKإليها لذلك سنقوم بإلغاء اختيار عرضها. نقوم بعد ذلك بالضغط على موافق )

 .تباعا في نافذة المخرجات فنحصل على النتائج المطلوبة

المقاييس الإحصائية المطلوبة لكافة المتغيرات  النتيجة الأولى، بحسب ترتيب العرض في نافذة المخرجات ستكون 
في العامود الأول إلى اليسار، توجد أسماء المقاييس بالترتيب التالي؛ عدد  (.23.3الثمانية كما يوضح الشكل )

ويساوي صفرا لعدم وجود قيم مفقودة  (Missing، عدد القيم المفقودة )مشاهدة 35وهو  (N Validالمشاهدات )
المتوسط، الوسيط، المنوال، الانحراف المعياري، القيمة الصغرى، القيمة الكبرى، الربيعات: الربيع  ،في البيانات

 (.75، و50، 25، )ولاحظ أنها معروضة باسم المئين الأول، الثاني، والثالث

 
 ."بيانات الطلبة: المقاييس الإحصائية الاستكشافية لمتغيرات الملف "23.3شكل 

بشكل فردي أو أحادي، بمعنى أن قيم المقاييس قد تم  أو المقاييس المحسوبة قد ظهرتنتائج اللاحظ هنا أن وي
حسابها لكل متغير على حدة )في عامود مستقل(، ولا توجد نتيجة محسوبة باستخدام متغيرين أو أكثر في نفس 

 :استخلاص التالي. وبالنظر إلى هذه النتائج يمكننا الوقت

 ذا ما نظرنا إلى الوس لهما أوساط متقاربة تقترب  2و 1ط الحسابي للدرجات فإننا نلاحظ أن المقررين وا 
، أما المقرر الثالث فيختلف وسطه عن المقررين الأولين ويتجه (72.97و 71.31) من تقدير جيد جدا
. وضمن عائلة الأوساط أيضا، ي لاحظ تساوي الوسيط للمقررين الأولين (55.34) نحو التقدير مقبول

بصورة كبيرة. هذه النتيجة تعطي انطباعا "مبدئيا"  (53) اختلاف )ارتفاع( قيمته عن المقرر الثالثو ( 75)
 .3هو أفضل من أداؤهم في المقرر  2و 1بأن أداء الطلاب في المقررين 
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 درجات  1الارتفاع الطفيف في قيم الوسيط للمقررين الأولين يعكس وجود التواء بسيط إلى اليسار في توزيع
الطلاب في هذين المقررين، بمعنى أن الدرجات تتجه إلى اليمين، أي تتجه نحو الدرجات الأعلى، وهذه 

 .الملاحظة تتوافق مع قيم الأوساط للدرجات

 ( 95، و96، 94إذا ما نظرنا إلى القيم الكبرى للمقررات الثلاثة والتي ي لاحظ تقاربها  ،)على الترتيب
ائج السابقة، نستنتج وجود قيم متطرفة عليا في المقرر الثالث، بمعنى أن طالب أو فإننا، وبعد قراءة النت

أكثر قد حققوا درجات عالية جدا في هذا المقرر رغم تدني مستوى الأداء لغالبية الطلاب مما ي عد من 
 الناحية الإحصائية "تطرفا" في قيم ذلك المتغير.

 إلى قيم الربيعات في النتيجة السابقة فإننا نلاحظ أن قيم الربيع الأول هي متقاربة في المقررين  بالنظر
% من الطلاب )أي الأكثرية( هي تقريبا جيد 75( وهذه القيم تعني أن تقديرات 67.5و 63.5الأولين )

ما يدل على تقارب ( م84.5و 83في المقررين. كما أن قيم الربيع الثالث للمقررين هي متقاربة جدا )
، فمن الملاحظ أن قيم الربيع الأول ررين. أما بالنسبة للمقرر الثالثتوزيع درجات الطلاب في هذين المق

، )مما يعني أن 60والثالث له متدنية كثيرا عن المقررين الأولين، وحيث أن قيمة الربيع الثالث له هي 
 3، فهذا كله يؤكد أن أداء الطلاب في المقرر% من درجات الطلاب في هذا المقرر هي أقل من جيد(75

 .2و 1كان تحت المستوى الم رضي مقارنة بالمقررين 

  من قيم الانحراف المعياري للدرجات، نرى بأن متوسط الفروقات بين درجات الطلبة في المقررات الثلاثة
ة في أي مقرر من في أداء الطلب معدل الاختلافدرجة تقريبا، بمعنى أن  15هو متقارب جدا ويساوي 

اختلافا كبيرا بين مستوى الطلبة ضمن كل مقرر من هذه عد درجة، وذلك ي   15المقررات الثلاثة هو 
 .المقررات

اري  1.4.3

إن الكثير من تلك الاستنتاجات السابقة وغيرها يمكن قراءتها "بشكل مرئي" باستخدام التمثيل البياني، 
الذي ستكون نتائجه متوفرة ضمن نافذة المخرجات، وسنقوم بعرض المدرجات التكرارية  لمدرج التكراري اوعلى رأسها 
وهي درجات الطلبة في المقررات "(، بيانات الطلبة)ملف البيانات "، في مثالنا الحالي الثلاثة الأولى للمتغيرات

 ؛لتسهيل المقارنة بينها ((،24.3، )شكل )الثلاثة، في شكل واحد هنا

                                                 
 الاحتمالي للمتغير.نذكر هنا أن مصطلح "توزيع" الدرجات يشير إلى نمط انتشار قيم المشاهدات ولا ي قصد به التوزيع  1

 )Histogram( المدرج التكر
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 ."بيانات الطلبةفي الملف " 3، و2، 1مقرر  درجات الطلبة في المدرجات التكرارية للمتغيرات: 24.3شكل 

، أما 2و 1( وجود التواء بسيط إلى اليسار في توزيع المقررين الأولين 24.3وي لاحظ من المدرجات في الشكل )
 ينالأخير  ينإلى اليمين والذي ساعد على ظهوره وجود القيم المتطرفة العليا، )العامود فت ظهر التواءقيم المقرر الثالث 

 (.التكراري  ي يمين المدرجف

، فيتم وعدد غرف منزل الطالب، عدد أفراد أسرة الطالب عمر الطالبوهي فيما يخص باقي المتغيرات الكمية؛ أما 
عضها البعض، )كما كان الحال مع درجات الطلاب(، لأنها دراسة توزيعاتها بشكل منفصل أي بدون مقارنتها مع ب

 ؛ فالعمر م قاس بالسنة وأفراد الأسرة بعدد الأشخاص وغرف المنزل م قاسة بعددها.مقاسة بوحدات قياس مختلفة

 (، يمكن ملاحظة التالي بالنسبة لمتغيرات "العمر"، "الأسرة"، و"المنزل":23.3لشكل )من ا

 سنة تقريبا، وهي أعمار منطقية تتناسب وطبيعة المرحلة الدراسية  22طلبة هو متوسط أو معدل أعمار ال
( وهو معدل قد ي عتبر مرتفع إلى حد ما 5)بوسيط يساوي  6لهم. ومعدل عدد أفراد أسرة الطالب هو 

ن كان اعتياديا بالنسبة للأسرة العربية. أما معدل عدد الغرف في منزل الطالب في هذه العينة  عالميا، وا 
 (6بالنظر إلى معدل أفراد أسر الطلبة )وهو  من الغرف المعدلغرف )للوسط والوسيط( وهذا  4فيساوي 

 هؤلاء الطلبة. منازل بوجود اكتظاظ في يعطي انطباعا

 ،كما  ،متوسط الفروقات بين أعمار الطلاب هو أقل من سنتين نرى أن من الانحراف المعياري للمتغيرات
تشتت كبيرة نوعا ما ضمن عدد أفراد أسر هؤلاء الطلاب، وأما عدد غرف منازل ي لاحظ أن هنالك درجة 

 تلك الأسر فهي غير مختلفة كثيرا فيما بينها، حيث أن مقاييس تشتتها لها قيم منخفضة.

 وبالنسبة للمدرجات التكرارية لمتغيرات العمر، عدد أفراد الأسرة، وعدد غرف المنزل، فإننا سنقوم بعرضها في الشكل
 (، للاختصار؛25.3التالي، )
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 ."بيانات الطلبةالعمر، عدد أفراد الأسرة، وعدد غرف المنزل للطالب في الملف " المدرجات التكرارية لمتغيرات: 25.3شكل 

ومن هذه المدرجات التكرارية يمكن الوصول لنفس الملاحظات السابقة للمتغيرات الثلاثة. وننوه هنا إلى أن المدرجات 
التكرارية يمكن أن تستخدم لتوضيح سلوك المتغيرات من حيث مدى اقترابها من التوزيع الطبيعي كما سنوضح 

 لاحقا.

ووسيط يساوي  1.49قد أعطى على سبيل المثال متوسط قدره متغير جنس الطالب  ه ي لاحظ أنفإنمن جهة أخرى، 
إلى كون هذا المتغير وصفي وتم تعريفه ليأخذ وغير ذلك من قيم للمقاييس الأخرى والسبب في ذلك يرجع  1.00
للإناث، وبالتالي فإن قيم المقاييس الإحصائية لهذا المتغير لن تكون "حقيقية" نظرا  2للذكور والقيمة  1القيمة 

ليس لها وحدة قياس. ولذلك يفضل عادة استخدام مقاييس مثل  1.49لطبيعة المتغير، بمعنى أن قيمة المتوسط 
وال مع المتغيرات الوصفية. وكذلك الأمر مع المتغير الذي يمثل ترتيب الفصل الدراسي للطالب. ولذلك النسبة والمن
 المتغيرين هنا. رض المدرجات التكرارية الخاصة بهاذينلن يتم ع

يمكن القول بأن عدد الذكور هو متقارب جدا مع عدد الإناث في  من الرسومات البيانية للمتغيرين وعموما، فإنه
هذه البيانات مع وجود ارتفاع طفيف في عدد الذكور، وكذلك ي لاحظ أن معظم مسجلون في فصول دراسية في 

 المرحلة المتوسطة من الفصل الرابع إلى الفصل السادس.

 (Adjusting the Histogram) غيير الفترات في المدرج التكراري ت 1.1.4.3

في بعض الحالات، قد يكون من الملائم تعديل عدد أو طول الفترات ضمن المدرج التكراري بحسب وحدة قياس 
 المتغير، ولعمل ذلك نقوم بالآتي؛
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وفي نافذة المخرجات قم بالنقر المزدوج على المدرج "(، بيانات الطلبةفي نفس المثال السابق، )ملف البيانات "
( كما يوضح Chart Editor) محرر الرسم"، فتظهر نافذة 1ص بالمتغير "درجة الطالب في المقررالتكراري الخا

 (.26.3الشكل )

 
 ."1مقررللمدرج التكراري للمتغير " : نافذة محرر الرسم26.3شكل 

بعنوان  وستظهر نافذة فرعية أخرى  1في هذه النافذة، قم بالنقر المزدوج من جديد على المدرج التكراري بالتحديد
(، وفي الجزء الخاص Binningضمن خيار تحديد المدى )(. 27.3في الشكل ) ، كما(Propertiesخصائص )

(، وفي Interval width( ثم اختر طول الفترة )Custom(، اختر تعديل حسب الطلب )X Axis) Xبمحور 
درجات، )حيث أن المتغير يمثل درجات طلبة تتراوح  10وذلك لتعديل طول الفترة إلى  10المستطيل المقابل اكتب 

 (.درجات 10لذلك سيكون من المناسب أن يكون طول الفترة  100إلى  0ما بين 

( ليتم تنفيذ التعديل المطلوب، قم بعدها بإغلاق النافذة بالضغط Applyوبعد تحديد طول الفترة اضغط تطبيق )
 .(Closeعلى إغلاق )

                                                 
هنا أن مكان النقر يحدد الجزء الذي يرغب المستخدم بتعديله، فمثلا إذا ما تم النقر على خلفية الرسم فستظهر نافذة فرعية خاصة  نذكر 1

 بألوان الشكل والخلفية وغيرها، وهكذا بالنسبة للمواضع الأخرى في نافذة محرر الرسم.
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المدرج التكراري تغير طول فترات سمممممممممتلاحظ الآن 
. سممنقوم تاليا في الشممكل وكذلك تغير عدد الأعمدة

بتغيير مظهر قيم بممدايممة ونهممايممة كممل فترة )عممامود 
على الرسممممم( بحيث تظهر كل القيم على الشممممكل. 

 ضممممممن نافذة محرر الرسمممممم السمممممابقة لتنفيذ ذلك قم
 Xعلى أي قيمممة من قيم المحور  المزدوج بممالنقر

جديدة قم ضمممممممممممممممنها باختيار ذة فرعية فتظهر ناف
( فتحصممممممممل على الخيارات المبينة Scaleمقياس )

 (.28.3في الشكل )

في تلك النافذة الفرعية، وفي الجزء الخاص بمدى 
(، سنقوم بتغيير مقدار الزيادة Rangeتوزيع القيم )
توزع القيم في محور درجات، ثم نضغط تطبيق فيتغير مقياس  10إلى  20من ( Major Incrementالرئيسية )

X وبذلك نكون خصائص محرر الرسم بحيث تظهر القيم في بداية ونهاية كل فترة، نقوم بعد ذلك بإغلاق نافذة ، 

قد انتهينا من عمل التعديلات على شممممممممكل المدرج 
إغلاق يمكنممممممك الآن  التكراري للمتغير المطلوب.

جراء تعديلات على مواضممممع  نافذة محرر الرسممممم وا 
شمكل نفسمه أو الانتقال إلى رسمم بياني أخرى في ال

جراء أية تعديلات أخرى.  آخر وا 

وبنفس الأسمممممممملوب يمكن تطبيق أي تعديلات على 
الرسمممومات البيانية بحسمممب الحاجة لها، وسمممتلاحظ 
عندها بعض التغيرات في نوافذ خصممممائص محرر 

وع الرسم الذي تقوم بإجراء التعديل الرسم بحسب ن
 عليه.

الرسومات البيانية الشهيرة في عرض  ضمن منو 
والذي يقدم تقريبا نفس المعلومات التي يقدمها المدرج التكراري مع بعض  بشكل الصندوق البيانات ما ي عرف 

 ة التالية؛الإضافات الهامة، ويمكننا تقديم تعريف مبسط لهذا التمثيل البياني الهام بالصور 

  

 
 محرر الرسم. الفترات في : نافذة خصائص27.3شكل 

 
 : نافذة خصائص مقياس الرسم في محرر الرسم.28.3شكل 
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 (The Boxplot)الصندوق  شكل 2.4.3

هو ببساطة رسم بياني يتم من خلاله توضيح خمسة مقاييس هامة تمثل بحد ذاتها شكل الصندوق 
وهذا الرسم يمكن استخدامه لوصف  البيانات.سلوك ملخصا، قد يكون بمفرده كافيا في بعض الأحيان، لتوضيح 

مجموعة واحدة )متغير واحدة( من البيانات أو للمقارنة بين متغيرين أو أكثر، إذ يمكن من خلاله مراقبة تشتت 
التعرف  يمكنناالصندوق  من خلال شكل، وأيضا عن مركزها وكذلك ملاحظة مدى تماثل توزيعهاتوزيع البيانات 

 ا سنرى.على القيم المتطرفة بصورة واضحة جدا كم

 Five-Numbers) الأرقام الخمسةبملخص والتي تسمى أيضا  إن المقاييس الخمسة التي يعرضها الصندوق،

)Summary1(، الربيع الأول والكبرى  الدنيا ، هي القيمتينQ( الربيع الثالث ،)3Q( والوسيط ،)�̃�( . ويكون الشكل
 ((؛29.3على الصورة التالية، )شكل ) رسم الصندوق التقليدي ل

 

 موضحا عليه المقاييس الإحصائية المرتبطة به. لرسم الصندوق : شكل بياني افتراضي 29.3شكل 

( أنه إذا لم توجد قيم متطرفة في توزيع البيانات، فإن القيمة العظمى ستكون هي القيمة 29.3ويلاحظ من الشكل )
ولتوضيح كيفية  .بالنسبة للقيمة الدنيا في البيانات، وكذلك الحال الصندوق عند الخط الذي يمثل الحد الأعلى في 

لمتغيرات الثلاثة لتمثيل ا باستخدامهسنقوم ، SPSSفي برنامج  بيانيا لتمثيل توزيع المتغير الصندوق  شكلاستخدام 
 ؛ملف البيانات "بيانات الطلبة"من  الأولى
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فتظهر النافذة التالية،  Graphs>Legacy Dialogs>Boxplotقم باختيار  SPSSفي الشريط العلوي لبرنامج 
 ((؛30.3)شكل )

( Simpleسمممنقوم هنا باختيار تنفيذ شمممكل الصمممندوق البسممميط )
( في الشممممكل، )وسممممنتطرق لشممممكل 1والمشممممار إليه بالسممممهم رقم )

عدة الصممممممممممندوق باسممممممممممتخدام التصممممممممممنيف تاليا(، ونختار تمثيل 
( في الشمممكل. 2كما يشمممير السمممهم رقم ) 1متغيرات في آن واحد

(، فتظهر نافذة جديدة كما Defineثم نضممممممممممممغط أمر تعريف )
 (.31.3يوضح الشكل )

قم في تلك النافذة باختيار المتغيرات الثلاثة الأولى، )وهي درجة 
ونقلها إلى الخانة (، 3والمقرر 2والمقرر 1الطالب في المقرر

( كما هو مبين في الشكل، ثم اضغط Boxes Represents) الصناديق تمثل: العليا في يمين النافذة والمعنونة
 .(OK) موافق

 
 .، )لعدة متغيرات آنيا(دوق شكل الصننافذة تحديد المتغيرات ل: 31.3شكل 

 ونلاحظ من الشكل ما يلي:. (32.3فيظهر الشكل المطلوب في نافذة المخرجات، كما يوضح الشكل )

                                                 
ل البياني لعدة متغيرات في آن واحد يتم استخدامه فقط عندما تكون المتغيرات لها نفس وحدة القياس نشير هنا إلى أن اختيار التمثي 1

 وليست من وحدات قياس مختلفة.

 

 نافذة خيارات شكل الصندوق.: 30.3شكل 



76 

 

 
 ."بيانات الطلبةفي الملف " 3، و2، 1مقرر  درجات الطلبة في للمتغيرات: شكل الصندوق 32.3شكل 

في  الأعلىإلى الجانب  2و 1 اقتراب الصندوق، والذي يمثل كتلة البيانات، في المتغيرين أو المقررين الأولين. 1
الرسم مما ي ظهر التواء إلى اليسار في توزيع البيانات، وهذه دلالة على ارتفاع المستوى الدراسي للطلاب في هذين 

ليس التواء بالمعنى الصحيح، لأن كل المشاهدات في هذا  (3)المقررالمقررين. إلا أن ما نراه في المتغير الثالث 
 أعلىفي  )حيث تمثل القيم على الرسم ترتيب القيمة المتطرفة( المتطرفة المتغير، باستثناء النقاط )الدرجات( الثلاثة

 .سفلالرسم، تنحصر في الجانب الأ

( تقريبا، أما أغلبية الدرجات في 85إلى  65تنحصر في الفترة ) 2و 1 أغلبية درجات الطلاب في المقررين. 2
وى الطلاب في المقرر الثالث، كما ذكرنا (، مما يدل على انخفاض مست60إلى  50فتنحصر في الفترة ) 3المقرر
 سابقا.

الثاني،  قرر( في الم40متطرفة )هي الدرجة عدم ظهور قيم متطرفة في المقرر الأول، وظهور قيمة واحدة . 3
 أخرى في رسومات  قد لا تظهر تيالو  في المقرر الثالث (33و 27وكذلك ظهور قيم متطرفة دنيا )هما الدرجتان 

 يم المتطرفة الثلاثة الكبرى الظاهرة.بوضوح، إضافة للق

مما  2و 1الصندوق( والذي يمثل تشتت درجات الطلاب يبدو أكبر في المقررين  ممثلا بطولانتشار البيانات ). 4
، إلا أن ذلك لم يكن جليا واضحا في النتائج والرسومات السابقة، ولا حتى بحساب الانحراف 3هو عليه في المقرر
، 15.605(، الانحرافات المعيارية للمقررات الثلاثة على الترتيب هي 23.3)من الشكل ) الثلاثة؛المعياري للمقررات 

وزيع البيانات في والتي تبدو متقاربة، وهذه في الواقع إحدى مزايا التمثيل الجيد لتدرجة(،  14.289، و15.219
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الأولين سببه  قررينمن قيم الم الثالث قررب قيمة الانحراف المعياري للماقتراوننوه هنا إلى أن  رسم الصندوق.
 .وجود القيم المتطرفة العليا التي أدت لرفع قيمته

التمثيل البياني لشكل الصندوق بطريقة ت ظهر توزيع المتغير الأساسي مصنفا بحسب من جديد، يمكن استخدام 
الصندوق لمتغير عمر الطالب بحسب متغير )أو متغيرين(، فمثلا يمكننا باستخدام بيانات المثال الحالي تنفيذ شكل 

 النوع؛ ذكر أو أنثى.

وفي النافذة  Graphs>Legacy Dialogs>Boxplotباختيار  SPSSفي الشريط العلوي لبرنامج لعمل ذلك، قم 
(، 1( والمشار إليه بالسهم رقم )Simpleتنفيذ شكل الصندوق البسيط )( قم باختيار 30.3التي تظهر في الشكل )

(. ثم نضغط Summaries of groups of casesتمثيل متغير واحد ) خيار ر الخيار الأول وهوثم قم باختيا
 (.33.3) الشكل هو فيكما  جديدة (، فتظهر نافذةDefineأمر تعريف )

 
 : نافذة تحديد المتغيرات لشكل الصندوق، )لمتغير واحد(.33.3شكل 

، )كما يوضح الشكل(، ثم (Variable) المتغير عمر الطالب في الخانة الأولى العليا قم في تلك النافذة باختيار
ثم اضغط ، (Category Axis) قم باختيار متغير التصنيف أو التقسيم وهو متغير جنس الطالب في الخانة الثانية

(. 34.3ل )فيظهر شكل الصندوق المصنف بحسب جنس الطالب في نافذة المخرجات، كما يوضح الشك موافق
 هم في الغالب أكبر سنا من الطالبات. في العينة بوضوح أن الطلبة الذكور ونلاحظ من الشكل
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 ."بيانات الطلبةلعمر الطالب بحسب النوع للمتغيرات في الملف ": شكل الصندوق المصنف 34.3شكل 

ويمكن أيضا، في نفس السياق، استخدام رسم الصندوق لتمثيل متغير ما اعتمادا على تصنيفه باستخدام متغيرين 
((. فمثلا يمكننا في نفس المثال الحالي اسمممتخدام 34.3وليس متغير واحد فقط، )كما شممماهدنا في الشمممكل السمممابق )
شممممممممكل الصممممممممندوق لتمثيل متغير عمر الطالب بناء على 

 ومتغير عممدد حجرات منزلممه. لتنفيممذ ذلممك،متغير الجنس 
 بممممممماختيمممممممار SPSSقم في الشممممممممممممممريط العلوي لبرنمممممممامج 

Graphs>Legacy Dialogs>Boxplot  وفي النافذة
تنفيذ شمممممممكل ( قم باختيار 35.3التي تظهر في الشمممممممكل )

( والمشار إليه بالسهم Clusteredالصندوق المصنف )
إليممه  والمشممممممممممممممممار (، ثم قم بمماختيممار الخيممار الأول1رقم )

ضغط اوهو خيار تمثيل متغير واحد. ثم  (2بالسهم رقم )
(، فتظهر نافذة جديدة كما هو في Defineأمر تعريف )

 (.36.3الشكل )

(، ثم قم باختيار متغير Variableالمتغير عمر الطالب في الخانة الأولى العليا ) قم في تلك النافذة باختيار
(، ثم اختر متغير التصنيف الثاني Category Axisالخانة الثانية ) التصنيف الأول وهو متغير جنس الطالب في

فيظهر شكل  ثم اضغط موافق (،Define Clusters by)وهو عدد الحجرات في منزل الطالب في الخانة الثالثة 
)في المحور الأفقي( وبحسب عدد حجرات المنزل )مقسما للذكور  جنس الطالب كلا من الصندوق المصنف بحسب

 (.37.3في نافذة المخرجات، كما يوضح الشكل ) اث كل على حده(وللإن

 

: نافذة خيارات شكل الصندوق مع  اختيار رسم 35.3شكل 
 الصندوق المصنف.
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 : نافذة تحديد المتغيرات لشكل الصندوق، )لمتغير واحد مصنف بحسب متغيرين(.36.3شكل 

الطلبة الذكور في كما أنه يمكن القول بأن  ارتفاع أعمار الطلبة الذكور في العينة في العموم، ونلاحظ من الشكل
قطن في منازل ييقطنون في منازل أعداد حجراتها تتراوح ما بين حجرتين وأربعة حجرات، وأما الطالبات فالغالب 

 .على الأكثر ستة حجرات وأخمسة  وأعدد حجراتها هو ثلاثة 

 
 ."الطلبةبيانات لعمر الطالب مصنفا بحسب النوع وعدد حجرات المنزل للطالب للمتغيرات في الملف ": شكل الصندوق 37.3شكل 
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 (Line or Time Chart)مخطط الزمن الرسم الخطي أو  3.4.3

وهو نوع من الرسومات البيانية التي تهدف إلى توضيح التغير في مفردات البيانات خلال فترة زمنية 
 الإنتاجية ...، أو حتى مواسم(. ويستخدم هذا النوع من الرسومات في الكثير من المجالاتأشهرمعينة )سنوات، 

أبرزها عرض التقارير الاقتصادية والصناعية. والتمثيل البياني لمخطط الزمن يتم برصد نقطة لكل قيمة من قيم 
ولتوضيح كيفية تنفيذ هذا النوع من  المتغير مقابل كل وحدة زمنية ثم توصيل هذه النقاط بخطوط مستقيمة.

 الرسومات، لنأخذ المثال التالي؛

 تم ،في بناء جدران المنشئات العسكريةقوة تحمل خليط من المعادن المستخدمة  رباختبا إجراء دراسة تتعلق أثناء
مع زيادة درجة الحرارة المحيطة  خلال ثمانية أشهر متتالية مرات 8عمل نموذج أولي وتم اختباره في البداية 

رة المستخدمة مع إضافة معدن جديد للخليط وا عادة الاختبار تحت نفس درجات الحراتم بعد ذلك بالتدريج. ثم 
 المرفق )جدول الخليط الأول فكانت النتائج، )والتي تمثل مقاومة الخليط بالكيلوجرام(، كما هو موضح في الجدول

 (؛(5.3)

 خلال فترة ثمانية أشهر. : نتائج مقاومة خليط المعادن قبل وبعد إضافة المعدن الجديد5.3جدول 

 أغسطس يوليو يونيو مايو ابريل مارس فبراير يناير الشهر

 13.1 12.6 13.2 13.6 12.3 13.4 12.9 12.6 )المقاومة قبل الإضافة(

 13.1 13.5 13.6 14.2 13.9 13.3 13.7 12.9 )المقاومة بعد الإضافة(

مخطط الزمن لتمثيل التغير في مقاومة خليط المعدن قبل الإضافة خلال الأشهر المتلاحقة. وسنقوم باستخدام 
، وليكن باسم SPSS(( في ملف بيانات جديد في 5.3وستكون الخطوة الأولى هي إدخال البيانات )في جدول )

 (.38.3كما يظهر في الشكل ) "مقاومة المعدن"

 
 : ملف بيانات "مقاومة المعدن".38.3شكل 
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 ، فتظهر نافذةGraphs>Legacy Dialogs>Lineباختيار بعد إدخال البيانات، قم في شمممممريط الأدوات العلوي 
(. قم باختيار 39.3الرسمممممم الخطي كما هو في الشمممممكل ) خيارات

( والمشمممممممار إليه Simpleتنفيذ شمممممممكل الرسمممممممم الخطي البسممممممميط )
(، ثم قم بتحمممديمممد الخيمممار الخممماص بتمثيمممل قيم 1بمممالسممممممممممممممهم رقم )

( والمشمممممار إليه Values of individual casesاهدات )المشممممم
 (.2بالسهم رقم )

فتظهر نافذة تعريف ( Defineاضممممممممممممغط بعد ذلك على تعريف )
((، في تلك 40.3المتغيرات الخاصة بالرسم المطلوب، )الشكل )

النافذة سممممممممممممنقوم باختيار المتغير )المقاومة قبل الإضممممممممممممافة( في 
(، Line Represents) مثمممل: الخط يالأول في الأعلى المربع

( نختار خيار Category Labels) المربعومن أسممممممممممممممفل ذلك 
 في الشممريط أدناه "الشممهر"(، ثم نختار متغير Variableمتغير )

 ((.41.3فنحصل على الشكل البياني المطلوب، )شكل )

 
 : نافذة تحديد المتغيرات للرسم الخطي لمتغير واحد.40.3شكل 

 
 : نافذة خيارات الرسم الخطي.39.3شكل 
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وجود تذبذب في ارتفاع وانخفاض مقاومة المعدن  (، نلاحظ41.3مخطط الزمن في الشكل )من الرسم الخطي أو 
ارتفاع مقاومة المعدن من تجارب شهر يناير حتى شهر مارس ثم  قبل الإضافة خلال الأشهر المتتالية، فنلاحظ

 انخفاض مقاومة المعدن في شهر ابريل ثم ارتفاعها في مايو وهكذا.

 
 في ملف "مقاومة المعدن". المقاومة_قبل_الإضافة: الرسم الخطي لمتغير 41.3شكل 

يمكننا ، الحالي، ففي المثال )أو أكثر( ويمكن أيضا استخدام الرسم الخطي لمقارنة التغير عبر الزمن بين متغيرين
ت العلوي باختيار في شريط الأدوانقوم مقارنة مقاومة المعدن قبل وبعد إضافة المعدن الجديد. ولتنفيذ ذلك، 

Graphs>Legacy Dialogs>Line( 39.3، فتظهر نافذة خيارات الرسم الخطي كما هو في الشكل) السابق. 

م بتحديد الخيار و قن(، ثم 3( والمشار إليه بالسهم رقم )Multiple) لمتعددباختيار تنفيذ شكل الرسم الخطي ا نقوم
( فتظهر Defineضغط بعد ذلك على تعريف )ن (.2)الخاص بتمثيل قيم المشاهدات والمشار إليه بالسهم رقم 

 السابق. (40.3الشكل ) كما هو موضح في نافذة تعريف المتغيرات الخاصة بالرسم المطلوب

 الإضافة( في الشريط بعد)المقاومة و )المقاومة قبل الإضافة( ينالمتغير  كلا من في تلك النافذة نقوم باختيار
( نختار خيار متغير Category Labels(، ومن أسفل ذلك الشريط )Line Representsالأول في الأعلى )

(Variable ثم نختار متغير ،)"((.42.3، )شكل )الرسم الخطي المتعددفي الشريط أدناه فنحصل على  "الشهر 
 .الثمانية عبر الأشهر إضافة المعدن الجديد قد أدى إلى زيادة مقاومة الخليط بصورة عامةوي لاحظ من الرسم أن 
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 في ملف "مقاومة المعدن". المقاومة_قبل_الإضافة و المقاومة_قبل_الإضافة: الرسم الخطي لمتغيري 42.3شكل 

 

 (Normality of Variables)طبيعية توزيع المتغيرات  4.4.3

، ومن الكمية تعرفنا فيما سبق على استخدام المدرج التكراري وشكل الصندوق لاستكشاف توزيع المتغيرات
لمتغير ما إذا كان طبيعيا أم لا. إلا أن كثير ل الاحتمالي توزيعالضمن استخدامات هذين التمثيلين التعرف على 

للتحقق من توزع المتغير طبيعيا وهو  1الرسم البيانيضمن طرق فضلون استخدام أسلوب آخر من المتخصصين ي
( حيث يمثل الأول رسم الربيعات والثاني Q-Q and P-P Normal Probability Plot، )P-Pو Q-Qرسم 

 . ولتوضيع الصورة لنأخذ المثال التالي؛التوزيع الطبيعيفي  مطابقتها بقريناتهارسم المئينات للمتغير و 

طبيعيا. من  للمقارنة بين مدى توزع المتغيرات الثلاثة Q-Q، سنقوم بتطبيق رسم بة"يانات الطل"ب في ملف البيانات
نافذة عندها فتظهر ، Analyze>Descriptive Statistics>Q-Q Plotsلوي قم باختيار شريط الأدوات الع

( يمكنك Test Distribution(. في القسم العلوي الأيمن من النافذة )43.3كما هو مبين في الشكل ) Q-Qرسم 
الحالي نرغب  له، وفي مثالنا Q-Qملاحظة وجود الخيار الخاص باختيار التوزيع الاحتمالي الذي ترغب برسم 

 .، والذي يمثل الخيار الافتراضي للرسملبعض المتغيرات ومقارنتها بالتوزيع الطبيعي Q-Qبرسم 

 

                                                 
يمكن الإجماع على أن أفضل الأساليب الإحصائية للتأكد من التوزيع الاحتمالي للمتغيرات، ومن ضمنها التوزيع الطبيعي، هي اختبارات  1

 نتطرق للاختبارات الخاصة بالتوزيع الطبيعي في الفقرة القادمة. الفروض. وسوف
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 ."بيانات الطلبة"لملف البيانات  Q-Q: نافذة رسم 43.3شكل 

ررات، ونقلها إلى خانة المتغيرات، وبعدها سنقوم باختيار المتغيرات الثلاثة الأولى، وهي درجات الطلبة في ثلاثة مق
لكل  Q-Qنضغط موافق فنحصل على عدة نتائج من أهمها المتوسط والانحراف المعياري للمتغيرات إضافة لرسم 

 ( التالي الرسومات للمتغيرات جنبا إلى جنب لتسهيل المقارنة.44.3متغير. وسنعرض في الشكل )

   

 ".بيانات الطلبةلدرجات الطلبة في المقررات الثلاثة في الملف " Q-Q: رسم 44.3شكل 

يتم التدقيق في مدى اقتراب النقاط، )والتي تمثل المشاهدات للمتغير(، من الخط القطري  P-Pأو  Q-Qفي رسم 
من الخط  المرسوم، )والذي يمثل توزيع النقاط الافتراضي للتوزيع الطبيعي(، وبالتالي كلما اقتربت نقاط المتغير

درجات ( يمكننا القول بأن 44.3من الشكل )و  القطري كلما دل ذلك على اقتراب توزيع المتغير من التوزيع الطبيعي.
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هي الأكثر اقترابا من التوزيع الطبيعي مقارنة بدرجات الطلبة في المقررين الآخرين، ونلاحظ  1الطلبة في المقرر
(، عن التوزيع الطبيعي بصورة كبيرة. إلا أنه، وكما ذكرنا 3بة في المقررأيضا ابتعاد المتغير الثالث، )درجات الطل

سابقا، يكون من المفضل إحصائيا اختبار توزيع المتغيرات طبيعيا باستخدام اختبارات الفروض وعدم الاعتماد كليا 
 .في الفقرة التاليةكما سنرى  على الرسم البياني

 SPSS (Using the Explore command in SPSS)امل في استخدام أسلوب استكشاف البيانات الش 5.3

لاحظنا في الأمثلة السابقة كيفية استخدام المقاييس الإحصائية الوصفية والرسومات البيانية عن طريق 
الموجودة تحت قائمة ( Descriptives) ( والإحصاءات الوصفيةFrequenciesالتكرارات ) اختيار أوامر

(Analyze>Descriptive Statistics) بكيفية ف القارئ . والآن سنعرّ شريط الأوامر العلوي في البرنامج في 
( Explore) استكشافعن طريق استخدام أمر  أشملأعم و متغيرات الدراسة بصورة  سلوكاستكشاف توزيع أو 

 الموجود ضمن نفس القائمة السابقة.

مكونة عينة يضم بيانات تمثل والذي (، 6.3جدول ) الجدول التالي،وكمثال تطبيقي لاستكشاف البيانات، سنستخدم 
عن المدة الزمنية المعتادة، وهي ثمانية فصول  القدامى، )الذين تأخر تخرجهم طلبةالمن معظمهم طالبا  90من 

، (MA) كلية العلوم بجامعة بنغازي مقسمة بحسب التخصص أو القسم العلمي، )رياضيات (، فيتقريبا دراسية
جنس الطالب،  ،درجة( 4.00إلى  0.00، )على مقياس من (، وتشمل معدل الطالب(PH) وفيزياء، (ST) إحصاء

 وعدد الفصول الدراسية التي أنجزها الطالب.

 طالبا من طلبة كلية العلوم في جامعة بنغازي. 90معدلات عينة من : 6.3جدول 
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1 MA M 1.96 20 31 ST F 1.60 12 61 PH F 1.75 23 
2 MA M 1.57 18 32 ST M 1.51 14 62 PH F 1.67 19 
3 MA F 1.48 16 33 ST F 1.98 14 63 PH F 1.58 21 
4 MA F 1.58 21 34 ST M 2.18 18 64 PH F 1.41 21 
5 MA F 1.80 18 35 ST F 1.64 18 65 PH F 1.61 20 
6 MA F 1.26 15 36 ST F 1.68 16 66 PH M 1.53 20 
7 MA F 1.69 16 37 ST F 1.90 17 67 PH F 1.68 17 
8 MA M 1.26 14 38 ST F 1.54 18 68 PH F 1.46 19 
9 MA F 1.60 12 39 ST M 1.56 13 69 PH F 1.26 20 
10 MA F 1.89 13 40 ST F 1.56 13 70 PH F 1.62 19 
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 طالبا من طلبة كلية العلوم في جامعة بنغازي. 90: معدلات عينة من 6.3جدول )تابع( 
11 MA F 1.48 12 41 ST F 1.88 13 71 PH F 1.57 18 
12 MA F 2.25 11 42 ST F 1.16 13 72 PH F 2.09 13 
13 MA M 1.63 11 43 ST F 1.74 12 73 PH F 1.57 19 
14 MA F 1.50 11 44 ST F 1.15 12 74 PH F 1.45 19 
15 MA F 1.78 11 45 ST F 1.25 13 75 PH F 1.67 18 
16 MA F 1.84 11 46 ST M 1.55 13 76 PH F 1.78 18 
17 MA M 2.40 11 47 ST M 1.45 13 77 PH F 1.68 18 
18 MA M 2.09 11 48 ST M 1.75 13 78 PH F 1.53 17 
19 MA F 1.74 11 49 ST F 2.01 13 79 PH M 1.66 16 
20 MA F 1.52 9 50 ST M 1.40 13 80 PH F 1.66 16 
21 MA M 1.79 9 51 ST M 1.63 13 81 PH F 1.84 12 
22 MA F 3.15 8 52 ST F 1.87 12 82 PH F 1.79 16 
23 MA F 1.95 2 53 ST M 1.78 5 83 PH F 1.63 16 
24 MA F 3.39 7 54 ST M 1.58 12 84 PH F 1.73 16 
25 MA F 1.87 7 55 ST F 1.88 11 85 PH F 1.60 16 
26 MA F 3.18 8 56 ST F 1.73 11 86 PH F 1.75 16 
27 MA F 3.67 8 57 ST M 1.36 10 87 PH F 1.75 16 
28 MA F 1.49 8 58 ST F 1.97 11 88 PH F 1.81 16 
29 MA F 3.41 8 59 ST F 1.47 11 89 PH M 2.13 10 
30 MA F 1.86 7 60 ST M 1.63 11 90 PH M 2.31 12 

 3، و2، 1وحفظه باسم "معدلات الطلبة"، )مستخدما القيم  SPSSم بإدخال البيانات في ملف جديد في برنامج ق
بعد ذلك قم  لترميز الذكور والإناث على الترتيب(، 2و 1على الترتيب، والقيم  PH، وMA ،STلترميز الأقسام 

، وستظهر لك نافذة جديدة Analyze>Descriptive Statistics>Exploreمن شريط الأدوات العلوي باختيار 
 (.45.3كما يوضح الشكل )

 
 ."معدلات الطلبة"ملف لل (Exploreاستكشاف البيانات ) : نافذة45.3شكل 
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 أي (،مثل معدل الطالب والفصل الدراسي، )استكشافهافي هذه النافذة، يمكنك اختيار المتغيرات التي ترغب في 
حساب المقاييس الإحصائية والرسومات البيانية الأساسية لها عن طريق اختيارها ونقلها إلى مربع القائمة  يمكنك

( لاختيار النتائج Statistics(، بعد ذلك يمكنك الضغط على خيار الإحصاءات )Dependent List)الأساسية 
( Both( لاختيار الرسومات البيانية المطلوبة، مع ملاحظة ترك خيار الاثنين )Plotsم خيار الرسومات )المطلوبة ث

 في أسفل النافذة كما هو.

، وسنقوم باستخدام أمر في هذا المثال، سنترك للقارئ استكشاف بيانات الطلبة باستخدام الخطوات السابقة
سمة أو مصنفة بحسب تخصص الطالب )القسم العلمي( ( عن طريق عرض النتائج مقExploreالاستكشاف )

 بين الأقسام. معدلات الطلبة القدامى وذلك لغرض مقارنة

 Dependentإلى مربع القائمة ) ونقله (Exploreفي نافذة ) "معدل الطالب" قم باختيار المتغيرمن جديد، 

List ،)بعد ذلك قم باختيار متغير التصنيف "القسم العلمي" ونقله إلى ( مربع قائمة التصنيفFactor List .)
 (؛46.3( فتظهر نافذة فرعية كما يظهر في الشكل )Statisticsالآن قم بالضغط على خيار الإحصاءات )

ستلاحظ في تلك النافذة اختيار مسبق لأمر "وصفي" 
(Descriptive ) والذي سنتركه كما هو، وتلاحظ

أسفل منه وجود مربع خيار نسبة الثقة لفترة الثقة للوسط 
 Confidence Interval forالحسابي للمجتمع )

Mean% والتي سنتركها  95( وهي النسبة الافتراضية
قم بالنقر على المربع المقابل لخيار أيضا كما هي. 

مقاييس ( والذي يوفر بعض الPercentilesالمئينات )
الهامة لتوزيع المتغير كما سنوضح تاليا، ولاحظ أنه 
يمكنك أيضا اختيار إظهار أبرز القيم المتطرفة للمتغير 

التعرض له في البند قوم بوهو ما سن(، Outliersفي جدول خاص إذا ما قمت بالنقر على الخيار الخاص بها )
الآن اضغط استمرار  على أسلوب آخر لاكتشاف القيم المتطرفة كما سنرى.هنا سنعتمد و  الأخير من هذا الفصل،

(Continue( في هذه النافذة، وستعود للنافذة السابقة، في الشكل )قم بعدها بالضغط على خيار الرس45.3 ،)م 
(Plot( وستظهر نافذة جديدة كما هو موضح في الشكل التالي، شكل )؛47.3) 

 

ضمن نافذة الاستكشاف خيار الإحصاءات : نافذة 46.3شكل 
(Explore.) 
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عرض المدرج  المربع الأيمن من النافذة سنقوم باختيارفي  
( إضافة لخيار عرض رسم الساق Histogramالتكراري )
وسنقوم أيضا باختيار عرض . (Stem and leafوالورقة )

 Normality plotsرسومات واختبارات التوزيع الطبيعي )

with Testثم نضغط استمرار بعد ( في الخانة التي تليها ،
ط فيها ذلك فنرجع لنافذة الاستكشاف السابقة والتي سنضغ

على موافق ليتم تنفيذ كل ما تم اختياره في النوافذ الفرعية؛ 
 نافذة الإحصاءات ونافذة الرسم.

والتي نقترح تخزينها في ملف مخرجات  في نافذة المخرجات،
رسومات البيانية والتي سنفرد ستلاحظ ظهور عدد كبير من الجداول وال خاص باسم "استكشاف معدلات الطلبة"،

 للتعليق عليها. قادمال البند

 (Interpreting the Results of Data Exploration)استكشاف البيانات  تفسير نتائج 6.3

بصورة أحادية، )أي حساب المقاييس ستكشاف البيانات أو المتغيرات طرق متعددة لا فيما سبقتناولنا  
سنستعرض كيفية تفسير أهم النتائج الخاصة  ناوهالإحصائية واستخدام التمثيل البياني لكل متغير على حده(، 

 .باستكشاف المتغيرات الأحادية، وأيضا الاستكشاف المتضمن للتصنيف بحسب متغير وصفي

السابقة لهذا البند، تناولنا المثال الخاص بمعدلات الطلبة القدامى، )ملف "معدلات الطلبة"(، وتم  اتفي الفقر 
( وتعريف المتغير Analyze>Descriptive Statisticsقائمة ) ( ضمنExploreاستخدام أمر استكشاف )

"معدل الطالب" كمتغير كمي نرغب باستكشاف طبيعته وتوزيعه، ومتغير "القسم العلمي" كمتغير وصفي ي ستخدم 
(، وقد اقترحنا PH(، وفيزياء )ST(، إحصاء )MA؛ رياضيات )لتصنيف معدلات الطلبة بناء على التخصص

 باسم "استكشاف معدلات الطلبة".  تخزين المخرجات

 في نافذة المخرجات هذه، سيكون عرض النتائج بالصورة التالية؛

 Case) ملخص معالجة المشاهدات الجدول الأول، الذي هو بعنوانالبداية تكون عادة بجداول النتائج، و  .1

Processing Summary مشاهدة لكل  30(، يتم فيه عرض عدد ونسب المشاهدات في كل قسم، ونلاحظ أنها
 مشاهدة كلية ولا توجد قيم مفقودة. 90بمجموع قسم 

(، المقاييس الإحصائية لمتغير Descriptives) الإحصاءات الوصفية بعنوانوهو يضم الجدول الثاني،  .2
بحيث يضم الجزء الأول من الجدول  سم العلمي للطالب"معدلات الطلبة" مقسمة بحسب التخصص أي بحسب الق

 

 نافذة الاستكشاف. ضمن الرسمخيار : نافذة 47.3شكل 



 

89 

 

(، والجزء الثالث نتائج طلبة قسم PH(، والجزء الثاني نتائج طلبة قسم الفيزياء )MAنتائج طلبة قسم الرياضيات )
 .STثم  PHثم  MA(، وهذا الترتيب في عرض النتائج هو بحسب الأبجدية الإنجليزية للتقسيمات STالإحصاء )

 لمقاييس يمكننا استكشاف التالي:من هذه ا

 ( من قيم الوسط الحسابيMean للطلبة في الأقسام يمكن القول بأن ) مستوى طلبة قسم الرياضيات هو
ولاحظ أن القيمة على يمين الوسط الحسابي هي الخطأ المعياري له  .مين الآخرينأعلى من القس

(𝑆𝐸(�̅�𝑀𝐴).) 

  تقدير الوسط الحسابي لمجتمع بناء على ارتفاع قيمة الوسط الحسابي لمعدل طلبة قسم الرياضيات، فإن
، MAμ < 1.75 > 2.25، معدلات طلبة قسم الرياضيات يتراوح في فترة ثقة أكبر من القسمين الآخرين

ن حدي الفترة ستتراوح في العموم بيبأن معدلات طلبة قسم الرياضيات  95أي أننا واثقون بنسبة %
السابقين. أما بالنسبة لمعدلات طلبة قسمي الفيزياء والإحصاء فإن تقدير متوسطاتها في العموم سيتراوح 

 تقريبا على التوالي. STμ < 1.55 > 1.74و PHμ < 1.61 > 1.76في مجال أضيق، وهو 

 ( بمقارنة قيم الوسيطMedian،بقيم الوسط الحسابي لمعدلات الطلبة في كل قسم )  معدلات أن نلاحظ
�̅�𝑀𝐴 بشكل ملاحظ، الطلبة في قسم الرياضيات تحتوي على قيم متطرفة عليا = 2.00 > �̃�𝑀𝐴 = 1.79 

 .من بعضها البعض أما في قسمي الفيزياء والإحصاء فقيم الوسيط والوسط الحسابي متقاربة
 ( بالنظر لقيم الانحراف المعياريStd. Deviation )( وقيم المدىRange ) ،لمعدلات الطلبة في الأقسام

MAS.D  =أو تشتتا، ) طلبة قسم الرياضيات الدراسية هي الأكثر اختلافا معدلاتبأن نستطيع القول 

0.67 ،= 2.41 MARange.وبالنظر إلى المدى الربيعي  (، مقارنة بطلبة قسمي الفيزياء والإحصاء
(Interquartile Range فيمكن ملاحظة أن ) ويؤيد  .الإحصاء هي الأكثر تجانسامعدلات طلبة قسم

 ( لمعدلات الطلبة في كل قسم.Minimum and Maximumهذه الملاحظة القيم الصغرى والكبرى )

 ( قيم الالتواءSkewness تشير إلى وجود ) التواء حاد إلى اليمين في توزيع معدلات طلبة قسم الرياضيات
بالنسبة لتوزيع معدلات قسم الإحصاء فيوجد التواء طفيف جدا ، أما يليه قسم الفيزياء لكن بالتواء أقل حده

 إلى اليسار.

( والتي تعتبر Quartiles( يضم مقاييس المئينات والربيعات )Percentiles) المئينات الجدول الثالث بعنوان .3
لأول أيضا( للأقسام العلمية الربيع ا) 25القيم للمئين من المقاييس الهامة في اكتشاف توزيع المتغيرات. فمثلا؛ 

للفيزياء،  1.57للرياضيات،  1.55تقريبا ) 1.57من معدلات الطلبة هي أقل من المعدل  25الثلاثة ت ظهر بأن %
 .في الأقسام الثلاثة مقبول فأقل مستواهمربع الطلبة للإحصاء(، وهذا يعني أن  1.50و
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من طلبة قسمي الفيزياء والإحصاء معدلاتهم  75%الربيع الثالث(، فإن  )وهي أيضا قيمة 75أما بالنسبة لقيم المئين 
من الطلبة  25على التوالي(، وأما بالنسبة لقسم الرياضيات فإن % 1.87و 1.75، )مقبول فأقل الدراسية هي

، هو أفضل أي بتقدير جيد، وهذا في المجمل يعني بأن مستوى طلبة قسم الرياضيات 2.13معدلاتهم هي أكبر من 
 .ويمكن التعمق في هذا الاستنتاج من خلال مراقبة قيم المئينات الأخرى في الجدول

 Test ofالجدول التالي في ترتيب النتائج هو الجدول الخاص باختبار التوزيع الطبيعي، وهو بعنوان ) .4

Normality .) ويلك-شابيرووهو يضم اختبارين شهيرين هما اختبار (Shapiro-Wilk Test)  واختبار
ويقوم باختبار الفرضية الصفرية التي (، وكلاهما Kolmogorov-Smirnov Test) سميرنوف-كولموجوروف

 .(0H:العينة مسحوبة من مجتمع طبيعي تقضي بتبعية توزيع المتغير أو العينة بتوزيع طبيعي؛ )

(. .Sig(، والقيمة الاحتمالية )dfية )(، ودرجة الحر Statisticنشاهد قيمة إحصاءة الاختبار )وفي جدول النتائج 
 أقل منهي  (P-value) إذا كانت القيمة الاحتماليةوحيث أن قاعدة قبول أو رفض الفرضية الصفرية هي )

-واختبار كولموجوروف ويلك-شابيروفإنه يمكن القول من اختباري ، 1(نرفض الفرضية الصفرية 0.05 القيمة
معدلات طلبة قسم الإحصاء تتبع التوزيع الطبيعي، ومعدلات طلبة قسم الفيزياء تتأرجح بين الطبيعية أن  سميرنوف
(، أما معدلات طلبة قسم الرياضيات فإنها ويلك-شابيرو( وغير الطبيعية )اختبار سميرنوف-كولموجوروف)اختبار 

 لا تتوزع بتوزيع طبيعي بإجماع الاختبارين.

المدرجات التكرارية لمتغير الدراسة بحسب القسم وأولها يلي الجداول في ملف المخرجات الرسومات البيانية،  .5
نلاحظ أن المدرج  العلمي، وبمقارنة المدرجات التكرارية الثلاثة

الخاص بمعدلات قسم الإحصاء هو الأقرب لتشكيل الشكل الناقوسي 
((، مع 48.3الشهير لمنحنى التوزيع الطبيعي، )شكل )المتماثل 

 وجود التواء طفيف إلى اليسار. 

ومدرج معدلات قسم الفيزياء يوجد به التواء ظاهر إلى اليمين مع 
اقترابه إلى حد ما من التوزيع الطبيعي، أما المدرج التكراري الخاص بمعدلات قسم الرياضيات فهو أبعد ما يكون 

اما مع ما مع وجود التواء كبير إلى اليمين في توزيع المشاهدات. وهذه النتائج متوافقة تمعن التوزيع الطبيعي 
 (.49.3ويمكن متابعة هذه الملاحظات من خلال الشكل ) سبق.

                                                 
 هي احتمال الوقوع في خطأ من النوع الأول، )رفض الفرضية الصفرية وهي صحيحة(. 0.05حيث أن  1

 

 .المعياري  التوزيع الطبيعي: منحنى 48.3شكل 
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في على الترتيب من اليمين إلى اليسار  م الرياضيات، الفيزياء، والإحصاء،: المدرجات التكرارية للمعدلات في أقسا49.3شكل 

 ".استكشاف معدلات الطلبةالمخرجات " ملف

. وهذه ةعلميالم اقس( للأStem-and-Leaf Plots) رسومات الساق والورقةالرسومات التالية في الترتيب هي . 6
في المتغيرات التي  في التعرف على توزيع المتغيرات، وبالذات التوزيع الطبيعيجيدة الرسومات هي وسيلة بصرية 
وفكرة رسم الساق والورقة هي بسيطة بحد ذاتها، إذ يمثل العامود الأول إلى اليسار  .تضم مشاهدات قليلة نسبيا

والثالث الذي يمثل "الأوراق" هما تكرارات قيم المشاهدات للمتغير، والعامود الثاني )الأوسط( الذي يمثل "الساق" 
يضم كل صف القيم القريبة من بحيث القيم الفعلية للمشاهدات موزعة تصاعديا، )من أعلى الرسم إلى الأسفل(، 

 بعضها البعض.

 :ملاحظة
يمثل خانة القيمة الصحيحة للمعدل بينما تمثل الأوراق القيمة الأولى بعد  قد في مثالنا الحالي، نجد أن الساق

)كما هو الحال في رسمي قسم الرياضيات والإحصاء(، أو قد يمثل الساق خانة القيمة  الفاصلة العشرية،
فمثلا؛ في  (.كما نلاحظ في رسم قسم الفيزياءالصحيحة للمعدل مع القيمة الأولى بعد الفاصلة العشرية، )

 :الشكلالرسم الأول الخاص بقسم الرياضيات نجد في الصف الأول تحت عامودي الساق والورقة 
 :تحت عامود التكرار، وهذا يتم قراءته كالتالي 2والقيمة    1  .  22 

ضمن  1.26و 1.26تين القيمتين هما فعليا اوه) ،1.2توجد مشاهدتان )معدلان( كلاهما يبدأ بالقيمة 
 ، وهكذا الأمر بالنسبة لباقي الصفوف في الرسم.2، ولهذا تكون قيمة التكرار (المشاهدات

رسم الساق والورقة يعكس توزيعا طبيعيا للمتغير، يمكنك اعتبار القيم في صفوف الساق ولملاحظة ما إذا كان 
والورقة بمثابة الأعمدة في المدرج التكراري، فبالنظر إلى رسم الساق والورقة لقسم الإحصاء يمكنك ملاحظة امتداد 

توزيع الذي يمثله منحنى التوزيع يشبه الالقيم في الصفوف الوسطى وانحسارها في الصفوف العليا والسفلى، وهذا 
 توضح قيمالطبيعي ولكن بصورة مقلوبة. والميزة الأساسية في رسم الساق والورقة عن باقي الرسومات أنها 
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، واضحة. وهكذا يمكننا من خلال الرسومات الثلاثة للساق والورقة المشاهدات وتراكمها )تكرارها( بصورة فعلية
توزيع معدلات طلبة قسم الإحصاء من التوزيع الطبيعي بصورة أكبر من توزيع ملاحظة اقتراب  ((،50.3)شكل )

المعدلات في قسم الفيزياء، أما قسم الرياضيات فمعدلات طلبته تبتعد عن التوزيع الطبيعي كل البعد، وهذه النتائج 
 .ت التكراريةرجاوالمد قها من نتائج اختبارات الفروضبلما سمؤيدة 

   

في على الترتيب من اليمين إلى اليسار : شكل الساق والورقة للمعدلات في أقسام الرياضيات، الفيزياء، والإحصاء، 50.3شكل 
 ."استكشاف معدلات الطلبةملف المخرجات "

في المتغير، فنلاحظ  التعرف على القيم المتطرفةيشكل أداة فعالة في إضافة إلى ما سبق، فإن رسم الساق والورقة 
في قسم الرياضيات وجود خمسة معدلات متطرفة عليا عند النظر للصف الأخير في الرسم حيث نرى بأن التكرار 

( والتي تدل على وجود قيم متطرفة وهي المعدلات التي هي أكبر Extremes (>=3.2)، وظهور عبارة )5يساوي 
(، 1.26)وهي  صغرى  متطرفة ةود قيم. وكذلك الأمر بالنسبة لقسم الفيزياء، حيث نرى وج3.2من أو تساوي 

أما بالنسبة لمعدلات طلبة قسم الإحصاء فلا ي ظهر  .2.09وثلاثة قيم متطرفة عليا هي أكبر من أو تساوي المعدل 
 الرسم أية قيم متطرفة.

الخاص بمعدلات  Q-Qوالذي تعرضنا له سابقا، ونلاحظ أن رسم  ((،51.3)شكل ) ،Q-Qننتقل الآن لرسم  .7
طلبة قسم الإحصاء هو الأقرب للتوزيع الطبيعي، أما النقاط على الشكل الخاص بقسم الفيزياء فتبتعد عن الخط 
المستقيم في القيم العليا، أما القيم في رسم معدلات قسم الرياضيات فتبتعد في المجمل عن الخط المستقيم، مما 

القسم عن التوزيع الطبيعي. وهذه النتائج تدور في نفس فلك التعليقات يدل على ابتعاد توزيع المشاهدات في هذا 
 السابقة للأقسام العلمية الثلاثة.
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 ."استكشاف معدلات الطلبةملف المخرجات "في للمعدلات في أقسام الرياضيات، الفيزياء، والإحصاء،  Q-Q: رسم 51.3شكل 

، فإنه يظهر عادة مرافقا لرسم آخر هو "نمط انتشار نقاط رسم SPSSفي برنامج  Q-Qعندما يتم طلب رسم  .8
Q-Q( "Detrended Normal Q-Q Plot .) وهذا الرسم يمثل انتشار نقاط المشاهدات الفعلية مع قيمها المعيارية

(Z Scores فالمتغير الذي يتبع توزيعه توزيعا طبيعيا تكون النقاط فيه .) متجمعة أكثر ما يمكن حول الخط
)عند القيمة صفر على المحور الصادي(، مما يعني اقتراب معظم قيم هذا المتغير من المركز،  المستقيم الأفقي

 وبالتالي الاقتراب من التوزيع الطبيعي.

الرسم الخاص بقسم الإحصاء، مما  ل الخط الأفقي فيو حالنقاط  تجمع (،52.3، من شكل )وفي مثالنا، نلاحظ
ي هذا القسم من التوزيع الطبيعي. وفي الرسم الخاص بقسم الفيزياء، يدل على اقتراب توزيع معدلات الطلبة ف

نلاحظ تجمع الكثير من النقاط حول الخط المستقيم وكذلك ابتعاد القيم العليا عنه مما يضع معدلات هذا القسم 
التوزيع  موضع الشك في مدى اقترابها من التوزيع الطبيعي. أما معدلات طلبة قسم الرياضيات فهي بعيدة جدا عن

 الطبيعي وهذا ما يعكسه ابتعاد معظم النقاط عن الخط المستقيم على الرسم.

   

على الترتيب من اليمين إلى  للمعدلات في أقسام الرياضيات، الفيزياء، والإحصاء، Q-Qنمط انتشار نقاط : رسم 52.3شكل 
 ."استكشاف معدلات الطلبةملف المخرجات "في  اليسار



94 

 

، )شكل (، تم عرضه لكل قسم علمي في شكل واحدBoxplotالأخير في مثلنا، وهو شكل الصندوق )الرسم  .9
 لتسهيل المقارنة بين توزيع المعدلات للأقسام. ((،53.3)

 

ملف في  على الترتيب من اليسار إلى اليمين، : شكل الصندوق للمعدلات في أقسام الرياضيات، الفيزياء، والإحصاء،53.3شكل 
 ."استكشاف معدلات الطلبةجات "المخر 

 ، من أهمها؛الحصول على عدة استنتاجات من شكل الصندوق ويمكن 

 يمكن ملاحظة 1بالنظر إلى "طول" الصندوق المظلل لكل قسم، والذي يمثل توزيع أو انتشار المشاهدات ،
، وهذا يدل على الاختلاف الكبير انتشار البيانات )معدلات الطلبة( في قسم الرياضيات هو الأكبرأن 

تجانس المستوى في المستوى الدراسي للطلبة القدامى في هذا القسم، وعلى النقيض يمكن ملاحظة 
، )نظرا "لانكماش" حجم الصندوق الخاص به(. أما الدراسي للطلبة القدامى في قسم الفيزياء إلى حد كبير

قد تم الوصول في المستوى الدراسي. وهذه الاستنتاجات  بالنسبة لقسم الإحصاء، فهنالك تجانس إلى حد ما
لها سابقا بطريقة رقمية من خلال حساب مقاييس التشتت لكل قسم علمي، )مثل الانحراف المعياري 

 والمدى وغيرها(.

  الخط الأفقي داخل كل صندوق مظلل، والذي يمثل قيمة الوسيط للمشاهدات لكل قسم، إضافة لارتفاع
 مقارنة بباقي الأقسام. معدلات الطلبة في قسم الرياضيات هي الأعلىالصندوق المظلل ككل، ي ظهر أن 

                                                 
للمشاهدات  إضافة لطول الأطراف، وهي الخطوط الخارجة من طرفي الصندوق المظلل لأعلى وأسفل، والتي تمثل القيم العليا والصغرى  1

 ضمن سياق القيم المعتدلة، أي باستثناء القيم المتطرفة.
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 الأرقام تمثل ترتيب  النقاط المرقمة أعلى و/أو أسفل الصندوق تمثل القيم المتطرفة في المشاهدات، وهذه
هذه القيم في المتغير. ويمكن بوضوح رؤية أن قسم الرياضيات يحتوي على خمسة قيم متطرفة عليا، 

وأما معدلات الطلبة (. في ذلك القسم 3.67)أكبرها هي القيم السابعة والعشرون في المتغير، وهو المعدل 
في ذلك  2.31 القيمة التسعون، وهو المعدل في قسم الفيزياء، فتضم ثلاثة قيم متطرفة عليا، )أكبرها

في ذلك القسم(. وأما قسم  1.26وقيمة متطرفة صغرى، )القيمة التاسعة والستين، وهو المعدل (، القسم
 الإحصاء فلا تظهر فيه معدلات متطرفة للطلبة القدامى.

ام بعض أدوات الإحصاء وبهذا نكون قد استعرضنا أهم الاستنتاجات التي تم الحصول عليها من خلال استخد
من خلال النتائج  نفسملاحظات القارئ هي تكرار الحصول على  أبرز الاستكشافي الأساسية، وقد تكون من

استخدام مقاييس إحصائية أو رسومات بيانية مختلفة، وأن هذا قد ي عد إهدارا للوقت، إلا أننا نجيب هنا ببساطة إلى 
وي عطي الباحث  تأكيدا لهذا الاستنتاجتاج باستخدام أساليب مختلفة ي عد أن الحصول على نفس النتيجة أو الاستن

 تحليله الإحصائي. نتائج فيوالثبات المزيد من الثقة 

وكتمرين إضافي للقارئ، نقترح إعادة تطبيق هذا البند على نفس المتغير "معدل الطالب" في ملف البيانات "معدلات 
 الطلبة" بطريقتين:

 كمتغير تقسيم بدلا عن المتغير "القسم العلمي".باستخدام المتغير "جنس الطالب"  .1

في  (Exploreنافذة استكشاف البيانات )في  (Factor Listمربع )بدون إدراج متغير تقسيم، أي ترك  .2
 ( فارغا.45.3الشكل )

 (Exploring the Extreme Values)استكشاف القيم المتطرفة  7.3

، ي الأمثلة السابقةف مثل المدرج التكراري وشكل الصندوق  من خلال استخدامنا للتمثيل البياني للمتغيرات 
تحديد هذه القيم المتطرفة لاحظنا ظهور بعض القيم المتطرفة في بعض المتغيرات، وفي هذا البند، سنقدم طريقة 

 ؛اإليه سابق، والذي تمت الإشارة SPSS برنامج من خلال استخدام أحد خيارات أسلوب الاستكشاف في

 Analyze>Descriptiveالعلوي باختيار في ملف البيانات "معدلات الطلبة"، قم في شريط الأوامر 

Statistics>Explore ( (، قم في تلك 45.3فتظهر نافذة الاستكشاف، كما يظهر في الشكل السابق )شكل)
 Dependentالقائمة الأساسية )النافذة باختيار المتغيرين "معدل الطالب" و"الفصل الدراسي" ونقلهما إلى مربع 

List .)بعد ذلك اضغط على خيار ( الإحصاءاتStatistics في يمين النافذة فتظهر النافذة الفرعية الخاصة )
 ((.46.3بالإحصاءات كما يظهر في الشكل السابق، )شكل )
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( فقط ثم نضغط استمرار. وبعد العودة للنافذة Outliersفي تلك النافذة الفرعية سنقوم باختيار خيار القيم المتطرفة )
( في Display( في الجزء الخاص بخيارات العرض )Statisticsءات فقط )الأساسية، سنختار عرض الإحصا

 أسفل النافذة، ثم نضغط موافق.

في نافذة المخرجات، سنحصل على جدولين؛ الأول هو الجدول الخاص بأحجام العينات وعدد القيم المفقودة، وأما 
بالنسبة لمتغير معدل الطالب، فإن  ة.فهو الجدول الخاص بالقيم المتطرف( هنا(، 7.3الجدول الثاني، )جدول )

( لهذا المتغير، فمثلا؛ نلاحظ وجود خمسة قيم Lowestصغرى )و ( Highestالجدول ي ظهر قيم متطرفة عليا )
( يمثل ترتيب القيم المتطرفة في المتغير، Case Numberمتطرفة عليا )حيث أن العامود الثاني من اليمين )

 .3.67، و3.41، 3.39، 3.18، 3.15( يعرض القيمة المتطرفة(، وهي Valueمين )والعامود الأول من الي

 "معدل_الطالب" و"الفصل_الدراسي"القيم المتطرفة للمتغيرين : 7.3جدول 
 في ملف البيانات "معدلات الطلبة".

Extreme Values 

  Case Number Value 

 Highest 1 27 3.67 معدل الطالب

2 29 3.41 

3 24 3.39 

4 26 3.18 

5 22 3.15 

Lowest 1 44 1.15 

2 42 1.16 

3 45 1.25 

4 69 1.26 

5 8 1.26a 

الفصل الدراسي 
 للطالب

Highest 1 61 23 

2 4 21 

3 63 21 

4 64 21 

5 1 20b 

Lowest 1 23 2 

2 53 5 

3 30 7 

4 25 7 

5 24 7 
a. Only a partial list of cases with the value 1.26 are shown in the table of 

lower extremes. 
b. Only a partial list of cases with the value 20 are shown in the table of 

upper extremes. 

 1.26( فوق القيمة aالحاشية )أما القيم المتطرفة الصغرى لهذا المتغير فهي أكثر من خمسة قيم حيث أن وجود 
الطلبة الذين تحصلوا يعني أنه قد تم عرض جزء فقط من القيم المتطرفة الصغرى لهذا المتغير. وهذا يعني أن 

قد تم تصنيف معدلاتهم بأنها متطرفة بالنسبة  1.26فأكثر أو معدلات تتراوح حول المعدل  3.15على معدلات 
 لبقية الطلبة في الكلية.
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، 20فإن ترتيب الفصول الدراسية حول القيمة مر بالنسبة للمتغير الثاني، وهو الفصل الدراسي للطالب، وكذلك الأ
((، قد تم تصنيفهم بأنهم اجتازوا الحد الطبيعي لعدد الفصول الدراسية في هذه الكلية، b)والمشار إليه بالحاشية )

فقد تم تصنيفها كقيم متطرفة  7، و5، 2ولهم الدراسية أي أنهم قد تأخروا في التخرج. وأما الطلبة الذين ترتيب فص
 صغرى مقارنة بباقي الطلبة.

باستخدام متغير تصنيف لمتغير أو أكثر  عرض القيم المتطرفةمن جديد، يمكننا باستخدام نفس نافذة الاستكشاف 
 كما سنرى؛ وصفي أو أكثر

 Analyze>Descriptiveلوي باختيار لنفس ملف البيانات "معدلات الطلبة"، قم في شريط الأوامر الع

Statistics>Explore ( (، قم في تلك النافذة باختيار المتغير 45.3وفي نافذة الاستكشاف، )شكل)
(، واختيار المتغيرين "القسم العلمي" Dependent List"معدل الطالب" ونقله إلى مربع القائمة الأساسية )

 (.Factor Listتصنيف )و"جنس الطالب" ونقلهما إلى مربع قائمة ال

( في يمين النافذة وفي النافذة الفرعية الخاصة بالإحصاءات، Statisticsبعد ذلك اضغط على خيار الإحصاءات )
( فقط ثم اضغط استمرار. وبعد العودة للنافذة Outliers((، قم باختيار خيار القيم المتطرفة )46.3)شكل )

 جزء الخاص بخيارات العرض في أسفل النافذة، ثم اضغط موافق.الأساسية، اختر عرض الإحصاءات فقط في ال

لى جانب الجداول الخاصة بأحجام العينات وعدد القيم المفقودة، سنلقي الضوء على  أولا في نافذة المخرجات، وا 
الجدول الخاص بالقيم المفقودة لمتغير معدل الطالب مصنفا بناء على القسم العلمي الذي يتبعه الطالب، )جدول 

 ((؛8.3)
"معدل_الطالب" مصنفا بحسب المتغير : القيم المتطرفة للمتغير 8.3جدول 

 )ملف البيانات "معدلات الطلبة"(. ،"القسم_العلمي"
Extreme Values 

 Case Number Value الطالبقسم        

معدل 

 الطالب

MA Highest 1 27 3.67 

2 29 3.41 

3 24 3.39 

4 26 3.18 

5 22 3.15 

Lowest 1 8 1.26 

2 6 1.26 

3 11 1.48 

4 3 1.48 

5 28 1.49 

ST Highest 1 34 2.18 

2 49 2.01 

3 33 1.98 

4 58 1.97 

5 37 1.90 
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"معدل_الطالب" مصنفا بحسب : القيم المتطرفة للمتغير 8.3جدول )تابع( 
 )ملف البيانات "معدلات الطلبة"(. ،المتغير "القسم_العلمي"

 

 

Lowest 1 44 1.15 

2 42 1.16 

3 45 1.25 

4 57 1.36 

5 50 1.40 

PH Highest 1 90 2.31 

2 89 2.13 

3 72 2.09 

4 81 1.84 

5 88 1.81 

Lowest 1 69 1.26 

2 64 1.41 

3 74 1.45 

4 68 1.46 

5 78 1.53a 
a. Only a partial list of cases with the value 1.53 are shown in the table 
of lower extremes. 

نتيجة استخدام متغير التصنيف "القسم العلمي" للطالب، ومن هذا الجدول يمكننا ملاحظة التغيرات التي حدثت 
 ؛بحيث أن أصبحت مختلفة في كل قسمالقيم المتطرفة العليا لمعدلات الطلبة ف

  3.67و 3.15معدلات الطلبة المتطرفة العليا تتراوح ما بين( في قسم الرياضيات ،MA وتتراوح ما بين ،)
 (.PHفي قسم الفيزياء ) 2.31و 1.81ما بين (، وتتراوح STفي قسم الإحصاء ) 2.18و 1.90

  1.49و 1.26معدلات الطلبة المتطرفة الصغرى تتراوح ما بين( في قسم الرياضيات ،MA وتتراوح ما بين ،)
 (.PHفي قسم الفيزياء ) 1.53(، وتتراوح حول STفي قسم الإحصاء ) 1.40و 1.15

يكون كذلك في قسم آخر، وهذا التصنيف قد يكون أكثر قد لا  معينوهذا يعني أن ما ي عد قيمة متطرفة في قسم 
فمن النتيجة السابقة  في مستوى الطلبة بين الأقسام العلمية المختلفة. في غياب التجانسدقة في كثير من الأحيان 

نستطيع القول بأن المعدلات المرتفعة "المتطرفة" للطلبة في قسم الرياضيات هي التي أدت لرفع الوسط الحسابي 
 عدلات الطلبة في هذا القسم عن المعدلات في القسمين الآخرين.لم

 فيمكن ملاحظة أن؛((، 9.3وثانيا، بالنسبة للجدول الآخر في نافذة المخرجات، )جدول )

  3.67و 3.15للطلبة الذكور، وتتراوح ما بين  2.40و 2.09معدلات الطلبة المتطرفة العليا تتراوح ما بين 
 للطالبات.

 1.26و 1.15للذكور وتتراوح ما بين  1.51و 1.26المتطرفة الصغرى تتراوح ما بين  معدلات الطلبة 
 للطالبات.
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وهذا يسوف يعطي الانطباع بأن المستوى الدراسي للطالبات في العموم هو أعلى من الطلبة الذكور لأن القيم 
 المتطرفة العليا ستؤدي لارتفاع الوسط الحسابي لمعدلات الطالبات.

 "معدل_الطالب" مصنفا بحسب المتغير: القيم المتطرفة للمتغير 9.3جدول 
 )ملف البيانات "معدلات الطلبة"(. ،"جنس_الطالب"

Extreme Values 

 Case Number Value جنس الطالب

 M Highest 1 17 2.40 معدل الطالب

2 90 2.31 

3 34 2.18 

4 89 2.13 

5 18 2.09 

Lowest 1 8 1.26 

2 57 1.36 

3 50 1.40 

4 47 1.45 

5 32 1.51 

F Highest 1 27 3.67 

2 29 3.41 

3 24 3.39 

4 26 3.18 

5 22 3.15 

Lowest 1 44 1.15 

2 42 1.16 

3 45 1.25 

4 69 1.26 

5 6 1.26 

وعادة ما نقوم "بربط" النتائج الخاصة بالقيم المتطرفة بالنتائج العامة إذا ما تبين لنا وجود تأثير هام لتلك القيم 
حيث أن زيادة عدد وقيمة التطرف في مشاهدات المتغير تؤدي لتغير النمط الذي ي ظهره ضمن متغيرات الدراسة، 

 هذا المتغير.
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 الفصل الرابع

 SPSSتحليل البيانات الاستدلالي في 

 (Inferential Data Analysis in SPSS) 

 
في الفصل السابق تناولنا أهم الطرق الإحصائية من مقاييس وتمثيل بياني لاستكشاف ووصف البيانات 

لك إلى معلومات "تمهيدية" وتحديد الأنماط التي تتخذها وتحويل ذ بغية الوصول لفهم واضح حول توزيع هذه البيانات
 المعالم طرق تقديرالأساليب الإحصائية التي تتضمن  باستعراضهذا الفصل، سنقوم  فيو  يمكن الاستفادة منها.
وذلك بهدف الوصول  ،المختلفة تقدير معالم النماذج الإحصائية ذلك شملوي، المتعلقة بها واختبارات الفروض

وتندرج كل  ت بصورة أكثر عمقا مما تم الوصول له بالأساليب الاستكشافية.للمعلومات الكامنة ضمن طيات البيانا
تحت مفهوم علم الإحصاء الاستدلالي )أو الاستنتاجي(، ذلك العلم الذي يتكون من مجموعة من  تلك المواضيع

بمجتمع ما تقديرات والوصول لدلالات واختبار الفرضيات الإحصائية المتعلقة الالطرق التي تستخدم في استنتاج 
 أو أكثر.

 (Inference about the Population Mean) الاستدلال حول الوسط الحسابي للمجتمع 1.4

لمجتمع هنا تقدير معلمة المجتمع بنقطة أو بفترة، واختبار لحول الوسط الحسابي  لاليُقصد بالاستد 
الاحصائي تحت عنوان تقدير أو  مساواتها لقيمة مفترَضة، ويندرج هذا الموضوع في كثير من كتب الاستدلال

 وسنبدأ بتناول المجتمع الواحد. .والعينتين اختبار العينة الواحدة

 (Inference about the Mean of One Population) واحد الاستدلال حول الوسط لمجتمع 1.1.4

جراء الاختبارات المتعلقة تقدير فترة الثقة للوسط الحسابي للمجتمع لتوجد عدة صيغ  به، وهذه الصيغ  وا 
تختلف باختلاف حجم العينة ومعلومية تباين المجتمع، لذلك سيتم عرض الصيغة النظرية لفترة الثقة بمعلومية تباين 

 ؛𝜎2المجتمع 

 بالصيغة التالية:  الحسابي فترة ثقة للوسط 100(-1)%يتم تعريف 

𝜇𝑋: �̅� ∓ 𝑍𝛼
2⁄

𝜎

√𝑛
 

𝑍𝛼مسحوبة من هذا المجتمع، و nابي لعينة حجمها هو الوسط الحس �̅�حيث 
التي تتبع  Zهي قيمة الإحصاءة  ⁄2

𝛼التوزيع الطبيعي المعياري باحتمال قدره 
2⁄. 
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 )أو فرضية العدم(:ويتم اختبار الفرضية الصفرية 

𝐻0: 𝜇 = 𝜇0 

 :بالصورة 𝑍𝑐 باستخدام الإحصاءة αعند مستوى معنوية 

𝑍𝑐 =
�̅� − 𝜇0

𝜎

√𝑛

 

بيانات ، نقوم أولا بفتح ملف البيانات، وليكن ملف "SPSSولعمل استدلال حول الوسط الحسابي لمجتمع في برنامج 
تمع أعمار الطلبة في تلك " على سبيل المثال. في هذا الملف، لنفرض أننا نريد أولا تقدير فترة الثقة لمجالطلبة
 بالآتي؛فنقوم  يمة معينة لمتوسط المجتمع )معلمة المجتمع(،واختبار فرضية حول ق ،الكلية

فتظهر النافذة ، Analyze>Compare Means>One-Sample T Testفي شريط الأدوات العلوي اختر الأمر 
 (؛1.4التالية، شكل )

 
 "(.بيانات الطلبة: نافذة تقدير واختبار الوسط الحسابي لمجتمع واحد )لملف بيانات "1.4شكل 

قم باختيار المتغير "عمر الطالب بالسنوات" ونقله إلى مربع متغير ، العمر𝜇تقدير الوسط الحسابي لمتغير العمر، ل

( يمكنك تحديد نسبة الثقة التي ترغب بتقدير Options(. الآن، ومن أمر خيارات )Test Variable(s)الاختبار )
ذا رغبت بإبقائها كما هي فلا داعي للضغط على أمر 95فترة الثقة عندها، وتكون عادة النسبة الافتراضية % ، وا 

أي أننا سنة على سبيل المثال،  22خيارات. بعد ذلك قم بتحديد القيمة التي سيتم اختبار المعلمة عندها، ولتكن 
:𝐻0سنختبر الفرضية الصفرية  𝜇 = (، ثم اضغط Test Valueفي مربع قيمة الاختبار ) 22. قم بكتابة  22

 (.OK) موافق
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حيث يضم الجدول الأول حجم العينة، ، ((2.4و) (1.4) الجدولين)ستظهر في نافذة المخرجات النتيجة التالية، 
(. وهذه 𝑆𝐸(�̅�)(، والخطأ المعياري للمقدر )SD(X)(، الانحراف المعياري للعينة )�̅�الوسط الحسابي للعينة )

كما رأينا في الفصل الثالث، إلا أنها تأتي هنا مرافقة لأمر  المقاييس يمكن الحصول عليها باستخدام بطرق أخرى 
 تقدير فترة الثقة واختبار الفروض.

 ".بيانات الطلبةفي ملف " "العمر"لمتغير  الإحصاءات لعينة واحدةجدول : 1.4جدول 
One-Sample Statistics 

  N Mean Std. Deviation Std. Error Mean 

 278. 1.648 22.14 35 عمر الطالب بالسنوات

والقيمة الاحتمالية للاختبار ودرجة الحرية لها،  1، فيضم قيم إحصاءة الاختبار((2.4) )جدول أما الجدول الثاني،
(P-value وقيمة الفرق ،)( وهي للاختبار من طرفين، )حيث لا يتوفر هنا خيار إجراء الاختبار من طرف واحد
(�̅� − 𝜇0 ،)ابي.وفترة الثقة للوسط الحس 

 ".بيانات الطلبةفي ملف " "العمر"جدول اختبار الوسط الحسابي لعينة واحدة لمتغير : 2.4جدول 

One-Sample Test 

 

Test Value = 22 

t df 

Sig. (2-

tailed) 

Mean 

Difference 

95% Confidence Interval of 

the Difference 

Lower Upper 

 71. -42.- 143. 611. 34 513. الطالب بالسنوات عمر

، 95% ( بنسبة ثقةP-value > 0.05قبول الفرضية الصفرية )حيث أن ل نميل ناأن ، يمكن القولمن هذه النتيجةو 
سنة، وأن تقدير القيمة الحقيقية  22هو  في المجتمع مما يعني قبول الادعاء القائل بأن متوسط أعمار الطلبة

 ( سنة.22.708≅23( و)21.576≅22) )المعلمة( لهذا المتوسط سيتراوح ما بين

 (Using the Error Bars)استخدام أعمدة الخطأ  1.1.1.4

فترات الثقة لمتوسط مجتمع درجات الطلبة للمقررات  بين مقارنةالب في المثال السابق لنفرض بأننا نرغب 
عندها يمكن استخدام الرسم . "بيانات الطلبة" في ملف البيانات "3"، و"مقرر2"، "مقرر1)المتغيرات( الثلاثة "مقرر

باختيار الأمر  نقوم من شريط الأوامر العلوي  ( في تنفيذ ذلك.Error Bars) لأعمدة الخطأالبياني 
Graphs>Legacy Dialogs>Error Bar ( 2.4فتظهر نافذة الرسم كما في شكل.) 

 

                                                 
 توزيعالكلا من  تتضمن استخدامت التي على الاختبارا tيتم إطلاق مسمى اختبار ننوه هنا إلى أنه في معظم البرامج الإحصائية  1

 حيث أن قيم الإحصاءة في التوزيع الثاني تقترب من التوزيع الطبيعي بزيادة حجم العينة. tوتوزيع  Z الطبيعي
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( كما هو ولكن سنختار التنفيذ لعدة متغيرات Simpleبقاء اختيار الأعمدة البسيطة )في تلك النافذة، سنقوم بإ
(Summaries of separate variables ثم نضغط ،)

(. 3.4( فتظهر نافذة جديدة كما في الشكل )Defineتعريف )
في هذه النافذة، سنقوم باختيار المتغيرات التي نرغب بتنفيذ 

غيرات الثلاثة الأولى في قائمة ، )وهي المتأعمدة الخطأ لها
( Error Barsالمتغيرات(، ونقلها إلى مربع أعمدة الخطأ )

 في يمين النافذة.

 

 

 
 "(.بيانات الطلبة)لملف بيانات " أعمدة الخطأ لرسم : نافذة تعريف المتغيرات3.4شكل 

 
 (.Error Bars: نافذة أعمدة الخطأ )2.4شكل 
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ذا ما ضغطت (، Bars Representتحت مربع أعمدة الخطأ، يوجد خيار خاص بما ستمثله هذه الأعمدة، )و  وا 
على السهم الخاص به ستظهر ثلاثة خيارات هي؛ فترة الثقة للوسط، الخطأ المعياري للوسط، والانحراف المعياري. 

نسبة ثقة للفترة، ونضغط موافق  95في مثالنا سنبقي على الخيار الأول الافتراضي، وكذلك سنبقي على اختيار %
أعمدة الخطأ للمتغيرات الثلاثة المختارة في نافذة المخرجات، كما نشاهد في في أسفل النافذة. سيظهر بعدها رسم 

 ،3مقارنة بأدائهم في المقرر 2و 1من الشكل يمكننا ملاحظة ارتفاع مستوى أداء الطلبة في المقررين  (.4.4الشكل )
 )لاحظ أن النقطة المستديرة في منتصف كل عامود تمثل متوسط العينة(.

أن في العموم، وكتقدير لمتوسط المجتمع الذي يمثل درجات الطلبة في المقررات الدراسية،  إنهول وأيضا يمكننا الق
 3درجة تقريبا(، وأما في المقرر 77إلى  66سيتراوح بين جيد وجيد جدا، )من  2و 1مستوى الطلبة في المقررين 

 فسيتراوح ضمن درجات التقدير مقبول.

 
 "(.بيانات الطلبة)لملف بيانات " ،"3"، و"مقرر2"، "مقرر1"مقررة الخطأ للمتغيرات : التمثيل البياني لأعمد4.4شكل 

ويمكن أيضا استخدام أعمدة الخطأ للمقارنة بين فترات الثقة لمتغير واحد بناء على متغير تقسيم وصفي، فمثلا؛ 
للذكور وللإناث ومقارنة  "لطلبةبيانات ا"يمكننا تقدير ورسم فترتي ثقة لمتغير عمر الطالب، في نفس ملف البيانات 

 الأداء الدراسي لكل منهما.
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، ثم اختر التنفيذ Graphs>Legacy Dialogs>Error Barباختيار الأمر  قم في شريط الأوامر العلوي 
( فتظهر نافذة Defineغط تعريف )اض(، ثم Summaries for groups of casesلمجموعات من المشاهدات )

 (.5.4جديدة كما في الشكل )

في هذه النافذة، سنقوم باختيار تمثيل أعمدة الخطأ لمتغير عمر الطالب باستخدام متغير جنس الطالب كمتغير 
باختيار المتغير "عمر الطالب بالسنوات" في مربع المتغير  ،(5.4تقسيم. قم، كما هو موضح في الشكل )

(Variableثم قم باختيار المتغير "جنس الطالب" في مربع محور ،) ( التصنيفCategory Axis مع إبقاء ،)
 كما هما. نسبة ثقة للفترة 95% وخيار، لفترة الثقة للوسط الحسابي الافتراضيالخيار 

 
تغير باستخدام ضمن م لمجموعات من المشاهدات أعمدة الخطأ تنفيذ: نافذة اختيار 5.4شكل 

 "(.بيانات الطلبة)لملف بيانات " تقسيم لمتغير وصفي،

عمر الطالب بناء على تقسيم المشاهدات لأعمدة الخطأ لالتمثيل البياني المطلوب ظهر يغط على موافق، سبعد الض
. ومن هذه الأعمدة يمكننا ملاحظة وجود ارتفاع ملحوظ في أعمار الطلبة ((6.4، )شكل )بحسب جنس الطالب

في جتمع أعمار الطلاب الذكور سيكون كما يمكننا القول بأن تقدير الوسط الحسابي لمالذكور مقارنة بالطالبات. 
  .95تقدير الوسط الحسابي لمجتمع أعمار الطالبات بنسبة ثقة %العموم أعلى من 
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التمثيل البياني لأعمدة الخطأ لمتغير عمر الطالب بناء على تقسيم المشاهدات بحسب جنس : 6.4شكل 

 "(.بيانات الطلبة)لملف بيانات " ،الطالب

 (Inference about the Mean of Two Populations) ينحول الوسط لمجتمعالاستدلال  2.1.4

 (Inference about Independent Samples) للعينات المستقلةالاستدلال  1.2.1.4

:𝐻0تُعرّف الصيغة العامة لإحصاءة اختبار الفرق بين متوسطين )  𝜇1 − 𝜇2 =  ( بالصورة التالية:0

𝑍𝑐 =
(�̅�1 − �̅�2) − (𝜇1 − 𝜇2)

√(𝜎1
2 𝑛1⁄ ) + (𝜎2

2 𝑛2⁄ )
 

 t، وتُستخدم إحصاءة ينالكبيرة أو عند توفر قيم التباين للمجتمع المستقلة وذلك في الحالات التي تتضمن العينات
ي يجب أن يكون والت ، )صغر حجم العينة أو عدم توفر معلومات حول تباينات المجتمعين(،في الحالات الأخرى 

 من المعلوم فيها تساوي أو عدم تساوي تباينات المجتمعين.

، الطريقة SPSSلإجراء استدلال حول الفرق بين الوسطين الحسابيين لمجتمعين في برنامج وتوجد طريقتين 
 المختصرة والطريقة المطولة.

 للعينة، والانحراف المعياري للعينةحجم العينة، الوسط الحسابي  كل من يتم إدخال قيم :الطريقة المختصرةفي 
 مباشرة في نافذة التحليل كما سنوضح في المثال التالي؛ وذلك لكل من العينتين

في ملف  2و 1لنفرض أننا نريد إجراء استدلال إحصائي للفرق بين وسطي مجتمعات درجات الطلبة في المقررين 
:𝐻0فرية؛ ، أي نريد اختبار الفرضية الص"بيانات الطلبة"البيانات  𝜇

مقرر1 − 𝜇
مقرر2 = فترة ثقة  95، وتقدير 0%

لتنفيذ ذلك نحتاج لحساب قيم الوسط الحسابي والانحراف المعياري للعينتين )أي للمتغيرين( أولا. للفرق بينهما. 
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ب تلك وبالتالي إما أن نكون قد حصلنا عل تلك القيم من التحليل الاستكشافي للمتغيرين مسبقا، أو نقوم بحسا
 Analyze>Descriptive Statistics>Descriptives في شريط الأوامر العلوي قم باختيار .المقاييس مباشرة

" واختيار الوسط الحسابي والانحراف المعياري فقط من أمر الخيارات 2" و"مقرر1اختيار المتغيرين "مقررثم 
(Options ثم الضغط على موافق فنحصل على القيم المطلوبة في )( (.3.4نافذة المخرجات، )جدول) 

 ."بيانات الطلبةبيانات "الملف في  2و 1لمقرري  الوسط الحسابي والانحراف المعياري : 3.4دول ج
Descriptive Statistics 

  N Mean Std. Deviation 

 15.605 71.31 35 1درجة الطالب في المقرر

 15.219 72.97 35 2درجة الطالب في المقرر

Valid N (listwise) 35     

 Analyze>Compare Means>Summaryمن جديد، وفي شريط الأدوات العلوي، قم باختيار 

Independent Samples T-Test  (. قم بإخال القيم المطلوبة كما هو موضح 7.4نافذة كما في الشكل )فتظهر
 .((4.4جدول ))، مخرجاتفي نافذة ال ممثلة بثلاثة جداول في الشكل ثم اضغط موافق فتظهر النتائج

 
سطي مجتمعين، )الطريقة نافذة إدخال القيم الخاصة بالاستدلال حول الفرق بين و : 7.4شكل 

 "(.بيانات الطلبة)لملف بيانات " المختصرة(،

. ويضم للعينتين والخطأ المعياري للوسط الوسط الحسابي والانحراف المعياري الجدول الفرعي الأول )أ( يضم قيم 
ول الفرعي الثاني )ب( نتائج اختبار الفرق بين الوسطين في حالتين؛ الأولى بافتراض تساوي تبايني المجتمعين، الجد
(Equal variances assumed( ،والثانية بافتراض عدم تساوي تبايني المجتمعين ،)Equal variances not 

assumed.) 
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 ."بيانات الطلبةبيانات "الملف في  2و  1المقررين  سابيين لمجتمعيالفرق بين الوسطين الح: نتائج الاستدلال حول 4.4جدول 
Summary Data (أ) 

  N Mean 

Std. 

Deviation 

Std. Error 

Mean  
Sample 1 35.000 71.310 15.060 2.546 

 
Sample 2 35.000 72.970 15.200 2.569 

 

      

Independent Samples Test (ب) 

  

Mean 

Difference 

Std. Error 

Difference t df 

Sig. (2-

tailed) 

Equal variances assumed -1.660 3.617 -.459 68.000 .648 

Equal variances not assumed -1.660 3.617 -.459 67.994 .648 

Hartley test for equal variance: F = 1.019, Sig. = 0.4783 

      

95.0% Confidence Intervals for Difference (ج) 
   

  

Lower 

Limit 

Upper 

Limit    

Asymptotic (equal variance) -8.749 5.429 
   

Asymptotic (unequal variance) -8.749 5.429 
   

Exact (equal variance) -8.877 5.557 
   

Exact (unequal variance) -8.877 5.557 
   

 اختبار هارتليتبايني المجتمعين، )نتائج اختبار تساوي  وفي أسفل الجدول الفرعي الثاني )ب(، نلاحظ وجود
(Hartley test for equal variance ،)) ومنه يتضح قبول الفرضية الصفرية𝐻0: 𝜎1

2 = 𝜎2
، وبالتالي اعتماد 2

إلى نتائج اختبار الفرق بين وسطي المجتمعين الخاصة به في الصف الأول من الجدول. ومن هذه النتيجة نخلص 
:𝐻0قبول الفرضية  𝜇

مقرر1 − 𝜇
مقرر2 = درجات  معدلات أي الاعتقاد بتساوي  (،P-value =0.648)حيث أن  ،0

 .2و 1الطلبة في مجتمعي المقررين 

، )بتقدير تقاربي 2و 1وأما الجدول الفرعي الثالث )ج(، فيضم فترة الثقة للفرق بين وسطي مجتمعي المقررين 
(Asymptoticوتقدير ) ( محددExact ومنه يتضح أن ،))−8.87 < 𝜇

مقرر1 − 𝜇
مقرر2 < وهذا يعني ،  5.55

، وذلك بسبب كون الفرق بين 2درجات الطلبة في المقرر أقل منستكون في العموم  1أن درجات الطلبة في المقرر
 (.-8.87التقديرين هو أقرب للقيمة السالبة )

تين، )المطلوب تقدير الفرق بين متوسطات مجتمعيهما(، في متغير : فيجب إدخال العينيالطريقة المطولةأما في 
دراج متغير وصفي يضم رمز التمييز بينهما، والمثال التالي يوضح هذه الطريقة. الجدول ) ( 5.4)عامود( واحد، وا 

 شخصا أجروا مقابلات شخصية للعمل في قسم الموارد البشرية 20يضم بيانات تمثل النتائج التي حصل عليها 
 درجة(؛ 100في شركتين، )حيث كان التقييم من 
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باسم "المقابلات  SPSSوسنقوم بإدخال هذه البيانات في ملف جديد في 
في  2متبوعة بنتائج الشركة  1ج الشركةالشخصية"، عن طريق إدخال نتائ

عامود واحد، ثم إدخال رمز يميز بين نتائج الشركتين في العامود الثاني كما 
، مع التنويه ، والذي يمثل مقطعا من البيانات(8.4هو موضح في الشكل )

ثم  2للشركة 2كرمزوالقيمة  ،1للشركة كرمز 1هنا إلى أنه تم إدخال القيمة 
  .(Valuesمود القيم )تعريف ذلك في عا

ولإجراء استتتتتتتتتتتتتتدلال إحصتتتتتتتتتتتتتائي 
للفرق بين وستتتتتتتتتتتتتتطي مجتمعات 
نتائج المقابلات الشتتتتخصتتتتية في 
الشتتتركتين، أي اختبار الفرضتتتية 

 الصفرية؛

 𝐻0: 𝜇
شركة1 − 𝜇

شركة2 = 0 ،

فترة ثقتتتتتة للفرق  95وتقتتتتتدير %
 Analyze>Compare Means>Independent Samplesنقوم من شتتتتتريط الأوامر العلوي باختيار ، بينهما

T-Test ( ؛9.4فتظهر النافذة الخاصتتتتتتتتة بتعريف المتغيرات كما في الشتتتتتتتتكل)  في تلك النافذة، قم باختيار المتغير
(، ثم قم بنقل المتغير "الشتتتركة" إلى مربع متغير Test Variable"نتائج_المقابلات" ونقله لمربع متغير الاختبار )

ندها "ستتيضتتيس" أستتفل ذلك المربع الأمر الخاص بتعريف التصتتنيفات أو (، وعGrouping Variableالتصتتنيف )
 (، قم بالضغط عليه لتعريف العينة الأولى والثانية.Define Groupsالمجموعات )

 
وسطي مجتمعين، )الطريقة : نافذة إدخال القيم الخاصة بالاستدلال حول الفرق بين 9.4شكل 

 خصية"(.)لملف بيانات "المقابلات الش المطولة(،

 

 : نتائج المقابلات الشخصية5.4جدول 
 في الشركتين.

 
 نتائج

 1الشركة  
 

 نتائج
 2الشركة  

1 71 1 70 
2 55 2 56 
3 62 3 60 
4 70 4 71 
5 23 5 20 
6 56 6 58 
7 80 7 82 
8 74 8 75 
9 66 9 65 

10 68 10 70 
11 43 11 40 
12 56 12 55 
13 90 13 89 
14 56 14 57 
15 42 15 40 
16 70 16 71 
17 68 17 70 
18 40 18 39 
19 58 19 60 
20 60 20 59 

 
: مقطع من ملف بيانات 8.4شكل 

 "المقابلات الشخصية".
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 1(، قم بكتابة القيمة 10.4بعد الضتتتتغط على أمر تعريف المجموعات، ستتتتتظهر النافذة الفرعية كما في الشتتتتكل ) 
، الثانية )العينة( للمجموعة 2الأولى والقيمة  )العينة( للمجموعة

((، 9.4لتعود للنافذة الأصتتتتتتتتلية، )شتتتتتتتتكل )ثم اضتتتتتتتتغط استتتتتتتتتمرار 
 اضتتتتتتغط بعدها على موافق فتظهر نتائج الاستتتتتتتدلال الإحصتتتتتتائي

في نافذة  لتقدير الفرق بين وستتتتتتتتتتتتتطي مجتمعي نتائج الشتتتتتتتتتتتتتركتين
ستتتتتتتتتتتتتتتلاحظ وجود في ذلك الجدول،  .((6.4جدول ))المخرجات، 

قيم الوستتتتتتط الحستتتتتتابي للعينتين )الشتتتتتتركتين(، الانحراف المعياري 
ن، والخطأ المعياري للوستتتتط الحستتتتابي للعينتين في الجدول للعينتي

فيحتوي على  . وأما الجدول الفرعي الثاني )ب(الفرعي الأول )أ(
 نتائج اختبار الفروض وتقدير فترة الثقة.

 .("المقابلات الشخصيةملف بيانات ") ،2و 1الشركتين  مجتمعيلالفرق بين وسطين الاستدلال حول : نتائج 6.4جدول 
Group Statistics  (أ) 

 

 N Mean Std. Deviation الشركة

Std. Error 

Mean 

 3.419 15.288 60.40 20 1شركة المقابلات_نتائج

 3.631 16.239 60.35 20 2شركة

 

Independent Samples Test  (ب) 

 

Levene's 

Test for 

Equality 

of 

Variances t-test for Equality of Means 

F Sig. t df 

Sig. 

(2-

tailed) 

Mean 

Difference 

Std. 

Error 

Differenc

e 

95% Confidence 

Interval of the 

Difference 

Lower Upper 

 نتائج

 المقابلات

Equal variances 

assumed 
.023 .881 .010 38 .992 .050 4.987 -10.046- 10.146 

Equal variances 

not assumed 
  .010 37.862 .992 .050 4.987 -10.047- 10.147 

 يمكننا استنتاج التالي، )بقراءة أعمدة الجدول من اليسار لليمين(:(، 6.4الجدول )في  الفرعي الثاني )ب( الجدول من

 ( ،قبول الفرضية القائلة بتساوي تباينات مجتمعي الشركتينP-value =0.881 وبالتالي اعتماد النتائج ،)
:𝐻0 الخاصة بهذه الفرضية، 𝜎1

2 = 𝜎2
2  ،(Equal variances assumed.) 

 ( ،قبول الفرضية القائلة بتساوي الوسطين الحسابيين لمجتمعي الشركتينP-value =0.992 مما يعني ،)
 تساوي أداء الأشخاص في المقابلات الشخصية في كلا الشركتين.

  10.04−التقدير < 𝜇
شركة1 − 𝜇

شركة2 < النتيجة السابقة وهي عدم وجود اختلاف يُؤكد نفس  10.14

 معنوي )ذو أهمية( في معدل أداء الأشخاص في المقابلات الشخصية في الشركتين.

 
: نافذة تعريف العينتين في ملف بيانات 10.4شكل 

 "المقابلات الشخصية".
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 (Inference about Paired Samples) (غير المستقلةالمرتبطة )للعينات الاستدلال  2.2.1.4

توسطي مجتمعين في حال كون في هذا البند، سنستعرض كيفية تطبيق الاستدلال الإحصائي للفرق بين م 
 ؛SPSSالعينات غير مستقلة. ولنأخذ المثال التالي لشرح كيفية تنفيذ ذلك في برنامج 

قبل وبعد إعطاؤهم  مريضا في إحدى المستشفيات 15لعينة من قياس ضغط الدم  (، تمثل7.4البيانات في جدول )
لال حول وجود فرق معنوي عند المرضى قبل وبعد والمطلوب هو إجراء استدواء تجريبي موسع للأوردة الدموية. د

:𝐻0تناولهم للدواء التجريبي. وهذا الاستدلال سيشمل اختبار الفرضية   𝜇𝐷 = هو الوسط الحسابي  𝜇𝐷، حيث  0
عينات باسم " SPSSقم بإدخال محتويات هذا الجدول في ملف بيانات جديد في  .للفرق بين مشاهدات المجتمعين

ضغط الدم "، مع إدخال التعريفات "2" والثاني باسم "عينة1في عامودين )متغيرين(؛ الأول باسم "عينةدم"، ضغط ال
 (.Label" في خانة )ضغط الدم بعد استخدام الدواء" و"قبل استخدام الدواء

 مريض قبل وبعد إعطاؤهم دواء تجريبي. 15لعدد : نتائج قياس ضغط الدم 7.4 جدول 

 
 1العينة 

 استخدام الدواء( قبللدم )ضغط ا
 

 2العينة 
 استخدام الدواء( بعد)ضغط الدم 

1 130 1 125 
2 128 2 130 
3 140 3 135 
4 115 4 120 
5 146 5 150 
6 150 6 152 
7 123 7 120 
8 160 8 159 
9 156 9 160 

10 150 10 152 
11 112 11 115 
12 110 12 115 
13 175 13 170 
14 160 14 162 
15 178 15 180 

 Analyze>Compare Means>Paired-Samples T Test قم باختيار في شريط الأوامر العلوي،الآن، 
( في لوحة CTRLقم أولا بالضغط على زر التحكم )تلك النافذة، ((. في 11.4فتظهر النافذة التالية، )شكل )

ضغط الدم بعد " و"غط الدم قبل استخدام الدواءض"المفاتيح في جهازك ثم انقر على المتغير الأول ثم الثاني، )
(، وستلاحظ Paired Variablesإلى مربع المتغيرات المرتبطة ) معا(، وبعد تحديدهما قم بنقلهما "استخدام الدواء

 أن كلا المتغيرين قد تم وضعهما في نفس الصف.
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 ".عينات ضغط الدمسطي مجتمعين لملف بيانات ": نافذة تحديد العينات المرتبطة للاستدلال حول الفرق بين و 11.4شكل 

في الجدول الفرعي الأول (. 8.4اضغط موافق بعد ذلك وستظهر النتائج في نافذة المخرجات كما يوضح الجدول )
)أ(، وكالمعتاد سنلاحظ ظهور النتائج الخاصة بالوسط الحسابي والانحراف المعياري للعينتين، وكذلك الخطأ 

أما الجدول الفرعي الثاني )ب(، فيمثل معامل الارتباط بين العينتين والذي  لوسط الحسابي.المعياري لتقدير ا
 .في الفصل الخامس سنتناوله بالتفصيل لاحقا عندما نتطرق لموضوع الارتباط بين المتغيرات

 ."عينات ضغط الدمت "بياناالملف لعينتين مرتبطتين في الفرق بين الوسطين الحسابيين الاستدلال حول : نتائج 8.4جدول 
Paired Samples Statistics  (أ) 

 Mean N Std. Deviation Std. Error Mean 

Pair 1 5.661 21.926 15 142.20 الدواء استخدام قبل الدم ضغط 

 5.520 21.378 15 143.00 الدواء استخدام بعد الدم ضغط

Paired Samples Correlations  (ب) 

 N Correlation Sig. 

Pair 1 000. 986. 15 الدواء استخدام بعد الدم ضغط  &الدواء استخدام قبل الدم ضغط 

Paired Samples Test  (ج) 

 

Paired Differences 

t df 

Sig. 

(2-

tailed) Mean 

Std. 

Deviation 

Std. 

Error 

Mean 

95% C. I. of the 

Difference 

Lower Upper 

Pair 1 الدواء استخدام قبل الدم ضغط 

 الدواء استخدام بعد الدم ضغط -
-.800- 3.649 .942 -2.821- 1.221 -.849- 14 .410 

ومنها نستنتج  مرتبطتيناللعينتين لالاستدلال حول الفرق بين الوسطين أما الجدول الفرعي الثالث )ج(، فيضم نتائج 
فترة  95وتقدير % (.P-value =0.410عد استخدامه، )عدم وجود فرق معنوي بين العينتين قبل استخدام الدواء وب

2.821−ثقة للفرق بين الوسطين هو  < 𝜇𝐷 <  والذي يؤكد نفس النتيجة السابقة. 1.221
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 (Testing the Equality of Population Variances) لمجتمعا اختبار تساوي تباينات 2.4

(، أهمية التحقق للعينات المستقلة) وسطي المجتمع،حول الفرق بين  الاستدلالب تناولنا في الجزء المتعلق 
 من تساوي أو عدم تساوي تباينات المجتمع قبل اختبار تساوي الأوساط. إلا أن التحقق من تساوي تباينات المجتمع،

، عادة ما يكون مفيدا للباحث باختلاف أو بصورة أبسط، التحقق من مدى تجانس المشاهدات بين المتغيرات
وتوجد بضعة اختبارات يمكن استخدامها لاختبار الفرضية؛  ي يتبعه في التحليل الإحصائي.الأسلوب الذ

𝐻0: 𝜎1
2 = 𝜎2

2 = ⋯ = 𝜎𝑘
(، Bartlett's Test) اختبار بارتليتو (Leven's Test) اختبار ليفين من أهمها 2

 ؛التالي البندتناول اختبار ليفين في لا يتضمن اختبار بارتليت لتجانس التباين، لذلك سن SPSSإلا أن برنامج 

 (Leven's Testاختبار ليفن ) 1.2.4

( حيث One-way ANOVAيمكن اعتبار أن اختبار ليفين هو ببساطة تحليل تباين في اتجاه واحد )
ا التي تنتمي له (�̅�) ومتوسط المجموعة (Y) هو الفرق المطلق بين قيمة المشاهدة (Z) يكون المتغير الرئيسي فيه

𝑍𝑖𝑗، أي أن المشاهدة = |𝑌𝑖𝑗 − �̅�𝑖.| حيث( ،𝑌𝑖𝑗  هي المشاهدةj  في المجموعةi) . وتكون إحصاءة اختبار ليفن
(W تتبع توزيع )F ( بدرجات حريةk - 1( و )N - k ،):بالصورة التالية 

𝑊 =
𝑁 − 𝑘

𝑘 − 1
 

∑ 𝑁𝑖(𝑍𝑖.−𝑍..)
2𝑘

𝑖=1

∑ ∑ (𝑍𝑖𝑗−𝑍𝑖.)2𝑁𝑖

𝑗=1
𝑘
𝑖=1

 

هدات هو عدد المشا i ،Nهو عدد المشاهدات في المجموعة  𝑁𝑖هو عدد المجموعات )المتغيرات(،  k ؛حيث
عوضا عن استخدام الوسط  (المتغير))وننوه هنا إلى أن صيغة ليفين قد تستخدم أيضا وسيط المجموعة  الكلي.

  ة(.الحسابي في الصيغة السابق

في أكثر  SPSSن، فإنه يمكن تنفيذه في برنامج بالنسبة لاختبار ليفي 
من موضع، كما لاحظنا سابقا عند اختبار الفرق بين الأوساط الحسابية، 

 أو كما سنقوم بعرضه من خلال المثال التالي؛

بالدينار  أنواع من شواحن الهواتف النقالة 10البيانات التالية تمثل أسعار 
، والمطلوب ((9.4جدول )) ،Cو ،A ،B، في ثلاثة متاجر مختلفة الليبي

 تباين هنا اختبار ما إذا كان هنالك اختلاف ذو أهمية )معنوية( بين
:𝐻0الأسعار في المتاجر، أي اختبار الفرضية  𝜎𝐴

2 = 𝜎𝐵
2 = 𝜎𝐶

2. 

 أسعار شواحن الهواتف النقالة : 9.4جدول 
 .في ثلاثة متاجر مختلفة  بالدينار الليبي

  Aالمتجر  Bالمتجر  Cالمتجر 
60 60 72 1 

50 63 80 2 

51 59 74 3 

54 64 86 4 

40 59 50 5 

45 66 71 6 

49 74 51 7 

79 60 90 8 

59 61 47 9 

52 70 40 10 
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أسعار باسم " SPSS( في ملف بيانات جديد في 9.4لجدول )لتنفيذ اختبار ليفين، سنقوم بإدخال البيانات من ا
في نفس العامود ثم المتجر  Bأولا في العامود الأول متبوعة بقيم المتجر  A" بحيث يتم إدخال قيم المتجر الشواحن

C وترميز 1. بعد ذلك سنقوم بترميز القيم للمتجر الأول بالرقم ،
، كما نشاهد 3لث بالرقم ، والمتجر الثا2قيم المتجر الثاني بالرقم 

 (.12.4في الشكل )

الأوامر العلوي بتتتتاختيتتتتار  شتتتتتتتتتتتتتتريطلتطبيق اختبتتتتار ليفين، قم من 
Analyze>Descriptive Statistics>Explore  فتظهر نافذة

ستتتتتخدامها ستتتتابقا )والتي تم التطرق لا (،Exploreالاستتتتتكشتتتتاف )
قم في تلتتتتتتك النتتتتتتافتتتتتتذة بنقتتتتتتل المتغير  في الفصتتتتتتتتتتتتتتتتتتتل الثتتتتتتالتتتتتتث(.

المتغيرات الأستتتتتتتتتتتتتتاستتتتتتتتتتتتتتية _الشتتتتتتتتتتتتتتواحن" إلى مربع قائمة "أستتتتتتتتتتتتتتعار
(Dependent List ونقل المتغير "المجموعات" إلى مربع قائمة )

 (.Factor Listمتغيرات التصنيف )

وحيث أننا مهتمون في هذا المثال باختبار تساوي التباينات فقط، 
( في الجزء الخاص Plotsفسنقوم باختيار خيار الرسم البياني )

( في أسفل النافذة، لأن اختبار ليفين يقع Display)بالعرض 
( في أعلى نافذة الاستكشاف على اليمين، فتظهر النافذة Plotsمن جديد قم بالنقر على خيار الرسم )ضمنها. 

. قم بإلغاء الخيار الافتراضي لرسم الساق والورقة ((13.4، )شكل )(Explore: Plotsالفرعية الخاصة بالرسم )
(Stem-and-leaf( لأننا لسنا بحاجة إليه هنا، وفي الجزء السفلي للنافذة )Spread vs Level with Leven 

Testبدون تحويل 1( قم باختيار الخيار الرابع( ؛Untransformed ثم اضغط استمرار للعودة إلى نافذة )
  الاستكشاف الأولى.

(، ملاحظة إمكانية 13.4)يمكنك أيضتتتا، في الشتتتكل )
اختيتتتار عرض الرستتتتتتتتتتتتتتم الختتتاص بتتتاختبتتتار الطبيعيتتتة 

(Normality عن طرق رسم )QQ  جراء اختبارات وا 
الآن وفي نتتتتافتتتتذة  وذلتتتتك لكتتتتل مجموعتتتتة(.الطبيعيتتتتة، 

الاستتتتتتكشتتتتتاف قم بالضتتتتتغط على موافق فتظهر النتائج 
ول في نافذة المطلوبة في نافذة المخرجات. الجدول الأ

 SPSSالمخرجتتات كتتالمعتتتاد في معظم نتتتائج برنتتامج 
                                                 

 .الخيارات المتاحة لاختبار ليفين هي خيارات خاصة بتحويل قيم المتغير الأساسي الذي يضم المجموعات 1

 
 ".أسعار الشواحن: ملف بيانات "12.4شكل 

 

 ف.لنافذة الاستكشا النافذة الفرعية الخاصة بالرسم: 13.4شكل 
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بعدد المشتتتتتاهدات الموجودة والمفقودة في كل مجموعة ونستتتتتبها. أما الجدول الثاني فيضتتتتتم نتائج اختبار هو خاص 
((، وفي هذا الجدول نلاحظ أن العامود الأول إلى اليسار يضم تقسيم النتائج بحسب طريقة 10.4ليفين، )جدول )

 ( اعتمادا على الوسط الحسابي أو الوسيط أو غيرها من الخيارات.Wاب إحصاءة ليفين )حس

 ".أسعار الشواحن": نتائج اختبار ليفين لملف البيانات 10.4جدول 

Test of Homogeneity of Variance 

  

Levene 

Statistic df1 df2 Sig. 

 Based on Mean 8.810 2 27 .001 أسعار_الشواحن

Based on Median 4.435 2 27 .022 

Based on Median 

and with adjusted df 4.435 2 18.862 .026 

Based on trimmed 

mean 
8.608 2 27 .001 

القائلة بتساوي  الصفرية يمكننا القول بأنه يمكن رفض الفرضية (،P-value = 0.001)تحديدا ، من هذه النتائج
. وهذه في العموم كل متجرأسعار الشواحن مختلفة فيما بينها ضمن أننا نعتقد التباينات في المجتمع، بمعنى 

((، والذي يعرض توزيع المشاهدات لكل 14.4النتيجة يمكن ملاحظتها بصريا من خلال الشكل التالي، )شكل )
تلافا ( هي الأكثر اخAولاحظ أن أسعار الشواحن في المتجر الأول ) مجموعة )متجر( عن طريق شكل الصندوق.

(، Spread vs Level Plotوأما بالنسبة للتمثيل البياني الأخير في نافذة المخرجات، ) مقارنة بالمتجرين الآخرين.
فهو يظهر انتشار وسيطات المجموعات الثلاثة حيث تمثل النقطة الأولى )من اليسار( والذي لن يتم عرضه هنا، 

أيضا مدى اختلاف الأسعار في المتجر  حظ من ذلك الرسمستلا، و Aثم المجموعة  C، ثم المجموعة Bالمجموعة 
A .عن باقي المتاجر 

 
 ".أسعار الشواحن": شكل الصندوق للمجموعات الثلاثة في ملف بيانات 14.4شكل 
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ويمكن تنفيذ اختبار ليفين أيضا عند استخدام أسلوب تحليل التباين في اتجاه واحد. في شريط الأدوات العلوي قم 
وفي نافذة التحليل اضغط على الخيارات  Analyze>Compare Means>One-way ANOVAباختيار 

(Options( واختر منها اختبار تجانس التباين )Homogeneity of variance test .ثم اضغط استمرار )
 ((.11.4على النتيجة المطلوبة، )جدول ) اضغط موافق في النافذة الأصلية فتحصل

ر ليفين باستخدام أسلوب تحليل التباين، لملف نتائج اختبا: 11.4جدول 

 ".أسعار الشواحن"البيانات 
Test of Homogeneity of Variances 

    أسعار_الشواحن

Levene Statistic df1 df2 Sig. 

8.810 2 27 .001 

 (Contingency Tables and Test for Independency)جداول الاقتران واختبار الاستقلالية  3.4 

بحيث تمثل  ،بشكل صفوف وأعمدة متغيرينتنظيم عرض  اجداول يتم من خلاله جداول الاقتران هي
الصفوف مستويات )تقسيمات( المتغير الأول وتمثل الأعمدة مستويات المتغير الثاني، وتضم "الخلايا" الناتجة عن 

المتغيرات  عادة من تكوين جداول الاقتران ميتالتقاء الصفوف والأعمدة التكرارات الناتجة عن "اقتران" أي مستويين. و 
الوصفية، إلا أنه يمكن إعادة ترميز المتغيرات الكمية إلى وصفية ثم استخدامها لتكوين الاقتران، وسنبدأ بشرح 

 الحالة الأولى؛

 تكوين جداول الاقتران من متغيرات وصفية 1.3.4
(Contingency Tables from Categorical Variables) 

في يح طريقة تكوين جداول الاقتران من متغيرين وصفيين لنأخذ المثال التالي؛ البيانات التالية، )لتوض 
في أحد مصانع  عامل 90لعينة مكونة من  مستوى الإنتاج ومستوى الأرق ((، تمثل متغيرين هما 12.4جدول )

سط، ومرتفع، وتم تقسيم ، حيث تم تقسيم مستوى الأرق إلى ثلاثة مستويات هي منخفض، متو الحديد والصلب
 .جيد، و مقبول، ضعيفثلاثة مستويات أيضا هي مستوى الإنتاج إلى 

العمال بحسب مستويات الأرق، تكوين جدول اقتران لهذين المتغيرين بهدف التعرف على توزيع  أولا وكان المطلوب
لعمال وذلك من خلال التكرارات وتوزيع مستويات الإنتاج، وتوزيع مستويات الإنتاج مقترنة بمستويات الأرق عند ا

 والنسب لهذه المستويات.

الأرق". بحيث نعطي المتغير الأول  باسم "مستوى  SPSSسنبدأ بإدخال هذين المتغيرين في ملف بيانات جديد في 
ونعطي المتغير الثاني  ،على الترتيب جيد، و مقبول، ضعيف :للمستويات 3، و2، 1 :"مستوى_الإنتاج" القيم
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مع تعريف هذه القيم بنفس  متوسط، ومرتفع على الترتيب.منخفض،  :للمستويات 3، و2، 1 :رق" القيم"مستوى_الأ
 (.Variable View( في نافذة المتغيرات )Valuesالأسماء في عامود القيم )

 عامل في أحد المصانع. 90لعينة من  مستوى الإنتاج ومستوى الأرق : 12.4جدول 
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 1 مرتفع جيد 21 متوسط ضعيف 41 مرتفع ضعيف 61 متوسط جيد 81 منخفض جيد
 2 مرتفع ضعيف 22 متوسط مقبول 42 مرتفع ضعيف 62 منخفض مقبول 82 مرتفع ضعيف
 3 مرتفع ضعيف 23 مرتفع ضعيف 43 متوسط ضعيف 63 مرتفع ضعيف 83 فعمرت ضعيف
 4 منخفض جيد 24 مرتفع ضعيف 44 منخفض مقبول 64 متوسط جيد 84 منخفض مقبول
 5 مرتفع ضعيف 25 متوسط جيد 45 متوسط مقبول 65 مرتفع مقبول 85 متوسط مقبول
 6 متوسط مقبول 26 متوسط ضعيف 46 منخفض جيد 66 مرتفع جيد 86 منخفض جيد

 7 مرتفع مقبول 27 منخفض جيد 47 مرتفع ضعيف 67 منخفض مقبول 87 متوسط مقبول
 8 متوسط جيد 28 متوسط مقبول 48 مرتفع ضعيف 68 منخفض مقبول 88 منخفض جيد

 9 مرتفع جيد 29 منخفض ضعيف 49 مرتفع ضعيف 69 متوسط مقبول 89 متوسط مقبول
 10 مرتفع جيد 30 مرتفع جيد 50 مرتفع ضعيف 70 متوسط جيد 90 مرتفع ضعيف
 11 مرتفع ضعيف 31 مرتفع ضعيف 51 متوسط جيد 71 مرتفع ضعيف   
 12 متوسط ضعيف 32 متوسط ضعيف 52 متوسط ضعيف 72 مرتفع مقبول   
 13 منخفض مقبول 33 متوسط مقبول 53 منخفض جيد 73 مرتفع مقبول   
 14 متوسط مقبول 34 مرتفع فضعي 54 منخفض ضعيف 74 منخفض جيد   
 15 منخفض جيد 35 مرتفع ضعيف 55 منخفض مقبول 75 متوسط مقبول   
 16 مرتفع ضعيف 36 منخفض جيد 56 منخفض ضعيف 76 مرتفع جيد   
 17 مرتفع ضعيف 37 مرتفع ضعيف 57 منخفض مقبول 77 مرتفع ضعيف   
 18 متوسط لمقبو 38 متوسط مقبول 58 منخفض ضعيف 78 منخفض جيد   
 19 متوسط ضعيف 39 مرتفع مقبول 59 منخفض ضعيف 79 مرتفع ضعيف   
 20 منخفض جيد 40 متوسط جيد 60 منخفض مقبول 80 متوسط مقبول   

 Analyze>Descriptiveالأن لتكوين جتتتتدول الاقتران للمتغيرين، قم في شتتتتتتتتتتتتتتريط الأدوات العلوي بتتتتاختيتتتتار 

Statistics>Crosstabs فتظهر النتتتتتتافتتتتتتذة ،
الختتتتتاصتتتتتتتتتتتتتتتتتتتة بتكوين الجتتتتتداول المشتتتتتتتتتتتتتتتركتتتتتة 

(Crosstabs( كما نرى في شتتتتتكل ،)15.4 .)
فتتي تتتلتتتتتتتك التتنتتتتتتتافتتتتتتتذة، قتتم بتتنتتقتتتتتتتل التتمتتتتتغتتتيتتتر 
"مستتتتتتتتتتتتتتتتتتتوى_الأرق" إلتتى متتربتتع الصتتتتتتتتتتتتتتتتفتتوف 

(Row(s) "ونقل المتغير "مستتتتتتتتوى_الإنتاج ،)
 (.Column(s)إلى مربع الأعمدة )

 
 الاقتران.النافذة الخاصة بتكوين جداول : 15.4شكل 
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( فتظهر النافذة الفرعية الخاصتتتتتتتتتتتة باختيار ما نود إظهاره في Cellsعلى خيار الخلايا ) في تلك النافذة اضتتتتتتتتتتتغط
قم في ((، 16.4المطلوب، )شتتتتتتتتتتتتتتكتتل ) جتتدول الاقتران

 لصتتتفوف والأعمدةلتلك النافذة باختيار إظهار النستتتب 
( كما هو Percentagesالنستتتتب ) في مربع والمجموع

ثم اضتتغط استتتمرار للعودة للنافذة  موضتتح في الشتتكل.
نافذة يمكننا وفي تلك ال ((.15.4)الستتتتتتتتتتتابقة، )شتتتتتتتتتتتكل 

إضتتتتتتتتتافة تمثيل الأعمدة البيانية بحستتتتتتتتتب التقستتتتتتتتتيمات 
للمتغيرين، وذلتتتتك بتتتتاختيتتتتار عرض الأعمتتتتدة البيتتتتانيتتتتة 

( في Display clustered bar chartsالمصتتتتتتنفة )
 النافذة. قم بعد ذلك بالضتتتتتتتتتتتتتتغط على موافق.أستتتتتتتتتتتتتتفل 

ستتتتتتتتتظهر بعد ذلك النتائج في نافذة المخرجات، بحيث 
أما الجدول الثاني في المخرجات،  يحتوي الجدول الأول على عدد المشتتتتتتتتتتتتاهدات الفعلية والقيم المفقودة ونستتتتتتتتتتتتبها.

 .توى_الإنتاج" و"مستوى_الأرق"للمتغيرين "مسالخاص بالمتغيرين الوصفيين ((، فهو جدول الاقتران 13.4)جدول )

 " و"مستوى_الأرق" في ملف البيانات "مستوى الأرق".مستوى_الإنتاج: جدول الاقتران للمتغيرين "13.4جدول 
 Crosstabulationمستوى_الأرق * مستوى_الإنتاج 

  
 مستوى_الإنتاج

Total جيد مقبول ضعيف 
 Count 5 9 12 26 منخفض مستوى_الأرق 

% within  100.0 %46.2 %34.6 %19.2 مستوى_الأرق% 
% within 28.9 %48.0 %32.1 %13.5 مستوى_الإنتاج% 
% of Total 5.6% 10.0% 13.3% 28.9% 

 Count 7 14 7 28 متوسط
% within  100.0 %25.0 %50.0 %25.0 مستوى_الأرق% 
% within 31.1 %28.0 %50.0 %18.9 مستوى_الإنتاج% 
% of Total 7.8% 15.6% 7.8% 31.1% 

 Count 25 5 6 36 مرتفع
% within  100.0 %16.7 %13.9 %69.4 مستوى_الأرق% 
% within 40.0 %24.0 %17.9 %67.6 مستوى_الإنتاج% 
% of Total 27.8% 5.6% 6.7% 40.0% 

Total Count 37 28 25 90 
% within  100.0 %27.8 %31.1 %41.1 مستوى_الأرق% 
% within 100.0 %100.0 %100.0 %100.0 مستوى_الإنتاج% 
% of Total 41.1% 31.1% 27.8% 100.0% 

 
 الاقتران.جداول  في خيار الخلايانافذة : 16.4شكل 
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في كل خلية في الجدول. هذه القيم هي التكرار، النسبة للصف، النسبة للعامود، والنسبة قيم  أربعةونلاحظ وجود 
أرق منخفض(، نجد أن عدد العمال الذين هم  ى ومستو  ضعيفللكل. فمثلا في الخلية الأولى؛ )مستوى إنتاج 

بالنسبة للعمال الذين لديهم مستوى  19.2عمال، ويمثلون % 5ولديهم مستوى أرق منخفض عددهم  ضعيفإنتاجهم 
 بالنسبة لكل العمال. 5.6، ويمثلون %ضعيفبالنسبة للعمال الذين مستوى إنتاجهم  13.5أرق منخفض، ويمثلون %

عن توزيع العمال بحسب مستويات الإنتاج  من جدول الاقتران ول على العديد من المعلوماتيمكننا الحصوبالتالي، 
 ما يلي: أهمهامستويات الأرق و 

  ومستوى الأرق  ضعيفالخلية التي لها أعلى نسبة للمجموع هي التي تمثل العمال الذين مستوى إنتاجهم
من الأرق في النوم بصورة كبيرة يكون  يعانون  (، وهذا يعني أن العمال الذين27.8%لديهم مرتفع )

. ويؤيد تلك النتيجة أيضا نسبة المجموع للعمال الذين مستوى إنتاجهم جيد مستوى إنتاجهم ضعيف
 (.13.3%ومستوى الأرق لديهم منخفض )

  وهي نسبة تُعد كبيرة، أما نسبة العمال الذين لديهم  40هي % مرتفعنسبة العمال الذين لديهم مستوى أرق
من  71.1، وبالتالي فإنه بجمع هتين النسبتين يمكن القول بأن %31.1ى أرق متوسط فهي %مستو 

 العمال يعانون من مستويات أرق متوسطة إلى مرتفعة في النوم.

 % أي أقل من ثلث العمال، ونسبة العمال الذين إنتاجهم  27.8نسبة العمال الذين إنتاجهم جيد هو
 .لسيس للإنتاج في هذا المصنعالوضع اوهذا يعكس  41.1ضعيف هو %

((، فهي الأعمدة البيانية المصنفة بحسب مستويات الإنتاج 17.4أما النتيجة الأخيرة في نافذة المخرجات، )شكل )
 سابقا بشكل مرئي.النتائج المذكورة  تمثل هذه الأعمدةو  ومستويات الأرق لدى العمال.

 
 "مستوى الأرق".يانات : الأعمدة البيانية المصنفة لملف الب17.4شكل 
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 (Contingency Tables from Quantitative Variables) كميةتكوين جداول الاقتران من متغيرات  2.3.4

في بعض الدراسات، قد نقوم بتحويل بعض المتغيرات الكمية إلى وصفية، أي إلى مستويات، وذلك بهدف  
النوع من المتغيرات، أو بهدف الحصول على تلخيص بعض الأساليب الإحصائية التي تتطلب هذا استخدامها في 

متغيران كميان، لنأخذ المثال من ولتكوين جدول اقتران من متغير كمي وآخر وصفي أو  لنمط معين في البيانات.
 التالي؛

شخصا إضافة  60أعمار عينة مكونة من ( و Vit. D( تمثل معدلات فيتامين دال )14.4البيانات في الجدول )
ناث.لتصنيفهم   ذكور وا 

 .شخصا 60( وأعمار عينة مكونة من Vit. Dمعدلات فيتامين دال ): 14.4جدول 

نوع
ال

 

ن 
امي

فيت
دل 

مع
مر دال
الع

 

نوع 
ال

 

ن 
امي

فيت
دل 

مع
مر دال
الع

 

نوع 
ال

 

ن 
امي

فيت
دل 

مع
مر دال
الع

 

 

 1 53 26 ذكر 21 55 26 أنثى 41 72 26 ذكر

 2 61 28 ذكر 22 69 29 أنثى 42 28 81 أنثى

 3 81 20 ذكر 23 68 20 أنثى 43 39 66 رذك

 4 25 51 أنثى 24 58 36 ذكر 44 27 20 أنثى

 5 20 30 أنثى 25 57 25 أنثى 45 48 24 أنثى

 6 71 25 أنثى 26 24 79 ذكر 46 67 29 أنثى

 7 80 21 أنثى 27 20 20 أنثى 47 25 20 أنثى

 8 65 28 ذكر 28 90 20 أنثى 48 39 78 ذكر

 9 30 74 ذكر 29 26 25 أنثى 49 46 23 أنثى

 10 22 80 ذكر 30 35 34 أنثى 50 58 26 أنثى

 11 77 26 ذكر 31 38 39 أنثى 51 67 80 ذكر

 12 50 30 أنثى 32 56 25 ذكر 52 81 28 ذكر

 13 65 24 ذكر 33 47 75 ذكر 53 36 45 ذكر

 14 23 22 أنثى 34 30 26 أنثى 54 35 69 ذكر

 15 61 26 ذكر 35 25 77 ذكر 55 24 20 أنثى

 16 46 24 أنثى 36 68 29 أنثى 56 31 84 ذكر

 17 31 76 ذكر 37 35 79 ذكر 57 21 80 ذكر

 18 35 78 ذكر 38 26 80 ذكر 58 84 32 ذكر

 19 26 80 ذكر 39 24 24 أنثى 59 78 75 ذكر

 20 48 23 أنثى 40 39 36 أنثى 60 88 77 ذكر



 

122 

 

يران "معدل فيتامين دال"، )المقاس بوحدة نانومول( و"العمر"، )المقاس بالسنة( ونلاحظ من هذه البيانات أن المتغ
هما متغيران كميان، ولتكوين جدول اقتران خاص بهما يجب أولا تحويلهما إلى متغيرات وصفية تأخذ مستويات 

 محددة.

، )شكل "فيتامين دالاسم "ب SPSSفي  ( في ملف بيانات جديد14.4لنقم أولا بإدخال المتغيرات الثلاثة من جدول )
( Valuesللإناث، ثم تعريف تلك القيم في خانة القيم ) 2للذكور والقيمة  1بحيث يتم إعطاء القيمة ((، 18.4)

  وسنعطي المتغيرات الثلاثة الأسماء "العمر"، "فيتامين_دال"، و"النوع". ،كالمعتاد

إعادة ترميز القيم في في الجزء الخاص بو في الفصل الثاني، 
، (Recode into Different Variableمتغير مختلف )

تناولنا كيفية تكوين متغير جديد عن طريق تعريف قيم أو 
سنقوم أيضا مستويات جديدة له من المتغير الأصلي، وهنا 

 ؛يدانبتعريف متغيران جد

بالنسبة للمتغير الأول، "العمر"، سنقوم بتحويله إلى متغير يأخذ 
 30(، )من 30ثلاثة مستويات هي الفئات العمرية؛ )أقل من 

لترميز  3، و2، 1، وسنستخدم القيم فأكثر( 51(، و)50إلى 
 الفئات العمرية السابقة على التوالي.

أقل من ات الثلاثة المُعدة من قِبل الأطباء المتخصصين وهي )وأما المتغير "فيتامين_دال" فسيتم إعطائه المستوي
( ويصنف فيها الشخص 75إلى  30وفيها يصنف الشخص بأنه يعاني من نقص في فيتامين دال، و)من  (30

 الطبيعي لفيتامين دال عند الإنسان البالغ. ى ( وهو المستو 75بأن مستوى فيتامين دال غير كافي، و)أكثر من 
للمستوى )أكثر من  3( والقيمة 75إلى  30للمستوى )من  2( والقيمة 30للمستوى )أقل من  1ة وسنعطي القيم

75.) 

 إعادة ترميز في متغير مختلف( من شريط الأوامر العلوي، ثم اختر Transform) تحويلالآن قم باختيار أمر 
(Recode into Different Variables ستظهر عندها نافذة إعادة الترميز في .) متغير جديد، كما يُشاهد في

(. وفي خانة Numeric Variableسنقوم باختيار المتغير "العمر"، ونقله إلى مربع المتغيرات ) (.19.4الشكل )
فئات " وكتابة "الفئة_العمرية( إلى اليمين، لنقم بتسمية المتغير الجديد بالاسم "Output Variableالمتغير المُخرج )

مربع (، فيلاحظ حدوث هذا التغيير في Change) تغيير(، ثم نضغط على أمر Label" في مربع الوصف )العمر
 .الفئة_العمرية" >-- العمرحيث سيظهر فيها النص " المتغيرات

 

 
"العمر"، "فيتامين_دال"، : المتغيرات 18.4شكل 

 في ملف البيانات "فيتامين دال". "و"النوع
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 ".فيتامين دال: نافذة إعادة الترميز في متغير مختلف لملف البيانات "19.4شكل 

ا في المتغير الجديد باستخدام قيم متغير "العمر"، فنقوم باختيار بعد ذلك سنقوم بتعريف القيم التي نود إعادة كتابته
(، فتظهر نافذة جديدة كما يُرى 19.4( في الشكل )Old and New Valuesوالجديدة ) أمر تعريف القيم القديمة

 (.20.4في الشكل )

نة، نحتاج لاستخدام الخيار س 30في هذه النافذة، لتعيين القيمة الأولى، والتي تشمل كل الأعمار التي هي أقل من 
(. فنكتب أولا القيمة المحددة للتصنيف الأول وهي Range, LOWEST through value) القيمة فأقل ،المدى
سنة مباشرة  30الأقل من  1، )وهي القيمة29(، ثم نكتب القيمة New Valueفي خانة القيمة الجديدة ) 1القيمة 

 .(Add) إضافةثم نضغط في متغير العمر(، 

 

 إعادة الترميز في متغيرلمتغير "العمر" في خيار  القيم القديمة والجديدةنافذة تعريف : 20.4شكل 
 ".فيتامين دالمختلف لملف البيانات "

                                                 
فإن هذا التصنيف سيشمل على العمر  (Range, LOWEST through value)في خانة  30ا تم كتابة القيمة ننوه هنا إلى أنه إذا م 1

 سنة من ضمنه. 30
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خانة في  2سنة، نكتب القيمة  50إلى  30للتصنيف الثاني وهو الأعمار من  2لتعيين القيمة الثانية، وهي القيمة 
( فتظهر خانتان فارغتان أسفل منه. يتم Range) المدىثم نضغط على الخيار  (New Valueالقيمة الجديدة )
 (.Addفي الخانة السفلى والضغط على ) 50في الخانة العليا والقيمة  30إدخال القيمة 

 سنة فأكثر، نكتب 51الأشخاص الذين أعمارهم  تمثلللتصنيف الثالث، و  3ولتعيين القيمة الثالثة، وهي القيمة 
 ,Range) المدى، القيمة فأكبر منثم نضغط على الخيار  (New Valueخانة القيمة الجديدة )في  3القيمة 

value through HIGHEST)  51ونكتب فيه القيمة( ثم نضغط على ،Add وبعد الانتهاء من تعيين كل .)
لك للنافذة السابقة، )شكل سنعود بعد ذ (.Continueالقيم المحددة للتصنيفات السابقة نضغط على استمرار )

((، نقوم بعدها بالضغط على موافق فيظهر المتغير الجديد "الفئة_العمرية" في نافذة عرض البيانات في 19.4)
 ملف البيانات "فيتامين دال".

 (Valuesفي عامود القيم ) 3، و2، 1الآن وللانتهاء من تعريف المتغير الجديد "الفئة_العمرية"، قم بتعريف القيم 
 فأكثر(. 51(، و)50إلى  30(، )من 30( للمستويات الثلاثة؛ )أقل من Variable Viewفي نافذة المتغيرات )

وبنفس الكيفية، سنقوم بتعريف متغير جديد لتحويل متغير "فيتامين_دال" إلى متغير وصفي ذو ثلاثة من جديد، 
( سنقوم باختيار ifferent VariablesRecode into D) 1إعادة ترميز في متغير مختلفمستويات. في نافذة 

 Output(. وفي خانة المتغير المُخرج )Numeric Variableالمتغير "فيتامين_دال"، ونقله إلى مربع المتغيرات )

Variable إلى اليمين، نقوم بتسمية المتغير الجديد بالاسم "مستويات_فيتامين_دال" وكتابة "مستويات فيتامين )
لاحظ حدوث هذا التغيير في مربع ن(، فChange) تغيير(، ثم نضغط على أمر Label)دال" في مربع الوصف 

 مستويات_فيتامين_دال". >--المتغيرات حيث سيظهر فيها النص "فيتامين_دال 

 Old and Newوالجديدة ) بعد ذلك نقوم بتعريف قيم المتغير الجديد فنقوم باختيار أمر تعريف القيم القديمة

Values )نانومول 30التي هي أقل من  معدلات فيتامين دال، والتي تشمل كل 1وهي  ن القيمة الأولىتعيي ثم ،
في خانة القيمة  1نكتب القيمة و  (،Range, LOWEST through value) القيمة فأقل ،المدىالخيار  في

 إضافةنضغط  ثم(، مباشرة نانومول 30، )وهي القيمة الأقل من 29(، ثم نكتب القيمة New Valueالجديدة )
(Add.) 

                                                 
 اتبصورة متتالية في نفس الجلسة لملف بيانات ما، فإنك ستلاحظ وجود الخيارات والإعداد SPSSعند استخدام الأوامر في برنامج  1

جراء التي قمت بها موجودة كما هي، وهذ ه الخاصية قد تكون مفيدة في كثير من الأحيان عندما تقوم بتكرار تحليل إحصائي معين وا 
تغييرات محددة، أما في حالات أخرى، مثل المثال الحالي، فإننا نكون بحاجة لإلغاء ما تم تعريفه للمتغير السابق وكتابة التعريفات 

 الجديدة.
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في  2نانومول، نكتب القيمة  75إلى  30للتصنيف الثاني وهي المعدلات من  2لتعيين القيمة الثانية، وهي القيمة 
( فتظهر خانتان فارغتان أسفل منه. Range) المدىثم نضغط على الخيار  (New Valueخانة القيمة الجديدة )

 (.Addفي الخانة السفلى والضغط على ) 75القيمة في الخانة العليا و  30يتم إدخال القيمة 

نانومول،  75للتصنيف الثالث، وهي معدلات فيتامين دال التي هي أكثر من  3ولتعيين القيمة الثالثة، وهي القيمة 
 ,Range) المدى، القيمة فأكبر منثم نضغط على الخيار  (New Valueخانة القيمة الجديدة )في  3القيمة  نكتب

value through HIGHEST)  76ونكتب فيه القيمة( ثم نضغط على ،Add وبعد الانتهاء من تعيين كل .)
(. سنعود بعد ذلك للنافذة السابقة، )شكل Continueالقيم المحددة للتصنيفات السابقة نضغط على استمرار )

" في نافذة عرض ((، نقوم بعدها بالضغط على موافق فيظهر المتغير الجديد "مستويات_فيتامين_دال19.4)
البيانات في ملف البيانات "فيتامين دال"، وللانتهاء من تعريف المتغير الجديد "مستويات_فيتامين_دال"، قم بتعريف 

( للمستويات الثلاثة؛ )أقل Variable Viewفي نافذة المتغيرات )( Valuesفي عامود القيم ) 3، و2، 1القيم 
 (.21.4شكل )، ويكون الشكل النهائي لملف البيانات "فيتامين دال"، (75( و)أكثر من 75إلى  30(، )من 30من 

 
: ملف البيانات "فيتامين دال" بعد تعريف المتغيرين الجديدين "الفئة_العمرية" 21.4شكل 

 و"مستويات_فيتامين_دال".

ال" إلى متغيرين وصفيين بعد أن تم تحويل المتغيران الكميان "العمر" و"فيتامين_دال" في ملف البيانات "فيتامين د
 رتبيين، سنقوم الآن بتكوين جدول الاقتران لهما؛

، فتظهر النافذة Analyze>Descriptive Statistics>Crosstabsقم في شريط الأدوات العلوي باختيار 
ربع (. في تلك النافذة، قم بنقل المتغير "الفئة العمرية" إلى مCrosstabsالخاصة بتكوين الجداول المشتركة )

 (.Column(s)(، ونقل المتغير "مستويات_فيتامين_دال " إلى مربع الأعمدة )Row(s)الصفوف )
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قم باختيار إظهار النسب للصفوف والأعمدة والمجموع في و ( Cellsاضغط في تلك النافذة على خيار الخلايا )
 ار للعودة للنافذة السابقة.ثم اضغط استمر  ،(Percentagesمربع النسب )

إضافة تمثيل الأعمدة البيانية بحسب التقسيمات للمتغيرين، وذلك باختيار عرض الأعمدة ب قملك النافذة وفي ت 
 ( في أسفل النافذة. قم بعد ذلك بالضغط على موافق.Display clustered bar chartsالبيانية المصنفة )

ى عدد المشاهدات الفعلية والقيم ستظهر بعد ذلك النتائج في نافذة المخرجات، بحيث يحتوي الجدول الأول عل
(، ومنه نستطيع ملاحظة 15.4أما الجدول الثاني فهو جدول الاقتران، والذي يظهر في جدول ) المفقودة ونسبها.

الذين لديهم نقص حاد في معدل فيتامين  سنة فأكثر( 15النسبة الأكثر بروزا هي نسبة الأشخاص الأكبر سنا )أن 
 (.%31.7دال، )

 جدول الاقتران للمتغيرين "الفئة_العمرية" و"مستويات_فيتامين_دال" في ملف البيانات "فيتامين دال". :15.4جدول 
 Crosstabulationفئات العمر * مستويات فيتامين دال 

  

 مستويات فيتامين دال

Total  75أكثر من  75إلى  30من  30أقل من 

فئات 

 العمر
 Count 7 2 7 16 30أقل من 

% within 100.0 %43.8 %12.5 %43.8 فئات العمر% 

% within  مستويات فيتامين

 دال
21.9% 14.3% 50.0% 26.7% 

% of Total 11.7% 3.3% 11.7% 26.7% 

إلى  30من 

50 

Count 6 9 5 20 

% within 100.0 %25.0 %45.0 %30.0 فئات العمر% 

% within  مستويات فيتامين

 دال
18.8% 64.3% 35.7% 33.3% 

% of Total 10.0% 15.0% 8.3% 33.3% 

 Count 19 3 2 24 فأكثر 51

% within 100.0 %8.3 %12.5 %79.2 فئات العمر% 

% within  مستويات فيتامين

 دال
59.4% 21.4% 14.3% 40.0% 

% of Total 31.7% 5.0% 3.3% 40.0% 

Total Count 32 14 14 60 

% within لعمرفئات ا  53.3% 23.3% 23.3% 100.0% 

% within  مستويات فيتامين

 دال
100.0% 100.0% 100.0% 100.0% 

% of Total 53.3% 23.3% 23.3% 100.0% 

((، ملاحظة ارتفاع هذه النسبة مقارنة بالنسب أو 22.4كما يمكن، من الأعمدة البيانية المصنفة للمتغيرين )شكل )
 التكرارات الأخرى.
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 للمتغيرين "الفئة_العمرية" و"مستويات_فيتامين_دال" في ملف البيانات "فيتامين دال".: الأعمدة البيانية المصنفة 22.4 شكل

 

 (Test for Independency)اختبار الاستقلالية  3.3.4

ية، لوصفيُعد اختبار الاستقلالية من الاختبارات الهامة المستخدمة في دراسة العلاقات بين المتغيرات ا 
وتُعرف  (.Pearson's Chi-Square Test) بيرسون مربع كايباستخدام جداول الاقتران، ويُعرف أيضا باختبار 

 بالصورة؛ ،((c-1)(r-1)والتي تتبع توزيع مربع كاي بدرجات حرية تساوي ) ،إحصاءة الاختبار الخاصة به

𝜒𝑐
2 = ∑

(𝑜𝑖 − 𝑒𝑖)
2

𝑒𝑖

𝑟𝑐

𝑖=1

 

𝑒𝑖هو التكرار المشاهد في الخلية،  𝑜𝑖حيث  =
مجموع العامود× مجموع الصف

المجموع الكلي
=عدد r ،هو التكرار المتوقع للخلية 

 .=عدد الأعمدةc والصفوف، 

، 0H: توجد استقلالية بين المتغيرين )الصفوف والأعمدة(ويتم في اختبار الاستقلالية اختبار الفرضية الصفرية؛ 
رفض الفرضية الصفرية يعني وجود علاقة ذات معنوية بين بعض أو كل مستويات المتغيرين في  إنف وبالتالي

 جدول الاقتران.

في تنفيذ اختبار الاستقلالية، سنعرف بعض المقاييس الإحصائية التي تستخدم كمقاييس إضافية لدراسة  ءوقبل البد
مقاييس وتسمى  مة إحصاء مربع كاي في حسابها،، والتي تعتمد على قيالارتباط بين متغيري جدول الاقتران

 ؛(Measures of Association based on Chi-Square) الترابط بناء على مربع كاي
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 (Phi Coefficient) فايمعامل  1.3.3.4

 معامل فاي للارتباط بالصورة التالية:يعرف  

𝜑 = √
𝜒𝑐

2

𝑛
 

𝜒𝑐حيث 
هو عدد المشاهدات )التكرارات( الكلي  nسوبة من جدول الاقتران، و هي قيمة إحصاءة مربع كاي المح 2

من الصفر كلما دل ذلك على ضعف العلاقة بين المتغيرين الوصفيين،  𝜑في جدول الاقتران. وكلما اقتربت قيمة 
 كلما اقتربت من الواحد الصحيح كلما دل ذلك على قوة العلاقة.بالمقابل و 

 (Contingency Coefficient)معامل الاقتران  2.3.3.4

 Pearson's Contingency) بمعامل الاقتران لبيرسون ، والذي يُعرف أيضا معامل الاقتران 

Coefficient،)  هو أيضا أحد المقاييس التي تستخدم لقياس درجة العلاقة بين متغيري جدول الاقتران، ويعتمد
 ة:أيضا مثل معامل فاي على إحصاءة مربع كاي، ويُعرف بالصور 

𝐶 = √
𝜒𝑐

2

𝑛 + 𝜒𝑐
2
 

𝜒𝑐حيث 
هو عدد التكرارات الكلي في جدول الاقتران. وينطبق عليه ما ينطبق  nهي قيمة إحصاءة مربع كاي ، و  2

على معامل كاي في التعليق على قيمته المحسوبة. ويمكننا أيضا ملاحظة العلاقة بين صيغتي كل من المعاملين 
 كالتالي:

𝐶 = √
𝜑2

1 + 𝜑2
 

 V (Cramer's V Coefficient)كرامر معامل  3.3.3.4

 في حسابه على إحصاءة مربع كاي، بالصورة التالية:هو الآخر ، والذي يعتمد Vيُعرف معامل كرامر  

𝑉 = √
𝜒𝑐

2

𝑛𝑘
 

𝜒𝑐حيث 
هو الحد الأدنى لعدد  k، و هو عدد التكرارات الكلي في جدول الاقتران n، هي قيمة إحصاءة مربع كاي 2

ويكون التعليق على قيمته كما هو الحال مع  .k =Min.(r,cالصفوف وعدد الأعمدة في جدول الاقتران، أي أن )
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ويمكن ملاحظة العلاقة بين صيغتي كل من معامل كرامر  المعاملين السابقين، معامل فاي ومعامل الاقتران.
 ومعامل فاي كالتالي:

𝑉 = √
𝜑2

𝑘
 

 (Kendall's Tau Coefficient)كندل تاو معامل  4.3.3.4

وهو معامل يُستخدم أيضا لحساب الارتباط بين متغيرين وصفيين، إلا أنه يتميز تحديدا بالتعامل مع  
 سنتناولها فيما يلي: طبيعة جدول الاقتران. وتتوفر لهذا المعامل ثلاثة صيغ بحسب المتغيرات الوصفية الرتبية

 ل تاومعامل كند B (Kendall's Tau-B) 

، )التي تتساوى فيها عدد مستويات الصفوف والأعمدة(. وتُعرف جداول الاقتران المربعةفي ويستخدم عادة 
 صيغة المعامل بالصورة:

𝜏𝑏 =
𝑃 − 𝑄

𝑛(𝑛 − 1)
2

 

( المتوافقة هما عدد الأزواج )من الخلايا 𝑄و  𝑃هو عدد التكرارات الكلي في جدول الاقتران، و  nحيث 
(Concordant( وغير المتوافقة )Discordant على الترتيب. ولتوضيح كيفية حساب هاتين القيمتين من جداول )

، أي التي تحتوي على صفين وعامودين، )حيث أن حساب القيمتين من الجداول الأكبر 2×2الاقتران ذات الحجم 
 ((؛16.4جدول الاقتران ذو القيم الافتراضية التالي، )جدول ) اعتبرحجما يكون أكثر تعقيدا باستخدام الحل اليدوي(، 

 بالصورة التالية: 𝑄و  𝑃لهذا الجدول، يتم حساب قيم كل من 

𝑃 = 𝑏 × 𝑐  و𝑄 = 𝑎 × 𝑑 

 

 عامل كندل تاوم B  مع التصحيح في حالة التساوي(Kendall's Tau-B with correction for ties) 

 .𝑄و 𝑃تساوي قيم وهو نفس المعامل السابق مع إضافة تصحيح في الحسابات للخلايا عند 

 

 

 افتراضي. 2×2: جدول اقتران 16.4جدول 
   المتغير الأول

   1المستوى  2المستوى 

b a  1المستوى 
 المتغير الثاني

d c  2المستوى 
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 معامل كندل تاو C (Kendall's Tau-C) 

التي يكون فيها عدد الصفوف وعدد الأعمدة  ، أيجداول الاقتران غير المربعةويستخدم هذا المعامل في 
 غير متساوي، ويأخذ الصيغة التالية:

𝜏𝑐 =
𝑃 − 𝑄

𝑛2(min(𝑟, 𝑐) − 1)2 min (𝑟, 𝑐)
 

,min(𝑟حيث  𝑐) .هي القيمة الأقل للصفوف والأعمدة 

لأقرب للواحد الصحيح، تكون وكما هو الحال مع معاملات الارتباط السابقة، فإن القيمة الأعلى لمعامل كندل، أي ا
𝑃مؤشرا على قوة العلاقة بين المتغيرين، ونظرا لوجود امكانية أن تكون  < 𝑄  فإن معامل كندل قد يأخذ القيمة

 السالبة، وهذا يكون مؤشرا على وجود علاقة عكسية بين المتغيرين.

 (Gamma Coefficient)جاما معامل  5.3.3.4

أيضا مثل معامل كندل، وتُعرف  𝑄و  𝑃ن متغيري جدول الاقتران على قيم يعتمد معامل جاما للارتباط بي 
 صيغته كالتالي:

𝛾 =
𝑃 − 𝑄

𝑃 + 𝑄
 

 كما هو الحال مع معامل كندل. 1و -1وتكون قيمته محصورة بين 

ستخدم ولن ،تنفيذ اختبار الاستقلالية لجداول الاقتران مع حساب معاملات الارتباط السابقةخطوات الآن سنقوم بشرح 
الأخير؛ "فيتامين دال". في هذا الملف، سنبدأ باختبار العلاقة بين المتغيرين "مستويات_فيتامين_دال"  ملف البيانات

 و"الفئة_العمرية".

، فتظهر النافذة Analyze>Descriptive Statistics>Crosstabsفي شريط الأدوات العلوي قم باختيار 
(. في تلك النافذة، قم بنقل المتغير "الفئة العمرية" إلى مربع Crosstabsالخاصة بتكوين الجداول المشتركة )

 (.Column(s)(، ونقل المتغير "مستويات_فيتامين_دال " إلى مربع الأعمدة )Row(s)الصفوف )

 ((،23.4، )شكل )نافذة جديدة( في يمين النافذة، فتظهر Statisticsالآن قم بالضغط على خيار الإحصاءات )
بجداول الاقتران. ولاحظ أننا قمنا في يار اختبار مربع كاي للاستقلالية ومعاملات الارتباط المتعلقة خاصة باخت

 .Cو  Bومعاملي كندل تاو  Vمل الاقتران ومعاملي فاي وكرامر اتلك النافذة باختيار اختبار مربع كاي، ومع
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ية. ولاحظ أننا لن نقوم باختيار إظهار ( للعودة للنافذة الأصلContinueنضغط بعد تلك الاختيارات استمرار )
( لأنه قد سبق التطرق لها. الآن اضغط Cellsمن خيار الخلايا ) مجاميع الصفوف والأعمدةالخلايا ونسب نسب 

 موافق في النافذة الأصلية للحصول على النتائج المطلوبة.

 
نافذة اختيار اختبار الاستقلالية ومعاملات الارتباط : 23.4شكل 

 ول الاقتران.لجدا

ستظهر في نافذة المخرجات أربعة جداول؛ الجدول الأول يمثل عدد المشاهدات الفعلية والقيم المفقودة ونسبها، 
، )جدول والجدول الثاني هو جدول الاقتران للمتغيرين "مستويات_فيتامين_دال" و"الفئة_العمرية"، والجدول الثالث

𝜒𝑐ستقلالية، ولاحظ من الصف الأول من الجدول أن يضم نتائج اختبار مربع كاي للا ((،17.4)
2 = 16.552 

بين  استقلاليةالقائلة بوجود  ( وهذا يدفعنا لرفض الفرضية الصفريةP-value = 0.002وأن القيمة الاحتمالية )
شخاص الاستدلال بوجود علاقة ذات أهمية بين معدلات فيتامين دال وأعمار الأدة(، و المتغيرين )الصفوف والأعم

(، نستطيع تأكيد انخفاض 22.4( وشكل )15.4في العموم. وبربط هذه النتيجة مع ما توصلنا له من جدول )
 سنة فأكبر. 51معدلات فيتامين دال لدى الأشخاص في الفئة العمرية 

للمتغيرين "مستويات_فيتامين_دال"  اختبار مربع كاي للاستقلاليةنتيجة : 17.4جدول 
 ملف البيانات "فيتامين دال".ل و"الفئة_العمرية"

Chi-Square Tests 

  Value df 

Asymptotic 

Significance (2-

sided) 

Pearson Chi-Square 16.552a 4 .002 

Likelihood Ratio 16.285 4 .003 

Linear-by-Linear Association 7.956 1 .005 

N of Valid Cases 60     
a. 4 cells (44.4%) have expected count less than 5. The minimum expected count is 3.73. 
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في حساب قيمة  5قيمها أقل من  (ieتكرارات متوقعة ) 4والملاحظة الموجودة في أسفل الجدول هي للتنبيه بوجود 
 إحصاءة مربع كاي.

معاملات الارتباط الخاصة فيضم النتائج الخاصة بقيم ((، 18.4، )جدول )في نافذة المخرجات أما الجدول الرابع
( لكل المعاملات، نجد أن جميعها أقل P-valueبجدول الاقتران للمتغيرين المعنيين. وبالنظر إلى قيم الاحتمالية )

وبالتالي نستطيع القول بوجود علاقة ذات معنوية عالية بين معدلات فيتامين دال والفئة العمرية. ولاحظ  0.05من 
ت مثل معامل فاي ومعامل الاقتران، ولاحظ أيضا الإشارة السالبة لمعاملات كندل مما ارتفاع قيم بعض المعاملا

 يدل على وجود علاقة عكسية بين المتغيرين.

 لملف "فيتامين دال".ل ،"مستويات_فيتامين_دال" و"الفئة_العمرية" : معاملات الارتباط لجدول الاقتران للمتغيرين18.4جدول 
Symmetric Measures 

  

Value 

Asymptotic 

Standardized 

Errora 

Approximate Tb 
Approximate 

Significance 

Nominal by 

Nominal 

Phi .525     .002 

Cramer's V .371     .002 

Contingency Coefficient .465     .002 

Ordinal by 

Ordinal 

Kendall's tau-b -.347 .114 -3.020 .003 

Kendall's tau-c -.329 .109 -3.020 .003 

N of Valid Cases 60       
a. Not assuming the null hypothesis. 

b. Using the asymptotic standard error assuming the null hypothesis. 

 

 إضافية تصنيف اتاختبار الاستقلالية باستخدام متغير  4.3.4
(Test for Independency using additional Classification Variables) 

 أو أكثر في بعض الدراسات، قد نكون بحاجة لتحليل العلاقة بين متغيرين وصفيين بوجود متغير ثالث 
مستويات يمكن تصنيف العلاقة بين المتغيرين الأساسيين بناء عليها، ولتوضيح الفكرة لنعد لملف  يتضمن/تتضمن

ننا سنقوم الآن باختبار العلاقة بين المتغيرين "مستويات_فيتامين_دال" البيانات "فيتامين دال" مرة أخرى، حيث أ
وأهمية هذه الخطوة تكمن في التحقق من أنه إذا أم أنثى،  كان و"الفئة_العمرية" بناء على تصنيف الشخص ذكر

 على تلك العلاقة أم لا. "أثر"ما وجدت علاقة قوية بين المتغيرين الأساسيين فهل للمتغير الثالث 

، فتظهر النافذة Analyze>Descriptive Statistics>Crosstabsفي شريط الأدوات العلوي قم باختيار 
قم بنقل المتغير "الفئة العمرية"  ((،24.4)شكل ) (. في تلك النافذة،Crosstabsالخاصة بتكوين الجداول المشتركة )

( كما Column(s)" إلى مربع الأعمدة )(، ونقل المتغير "مستويات_فيتامين_دالRow(s)إلى مربع الصفوف )
( Layer 1 of 1الطبقات ) نفذناه سابقا، ولتعريف المتغير الثالث، متغير "النوع"، قم بنقل هذا المتغير إلى مربع

 في أسفل النافذة كما هو موضح في الشكل.
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 .الاقترانالنافذة الخاصة بتكوين جداول في  تعريف متغير تصنيف إضافي: 24.4شكل 

( الظاهر في Nextفي هذا المربع باستخدام زر التالي ) إضافة أكثر من متغير تصنيفوننوه هنا إلى أنه يمكن 
 النافذة إذا ما تتطلب الأمر، إلا أنه في مثالنا الحالي لدينا متغير تصنيف إضافي واحد فقط وهو "النوع".

 V، ومعمل الاقتران ومعاملي فاي وكرامر ( قم باختيار اختبار مربع كايStatisticsفي خيار الإحصاءات )
((، قم من جديد بالنقر 24.4جدول الاقتران، )شكل )ثم اضغط استمرار. وفي نافذة  Cو Bومعاملي كندل تاو 
( وتأكد من عدم اختيار إظهار النسب لعدم الحاجة لها حاليا، ثم اضغط استمرار وفي Cellsعلى خيار الخلايا )

 (، ثم اضغط موافق.Display clustered bar chartsرض الأعمدة البيانية المصنفة )النافذة الأصلية اختر ع

قد تم تقسيمه بحسب الذكور )القسم الأول من ((، 19.4في نافذة المخرجات، نلاحظ أن جدول الاقتران، )جدول )
 الجدول(، والإناث )القسم الثاني(، والكل )القسم الثالث(.

التكرارات، )أو النسب إذا ما أردنا(، للذكور على حده أو الإناث. إلا أنه من عيوب ويمكن من هذا الجدول مراقبة 
هذا التقسيم أن بعض الخلايا ستكون فيها التكرارات مساوية للصفر وخاصة في العينات الصغيرة كما هو الحال 

 في جدولنا الحالي.

سنة فأكثر  51كان للذكور الذين أعمارهم  (10( أن التكرار الأعلى للذكور )19.4وأهم ما يُلاحظ في الجدول )
نانومول  30نانومول. وأما بالنسبة للإناث، فمعدلات الفيتامين التي تقل عن  30ومستوى فيتامين دال لديهم أقل من 

 كانت متوزعة بصورة متقاربة للفئات العمرية الثلاثة.
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باستخدام متغير "النوع"  فئة_العمرية""مستويات_فيتامين_دال" و"ال : جدول الاقتران للمتغيرين19.4جدول 
 كمتغير تصنيف، )ملف البيانات "فيتامين دال"(.

 Crosstabulationفئات العمر * مستويات فيتامين دال * النوع 
Count       

 النوع
 مستويات فيتامين دال

Total  75أكثر من  75إلى  30من  30أقل من 
فئات  ذكر

 العمر
 6 6 0 0 30أقل من 

 10 5 5 0 50إلى  30من 
 15 2 3 10 فأكثر 51

Total 10 8 13 31 
فئات  أنثى

 العمر
 10 1 2 7 30أقل من 

 10 0 4 6 50إلى  30من 
 9 0 0 9 فأكثر 51

Total 22 6 1 29 
Total  فئات

 العمر
 16 7 2 7 30أقل من 

 20 5 9 6 50إلى  30من 
 24 2 3 19 فأكثر 51

Total 32 14 14 60 

 فنلاحظ فيه ما يلي؛((، 20.4أما الجدول التالي في نافذة المخرجات، )جدول )

  للمتغيرين "مستويات_فيتامين_دال" و"الفئة_العمرية" اختبار مربع كاي للاستقلاليةنتيجة  : 20.4جدول 
 باستخدام متغير "النوع" كمتغير تصنيف، )ملف البيانات "فيتامين دال"(.

Chi-Square Tests 

 Value df النوع
Asymptotic 

Significance (2-sided) 
 Pearson Chi-Square 22.584b 4 .000 ذكر

Likelihood Ratio 27.207 4 .000 
Linear-by-Linear Association 15.888 1 .000 
N of Valid Cases 31    

 Pearson Chi-Square 6.635c 4 .156 أنثى
Likelihood Ratio 8.300 4 .081 
Linear-by-Linear Association 2.627 1 .105 
N of Valid Cases 29    

Total Pearson Chi-Square 16.552a 4 .002 
Likelihood Ratio 16.285 4 .003 
Linear-by-Linear Association 7.956 1 .005 
N of Valid Cases 60    

a. 4 cells (44.4%) have expected count less than 5. The minimum expected count is 3.73. 

b. 8 cells (88.9%) have expected count less than 5. The minimum expected count is 1.55. 

c. 6 cells (66.7%) have expected count less than 5. The minimum expected count is .31. 
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𝜒𝑐القسم الأول من الجدول، الخاص بالذكور، نرى أن من الصف الأول في 
2 = وأن القيمة الاحتمالية  22.584

(0 value =-Pوهذا يدفعنا لرفض الفرضية الصفرية ) 0:توجد استقلالية بين المتغيرين )للذكور( ؛H،  والقول بوجود
الصف الأول في القسم الثاني من ومن علاقة ذات أهمية بين معدلات فيتامين دال وأعمار الرجال في العموم. 

𝜒𝑐الجدول، الخاص بالإناث، نرى أن 
2 = ( وهذا يدفعنا لقبول P-value = 0.156وأن القيمة الاحتمالية ) 6.635

والقول بعدم وجود علاقة بين معدلات فيتامين ،  0H:؛ توجد استقلالية بين المتغيرين )للإناث( الفرضية الصفرية
 .(21.4وتتأكد هذه النتائج من خلال حساب معاملات الارتباط في جدول )ي العموم. دال وأعمار النساء ف

باستخدام متغير "النوع"  "مستويات_فيتامين_دال" و"الفئة_العمرية" معاملات الارتباط لجدول الاقتران للمتغيرين: 21.4جدول 
 كمتغير تصنيف، )ملف البيانات "فيتامين دال"(.

Symmetric Measures 

 Value لنوعا

Asymptotic 

Standardized 

Errora 

Approximate 

Tb 

Approximate 

Significance 

 ذكر
Nominal by 

Nominal 

Phi .854    .000 

Cramer's V .604    .000 

Contingency 

Coefficient 
.649    .000 

Ordinal by 

Ordinal 

Kendall's tau-b -.694 .089 -7.148 .000 

Kendall's tau-c -.665 .093 -7.148 .000 

N of Valid Cases 31    

 أنثى
Nominal by 

Nominal 

Phi .478   .156 

Cramer's V .338   .156 

Contingency 

Coefficient 
.431   .156 

Ordinal by 

Ordinal 

Kendall's tau-b -.269 .136 -1.797 .072 

Kendall's tau-c -.203 .113 -1.797 .072 

N of Valid Cases 29     

Total 
Nominal by 

Nominal 

Phi .525    .002 

Cramer's V .371    .002 

Contingency 

Coefficient 
.465    .002 

Ordinal by 

Ordinal 

Kendall's tau-b -.347 .114 -3.020 .003 

Kendall's tau-c -.329 .109 -3.020 .003 

N of Valid Cases 60     

a. Not assuming the null hypothesis. 

b. Using the asymptotic standard error assuming the null hypothesis. 

"مستويات_فيتامين_دال" حيث نلاحظ من الجدول، )في القسم الأول(، أن جميع معاملات الارتباط للمتغيرين 
(، وهذا P-value=0عند الذكور، إضافة لكونها ذات معنوية، )كل القيم الاحتمالية قيمها مرتفعة  و"الفئة_العمرية"

 يدل على وجود علاقة قوية بين المتغيرين عند الرجال.

((، فالوضع على النقيض، إذ نلاحظ أن جميع القيم الاحتمالية 21.4أما عند النساء، )في القسم الثاني من الجدول )
P-value>0.05عند  "مستويات_فيتامين_دال" و"الفئة_العمرية"لقول بعدم وجود علاقة معنوية بين ، مما يدفعنا ل

 النساء.
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وهذه النتائج يمكن ملاحظتها بصورة مرئية من خلال الأعمدة البيانية المصنفة لكل من الذكور والإناث في الشكل 
(25.4.) 

  
ية" و"مستويات_فيتامين_دال" للذكور )إلى اليمين(، والإناث )إلى للمتغيرين "الفئة_العمر : الأعمدة البيانية المصنفة 25.4شكل 

 اليسار(، )ملف البيانات "فيتامين دال"(.

وكخلاصة لما سبق من النتائج الخاصة بدراسة العلاقة بين متغيري "مستويات_فيتامين_دال" و"الفئة_العمرية"، 
ية المصنفة، اختبار الاستقلالية، ومعاملات الارتباط )والتي تشمل جدول الاقتران المتضمن للنسب، الأعمدة البيان

لجدول الاقتران بوجود متغير تصنيف النوع(، نستطيع القول بوجود علاقة عكسية قوية بين معدلات فيتامين دال 
 وأعمار الرجال، حيث أن الرجال الذين اجتازوا الخمسين عاما هم أكثر عرضة لنقص فيتامين دال في أجسامهم.

 (Analysis of Variance (ANOVA))ل التباين تحلي 4.4

يُعد مفهوم تحليل التباين من المفاهيم الهامة والأساسية في نظرية الاستدلال الإحصائي، حيث أنه يعتمد  
من خلال تحليل الاختلاف بين تلك المتوسطات، (، ثلاثة فأكثر، )عدة مجتمعات على مقارنة تساوي متوسطات

(، أو تحليل الاختلاف بين المتوسطات One-way ANOVAتباين في اتجاه واحد )وهو ما يُعرف بتحليل ال
 .(Two-way ANOVA، وهو ما يُعرف بتحليل التباين في اتجاهين )وداخل المجتمعات )أو المجموعات( معا
 وسنبدأ بشرح كيفية تنفيذ التحليل الأول؛

 (One-way ANOVA)تحليل التباين في اتجاه واحد  1.4.4

 ،SPSSم ملف البيانات "معدلات الطلبة" لتوضيح كيفية تنفيذ تحليل التباين في اتجاه واحد في سنستخد
حيث يمثل "معدل_الطالب" المتغير الرئيسي أو التابع في التحليل ويمثل "القسم_العلمي" متغير تقسيم المجموعات 

وسيكون الهدف هو  (.PHوالفيزياء )(، ST(، الإحصاء )MAوالتي تمثل الأقسام العلمية الثلاثة؛ الرياضيات )
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 التحقق من تجانس/اختلاف المستوى الدراسي للطلبة في الأقسام الثلاثة، أي اختبار الفرضية الصفرية:
  𝐻0: 𝜇𝑀𝐴 = 𝜇𝑆𝑇 = 𝜇𝑃𝐻 

فتظهر نافذة  ،Analyze>Compare Means>One-Way ANOVAفي شريط الأوامر العلوي، قم باختيار 
(. قم في تلك النافذة بنقل 26.4كما يوضح الشكل ) (One-way ANOVAتباين في اتجاه واحد )تحليل ال

( ونقل المتغير "القسم_العلمي" Dependent Listالمتغير "معدل_الطالب" إلى المربع الخاص بالمتغير التابع )
 (.Factorإلى المربع الخاص بمتغير التصنيف أو المجموعات )

 
 لملف البيانات "معدلات الطلبة".تحليل التباين في اتجاه واحد نافذة : 26.4شكل 

((، قم فيها باختيار عرض 27.4( فتظهر النافذة الفرعية التالية، )شكل )Optionsالخيارات ) أمراضغط على 
( Homogeneity of variance test( واختبار تساوي التباينات )Descriptiveالمقاييس الإحصائية الوصفية )
في مواضع سابقة في (، وهذه الخيارات في الواقع قد تم التطرق إليها Means plotوالتمثيل البياني للمتوسطات )

اختيار ما سبق اضغط الكتاب إلا أننا نقوم باختيارها هنا لتكون جزء مكملا لنتائج تحليل التباين. بعد الانتهاء من 
 استمرار للعودة للنافذة الأصلية للتحليل.

حيث أننا نقوم حاليا باختبار تستتتتتتاوي ثلاثة متوستتتتتتطات، فمن 
المتوقع أن تكون إما كلها متستتتتاوية، )وهذا ما ينتج عن قبول 
الفرضية الصفرية لاختبار تحليل التباين(، أو أن نرفض تلك 

جود متوستتتتتتتتتتطان الفرضتتتتتتتتتتية الصتتتتتتتتتتفرية والذي ستتتتتتتتتتينتج عنه و 
متستتتتتتاويان على الأقل، بمعنى أننا في مثالنا الحالي ستتتتتتنكون 
بحاجة لاختبار تستتتتتتتتاوي المتوستتتتتتتتطات في ثلاثة حالات هي؛ 

𝐻0: 𝜇𝑀𝐴 = 𝜇𝑆𝑇  ،𝐻0: 𝜇𝑀𝐴 = 𝜇𝑃𝐻و ،𝐻0: 𝜇𝑆𝑇 =

𝜇𝑃𝐻 بمعنى اختبار تساوي المستوى الدراسي للطلبة في كل ،
 لى حده، وهو ما يتم باستخدام اختبار تساوي الأوساط في مجتمعين كما شرحنا سابقا في هذا الفصل.قسمين ع

 
تحليل التباين  الخيارات ضمن نافذة نافذة: 27.4شكل 

 .في اتجاه واحد
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لذلك، وكخطوة استباقية، سنقوم باختيار تنفيذ هذه الاختبارات "الفرعية" للحصول على معلومات إضافية تساعدنا 
العلمية. ولعمل ذلك قم باختيار خيار  في الحكم النهائي على مدى تجانس المستوى الدراسي للطلبة في الأقسام

 ((؛28.4(، والذي سيُظهر النافذة الفرعية التالية، )شكل )Post Hocالتحليل البَعدي )

 
 .تحليل التباين في اتجاه واحدالتحليل البَعدي في نافذة : 28.4شكل 

(، ويمكن التحكم بمستوى المعنوية Bonferroni) اختبارات المقارنة المتعددة لبونفيرونيقم في تلك النافذة باختيار 
على مستوى المعنوية الافتراضي وهو  هنا سنبقيو ( في أسفل النافذة، Significance levelالمطلوب من مربع )

 استمرار للعودة للنافذة الأصلية، وفي تلك النافذة اضغط موافق. قم بعدها بالضغط على .0.05

((، يضم 22.4والجدول الأول في هذه النتائج، )جدول )ذة المخرجات، ستظهر بعد ذلك النتائج المطلوبة في ناف
القيم المحسوبة للمعدلات في كل قسم من الأقسام الثلاثة، وهذه القيم تشمل الوسط الحسابي، الانحراف المعياري، 

رى والكبرى الخطأ المعياري لتقدير الوسط الحسابي، فترة الثقة لتقدير الوسط الحسابي للمجتمع، والقيمة الصغ
 .لنفس البيانات للمعدلات. وهذه المقاييس قد تم التعليق عليها في الفصل الثالث

 لملف البيانات "معدلات الطلبة".بعض المقاييس الإحصائية لمعدلات الطلبة في الأقسام العلمية : 22.4جدول 
Descriptives 

 معدل الطالب
       

  N Mean 

Std. 

Deviation Std. Error 

95% Confidence 

Interval for Mean 

Minimum Maximum 

Lower 

Bound 

Upper 

Bound 

MA 30 2.0027 .67117 .12254 1.7520 2.2533 1.26 3.67 

ST 30 1.6463 .25022 .04568 1.5529 1.7398 1.15 2.18 

PH 30 1.6857 .21144 .03860 1.6067 1.7646 1.26 2.31 

Total 90 1.7782 .45550 .04801 1.6828 1.8736 1.15 3.67 
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يمثل نتيجة اختبار تجانس تباينات معدلات الطلبة في ((، 23.4والجدول الثاني في نافذة المخرجات، )جدول )
-Pة الثلاثة باستخدام اختبار ليفين، ومنه نستنتج وجود اختلاف بين تباينات معدلات الطلبة، )الأقسام العلمي

value = 0.) 

: اختبار تجانس التباينات لليفن لمعدلات الطلبة في الأقسام في 23.4جدول 
 ملف البيانات "معدلات الطلبة".

Test of Homogeneity of Variances 

    معدل الطالب
Levene Statistic df1 df2 Sig. 

14.098 2 87 .000 

تحليل الإحصائي وهو جدول تحليل التباين فيمثل النتيجة الرئيسية في هذا ال((، 24.4أما الجدول الثالث، )جدول )
 في اتجاه واحد.

ملف لمعدلات الطلبة في الأقسام الثلاثة في تحليل التباين في اتجاه واحد : جدول 24.4جدول 
 البيانات "معدلات الطلبة".

ANOVA 

      معدل الطالب

  

Sum of 

Squares df Mean Square F Sig. 

Between Groups 2.290 2 1.145 6.159 .003 

Within Groups 16.176 87 .186     

Total 18.466 89       

ومن هذا الجدول يمكننا الجزم بوجوب رفض الفرضية الصفرية القائلة بتساوي المتوسطات الثلاثة، )حيث أن القيمة 
قسمان على  (، وهذا يدل على وجود متوسطان مختلفان على الأقل، )أي وجودP-value =0.003الاحتمالية 

اختبارات المقارنة  وهذا يدفعنا لإجراءالأقل يختلف فيهما مستوى الطلبة الدراسي(، ضمن المتوسطات الثلاثة. 
 (؛25.4المتعددة للمتوسطات في الجدول التالي، جدول )

ملف  في أقسام الرياضيات، الإحصاء، والفيزياء في اختبارات المقارنة المتعددة للمتوسطات: جدول 25.4جدول 
 البيانات "معدلات الطلبة".

Multiple Comparisons 

Dependent 

Variable:  
معدل 

      الطالب
Bonferroni       

(I) قسم الطالب 

Mean 

Difference 

(I-J) 

Std. Error Sig. 

95% Confidence Interval 

Lower Bound Upper Bound 

MA 
ST .35633* .11133 .006 .0846 .6281 

PH .31700* .11133 .017 .0452 .5888 

ST 
MA -.35633-* .11133 .006 -.6281 -.0846 

PH -.03933 .11133 1.000 -.3111 .2324 

PH 
MA -.31700-* .11133 .017 -.5888 -.0452 

ST .03933 .11133 1.000 -.2324 .3111 
*. The mean difference is significant at the 0.05 level. 

 :ما يلي ومن هذا الجدول يتبين لنا
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وجود اختلاف بين معدلات الطلبة في قسمي الرياضيات والإحصاء، حيث أن القيمة الاحتمالية لاختبار  .1
𝐻0: 𝜇𝑀𝐴 = 𝜇𝑆𝑇  مما يدفعنا لرفض هذه الفرضية الصفرية. 0.006هي 

ء أيضا، حيث أن القيمة الاحتمالية وجود اختلاف بين معدلات الطلبة في قسمي الرياضيات والفيزيا .2
:𝐻0لاختبار  𝜇𝑀𝐴 = 𝜇𝑃𝐻  جعلنا نرفض الفرضية الصفرية.يمما  0.017هي 

وجود تكافؤ بين معدلات الطلبة في قسمي الإحصاء والفيزياء، حيث أن القيمة الاحتمالية لاختبار الفرضية  .3
𝐻0: 𝜇𝑆𝑇 = 𝜇𝑃𝐻  الفرضية الصفرية. وبالتالي نقبل 1.00هي 

 والنتيجة الأخيرة في نافذة المخرجات،
التمثيل البياني  تُظهر(، 29.4) شكل

لأقسام ا المعدلات في لمتوسطات
العلمية الثلاثة، ونلاحظ فيها بوضوح 
مدى اختلاف )ارتفاع( متوسط 

رياضيات معدلات الطلبة في قسم ال
 عن قسمي الإحصاء والفيزياء.

 

 

 (Two-way ANOVA)هين تحليل التباين في اتجا 2.4.4

في اتجاه واحد، رأينا كيف أن الاهتمام كان متركزا على دراسة الاختلاف بين عدة في تحليل التباين  
ين، فإنه إضافة لاختبار مجموعات، )والتي تكون عادة ممثلة بأعمدة البيانات(، أما في تحليل التباين في اتجاه

، أي كأننا ندرس الأعمدة واختبار الصفوف، )كاتجاه واحد أيضا(، فإننا نقوم بدراسة تداخل الأعمدة والصفوف معا
 ولتوضيح كيفية تنفيذ تحليل التباين في اتجاهين لنأخذ المثال التالي؛ .العلاقة بين متغيرين

طفلا بالسنتيمتر تم تقسيمهم إلى خمسة مجموعات  20كونة من أطوال عينة م( تمثل 26.4البيانات في الجدول )
، وبداخل كل (Milk1, Milk2, …, Milk5)نوع محدد من الحليب  كل مجموعة تم إعطاؤها ،ة الجدول()أعمد

بواقع نوع  (Vit.D1, …, Vit.D4مجموعة من هذه المجموعات الخمسة تم اعتماد أربعة أنواع من فيتامين دال )
يتامين لكل طفل، )وهو ما تمثله صفوف الجدول(، وذلك خلال عدة سنوات، بمعنى أن الطفل الأول واحد من الف

( Milk1سم، قد تم إعطاؤه نوع الحليب ) 95في العينة، )القيمة الأولى في أعلى يسار الجدول(، والذي طوله 
 (، وهكذا.Vit.D1ونوع الفيتامين )

 
 : التمثيل البياني لمتوسطات الأقسام الثلاثة.29.4شكل 
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، بحيث يتم تعريف ثلاثة متغيرات "أطوال الأطفالباسم " SPSSي ملف جديد في سنقوم أولا بإدخال هذه البيانات ف
 كالتالي:

  المتغير الأول، باسم "طول_الطفل"، ويمثل أطوال جميع الأطفال في العينة، حيث يتم إدخال قيم العامود
 (.Milk5( تحتها، وهكذا حتى العامود الخامس )Milk2( أولا ثم قيم العامود الثاني )Milk1الأول )

  المتغير الثاني، باسم "نوع_الحليب"، ويمثل نوع حليب الأطفال المعطى لكل طفل، حيث سيتم إعطاء
التي ستعطى لآخر أربعة  5لثاني أربعة أطفال، وهكذا حتى القيم  2لأول أربعة أطفال، والقيمة  1القيمة 

 على الترتيب في خانة (Milk5( إلى )Milk1التعريف ) 5إلى  1أطفال. مع ملاحظة إعطاء القيم من 
 ( في نافذة المتغيرات.Values) القيم

  المتغير الثالث، باسم "نوع_الفيتامين"، ويمثل نوع الفيتامين المعطى لكل طفل، حيث سيتم إعطاء القيم
 4إلى  1لكل أربعة أطفال بدء من الأعلى، إلى الأسفل. مع ملاحظة إعطاء القيم من  4، 3، 2، 1

 ( في نافذة المتغيرات.Values( على الترتيب في خانة القيم )Vit.D4( إلى )Vit.D1التعريف )

 ((؛30.4عند الانتهاء سيأخذ ملف البيانات الشكل التالي، )شكل )

 
 .SPSS: ملف البيانات "أطوال_الأطفال" في 30.4شكل 

في شريط  Analyze>General Linear Model>Univariateولتنفيذ تحليل التباين في اتجاهين، اختر 
 ((؛31.4الأدوات العلوي فتظهر النافذة التالية، )شكل )

 م.متر بحسب نوع الحليب ونوع الفيتامين المستخدَ أطوال عينة من الأطفال بالسنتي: 26.4جدول 
   نوع حليب الأطفال

Milk5 Milk4 Milk3 Milk2 Milk1   
100 96 93 101 95 Vit.D1 

 Vit.D2 97 100 98 97 94 نوع فيتامين دال

122 118 125 116 120 Vit.D3 

87 89 93 88 90 Vit.D4 
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 : نافذة تحليل التباين في اتجاهين لملف البيانات "أطوال_الأطفال".31.4شكل 

(، والمتغيران Dependent Variableفي هذه النافذة، قم باختيار المتغير "طول_الطفل" كمتغير تابع )
 .السابق ( كما هو موضح في الشكلFixed Factor(s)يتامين" كمتغيرات تقسيم )"نوع_الحليب" و"نوع_الف

((، وسنقوم بتنفيذ 32.4( فتظهر نافذة فرعية، )كما يظهر في الشكل )Modelالآن اضغط على خيار النموذج )
 :، كما يظهر فيهاأربعة أمور في تلك النافذة

 (.Custom) ( إلى مخصصSpecify Modelتغير خيار تحديد النموذج ) .1

 ( إلى اليمين.Model"نوع_الحليب" و"نوع_الفيتامين" إلى مربع النموذج )نقل كل من المتغيرين  .2

 (.Build Term(s)( من النافذة التي هي في المنتصف )All 2-wayاختيار النوع اتجاهين ) .3

 ( في أسفل النافذة.Include intercept in modelاختيار عدم إظهار ثابت النموذج ) .4

 عد تنفيذ الخطوات السابقة، اضغط استمرار للعودة للنافذة الأصلية.وب
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 : نافذة اختيار نوع النموذج في تحليل التباين في اتجاهين لملف البيانات "أطوال_الأطفال".32.4شكل 

طات ( لاختيار عرض التغير في المتوسPlots((، قم بالنقر على خيار الرسم )31.4في النافذة الأصلية، )شكل )
لأطوال الأطفال مرة مع نوع الحليب ومرة مع نوع الفيتامين ومرة أخرى مع الاثنين في آن واحد. لتنفيذ ذلك، قم 

 :((33.4، )في الشكل )بالخطوات الثلاثة التالية

( لاختيار Add( ثم اضغط إضافة )Horizontal Axisتغير "نوع_الحليب" إلى المحور الأفقي )انقل الم .1
 عرض رسم هذا المتغير.

بتتتتتتتالتتتتمتتتتثتتتتتتتل انتتتتقتتتتتتتل التتتتمتتتتتتتتتغتتتتيتتتتر  .2
"نوع_الفيتتتتتتتتامين" إلى المحور 

( Horizontal Axisالأفقي )
( Addثم اضتتتتتتتتتتتتتغط إضتتتتتتتتتتتتتافة )

لاختيتتتتتتتار عرض رستتتتتتتتتتتتتتم هتتتتتتتذا 
 المتغير أيضا.

يب" الآن انقل المتغير "نوع_الحل .3
من جديد في خانة المحور 

 (Horizontal Axis) الأفقي
 (.Addثم اضغط إضافة ) (Separate Linesوالمتغير "نوع_الفيتامين" إلى خانة الخطوط المنفصلة )

 
 : نافذة اختيار عرض الرسم في تحليل التباين في33.4شكل 

 اتجاهين لملف البيانات "أطوال_الأطفال".
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وفي تلك النافذة اضغط من جديد خيار التحليل ((، 31.4، )شكل )بعد ذلك اضغط استمرار للعودة للنافذة الأصلية
قم بعدها باختيار إجراء مقارنات بين ((، 34.4(، والذي سيُظهر نافذة فرعية جديدة، )شكل )Post Hocالبَعدي )

أوساط مستويات المتغيرين "نوع_الحليب" و"نوع_الفيتامين" عن طريق نقلهما إلى مربع اختبارات التحليل البعدي 
(Post Hoc Tests forثم اختيار ،)  إجراء اختبارات المقارنة المتعددة لبو( نفيرونيBonferroni والضغط ،)

 على استمرار. وفي النافذة الأصلية اضغط موافق.

 

 : نافذة اختيار المقارنات المتعددة للأوساط في34.4شكل 
 تحليل التباين في اتجاهين لملف البيانات "أطوال_الأطفال".

تقسيم المستويات في جدول البيانات ستظهر النتائج المطلوبة بعد ذلك في نافذة المخرجات. الجدول الأول يُظهر 
 وعدد القيم في كل مستوى.

 يل التباين في اتجاهين.((، هو الجدول الأساسي في مجموعة النتائج ويمثل جدول تحل27.4الجدول الثاني، )جدول )

 : نتائج جدول تحليل التباين في اتجاهين لملف البيانات "أطوال_الأطفال".27.4جدول 
Tests of Between-Subjects Effects 

Dependent Variable: طول_الطفل     

Source Type III Sum of Squares df Mean Square F Sig. 

Model 206497.900a 8 25812.238 2516.221 .000 

 882. 285. 2.925 4 11.700 نوع_الحليب

 000. 86.699 889.383 3 2668.150 نوع_الفيتامين

Error 123.100 12 10.258   

Total 206621.000 20    

a. R Squared = .999 (Adjusted R Squared = .999) 

 :نستنتج منهأهم ما و 
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أن تأثير أنواع الحليب الخمسة  أي عدم وجود اختلاف بين أطوال الأطفال نتيجة لاختلاف أنواع الحليب، .1
 متساوي على نمو الأطفال، بمعنى قبول الفرضية الصفرية:

𝐻0: 𝜇𝑀𝑖𝑙𝑘1 = 𝜇𝑀𝑖𝑙𝑘2 = 𝜇𝑀𝑖𝑙𝑘3 = 𝜇𝑀𝑖𝑙𝑘4 = 𝜇𝑀𝑖𝑙𝑘5 
 .P-value = 0.882للاختبار حيث أن القيمة الاحتمالية 

 
وجود اختلاف ذو معنوية بين أطوال الأطفال نتيجة لاختلاف أنواع الفيتامين المستخدم، أي أن تأثير  .2

 و الأطفال، بمعنى رفض الفرضية الصفرية:أنواع الفيتامين الأربعة غير متساوي على نم

𝐻0: 𝜇𝑉𝑖𝑡.𝐷1 = 𝜇𝑉𝑖𝑡.𝐷2 = 𝜇𝑉𝑖𝑡.𝐷3 = 𝜇𝑉𝑖𝑡.𝐷4 
 .P-value = 0حيث أن القيمة الاحتمالية للاختبار 

ل الخاص والنتيجة السابقة تدفعنا للتحقق من أنواع الفيتامين التي المختلفة فيما بينها وذلك عن طريق ملاحظة الجدو 
 (؛28.4بالمقارنات المتعددة للمتغير "نوع_الفيتامين" في الجدول )

لملف البيانات : المقارنات المتعددة بين متوسطات أنواع الفيتامين في تحليل التباين في اتجاهين 28.4جدول 
 "أطوال_الأطفال".

Multiple Comparisons 

Dependent 

Variable:  
      طول_الطفل

Bonferroni 
      

(I) نوع_الفيتامين 
Mean 

Difference 

(I-J) 

Std. Error Sig. 

95% Confidence Interval 

Lower 

Bound 

Upper 

Bound 

Vit.D1 Vit.D2 -.20 2.026 1.000 -6.59 6.19 

Vit.D3 -23.20-* 2.026 .000 -29.59 -16.81 

Vit.D4 7.60* 2.026 .017 1.21 13.99 

Vit.D2 Vit.D1 .20 2.026 1.000 -6.19 6.59 

Vit.D3 -23.00-* 2.026 .000 -29.39 -16.61 

Vit.D4 7.80* 2.026 .014 1.41 14.19 

Vit.D3 Vit.D1 23.20* 2.026 .000 16.81 29.59 

Vit.D2 23.00* 2.026 .000 16.61 29.39 

Vit.D4 30.80* 2.026 .000 24.41 37.19 

Vit.D4 Vit.D1 -7.60-* 2.026 .017 -13.99 -1.21 

Vit.D2 -7.80-* 2.026 .014 -14.19 -1.41 

Vit.D3 -30.80-* 2.026 .000 -37.19 -24.41 

Based on observed means. 

 The error term is Mean Square (Error) = 10.258. 

*. The mean difference is significant at the 0.05 level. 

 تطيع ملاحظة التالي:من هذا الجدول، نس
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 نوعي الفيتامين الثالث والرابع وكل من (Vit.D1نوع الفيتامين الأول ) وجود اختلاف معنوي بين .1
(Vit.D3 وVit.D4) ، حيث أن القيمة الاحتمالية الخاصة باختبار تساوي المتوسطات هي أقل من

0.05. 

(، حيث Vit.D2ع الفيتامين الثاني )( ونو Vit.D1عدم وجود اختلاف معنوي بين نوع الفيتامين الأول ) .2
 .0.05أن القيمة الاحتمالية الخاصة باختبار تساوي المتوسطات هي أكبر من 

( وكل من نوعي الفيتامين الثالث والرابع Vit.D2وجود اختلاف معنوي بين نوع الفيتامين الثاني ) .3
(Vit.D3 وVit.D4حيث أن القيمة الاحتمالية الخاصة باختبار تساوي ا ،) لمتوسطات هي أقل من

0.05. 

( وكل أنواع الفيتامين الأخرى، حيث أن القيمة Vit.D3وجود اختلاف معنوي بين نوع الفيتامين الثالث ) .4
 .0.05الاحتمالية الخاصة باختبار تساوي المتوسطات هي أقل من 

بالتغير في ، الخاص (35.4وهذه النتائج يمكن ملاحظتها أيضا بصورة مرئية من خلال التمثيل البياني، شكل )
 .ينأنواع الفيتاممتوسطات و  متوسطات أنواع الحليب

 

 
 : التمثيل البياني للأوساط في تحليل التباين في اتجاهين للمتغيرات في ملف البيانات "أطوال_الأطفال".35.4شكل 
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 الفصل الخامس

 تحليل الارتباط والانحدار الخطي

 (Linear Correlation and Regression Analysis) 

 

، البيانات ضمن المتغيرات فيإن من أهم المفاهيم التي يرتكز عليها علم الإحصاء هو دراسة العلاقات  
فصل، سنستعرض كيفية تنفيذ تحليل وتحليلها، وتكوين النماذج التي تفسر العلاقات السببية بينها. وفي هذا ال

 .SPSSالارتباط والانحدار الخطي باستخدام برنامج 

 (Linear Correlation Analysis)تحليل الارتباط الخطي  1.5

يستخدم تحليل الارتباط لدراسة العلاقات بين المتغيرات، وذلك من خلال حساب معامل )مقياس كمي(  
والذي بدوره يعكس من خلال قيمته نوع وقوة العلاقة  (Correlation Coefficient) بمعامل الارتباطيسمى 

الارتباط  إلى طبيعة العلاقة بين المتغيراتالموجودة بين المتغيرات. ويمكن تصنيف دراسة الارتباط من حيث 
 .(Linear and Non Linear Correlation) الخطي وغير الخطي

والتي يمكن تمثيلها  الدراسة قات الخطية بين متغيراتالارتباط الخطي هو الذي يهتم بدراسة العلاف
𝑦  :من الدرجة الأولى؛ )مثلارياضية بمعادلات  = 3𝑥 − (، وهذا النوع من الارتباط هو الذي سيتم تناوله في 1

 :. أما الارتباط غير الخطي فهو يدرس العلاقات التي تمثلها معادلات غير خطية؛ )مثلاالفصل من الكتابهذا 
𝑦 = 3𝑥2 − 𝑦 أو  1 = 5𝑒𝑥.) 

الارتباط البسيط، إلى  معامل الارتباط وعدد المتغيراتطبيعة وكذلك يمكن تصنيف دراسة الارتباط من حيث 
الارتباط البسيط هو الذي يدرس ؛ ف(Simple, Partial, and Multiple Correlation) الجزئي، والمتعدد

بين متغيرين بوجود تأثير لمتغير أو أكثر على هذين المتغيرين،  العلاقة بين متغيرين فقط، والجزئي يدرس العلاقة
 أما الارتباط المتعدد فهو يقيس العلاقة بين مجموعة من المتغيرات في آن واحد.

هي تمثيل قيم المتغيرات بيانيا وهو ما و  الرسمدراسة الارتباط بين المتغيرات بطريقتين؛ طريقة مراقبة أو عادة  يتمو 
والطريقة الثانية هي الطريقة الجبرية وذلك بحساب قيمة معامل الارتباط  (.Scatter Plot) نتشاربشكل الا يعرف 

 من خلال الصيغة الحسابية الخاصة بالمعامل.
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 (Analyzing Correlation by Scatterplot) شكل الانتشاردراسة الارتباط باستخدام  1.1.5

النقاط  رسم يتم عن طريق باستخدام شكل الانتشار لمتغيرين ن طريق التمثيل البيانيدراسة الارتباط عإن  
 معامل الارتباط الخطي ةانعكاسا لقيم هذا يعدو ، (2Dعدين )في ب   (Y) والصادي (X) على محوري الرسم السيني

 لنأخذ المثال التالي؛ SPSSولتوضيح كيفية تنفيذ ذلك في  في الواقع.

ونذكر القارئ هنا بأن هذه البيانات تضم ثمانية متغيرات " يانات الطلبةببفتح ملف البيانات " SPSSقم في برنامج 
، 1طالبا في إحدى الكليات، وهذه المتغيرات هي تقديرات الطلبة في ثلاثة مقررات دراسية؛  35لعينة مكونة من 

عدد ، و برة الطالعدد أفراد أس، ترتيب الفصل الدراسي للطالب، جنس الطالب، عمر الطالب بالسنوات، 3، و2
 الحجرات في منزل الطالب.

سنقوم أولا بإضافة متغير جديد لهذه البيانات بهدف تعزيز مفهوم العلاقة بين المتغيرات. هذا المتغير، )جدول 
، أي تقدير الطالب لعدد الساعات ((، هو معدل عدد ساعات الدراسة اليومية للطالب خارج مواعيد المحاضرات1.5)

 .اسة والمراجعة خلال اسبوع مقسوما على سبعة أيامالتي يستغرقها في الدر 

 متغير معدل عدد ساعات الدراسة اليومية للطالب.: 1.5جدول 
1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 16 17 18 

1.5 1 2 2.5 0.5 3 3.5 5 4.5 3.5 1 2 2.5 3.5 4 1 0.5 1 

                  

19 20 21 22 23 24 25 26 27 28 29 30 31 32 33 34 35  

4.5 3 3.5 4.5 2.5 4 1.5 3.5 5 2 2.5 2.5 2.5 1.5 5 2 5.5  

 انات "بيانات الطلبة" سنقوم بحفظ الملفلملف البي ، والذي سيأخذ الاسم "ساعات_الدراسة"،بعد إضافة هذا المتغير
 . SPSS برنامج " في2باسم "بيانات الطلبة

فتظهر  Graphs>Legacy Dialogs>Scatter/Dotقم من شريط الأوامر العلوي باختيار لتنفيذ شكل الانتشار، 
في تلك النافذة، سنبقي  ((؛1.5النافذة التالية، )شكل )

وهو شكل الانتشار البسيط على الخيار الافتراضي، 
(Simple Scatter ،) على أن نتطرق للخيارات

 لانتشار لاحقا.الأخرى لشكل ا

( فتظهر Defineنضغط بعد ذلك على تعريف )
نافذة جديدة لاختيار المتغيرات في شكل الانتشار 

 (.2.5البسيط كما في الشكل )
 

 لانتشار.: نافذة اختيار نوع شكل ا1.5شكل 
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( واختيار المتغير Y-Axis" ونقله لمربع المحور الصادي )1المتغير "مقررفي تلك النافذة، سنقوم باختيار 
درجات (، أي أننا نريد التعرف على شكل العلاقة بين X-Axisر السيني )"ساعات_الدراسة" ونقله لمربع المحو 

 ومعدل ساعات دراستهم اليومية. 1الطلبة في المقرر

 
 : نافذة اختيار متغيرات شكل الانتشار البسيط.2.5شكل 

 ((، في نافذة المخرجات.3.5بعد اختيار المتغيرات والضغط على موافق سيظهر شكل الانتشار، )شكل )

 
 " و"ساعات_الدراسة".1: شكل الانتشار البسيط للمتغيرين "مقرر3.5شكل 
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(، يمكننا بوضوح ملاحظة وجود علاقة خطية طردية قوية جدا بين المتغيرين، وهذا يكون منطقيا 3.5من شكل )
 لأنه بزيادة ساعات الدراسة اليومية فإن الدرجات ستزيد في المقرر.

، فمثلا إذا ما أردنا على نفس الرسملمراقبة علاقة متغير بأكثر من متغير لانتشار استخدام شكل ا أيضا يمكنناو 
 التعرف على شكل علاقة معدل ساعات الدراسة بدرجات الطلبة في المقررات الثلاثة، يمكننا عمل الآتي:

نافذة اختيار شكل في و  Graphs>Legacy Dialogs>Scatter/Dotفي شريط الأوامر العلوي باختيار 
 نافذة ( ثم اضغط تعريف فتظهرOverlay Scatter((، قم باختيار شكل الانتشار الفوقي )1.5الانتشار، )شكل )

 (؛4.5جديدة كما في الشكل )

 
 متغيرات في شكل الانتشار الفوقي.ال: نافذة اختيار 4.5شكل 

(؛ فيتم X-Y Pairsوالصادي ) في هذه النافذة، سيتم إدخال المتغيرات بصورة أزواج في مربع المحورين السيني
" ثم المتغير "ساعات_الدراسة"، ثم 2" أولا ثم المتغير "ساعات_الدراسة"، ثم المتغير "مقرر1إدراج المتغير "مقرر

، وبعد الانتهاء من الاختيار " ثم المتغير "ساعات_الدراسة"، كما هو موضح في الشكل السابق3المتغير "مقرر
 .نضغط موافق

ألوان نقاط الرسم بالنسبة للقارئ، و  أشكال نتشار المطلوب في نافذة المخرجات، )مع اختلاف فيسيظهر شكل الا
( يمثل 5.5في الشكل للحصول على مزيد من الوضوح في الرؤيا(. وننوه هنا إلى أن الشكل ) هاحيث أنه تم تغيير 
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" مع "ساعات_الدراسة"، 2"مقرر" مع "ساعات_الدراسة"، و1"دمجا" لثلاثة أشكال انتشار هي للمتغيرات "مقرر
 " مع "ساعات_الدراسة" في شكل واحد لتسهيل عملية المقارنة.3و"مقرر

 
 " مع "ساعات_الدراسة".3" و"مقرر2" و"مقرر1: شكل الانتشار الفوقي للمتغيرات "مقرر5.5شكل 

اسة ودرجات الطلبة في من شكل الانتشار يمكننا ملاحظة وجود علاقة خطية طردية قوية بين معدل ساعات الدر 
فعلاقته ضعيفة جدا مع ساعات الدراسة، أي أن الزيادة في عدد ساعات الدراسة  3، أما المقرر2و 1المقررين 

وهذا قد يدفع  3ولكن لا تزيد درجاتهم في المقرر 2، و1للطلبة يزيد وبشكل كبير من درجات الطلبة في المقررين 
 ة بهذا المقرر.الباحث للنظر في طبيعة الظروف المحيط

(، والتي Scatterplot Matrix) بمصفوفة الانتشارنوع آخر من التمثيل البياني لشكل الانتشار هو ما ي عرف 
 ت ستخدم لعرض أشكال الانتشار لعدة متغيرات )متغيرين فأكثر( في شكل مصفوفة مربعة كما سنرى؛

نافذة اختيار شكل في و  Graphs>Legacy Dialogs>Scatter/Dotباختيار  قم في شريط الأوامر العلوي 
( ثم اضغط تعريف فتظهر نافذة Matrix Scatter((، قم باختيار شكل مصفوفة الانتشار )1.5الانتشار، )شكل )

 (.6.5جديدة كما في الشكل )

مربع سنقوم، وعلى سبيل المثال، باختيار المتغيرات "العمر"، "الأسرة"، "المنزل"، و"ساعات_الدراسة" ونقلها إلى 
 .ثم نضغط موافق ( كما يظهر في الشكلMatrix Variablesمتغيرات المصفوفة )
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 متغيرات في مصفوفة الانتشار.ال: نافذة اختيار 6.5شكل 

 ((.7.5شكل ))ستظهر مصفوفة شكل الانتشار المطلوبة بعدها في نافذة المخرجات، 

 
 "، "المنزل"، و"ساعات_الدراسة".: مصفوفة الانتشار لمتغيرات "العمر"، "الأسرة7.5شكل 



153 

 

، )حيث أن كل شكل انتشار في المصفوفة هو خاص بالمتغيرين في ( يمكننا ملاحظة ما يلي7.5من الشكل )
 :الصف والعامود للشكل المحدد(

وجود علاقة خطية طردية قوية بين معدل ساعات الدراسة اليومية وعدد الحجرات في منزل الطالب، أي  .1
د الحجرات تزيد ساعات الدراسة، وهذا ي عد منطقيا حيث أن المزيد من الحجرات يعني توفر أنه بزيادة عد

 المساحة والمكان الكافي للدراسة.

وجود علاقة خطية عكسية قوية بين معدل ساعات الدراسة اليومية وعدد أفراد أسرة الطالب، بمعنى أنه  .2
عات الدراسة، وربما كان التفسير وراء ذلك كلما كبر حجم الأسرة كلما أدى ذلك لتناقص في معدل سا
 هو اكتظاظ منزل الطالب مما يؤثر على الجو العام للمذاكرة.

وجود علاقة ضعيفة جدا بين معدل ساعات الدراسة اليومية وعمر الطالب، مما يدل على أن الزيادة أو  .3
 النقصان في ساعات الدراسة ليس مرتبطا بالعمر.

ة بين عدد حجرات المنزل وعدد أفراد أسرة الطالب، وفي ذلك نوع من وجود علاقة خطية عكسية قوي .4
 التناقض المنطقي.

وجود علاقة ضعيفة جدا بين عمر الطالب وكلا من عدد حجرات المنزل وعدد أفراد أسرة الطالب، مما  .5
 المتغيرين. نيدل على أن الزيادة في عمر الطالب ليست مرتبطة بهاذي

 

 الرسم النقطي(  شكل الانتشار لمتغير مفرد((Dot plot) 

ي عتبر الرسم النقطي من الرسوم البسيطة التي ت ستخدم في وصف توزيع متغير واحد على خط الأعداد،  
ويمكن اعتباره في التفسير مشابها للمدرج التكراري أو شكل الساق والورقة الذي تناولناه سابقا في الفصل الثالث. 

"، قم في شريط الأوامر العلوي باختيار 2ملف البيانات "بيانات الطلبةولتنفيذ الرسم النقطي، باستخدام 
Graphs>Legacy Dialogs>Scatter/Dot ((، قم باختيار رسم1.5شار، )شكل )وفي نافذة اختيار شكل الانت 

 (؛8.5جديدة كما في الشكل ) ( ثم اضغط تعريف فتظهر نافذةSimple Dot)البسيط  النقاط

 
 ".2عريف المتغير في الرسم النقطي لملف بيانات "بيانات الطلبةنافذة ت: 8.5شكل 
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(، كما هو موضح في X-Axis Variable" ونقوم بنقله لمربع متغير المحور السيني )1سنختار المتغير "مقرر
الشكل، ويمكن للمستخدم الاختيار من بين ثلاثة طرق عرض للرسم النقطي عند الضغط على زر خيارات 

(Options و ،)( هي الرسم النقطي غير المتماثلAsymmetric وهو الخيار الافتراضي، الرسم النقطي المتماثل )
(Symmetric( والرسم النقطي المسطح ،)Flat وفي مثالنا سنبقي على الخيار الافتراضي وهو الرسم النقطي .)

 ونضغط موافق في النافذة الأصلية.غير المتماثل 

((. ومن الرسم يمكننا ملاحظة توزيع أو انتشار 9.5ي نافذة المخرجات، )شكل )سيظهر الرسم النقطي المطلوب ف
، إلا أن المدرج التكراري يمثل التكرار المناظر المدرج التكراري  كبير، والذي يشبه إلى حد 1درجات الطلبة في المقرر

 .يمة على محور واحدللفترات )في محورين(، أما الرسم النقطي فالنقاط المتراكمة فيه هي تكرار نفس الق

 
 ".2" في ملف بيانات "بيانات الطلبة1: الرسم النقطي للمتغير "مقرر9.5شكل 

 بيرسون معامل دراسة الارتباط باستخدام  2.1.5
(Analyzing Correlation using Pearson's Coefficient) 

 أي دراسة العلاقة المتبادلة، ،إن من أشهر معاملات الارتباط الخطي البسيط التي تستخدم لحساب الارتباط
(، Pearson Correlation Coefficient) الخطي البسيط للارتباطمعامل بيرسون بين متغيرين كميين هو 
𝑋 والذي يعرف للمتغيرين = (𝑥1, 𝑥2, … , 𝑥𝑛) و𝑌 = (𝑦1, 𝑦2, … , 𝑦𝑛)  :بالصيغة التالية 

𝑟𝑋𝑌 =
𝑆𝑋𝑌

√𝑆𝑋𝑋𝑆𝑌𝑌
=

 𝐶𝑜𝑣(𝑋, 𝑌)

√ 𝑉𝑎𝑟(𝑋) 𝑉𝑎𝑟(𝑌)
 

𝑉𝑎𝑟(𝑋)وحيث أن  =
𝑆𝑋𝑋

𝑛
𝑉𝑎𝑟(𝑌) و  =

𝑆𝑌𝑌

𝑛
,𝐶𝑜𝑣(𝑋و 𝑌) =

𝑆𝑋𝑌

𝑛
1−، و  ≤ 𝑟𝑋𝑌 ≤ . وهذا يعني  1

ما على حاصل مقسو  Yو X( بين المتغيرين Covariance) التغايرأن معامل الارتباط الخطي البسيط ما هو إلا 
 ضرب كلا من الانحراف المعياري للمتغيرين.
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 اختبار الفرضية الصفرية؛(، عن طريق Yو Xويتم اختبار معامل الارتباط، )بين المتغيرين 

𝐻0: 𝜌𝑋𝑌 = 0 

حصاءة الاختبار هي الإحصاءة  𝑛) ب  tوالتي تعني أن معامل الارتباط للمجتمع ليس له قيمة معنوية، وا  − 2 )
 ت حرية، وتعرف بالصورة:درجا

𝑡𝑐 =
𝑟𝑋𝑌

𝑆𝐸(𝑟𝑋𝑌)
 

 حيث

𝑆𝐸(𝑟𝑋𝑌) = √
1 − 𝑟𝑋𝑌

2

𝑛 − 2
 

 P-value < 0.05هو الخطأ المعياري لمعامل الارتباط )للعينة(. ورفض الفرضية الصفرية عند قيمة احتمالية 
 .بين المتغيرين الخطيةمعامل الارتباط أي أهمية العلاقة  )معنوية( يدل على أهمية

وهو ما  حساب معامل الارتباط البسيط لمتغيرين فقط أو لعدة أزواج من المتغيرات، SPSSويمكننا في برنامج 
(، والتي ي رمز لها في معظم الكتب بالرمز Correlation Matrix) مصفوفة الارتباطات البسيطةي عرف بتكوين 

R، بالطريقة التاليةالبسيط الخطي مكننا حساب معاملات الارتباط " ي2ففي ملف البيانات "بيانات الطلبة: 

فتظهر نافذة الارتباط الثنائي أو البسيط  Analyze>Correlate>Bivariateفي شريط الأوامر العلوي قم باختيار 
(Bivariate Correlations( كما هو في الشكل )؛10.5) 

 
 .("2ف بيانات "بيانات الطلبةمل) ة،البسيط اتالارتباط حساب : نافذة10.5شكل 
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"، "العمر"، "الأسرة"، 1الخطي البسيط بين المتغيرات "مقرر سنقوم على سبيل المثال بحساب معاملات الارتباط
( على اليمين. Variables"المنزل"، و"ساعات_الدراسة". وهكذا نقوم بنقل هذه المتغيرات إلى مربع المتغيرات )

ود ثلاثة خيارات أو ثلاثة أنواع من معاملات الارتباط البسيط وهي معامل بيرسون، ونلاحظ في منتصف النافذة وج
(، والمعاملين الأخيرين ي ستخدمان عادة لحساب Spearman، ومعامل ارتباط الرتب لسبيرمان )B-معامل كندل تاو

 قتران في الفصل السابق(.الارتباط البسيط بين المتغيرات الوصفية، )كما رأينا سابقا مع معمل كندل في جداول الا

وحيث أن كل المتغيرات المختارة هنا هي متغيرات كمية فسنختار حساب معامل بيرسون فقط، وهو الخيار 
( الافتراضي، ونبقي أيضا على Two-tailedالافتراضي للبرنامج. وسنبقي أيضا على خيار الاختبار من طرفين )

فنحصل على مصفوفة  ، ثم نضغط موافق(Flag significant correlationsالمعنوية ) تمييز الارتباطاتخيار 
 .(2.5الارتباطات البسيطة بين المتغيرات الم ختارة كما يظهر في جدول )

 "(.2)"بيانات الطلبة، "، "العمر"، "الأسرة"، "المنزل"، و"ساعات_الدراسة"1"مقرر: مصفوفة الارتباطات بين المتغيرات 2.5جدول 
Correlations 

رجة الطالب د 
 1في المقرر

عمر الطالب 
 بالسنوات

عدد أفراد 
 أسرة الطالب

عدد الحجرات 
في منزل 
 الطالب

معدل ساعات 
الدراسة 
 اليومية

درجة الطالب 
 1في المقرر

Pearson Correlation 1 -.416-* -.904-** .865** .897** 
Sig. (2-tailed)   .013 .000 .000 .000 
N 35 35 35 35 35 

مر الطالب ع
 بالسنوات

Pearson Correlation -.416-* 1 .292 -.273 -.456-** 
Sig. (2-tailed) .013   .089 .112 .006 
N 35 35 35 35 35 

عدد أفراد أسرة 
 الطالب

Pearson Correlation -.904-** .292 1 -.926-** -.764-** 
Sig. (2-tailed) .000 .089   .000 .000 
N 35 35 35 35 35 

عدد الحجرات 
في منزل 
 الطالب

Pearson Correlation .865** -.273 -.926-** 1 .756** 
Sig. (2-tailed) .000 .112 .000   .000 
N 35 35 35 35 35 

معدل ساعات 
 الدراسة اليومية

Pearson Correlation .897** -.456-** -.764-** .756** 1 
Sig. (2-tailed) .000 .006 .000 .000   
N 35 35 35 35 35 

*. Correlation is significant at the 0.05 level (2-tailed). 
**. Correlation is significant at the 0.01 level (2-tailed). 

 يكون لدينا ثلاثة قيم في كل "خلية" في الجدول وهي قيمة معامل بيرسون  هذه المصفوفة المربعة المتماثلة، فيو 
(Pearson Correlation( والقيمة الاحتمالية )Sig.( وحجم العينة )N.)  نستطيع ملاحظة العلاقات التالية:و 
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 = P-value) وكل من عمر الطالب 1وجود علاقة خطية عكسية قوية بين درجة الطالب في المقرر .1

بتقدم عمر  تنخفض 1لمقرر، أي أن درجة الطالب في ا(P-value = 0) وعدد أفراد الأسرة (0.013
الطالب وزيادة عدد أفراد أسرته، والعلاقة الأولى قد تكون متناقضة مع الواقع العملي، إذ أن زيادة عمر 
الطالب من المفترض أن تصاحبها زيادة في المستوى الدراسي بسبب زيادة الخبرة الأكاديمية عنده واقترابه 

 من مرحلة التخرج.

وكل من عدد حجرات منزل الطالب  1ة الطالب في المقرروجود علاقة خطية طردية قوية بين درج .2
كل من عدد الحجرات تزيد بزيادة  1أن درجة الطالب في المقررومعدل ساعات الدراسة اليومية، بمعنى 

 في المنزل ومعدل ساعات الدراسة اليومية، وهذه العلاقات منطقية جدا.

وعدد أفراد الأسرة، وعلاقة عكسية ضعيفة طردية ضعيفة )غير معنوية( بين عمر الطالب توجد علاقة  .3
بين العمر وعدد حجرات المنزل، وهذا ي عد منطقيا بالنسبة لمتغير العمر. إلا أن علاقة العمر بمعدل 

اليومية ي عد معنويا لوجود علاقة عكسية قوية تعكس انخفاض ساعات الدراسة للطالب ساعات الدراسة 
 بزيادة عمره.

وهذه العلاقة  )علاقة عكسية قوية(، أسرة الطالب بانخفاض عدد حجرات المنزل،يرتبط زيادة عدد أفراد  .4
من الانتقال لمنزل أكبر عند زيادة عدد أفرادها. ويرتبط الكثير من الأسر  تمكنربما تكون نتيجة عدم 

عدد أفراد أسرة الطالب أيضا بانخفاض معدل ساعات الدراسة للطالب، وهذا يعتبر منطقيا لأن العدد 
 للمذاكرة. ةالكافي المساحةلكبير لأفراد الأسرة عادة ما يسبب اكتظاظ المنزل وعدم حصول الطالب على ا

وجود علاقة طردية قوية بين عدد حجرات منزل الطالب ومعدل ساعات الدراسة اليومية، وهذا طبيعي  .5
 ة اليومية.حيث أن توفر المساحة المناسبة للمذاكرة يشجع الطالب عادة على زيادة ساعات الدراس

 (Partial Correlation Coefficient)معامل الارتباط الجزئي  3.1.5

في بعض الدراسات التي تتطلب فهم العلاقة المتبادلة ضمن عدة متغيرات، قد نكون مهتمين بتحليل 
 أثر متغير العلاقة بين ثلاثة أو أربعة متغيرات بحيث يتم حساب الارتباط بين متغيرين منهم مع "تثبيت" أو "وجود"

 أو متغيرين، وهو ما يعرف بحساب معامل الارتباط الجزئي. ثالث

، وتم عرضها في X، و1X ،2X ،3Xلنفرض أنه تم حساب معاملات الارتباط الخطي البسيط لأربعة متغيرات هي 
 مصفوفة الارتباط المتماثلة التالية:

𝑅 =

𝑋1 𝑋2 𝑋3 𝑋4
𝑋1

𝑋2

𝑋3

𝑋4 [
 
 
 
 
1 𝑟12 𝑟13 𝑟14

1 𝑟23 𝑟24

1 𝑟34

1 ]
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وجود  مع  2Xو 1Xبعض معاملات الارتباط الجزئية مثل معامل الارتباط الجزئي للمتغيرين  عندئذ يمكننا تعريف
 ؛بالصيغة التالية 3Xالمتغير 

𝑟12.3 =
𝑟12 − 𝑟13𝑟23

√(1 − 𝑟13
2 )(1 − 𝑟23

2 )
 

1− حيث ≤ 𝑟12.3 ≤ 𝑟13.2بالصورة  𝑟23.1و 𝑟13.2. وبالمثل، يمكن حساب  1 =
𝑟13−𝑟12𝑟23

√(1−𝑟12
2 )(1−𝑟23

2 )
 

𝑟23.1و =
𝑟23−𝑟12𝑟13

√(1−𝑟12
2 )(1−𝑟13

2 )
 . 

 :صيغةفهي تعطى بال 4Xو 3Xبتثبيت المتغيرين   2Xو 1Xمعامل الارتباط الجزئي للمتغيرين أما صيغة 

𝑟12.34 =
𝑟12.4 − 𝑟13.4𝑟23.4

√(1 − 𝑟13.4
2 )(1 − 𝑟23.4

2 )
=

𝑟12.3 − 𝑟14.3𝑟24.3

√(1 − 𝑟14.3
2 )(1 − 𝑟24.3

2 )
 

 .وبالمثل يمكن حساب باقي معاملات الارتباط الجزئي الأخرى 

. SPSS" في 2ب معامل الارتباط الجزئي لبعض المتغيرات في ملف البيانات "بيانات الطلبةوسنقوم الآن بحسا
فتظهر النافذة التالية، )شكل  Analyze>Correlate>Partialسنقوم في شريط الأدوات العلوي باختيار 

 ((؛11.5)

 
 ".2الارتباط الجزئي لملف بيانات "بيانات الطلبةحساب : نافذة 11.5شكل 

" و"ساعات_الدراسة" بوجود 1م على سبيل المثال بحساب معامل الارتباط الجزئي بين المتغيرين "المقررسنقو 
( ونقل المتغير Variablesالمتغير "العمر". فنقوم في تلك النافذة بنقل المتغيرين الأولين إلى مربع المتغيرات )

 (.11.5شكل )( كما يوضح الControlling forالثالث إلى مربع متغير التحكم )
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سيعطي معلومات حول حيث أن ذلك )ولمقارنة معامل الارتباط الجزئي بمعامل الارتباط البسيط لنفس المتغيرين، 
( في Optionsمدى تأثير المتغير الثالث على العلاقة بين المتغيرين الأساسيين(، نضغط على زر الخيارات )

 (.12.5في الشكل )نافذة الارتباط الجزئي فتظهر نافذة فرعية كما هو 

في هذه النافذة الفرعية، قم باختيار عرض الارتباطات البسيطة 
(Zero-order correlations كما هو موضح ثم اضغط )

استمرار للعودة لنافذة الارتباط الجزئي. وفي تلك النافذة اضغط 
اط الجزئي المطلوب موافق للحصول على معامل الارتب

 مصحوبا بمعاملات الارتباط البسيط بين كل متغيرين.

في نافذة المخرجات، سنحصل على معامل الارتباط الجزئي 
" و"ساعات_الدراسة" بوجود المتغير 1بين المتغيرين "المقرر

𝑟وجود علاقة طردية قوية جدا )((، والذي ي ظهر 3.5"العمر"، )جدول )
(العمر).(ساعات_الدراسة)(المقرر1) = 0.874 )

 ومعدل ساعات دراستهم اليومية بوجود تأثير متغير العمر. 1بين درجات الطلبة في مقرر

مع معاملات  " و"ساعات_الدراسة" بوجود متغير "العمر"1بين المتغيرين "المقرر: معامل الارتباط الجزئي 3.5جدول 
 (."2انات الطلبةملف بيانات "بيالارتباط البسيط للمتغيرات الثلاثة، )

Correlations 

Control Variables 
درجة الطالب 

 1في المقرر

معدل ساعات 

 الدراسة اليومية

عمر الطالب 

 بالسنوات

-none-a 
درجة الطالب في 

 1المقرر

Correlation 1.000 .897 -.416 

Significance (2-tailed)   .000 .013 

df 0 33 33 

معدل ساعات 

 يوميةالدراسة ال

Correlation .897 1.000 -.456 

Significance (2-tailed) .000   .006 

df 33 0 33 

عمر الطالب 

 بالسنوات

Correlation -.416 -.456 1.000 

Significance (2-tailed) .013 .006   

df 33 33 0 

عمر الطالب 

درجة الطالب في  بالسنوات

 1المقرر

Correlation 1.000 .874   

Significance (2-tailed)   .000   

df 0 32   

معدل ساعات 

 الدراسة اليومية

Correlation .874 1.000   

Significance (2-tailed) .000     

df 32 0   
a. Cells contain zero-order (Pearson) correlations. 

 1مقررالجزئي بقيمة معامل الارتباط البسيط بين درجات الطلبة في ولكن إذا ما تم مقارنة قيمة معامل الارتباط ال
𝑟ومعدل ساعات دراستهم اليومية، ) 

(ساعات_الدراسة)(المقرر1) = فإننا حيث أن قيم المعاملين متقاربة جدا،  (، 0.897

 
 الخيارات للارتباط الجزئي.: نافذة 12.5شكل 
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راسة" ببعضهما " و"ساعات_الد1"المقرر نستنج أن المتغير "العمر" ليس له أهمية معنوية في علاقة المتغيرين
 البعض.

" و"ساعات_الدراسة" بوجود المتغير "الأسرة"، 2من جديد لنقم بحساب معامل الارتباط الجزئي بين المتغيرين "المقرر
 ((.4.5وبتطبيق نفس الخطوات السابقة، نحصل على النتيجة في نافذة المخرجات، )جدول )

مع معاملات الارتباط  لأسرة"متغير "ا" و"ساعات_الدراسة" بوجود 2قرربين المتغيرين "الم: معامل الارتباط الجزئي 4.5جدول 
 (."2ملف بيانات "بيانات الطلبةالبسيط للمتغيرات الثلاثة، )

Correlations 

Control Variables 
معدل ساعات 

 الدراسة اليومية

درجة الطالب 

 2في المقرر

عدد أفراد 

 أسرة الطالب

-none-a  معدل ساعات

 يوميةالدراسة ال

Correlation 1.000 .847 -.764 

Significance (2-tailed)   .000 .000 

df 0 33 33 

درجة الطالب في 

 2المقرر

Correlation .847 1.000 -.907 

Significance (2-tailed) .000   .000 

df 33 0 33 

عدد أفراد أسرة 

 الطالب

Correlation -.764 -.907 1.000 

Significance (2-tailed) .000 .000   

df 33 33 0 

عدد أفراد 

 أسرة الطالب

معدل ساعات 

 الدراسة اليومية

Correlation 1.000 .566   

Significance (2-tailed)   .000   

df 0 32   

درجة الطالب في 

 2المقرر

Correlation .566 1.000   

Significance (2-tailed) .000     

df 32 0   
a. Cells contain zero-order (Pearson) correlations. 

ومعدل ساعات  2وبمقارنة قيمة معامل الارتباط الجزئي بقيمة معامل الارتباط البسيط بين درجات الطلبة في المقرر
𝑟دراستهم اليومية نرى بأن 

(الأسرة).(ساعات_الدراسة)(المقرر2) < 𝑟(2المقرر)(ساعات_الدراسة)  وهذا يدل على أن وجود متغير ،

" 2المتغيرين الأساسيين )"المقررالعلاقة الطردية بين  عدد أفراد الأسرة قد أدى إلى انخفاض حاد في 
ومعدل ساعات  2يؤثر سلبا في العلاقة بين درجات الطلبة في المقرر، أي أن زيادة عدد أفراد و"ساعات_الدراسة"(

 .1مكن دراسة العلاقة بين أي متغيرين بوجود متغير أو أكثرالدراسة. وبنفس الطريقة ي

 والكمية الارتباط بين المتغيرات الوصفية 2.5
(Correlation between Categorical and Quantitative Variables) 

لدراسة العلاقة بين متغيرين وصفيين يمثلان مستويات محددة في جدول في الفصل السابق، تطرقنا  
رة ، وفي هذا البند سنتناول كيفية حساب معامل الارتباط بين متغيران وصفيان بصو واختبار هذه العلاقة الاقتران

 .ةوصفيالو  ةكميال اتمتغير البين  عامة، وكيفية تحليل العلاقات

                                                 
 (.11.5الشكل )في  هو موضح( كما Controlling forمتغير التحكم )يمكن إضافة أكثر من متغير ثانوي في مربع  1
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 لية؛سنقوم بحساب معاملات الارتباط بين متغيرات هذه البيانات بالصورة التاباستخدام ملف البيانات "فيتامين دال"، 
فتظهر نافذة الارتباط الثنائي  Analyze>Correlate>Bivariateفي شريط الأوامر العلوي قم باختيار 

(Bivariate Correlations( كما رأينا في الشكل )قم باختيار المتغيرات "النوع"، "الفئة_العمرية"، 10.5 .)
 (.Variablesونقلها إلى مربع المتغيرات )و"مستويات_فيتامين_دال" 

، B-وفي منتصف النافذة، قم باختيار الأساليب الثلاثة لمعاملات الارتباط وهي معامل بيرسون، معامل كندل تاو
، رغم أنه مخصص لحساب الارتباط بين 1وقد قمنا هنا باختيار معامل بيرسون ومعامل ارتباط الرتب لسبيرمان، 

، ومعامل B-تباط للمتغيرات الوصفية؛ معامل كندل تاوالمتغيرات الكمية، بهدف مقارنة نتائجه بنتائج معاملات الار 
(، 5.5في جدول ) الموضحة، النتيجة الأولى سبيرمان. بعد ذلك اضغط موافق فتظهر النتائج في نافذة المخرجات.

علاقات ارتباط عكسية قوية ذات معنوية هي مصفوفة الارتباطات للمتغيرات الثلاثة التي تم تحديدها، وهي ت ظهر 
 ستويات فيتامين دال وكل من النوع وفئات العمر، وأيضا علاقة عكسية ضعيفة بين فئات العمر والنوع.بين م

((، 6.5)جاادول )، النتيجااة الثااانيااةوأمااا 
فهي مصاااااااااااااافوفة الارتباطات للمتغيرات 

بااسااااااااااااااتخاادام معااامال كناادل أولا  الثلاثاة،
 وكلا المعاملين ومعامل ساااابيرمان ثانيا،

ن ظهر علاقاااات ارتبااااط قريباااة جااادا مي  
تلك المحساااااااااااوبة بمعامل بيرساااااااااااون في 

الاساااااااااااتنتاج سااااااااااايكون و (. 5.5الجدول )
 كالتالي:

تعني أنه كلما زادت الفئة العمرية للشخص العلاقة العكسية القوية بين مستويات فيتامين دال وفئات العمر،  .1
 كلما نقصت لديه معدلات فيتامين دال، وهذه النتيجة مطابقة لما سبق.

لقوية بين مستويات فيتامين دال والنوع فلا يتم التعليق عليها كالنتيجة السابقة حيث أن أما العلاقة العكسية ا .2
 يكون هنالك معنى أن نقولإلى أنه لن ونلفت انتباه القارئ هنا النوع هو متغير وصفي اسمي وليس رتبي، 

متغير "النوع" باط بين في هذه الحالة دراسة الارت ويمكن ."كلما نقص النوع كلما زادت معدلات فيتامين دال"
علاقة بين فئات العمر للشكل الانتشار كما سنوضح تاليا، وكذلك الأمر بالنسبة  باستخدام ومتغير كمي آخر

 والنوع.

                                                 
ن معامل بيرسون يستخدم، من الناحية النظرية، لحساب الارتباط بين المتغيرات الكمية التي تتبع التوزيع لابد من التأكيد هنا على أ 1

 الطبيعي.

"النوع"، : مصفوفة معاملات الارتباط لبيرسون بين المتغيرات 5.5جدول 
 "الفئة_العمرية"، و"مستويات_فيتامين_دال".

Correlations 

  
 النوع

فئات 

 العمر

مستويات 

 فيتامين دال

 **-Pearson Correlation 1 -.201 -.499 وعالن

Sig. (2-tailed)   .123 .000 

N 60 60 60 

فئات 

 العمر

Pearson Correlation -.201 1 -.367-** 

Sig. (2-tailed) .123   .004 

N 60 60 60 

مستويات 

فيتامين 

 دال

Pearson Correlation -.499-
** 

-.367-** 1 

Sig. (2-tailed) .000 .004   

N 60 60 60 
**. Correlation is significant at the 0.01 level (2-tailed). 
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"النوع"، "الفئة_العمرية"، : مصفوفة معاملات الارتباط لكندل وسبيرمان بين متغيرات 6.5جدول 
 و"مستويات_فيتامين_دال".

Correlations 

 فئات العمر نوعال 
مستويات 

 فيتامين دال

Kendall's 

tau_b 

 **-Correlation Coefficient 1.000 -.190 -.466 النوع

Sig. (2-tailed)   .122 .000 

N 60 60 60 

 **-Correlation Coefficient -.190 1.000 -.347 فئات العمر

Sig. (2-tailed) .122   .003 

N 60 60 60 

ويات مست

 فيتامين دال

Correlation Coefficient -.466-** -.347-** 1.000 

Sig. (2-tailed) .000 .003   

N 60 60 60 

Spearman's 

rho 

 **-Correlation Coefficient 1.000 -.201 -.490 النوع

Sig. (2-tailed)   .123 .000 

N 60 60 60 

 **-Correlation Coefficient -.201 1.000 -.372 فئات العمر

Sig. (2-tailed) .123   .003 

N 60 60 60 

مستويات 

 فيتامين دال

Correlation Coefficient -.490-** -.372-** 1.000 

Sig. (2-tailed) .000 .003   

N 60 60 60 
**. Correlation is significant at the 0.01 level (2-tailed). 

 Graphs>Legacyلتوضاااااااااااااايح الملاحظة السااااااااااااااابقة لنقم بالخطوات التالية؛ في شااااااااااااااريط الأوامر العلوي اختر 

Dialogs>Scatter/Dot  ثم اختر الانتشاااااااااااااااااااار
( من نافذة الرساااااااااام، Simple Scatterالبساااااااااايط )
 في نافذةثم اضااااااااااااااغط تعريف. ((، 1.5)شااااااااااااااكل )

اختر المتغير ((، 2.5عريف المتغيرات، )شاااااااااااكل )ت
الكمي "فيتاااااااامين_دال" وقم بنقلاااااااه لمربع المحور 

( واختر متغير "النوع" وانقله Y-Axisالصااااااااااااادي )
ثم اضاااااااااااااغط  (X-Axisلمربع المحور السااااااااااااايني )

 .موافق

في نافذة المخرجات سيظهر شكل الانتشار التالي، 
في المحور الأفقي  2دلات فيتامين دال عند النساء )حيث أن الرقم أن مع((، ومنه يمكننا ملاحظة 13.5) 1)شكل

 .في مختلف الأعمار في المحور الأفقي( 1يشير للإناث( هي في العموم أقل من الرجال )رقم 

 

                                                 
 ننوه هنا إلى أننا قمنا ببعض التعديلات على الرسم فيما يخص القيم في المحور الأفقي وألوان النقاط في الرسم. 1

 
 " و"النوع".فيتامين_دال: شكل الانتشار للمتغيرين "13.5شكل 
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 (Simple Linear Regression Analysis) البسيط الخطي الانحدارتحليل  3.5

 ،والوصفية/الوصفية ،ط بين المتغيرات الكمية/الكميةفي البندين السابقين، تناولنا مفهوم الارتبا 
والكمية/الوصفية، ووضحنا كيفية حساب هذه المعاملات جبريا من خلال قوانين الارتباط، وبصريا من خلال انتشار 

 نقاط البيانات، وناقشنا كيفية استنتاج مدى قوة ونوع العلاقة بين المتغيرات.

 Causal) للعلاقة السببيةلا يكون كافيا في كثير من الحالات لأنه لا يتعرض إلا أن دراسة الارتباط بمفرده قد 

Relationship ( بين المتغيرات؛ ويقصد بالعلاقة السببية هنا كيفية وقوة تأثير متغير ما )أو أكثر( على متغير
( وعدد Xلعة ما )آخر )أو أكثر(، فمثلا؛ يمكن استخدام معامل الارتباط لدراسة قوة ونوع العلاقة بين سعر س

 تأثير(، والتي نتوقع منطقيا أن تكون علاقة عكسية قوية، إلا أننا لا نستطيع معرفة مدى Yالوحدات المباعة منها )
سعر السلعة على عدد الوحدات المباعة باستخدام معامل الارتباط فقط، لذلك نحن بحاجة لمقياس أو أسلوب 

تحليل الانحدار للقيام بهذه المهمة، وبالتالي يمكننا القول أنه لدراسة  إضافي لدراسة ذلك التأثير، وهنا يأتي دور
 لابد لنا من استخدام كلا من الأسلوبين؛ تحليل الانحدار والارتباط. أكثر تعمقاالعلاقات بين المتغيرات بصورة 

من أهم أهداف  (، والذي يعدPrediction) التنبؤإضافة إلى ذلك، يتم استخدام أسلوب تحليل الانحدار لغرض 
الأسلوب، فمثلا؛ إذا وجد أن هنالك تأثير معنوي لسعر السلعة على عدد الوحدات المباعة، بمعنى أن عدد الوحدات 

سعر السلعة، فيمكن عندها التنبؤ بعدد الوحدات المباعة )كتقدير مستقبلي أو كدراسة جدوى(  يعتمد علىالمباعة 
 ند أي قيمة افتراضية للسعر.عند ارتفاع أو انخفاض سعر السلعة، أي ع

وعمليا يمكن في الدراسات الاستكشافية استخدام تحليل الارتباط أولا لتبيان قوة العلاقة بين المتغيرات، فإن كان  
وكما هو  الانحدار لدراسة العلاقة السببية.هنالك علاقة معنوية بينها فيمكن عندئذ المضي قدما باستخدام تحليل 

رتباط، فإن أسلوب تحليل الانحدار يتعامل مع المتغيرات التي توجد بينها علاقات خطية وغير الاتحليل الحال مع 
 .كما ذكرنا سابقا خطية، إلا أننا سنركز على الانحدار الخطي فقط

 (Definition of Simple Linear Regression Model)تعريف نموذج الانحدار الخطي البسيط  1.3.5

 يان فإن نموذج الانحدار الخطي لهما يعرف بالصورة:متغيران كمY و Xإذا كان 

𝑦𝑖 = 𝛽0 + 𝛽1𝑥𝑖 + 𝜀𝑖     , 𝑖 = 1, 2, … , 𝑛 
 حيث:

 Y  : متغير الاستجابةأو  بالمتغير التابعيعرف (Dependent or Response Variable ،)X  : يعرف
 Explanatory or Independent Variable or) متغير التنبؤأو  المستقلأو  بالمتغير التوضيحي

Predictor،) 
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 𝛽0 و𝛽1  ويسمى( ،تعرف بمعالم النموذج𝛽1  ،)بمعامل الانحدار𝜀 يعرف بحد الخطأ العشوائي للنموذج، و 𝑛 هو
 عدد المشاهدات أو حجم عينة الدراسة.

قدير إحصائي لابد لها من وحد الخطأ العشوائي تم إضافته لنموذج الانحدار لعدة أسباب أهمها أن أي عملية ت
هامش خطأ للتقدير لأن القيمة المقدرة للمعلمة، )بصورة عامة(، لن تساوي القيمة الحقيقة للمعلمة كما تنص قواعد 

 التقدير. إلا أننا نطمح دائما لتقديرات تكون قريبة أكثر ما يمكن للقيمة الفعلية.

 ويتم تقدير معالم النموذج بالصيغ:

�̂�1 =
𝑆𝑋𝑌
𝑆𝑋𝑋

=
 𝐶𝑜𝑣(𝑋, 𝑌)

 𝑉𝑎𝑟(𝑋)
 ، �̂�0 = �̅� − �̂�1�̅� 

�̅�حيث  =
1

𝑛
∑ 𝑋𝑖
𝑛
𝑖=1  و�̅� =

1

𝑛
∑ 𝑌𝑖
𝑛
𝑖=1 العلاقة بين معامل  ملاحظة أن. ومن الصيغة السابقة، يمكننا

 الارتباط الخطي ومعامل الانحدار الخطي تكون بالصورة؛

�̂�1 =
√𝑆𝑌𝑌

√𝑆𝑋𝑋
𝑟𝑋𝑌 =

√𝑉𝑎𝑟(𝑌)

√𝑉𝑎𝑟(𝑋)
 𝑟𝑋𝑌 

 (Assumptions of OLS Method)فرضيات طريقة المربعات الصغرى الاعتيادية  2.3.5

في التقدير  (Ordinary Least Squares, (OLS)) الاعتيادية إن استخدام طريقة المربعات الصغرى 
تحقق مجموعة من الشروط أو الفرضيات، هذه الفرضيات تسمى أيضا فرضيات يكون من الناحية النظرية مقيدا ب

نموذج الانحدار الخطي. ومن الناحية العملية، فإنه عندما يقوم الباحث بتقدير معالم نموذج الانحدار فإنه لا يقوم 
نحدار لأن ثبات أو عادة بالتحقق من صحة هذه الفرضيات للنموذج الموفق، وهذا ي عد "نقصا" في نتائج تحليل الا

 تحقق هذه الفرضيات يدل على ثبات أو جودة النتائج التي سيتم الوصول إليها عن طريق النموذج المقدر.

وفيما يلي سنقوم بتلخيص أهم هذه الفرضيات، مع التذكير بأن هذه الفرضيات تسري على كل من النماذج الخطية 
 ددة، )التي تضم أكثر من متغير توضيحي(؛البسيطة، )التي تضم متغير توضيحي واحد(، والمتع

𝑦𝑖لتوفيق نموذج الانحدار الخطي:  = 𝛽0 + 𝛽1𝑥𝑖 + 𝜀𝑖   , 𝑖 = 1, 2, … , 𝑛   باستخدام طريقة المربعات
 الصغرى الاعتيادية لابد من توفر الفرضيات التالية:

)أو المتغيرات  المتغير التوضيحي ، والتي تعني أن المتغير التابع هو تركيبة خطية منالنموذج خطية .1
 ومعالم النموذج. التوضيحية(

(، بمعنى Non-Random) قيما غير عشوائية( تأخذ المتغيرات التوضيحيةالتوضيحي )أو  المتغير .2
 أنها قيما لا تتبع توزيعا احتماليا.
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عن بعضها  امستقلة خطي)في نماذج الانحدار المتعدد( لابد أن تكون جميعها  المتغيرات التوضيحية .3
يوجد بين أي متغيرين علاقة خطية )أي أن يكون معامل الارتباط الخطي  ألاالبعض، وي قصد بذلك 
 بينهما مساو للصفر(.

4.  
عن بعضها البعض، )بمعنى أن الارتباط أو التغاير  قيم حد الخطأ العشوائي مستقلةأن تكون  -أ

,𝐶𝑜𝑣(𝜀𝑖بينها مساو للصفر؛   𝜀𝑗) = 0, ∀𝑖 ≠ 𝑗 = 1, 2, … , 𝑛.) 
𝜎𝜀وتباين يساوي  0بمتوسط يساوي  حد الخطأ يتبع توزيعا طبيعيا -ب

𝐸(𝜀𝑖)، أي أن 2 = 0 ،
𝑉𝑎𝑟(𝜀𝑖) و = 𝜎𝜀
𝑖، لكل 2 = 1, 2, … , 𝑛. 

، بمعنى أن يكون للأخطاء نفس قيمة التباين مهما تغيرت قيم تجانس تباين قيم حد الخطأ -ج
𝑉𝑎𝑟(𝜀𝑖)المتغير التابع، ) = 𝜎𝜀

2, ∀𝑖 = 1, 2, … , 𝑛.) 

 ويمكن تلخيص الفرضيات )أ، ب، و ج( بالصورة؛

𝜀𝑖~𝑁𝐼𝐷(0, 𝜎𝜀
2), ∀𝑖 = 1, 2, … , 𝑛 

 التمثيل البياني لنموذج الانحدار الخطي البسيط 3.3.5
(Graphical Representation for the Linear Regression Model) 

(، Model Fitting) بتوفيق النموذج، وهو ما يعرف  𝛽1و 𝛽0ج الانحدار الخطي بعد تقدير معالم نموذ
يمكن تمثيل هذا النموذج أو رسم خط الانحدار بيانيا مباشرة على شكل الانتشار للمتغيرين وذلك من خلال تحديد 

خلال التعويض عن أي قيمتين للمتغير  على الرسم أو من �̂�1و الميل  �̂�0قيم الجزء المقطوع من المحور الصادي 
X .في نموذج الانحدار وتمرير خط مستقيم عبرهما 

((، يوضح شكل الانتشار لبيانات افتراضية وخط الانحدار الذي يمر عبرها وأيضا 14.5والشكل التالي )شكل )
ين قيم المتغير التابع الفعلية (، وتمثل الفرق بResiduals) 𝜀̂ بالبواقيالتي تسمى  εي ظهر تقديرات قيم حد الخطأ 

 وقيمه المقدرة، أي أنها تحسب بالصيغة؛
𝜀�̂� = 𝑦𝑖 − �̂�𝑖    , 𝑖 = 1, 2, … , 𝑛 

مما يعني أنه كلما قلت قيمة البواقي كلما دل ذلك على "جودة" توفيق النموذج وملائمته لبيانات العينة، ومن خواص 
ة والأخرى موجبة، وأن مجموع تلك القيم لابد أن يساوي الصفر، أي أن هذه البواقي أن بعض قيمها ستكون سالب

∑ 𝜀�̂�
𝑛
𝑖=1 = لابد أن تشكل إحدى نقاط خط Y و Xولاحظ أيضا من الشكل أن قيم متوسطات المتغيرين  .0

 الانحدار دائما، والتي كلما اقتربت من منتصف كتلة البيانات كلما دل ذلك على قلة القيم المتطرفة.
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 .وتوفيق خط الانحدار لبيانات افتراضية: شكل الانتشار 14.5شكل 

. سنقوم في شريط الأوامر "2بيانات الطلبةولنقم الآن بتوفيق نموذج انحدار خطي بسيط باستخدام بيانات المثال "
كل فتظهر نافذة تحليل الانحدار الخطي كما يظهر في الش Analyze>Regression>Linearالعلوي باختيار 

وعند اختيار المتغير التابع والمتغير أو المتغيرات التوضيحية، يجب أن يراعي الباحث العلاقة المنطقية (. 15.5)
السببية بين المتغيرات، أي أنه يجب أن يختار المتغير التابع الذي "يعتقد" أنه يعتمد أو يتأثر بتغير المتغير 

 التوضيحي.

 
 ".2الخطي لملف البيانات "بيانات الطلبةتحليل الانحدار : نافذة 15.5شكل 

كمتغير استجابة يتأثر  1فعلى سبيل المثال، واعتمادا على منطق السببية، يمكننا اختيار درجات الطلبة في المقرر
" ونقله إلى مربع المتغير التابع 1بتغير معدل ساعات الدراسة اليومية للطلبة، لذلك سنقوم باختيار المتغير "المقرر
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(Dependent واختيار المتغير "ساعات_الدراسة" ونقله لمربع المتغيرات التوضيحية أو المستقلة ،)
(Independent( كما يوضح الشكل ،)15.5.) 

المتغير التوضيحي "ساعات_الدراسة" " على 1في الخطوة التالية، سنقوم بتوفيق نموذج انحدار المتغير التابع "المقرر
مستخدمين الحد الأدنى للنتائج، بمعنى 
أننا سنقوم باختيار عرض أقل عدد من 
النتائج بهدف التدرج مع القارئ في شرح 

 كيفية تفسير النتائج خطوة بخطوة.

الشااااااااااااااكاال ) الانحاادار الخطي،في نااافااذة 
، اضااااااااااااااااااغااااط عاااالااااى خااااياااااااار ((15.5)

( فتظهر Statisticsالإحصااااااااااااااااااااءات )
((، 16.5النافذة الفرعية التالية، )شاااكل )

في تلاااااك الناااااافاااااذة قم بااااااختياااااار عرض 
( فقط ثم اضغط Estimatesالتقديرات )

اضغط  استمرار للعودة للنافذة الأصلية.
 فتظهر النتائج في نافذة المخرجات.بعد ذلك موافق 

نموذج، حيث أنه توجد عدة طرق "لبناء" الجدول الأول في النتائج يوضح الطريقة المتبعة في إدخال المتغيرات في ال
((، فيتم فيه عرض نتائج 7.5نماذج الانحدار سنتطرق لها لاحقا في هذا الفصل، أما الجدول التالي، )جدول )

 ومن هذا الجدول نستطيع كتابة نموذج الانحدار الموفق كالتالي:توفيق نموذج الانحدار الخطي المطلوب، 

�̂�𝑖 = 43.513 + 9.929 𝑥𝑖     , 𝑖 = 1, 2, … , 35 

�̂�1ويمكن "مبدئيا" تفسير قيمة معامل الانحدار  = )المتغير  Xبأنه يمثل تأثير معدل ساعات المذاكرة  9.929
في ساعات  الوحدة بمقدار )المتغير التابع(، بحيث أن كل زيادة Y، 1التوضيحي( على درجة الطالب في المقرر

 10في درجة الطالب بمقدار )نظرا للإشارة الموجبة للمعامل(  ستؤدي إلى زيادةساعة واحدة(، زيادة المذاكرة، )
9.929درجات تقريبا ) ≅ درجة الطالب (. بمعنى أن نمط الزيادة في �̂�0(، )وذلك بإهمال قيمة الجزء المقطوع 10

لقيم الأخرى في جدول وبالنسبة ل بحسب نموذج الانحدار الموفق. درجة 9.929يتغير بمعامل مقداره  1في المقرر
 النتائج فإننا سنقدم لها شرحا مفصلا لاحقا.

  

 
 .عرض الإحصاءات في تحليل الانحدارخيارات : نافذة 16.5شكل 
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 " على المتغير "ساعات_الدراسة".1"المقرر: نتائج تقدير معالم نموذج الانحدار الخطي للمتغير 7.5جدول 
Coefficientsa 

Model 

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. B Std. Error Beta 

1 (Constant) 43.513 2.660   16.359 .000 

 000. 11.669 897. 851. 9.929 معدل ساعات الدراسة اليومية
a. Dependent Variable: 1درجة الطالب في المقرر  

" و"ساعات_الدراسة" ورسم خط الانحدار الموفق على نفس 1"المقررلنقم الآن برسم شكل الانتشار للمتغيرين 
ثم اختر  Graphs>Legacy Dialogs>Scatter/Dot. لعمل ذلك، قم في شريط الأوامر العلوي باختيار 1مالرس

في نافذة تعريف و ((، ثم اضغط تعريف. 1.5( من نافذة الرسم، )شكل )Simple Scatterالانتشار البسيط )
( واختر متغير Y-Axisادي )" وقم بنقله لمربع المحور الص1((، اختر المتغير "المقرر2.5المتغيرات، )شكل )

 ( ثم اضغط موافق.X-Axis"ساعات_الدراسة" وانقله لمربع المحور السيني )

( كما Chart Editorبعد ظهور الرسم في نافذة المخرجات، قم بالنقر المزدوج عليه لتظهر نافذة تحرير الرسم )
 Elements>Fit Line at Total(، وفي شريط الأوامر العلوي لتلك النافذة اختر 17.5يظهر في الشكل )

وستلاحظ بعدها ظهور خط الانحدار الموفق في نافذة تحرير الرسم إضافة لظهور نافذة فرعية جديدة بعنوان 
قم بالضغط على إغلاق  والتي تتضمن إمكانية إجراء بعض التعديلات الإضافية،(، Propertiesخصائص )

(Closeفي تلك النافذ ) ،والتي ستقوم بإغلاقها باستخدام رمز إغلاق النوافذ ذو اللون ة للعودة لنافذة تحرير الرسم

 .×الأحمر وعلامة 

 
 محرر الرسم لشكل الانتشار.: نافذة 17.5شكل 

                                                 
يتضمن رسم شكل الانتشار وتوفيق خط الانحدار لقيم المتغير التوضيحي المعيارية  خيار الرسم في نافذة تحليل الانحدار SPSSفي  1
(Standardized.وليس القيم الفعلية له، لذلك نلجأ لتمثيل خط الانحدار بهذه الطريقة ) 
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على شكل  ةخط الانحدار الموفق ومعادلة الانحدار الخطي الموفق ظهورالآن وفي نافذة المخرجات ستلاحظ 
وي لاحظ من الشكل اقتراب الكثير من نقاط البيانات من خط الانحدار مما يدل على . ((18.5ل )الانتشار، )شك

يمكن الحكم على أهمية تأثير المتغير التوضيحي على المتغير التابع بصورة مبدئية و انخفاض قيم البواقي وبالتالي 
 نموذج الانحدار. في

 
 .لهما شكل الانتشار " على "ساعات_الدراسة" مع1رللمتغير "المقر  : خط الانحدار الموفق18.5شكل 

 (Assessment of Linear Regression Model) الخطي تقييم نموذج الانحدار 4.5

بعد تقدير معالم نموذج الانحدار الخطي، نكون بحاجة لتقييم هذا النموذج الموفق بمعنى التأكد من مدى  
السببية بين المتغيرات وللتنبؤ ببيانات جديدة. وهذا في العموم هو ملائمته وجودته للاستخدام في تفسير العلاقة 
ومن الناحية التطبيقية، فإن هذا التقييم هو في الواقع تقييم لشيئيين  شأن أي أسلوب إحصائي يعتمد على التقدير.

 أساسيين؛

 طبيعة ومدى تأثير متغير أو أكثر على المتغير التابع. .1
 )العينة( للتغير الخطي في العلاقة بينهما. مدى ملائمة مشاهدات المتغيرين .2

 ولاختبار جودة النموذج سنستعرض الطرق التالية؛

 (Multiple R)معامل الارتباط المتعدد  1.4.5

رغم أننا لم نتطرق لتحليل الانحدار المتعدد بعد، )وجود أكثر من متغير توضيحي في النموذج(، إلا أنه  
لمتعدد، والذي يعتبر معامل الارتباط البسيط حالة خاصة منه عند التعامل مع يمكننا استخدام معامل الارتباط ا
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بين المتغير التابع  طمتغيرين فقط. والنظرة إلى معامل الارتباط المتعدد بصورة عامة تكون بأنه مقياس للارتبا
باط المتعدد هي نفسها و"باقي" المتغيرات التوضيحية. وفي حالة نموذج الانحدار البسيط، تكون قيمة معامل الارت

𝑅قيمة معامل الارتباط الخطي البسيط )معامل بيرسون( أي أن؛  = 𝑟𝑋𝑌 وبالطبع، فإنه كلما زادت قيمة معامل .
الارتباط المتعدد دل ذلك على قوة العلاقة بين المتغير التابع والمتغير التوضيحي )أو المتغيرات التوضيحية( والذي 

وذج الموفق. أما بالنسبة للإشارة الجبرية لمعامل الارتباط المتعدد، فإنه يأخذ نفس إشارة بدوره يدل على جودة النم
، كما ذكرنا سابقا، واحرصمعامل الانحدار في نماذج الانحدار البسيط، وتبقى إشارته موجبة في النماذج المتعددة. 

 ضرورة اختبار معامل الارتباط للتأكد من معنويته.على 

 𝑹𝟐 (Coefficient of Determination or R-Squared) معامل التحديد 2.4.5

معامل التحديد هو مقياس إحصائي يستخدم لقياس جودة توفيق النموذج وهو يمثل نسبة الاختلاف في  
هو النسبة بين مجموع المربعات  ؛رياضيقيم المتغير التابع التي يفسرها نموذج الانحدار الموفق، أو بمعنى 

�̂�𝑖)للاختلاف المفسر  − �̅�)  ومجموع المربعات للاختلاف الكلي(𝑦𝑖 − �̅�)وبالتالي فإنه يأخذ الصيغة التالية؛ ، 

𝑅2 =
∑(�̂�𝑖 − �̅�)

2

∑(𝑦𝑖 − �̅�)2
 

 فإن معامل التحديد ما هو إلا مربع معامل الارتباط المتعدد، لذلك يمكن كتابة؛ ضاأي ورياضيا

𝑅2 = (𝑅)2 = (
𝑆𝑋𝑌

√𝑆𝑋𝑋𝑆𝑌𝑌
)

2

=
𝑆𝑋𝑌
2

𝑆𝑋𝑋𝑆𝑌𝑌
=

(𝐶𝑜𝑣(𝑋, 𝑌))2

𝑉𝑎𝑟(𝑋)𝑉𝑎𝑟(𝑌)
 

والقيمة التي يأخذها معامل التحديد هي نسبة ما يفسره نموذج الانحدار الموفق من العلاقة السببية بين المتغير 
ل مع معامل الارتباط المتعدد، فإن ارتفاع قيمة معامل التحديد هو مؤشر التابع والمتغير التوضيحي. وكما هو الحا

 على صحة أو جودة النموذج.

 :ملاحظات حول معامل التحديد 
 0(، حيث تدل القيمة 100، )بعد ضرب قيمته العشرية في 100و% 0ما بين % 𝑅2ستتراوح قيمة  .1

متغير التابع من خلال نموذج الانحدار، على أن النموذج لم يفسر أي شيء من الاختلاف في قيم ال
تعني أن النموذج الموفق هو "كامل" في توصيف العلاقة السببية، وعادة لا يتم الوصول  100والقيمة 

 لهاتين القيمتين من خلال البيانات في الحياة العملية.
يمكن مراقبة ما "يعكسه" معامل التحديد بيانيا من خلال رسم شكل الانتشار لقيم المتغير التابع الحقيقية  .2

𝑌  ضد قيمه المقدرة�̂�. 
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لا يمكن الاعتماد بصورة مطلقة على قيمة معامل التحديد بمفرده للحكم على جودة النموذج لأن القيم  .3
ذج جيد، )كما وأن القيم المنخفضة له قد تظهر أحيانا في المرتفعة للمعامل لا تعني "دائما" أن النمو 

(، لأن قيمته تتعلق بشكل كبير بحجم وطبيعة البيانات وعدد المتغيرات التوضيحية ذات معنويةنماذج 
تحليل البواقي  نتائج في النموذج، ولذلك يجب أن يتم مراقبة كل نتائج تحليل الانحدار، )ومن ضمنها

 الحكم على النموذج الموفق.(، قبل تقديم االذي سنتناوله لاحق
-Adjusted R)المعدل  حديدمعامل التيمكن إجراء تعديل على صيغة معامل التحديد لنحصل على  .4

squareأفضل لدى بعض الإحصائيين. وتعطى صيغته بالصورة؛ (، والذي ي عد 

𝑅𝑎𝑑𝑗
2 = 𝑅2 − (1 − 𝑅2)

𝑝

𝑛 − 𝑝 − 1
 

 تغيرات التوضيحية في النموذج.هو عدد الم 𝑝 هو حجم العينة، و 𝑛حيث 

 (Testing the Significance of the Regression Model)اختبار معنوية نموذج الانحدار  3.4.5

، وتهدف لاختبار 𝐹هذا الاختبار في الواقع هو اختبار تحليل التباين المعروف باستخدام الإحصاءة فيشر  
ذا الاختبار ي عد الأهم ضمن الأساليب المختلفة لتقييم النموذج، معنوية نموذج الانحدار الموفق ككل، لذلك فإن ه

:𝑯𝟎حيث يتم اختبار الفرضية الصفرية؛  يرغ معنوي )  . (نموذج الانحدار 

ذا تم رفض الفرضية السابقة عند مستوى معنوية  𝛼وا  = ,𝑝)ودرجات حرية  0.05 (𝑛 − 𝑝 − فهذا يعني  ((1
نوية( ويعبر عن العلاقة السببية بين المتغيرات. وتعرّف قيمة إحصاءة أن نموذج الانحدار الموفق جيد )ذو مع

 الاختبار بالصيغة:

𝐹𝑐 =
∑(�̂�𝑖 − �̅�)

2 /𝑝

∑(𝑦𝑖 − �̂�𝑖)2 /(𝑛 − 𝑝 − 1)
 

 𝐹هو عدد المتغيرات التوضيحية. أي أن قيمة الإحصاءة  𝑝 هي حجم العينة )عدد المشاهدات(، و 𝑛حيث 
�̂�𝑖)سابية هي عبارة عن النسبة بين مجموع المربعات للاختلاف المفسر الح − �̅�)  ومجموع المربعات للاختلاف

𝑦𝑖)غير المفسر  − �̅�)  كل مقسوم على درجات الحرية الخاصة به. ويتم عمليا حساب قيمة 𝐹  من جدول تحليل
 (.ANOVAالتباين )

𝑀𝑆𝐸الخطأ هو تقدير تباين حد الخطأ في النموذج؛  وننوه هنا إلى أن متوسط مجموع مربعات = �̂�𝜀
. ولحساب 2

قيم مجاميع المربعات الثلاثة الأساسية في جدول تحليل التباين نستخدم الصيغ التالية، والتي تسمى بمجاميع 
 Correction) بمعامل التصحيح( والتي تم "ضمن" صيغتها طرح ما ي عرف Corrected) المصححةالمربعات 

Term (CT))  الذي يساوي𝐶𝑇 =
(∑𝑌)2

𝑛
 ؛
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𝑆𝑆𝑅 =
𝑛 (𝐶𝑜𝑣(𝑋, 𝑌))2

𝑉𝑎𝑟(𝑋)

𝑇𝑆𝑆 = 𝑛 𝑉𝑎𝑟(𝑌)

𝑆𝑆𝐸 = 𝑇𝑆𝑆 − 𝑆𝑆𝑅 }
 
 

 
 

 

 (Testing the Significance of Predictors)اختبار معنوية المتغيرات التوضيحية  4.4.5

تأثير المتغير التوضيحي على المتغير التابع في نموذج الانحدار،  هذا الاختبار يتعلق بمراقبة أهمية
)وفي حالة وجود أكثر من متغير توضيحي في النموذج، فإنه يتم تنفيذ هذا الاختبار بعدد هذه المتغيرات(، ويتم 

 اختبار الفرضية الصفرية؛
𝐻0: 𝛽𝑗 = 0 

𝑗حيث  = 1, 2, … , 𝑝 مستوى معنوية عند  ، ورفض هذه الفرضية الصفرية𝛼 = ودرجات حرية  0.05
(𝑛 − 𝑝 − في نموذج الانحدار. وتعرف إحصاءة  𝑗يدل على أهمية تأثير المتغير التوضيحي ذو الترتيب  (1

 ، بالصيغة التالية:tاستيودنت الاختبار، وهي الإحصاءة 

𝑡𝑐 =
|�̂�𝑗|

𝑆𝐸(�̂�𝑗)
 , 𝑗 = 1, 2, … , 𝑝 

 حيث أن؛

𝑆𝐸(�̂�𝑗) = √𝑉𝑎𝑟(�̂�𝑗) = √
𝑀𝑆𝐸

(𝑛 − 1)𝑉𝑎𝑟(𝑋)
 

1)وكذلك يمكن إيجاد )تقدير(  − 𝛼)100%  فترة ثقة لمعالم النموذج𝛽𝑗 باستخدام الصيغة؛ 

𝛽𝑗 ∶ �̂�𝑗 ± 𝑡𝛼 2⁄
(𝑛 − 𝑝 − 1) 𝑆𝐸(�̂�𝑗)  , 𝑗 = 1, 2, … , 𝑝 

دنا بتقدير للحدود القصوى للقيم التي يمكن أن تأخذها هذه المعالم مما ومن فوائد فترة الثقة لمعالم النموذج أنها تزو 
 يساعد على تقييم النموذج.

، SPSSولنقم الآن بتوفيق نموذج انحدار جديد واستخدام طرق التقييم والاختبار السابقة بصورة عملية في برنامج 
((، باختيار المتغير 15.5ر الخطي، )شكل )"، قم في نافذة تحليل الانحدا2لنفس ملف البيانات "بيانات الطلبة

( Statistics" كمتغير تابع، والمتغير "الأسرة" كمتغير توضيحي، ثم اضغط على خيار الإحصاءات )1"المقرر
( وفترات الثقة Estimates((، قم باختيار عرض التقديرات )16.5وفي النافذة الفرعية الخاصة به، )شكل )
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(Confidence Intervalsو ت )( وفيق النموذجModel Fit( والإحصاءات الوصفية )Descriptives)،  ثم
 اضغط استمرار للعودة للنافذة الأصلية. اضغط بعد ذلك موافق فتظهر النتائج في نافذة المخرجات.

 الجدول الأول في تلك النتائج يتضمن الأوساط الحسابية والانحرافات المعيارية وعدد المشاهدات لمتغيري النموذج،
والجدول الثاني هو مصفوفة الارتباط، والتي تتضمن معامل ارتباط واحد فقط لأن النموذج يضم متغيرين اثنين 

𝑟فقط، ومن هذا الجدول يمكننا ملاحظة وجود علاقة عكسية قوية )
(الأسرة)(المقرر1) = ( ذات معنوية 0.904−

 في إدخال المتغيرات في النموذج.(. والجدول الثالث يوضح الطريقة المتبعة P-value = 0عالية )

 نستطيع كتابة نموذج الانحدار الموفق كالتالي:((، 8.5ومن الجدول الأخير في نافذة المخرجات، )جدول )

�̂�𝑖 = 98.994 − 4.613 𝑥𝑖     , 𝑖 = 1, 2, … , 35 

(، ستؤدي إلى انخفاض )نظرا في عدد أفراد أسرة الطالب، ) زيادة فرد واحد الوحدة وهذا يعني أن كل زيادة بمقدار
4.613درجات تقريبا ) 5للإشارة السالبة للمعامل(  في درجة الطالب بمقدار  ≅ (، وذلك بإهمال قيمة الجزء 5

، أي أن الزيادة في عدد أفراد الأسرة يكون له تأثير سلبي على مستوى الطالب الدراسي، وهذا قد يكون �̂�0المقطوع 
، كما وضحنا سابقا في الجزء الخاص ؤدي عادة لعدم توفر الجو المناسب للمذاكرةياكتظاظ المنزل  أن بسبب

 .بدراسة الارتباط

 " على المتغير "الأسرة".1"المقرر: نتائج تقدير معالم نموذج الانحدار الخطي للمتغير 8.5جدول 
Coefficientsa 

Model 

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. 

95.0% Confidence 

Interval for B 

B 

Std. 

Error Beta 

Lower 

Bound 

Upper 

Bound 

1 (Constant) 98.994 2.549   38.841 .000 93.808 104.179 

عدد أفراد أسرة 

 الطالب
-4.613 .380 -.904 -12.154 .000 -5.385 -3.841 

a. Dependent Variable: 1درجة الطالب في المقرر  

أن  ةلاحظتطيع منس((، 8.5ن نفس الجدول، )جدول )فمالموفق،  البسيط نأتي الآن لتقييم جودة نموذج الانحدار
(، value = 0-P) هي والقيمة الاحتمالية ،ct 38.841 =هو  الانحدارالخاص بمعلمة  قيمة إحصاءة الاختبار

وبالتالي يتم رفض الفرضية الصفرية التي تنص على عدم أهمية تأثير المتغير التوضيحي على المتغير 
𝐻0: 𝛽)التابع،

(الأسر ة) = )في  توى الطالب الدراسيعدد أفراد الأسرة له تأثير سلبي هام على مسبمعنى أن  (،0

 .(1المقرر
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ومن القيم التي تساعد الباحث في دراسة وتقييم النموذج أيضا هي قيمة الخطأ المعياري لمعامل الانحدار 

𝑆𝐸(�̂�1) = ( = Beta-0.904وأما القيمة ) .1التقدير دقةذلك من  دلوالتي كلما كانت منخفضة كلما ، 0.380
 .المعياريةفهي قيمة معامل الانحدار 

5.385−ومن العامودين الأخيرين في الجدول، نستطيع كتابة؛  < 𝛽1 < يعني أننا واثقون أي أننا  3.841−
من  سيتراوح في العموم بين انخفاض تأثير عدد أفراد الأسرة على مستوى الطالب الدراسي بأن تقدير 95بنسبة %

 .1درجات تقريبا في المقرر 5إلى  4

معامل الارتباط المتعدد ومعامل التحديد يمثل قيم والذي ((، 9.5) جدول، )الرابع في نافذة المخرجاتالجدول  منو 
، والتي تدل على وجود علاقة قوية أن قيمة معامل الارتباط المتعدد ملاحظةأولا يمكننا ومعامل التحديد المعدل، 

 ، ولكن بدون الإشارة السالبة.(R = 0.904الثنائي، ) طهي نفسها قيمة معامل بيرسون للارتبا تغيرين،جدا بين الم

 " على "الأسرة".1"المقرر: قيم معامل التحديد لنموذج انحدار 9.5جدول 
Model Summary 

Model R R Square Adjusted R Square Std. Error of the Estimate 

1 .904a .817 .812 6.769 
a. Predictors: (Constant), عدد أفراد أسرة الطالب 

تقريبا من  82نموذج الانحدار الموفق يفسر % بأن ، يمكننا القول(R Square) بالنظر لقيمة معامل التحديدو 
، )المتغير التابع( اعتمادا على عدد أفراد الأسرة )المتغير التوضيحي( 1الاختلاف في درجات الطالب في المقرر
 وكذلك الأمر مع قيمة معامل التحديد المعدل الذي يكون له نفس التعليق.وهذه النسبة في التفسير ت عد جيدة جدا، 

تحليل  اختبار النموذج ككل، وهو اختبار أيونأتي الآن للاختبار الأكثر أهمية في تقييم نموذج الانحدار الموفق، 
 التباين.

 " على "الأسرة".1"المقررذج انحدار : جدول تحليل التباين لنمو 10.5جدول 
ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 6767.575 1 6767.575 147.708 .000b 

Residual 1511.967 33 45.817     

Total 8279.543 34       
a. Dependent Variable: 1درجة الطالب في المقرر  
b. Predictors: (Constant), عدد أفراد أسرة الطالب 

" على 1"المقرر((، يمكننا استنتاج أن نموذج انحدار 10.5ففي الجدول الخامس في نافذة المخرجات، )جدول )
مما يدفعنا لرفض الفرضية  value = 0-Pبقيمة احتمالية  cF 147.708 =هو نموذج معنوي، حيث أن  "الأسرة"

:𝐻0الصفرية   .(نموذج الانحدار غير معنوي )

                                                 
نات مختلفة أو نماذج يتم عادة ما تستخدم قيم الخطأ المعياري في المقارنة بين عدة نماذج انحدار لنفس المتغيرات ولكن باستخدام عي 1

 فيها تغيير المتغيرات التوضيحية مع "تثبيت" المتغير التابع.
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وهكذا، وكمحصلة لنتائج تقييم نموذج الانحدار السابقة، يمكننا استنتاج أن نموذج انحدار درجات الطلبة في 
 على عدد أفراد الأسرة هو نموذج جيد التوفيق ويمكن استخدامه لدراسة العلاقة بين هذين المتغيرين وللتنبؤ. 1المقرر

 بناء على قيمة افتراضية أو أكثر لعدد أفراد الأسرة، ولنأخذ 1ما في المقررفمثلا؛ يمكننا التنبؤ بدرجات طالب 
𝑥0القيمة  = �̂�0  :، فعندها يكون لعدد أفراد أسرة 14 = 98.994 − 4.613 (14) = ، بمعنى أنه 34.412

 درجة تقريبا. 34ستنخفض إلى  1فردا فإن درجته في المقرر 14إذا أصبح عدد أفراد أسرة أحد الطلبة 

ختاما لهذا المثال، لنقم برسم خط الانحدار الموفق كما وضحنا أعلاه. قم في شريط الأوامر العلوي باختيار و 
Graphs>Legacy Dialogs>Scatter/Dot  ثم اختر الانتشار البسيط، ثم اضغط تعريف. وفي نافذة تعريف

ر متغير "الأسرة" وانقله لمربع المحور " وقم بنقله لمربع المحور الصادي واخت1المتغيرات اختر المتغير "المقرر
 السيني ثم اضغط موافق.

، وفي (Chart Editorبعد ظهور الرسم في نافذة المخرجات، قم بالنقر المزدوج عليه لتظهر نافذة تحرير الرسم )
قم بالضغط على إغلاق في تلك ثم  Elements>Fit Line at Totalشريط الأوامر العلوي لتلك النافذة اختر 

ثم أغلق نافذة التحرير، وسيكون شكل الانتشار للمتغيرين مع خط الانحدار لنافذة للعودة لنافذة تحرير الرسم، ا
، وي لاحظ من انتشار النقاط طبيعة العلاقة العكسية بين درجات الطلبة في (19.5الموفق كما هو في الشكل )

 وعدد أفراد الأسرة. 1المقرر

 
 شكل الانتشار لهما. " على متغير "الأسرة" مع1فق للمتغير "المقرر: خط الانحدار المو 19.5شكل 

، حيث أن القيم  �̂�0ونشير هنا إلى أنه من المفيد أحيانا النظر لقيمة )تقدير( الجزء المقطوع من المحور الصادي، 
عدد المتغيرات  المرتفعة لهذا المعامل قد تعني في بعد الأحيان ما ي عرف بنقص توصيف النموذج أي نقص في
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التوضيحية اللازمة لتكوين نموذج الانحدار الأفضل. لذلك، وفي كثير من الدراسات عادة ما نتجه لتكوين نماذج 
انحدار خطي متعددة بهدف مراقبة تأثير عدة متغيرات توضيحية على المتغير التابع، وهذا أقرب للواقع العملي 

 ناول التعامل مع نماذج الانحدار الخطي المتعدد في الجزء التالي.مهما كان مصدر متغيرات النموذج. وهكذا سنت

 (Multiple Linear Regression Analysis) المتعدد الخطي الانحدارتحليل  5.5

في الكثير من الدراسات التي تتطلب تطبيق أسلوب تحليل الانحدار، نجد أن توصيف العلاقة السببية  
عادة ما يكون فيه نقص في هذا التوصيف، بمعنى أن التغير في قيم المتغير  بين متغيرات الدراسة بمتغيرين فقط

التابع سيعتمد في الغالب على أكثر من متغير توضيحي واحد، وهنا تبرز الحاجة لإدراج عدة متغيرات توضيحية 
تغير التابع على في النموذج لتوصيف العلاقة السببية بشكل أوسع. وهكذا يمكن تعريف نموذج الانحدار المتعدد للم

𝑝 متغير توضيحي بالصورة التالية؛ 

𝑦𝑖 = 𝛽0 + 𝛽1𝑥𝑖1 + 𝛽2𝑥𝑖2 +⋯+ 𝛽𝑝𝑥𝑖𝑝 + 𝜀𝑖 
 أو

𝑦𝑖 = 𝛽0 +∑ 𝛽𝑗𝑥𝑖𝑗
𝑝

𝑗=1
+ 𝜀𝑖 

𝑖حيث   = 1, 2, … , 𝑛 و ، 𝑗 = 1, 2, … , 𝑝. 

من الناحية " لتوفيق نموذج انحدار متعدد وتفسير النتائج. و 2الطلبةولنقم باستخدام متغيرات ملف البيانات "بيانات 
يمكننا قبل البدء بتوفيق نموذج الانحدار العملية في الدراسات المتضمنة لاستخدام أسلوب تحليل الانحدار المتعدد، 

ضيحية، وذلك عن الخطي المتعدد أن "نستكشف" طبيعة العلاقة بين المتغير التابع وكل متغير من المتغيرات التو 
 طريق حساب معامل الارتباط الخطي البسيط لكل زوج منهما.

 3درجة الطالب في المقرر ات التوضيحية:متغير الولنفرض أننا نريد توفيق نموذج انحدار خطي لدراسة تأثير 
ومية (، ومعدل ساعات دراسة الطالب الي"الأسرة"(، وعدد أفراد أسرة الطالب )"العمر"(، وعمر الطالب )"3مقرر")
 .("2مقرر") 2( على متغير الاستجابة وهو درجة الطالب في المقرر"ساعات_الدراسة")

أو )سنقوم أولا بحساب مصفوفة الارتباط للعلاقات الثنائية بين المتغير التابع وكل متغير توضيحي لمراقبة وجود 
وفي  Analyze>Correlate>Bivariateفي شريط الأوامر العلوي قم باختيار علاقة خطية بينهما.  (عدم وجود

"العمر"، "الأسرة"، "، 3"مقرر"، 2المتغيرات "مقررسنقوم باختيار ((، 10.5نافذة الارتباط البسيط، )الشكل )
 .، ثم نضغط موافق( على اليمينVariablesإلى مربع المتغيرات ) ونقلها و"ساعات_الدراسة"
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 حليلبت تلك المصفوفة دامخوسنقوم باست((، 11.5) جدولستظهر مصفوفة الارتباط المطلوبة في نافذة المخرجات، )
 :، كما يليفقط، )وهي علاقة المتغير التابع بكل متغير توضيحي(أربعة علاقات 

 العمر"، "الأسرة"، و"ساعات_الدراسة"."، "3"، "مقرر2مقرر"مصفوفة معاملات الارتباط بين المتغيرات : 11.5جدول 
Correlations 

  

درجة الطالب 

 2في المقرر

درجة 

في  الطالب

 3المقرر

عمر الطالب 

 بالسنوات

عدد أفراد 

 أسرة الطالب

معدل ساعات 

الدراسة 

 اليومية

درجة الطالب 

 2في المقرر

Pearson Correlation 1 .055 -.454-** -.907-** .847** 

Sig. (2-tailed)   .752 .006 .000 .000 

N 35 35 35 35 35 

درجة الطالب 

 3في المقرر

Pearson Correlation .055 1 -.082 -.102 -.089 

Sig. (2-tailed) .752   .639 .561 .610 

N 35 35 35 35 35 

عمر الطالب 

 بالسنوات

Pearson Correlation -.454-** -.082 1 .292 -.456-** 

Sig. (2-tailed) .006 .639   .089 .006 

N 35 35 35 35 35 

عدد أفراد 

 أسرة الطالب

Pearson Correlation -.907-** -.102 .292 1 -.764-** 

Sig. (2-tailed) .000 .561 .089   .000 

N 35 35 35 35 35 

معدل ساعات 

الدراسة 

 اليومية

Pearson Correlation .847** -.089 -.456-** -.764-** 1 

Sig. (2-tailed) .000 .610 .006 .000   

N 35 35 35 35 35 

**. Correlation is significant at the 0.01 level (2-tailed). 

 3ودرجته في المقرر 2وجود علاقة خطية ضعيفة جدا بين درجة الطالب في المقرر حظنلا( ،r = 0.055 

 (.Sig. = 0.752و

 2بين درجة الطالب في المقرر معنويةد علاقة خطية عكسية جو ت ( ،وعمرهr = -0.454 وSig. = 0.006.) 

  حيث وعدد أفراد أسرته،  2بين درجة الطالب في المقررعكسية قوية جدا د علاقة خطية جو تو(r = -0.907 
 (.Sig. = 0و

 ثيح معدل ساعات دراسته اليومية، 2د علاقة خطية طردية قوية جدا بين درجة الطالب في المقرروجت لككذ 
(r = 0.847 و Sig. = 0.) 

كما يظهر في  ويمكننا إضافة لما سبق، استخدام مصفوفة شكل الانتشار لمراقبة العلاقات السابقة بصورة مرئية
وي لاحظ على الأخص انتشار ، حيث أن العلاقات الأربعة موجودة في الصف الأول من الرسم، (20.5شكل )

، ووجود علاقة عكسية "لا بأس 3ودرجته في المقرر 2النقاط بشكل عشوائي غير محدد لدرجة الطالب في المقرر
 .وعمره 2بها" بين درجة الطالب في المقرر
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 "، "العمر"، "الأسرة"، و"ساعات_الدراسة".3"، "مقرر2"مقررللمتغيرات فوفة شكل الانتشار : مص20.5شكل 

وبالتالي يمكننا مبدئيا القول بأن المتغيرات الثلاثة؛ عمر الطالب وعدد أفراد أسرته ومعدل ساعات دراسته ستكون 
أما متغير درجة الطالب  .2حدار خطي جيد مع متغير درجة الطالب في المقررن"مؤهلة" لتكوين نموذج امتغيرات 
فالرأي الأولي يشير بأنه لن يكون ذو أهمية في التأثير على المتغير التابع، إلا أننا، وبدافع تقديم شرح  3في المقرر

 متغيرات الدراسة المقترحة منذ البداية. بكلامل لتفسير نتائج الانحدار المتعدد، سنكمل توفيق نموذج الانحدار متك

((، باختيار المتغير 15.5نقوم في نافذة تحليل الانحدار الخطي، )شكل )لانحدار المتعدد المطلوب لتوفيق نموذج ا
كمتغيرات توضيحية، ثم نضغط  مر"، "الأسرة"، و"ساعات_الدراسة""، "الع3"مقرر" كمتغير تابع، والمتغيرات 2"المقرر

( Estimates، نختار عرض التقديرات )( وفي النافذة الفرعية الخاصة بهStatisticsعلى خيار الإحصاءات )
، ثم نضغط استمرار للعودة للنافذة (Model Fit( وتوفيق النموذج )Confidence Intervalsوفترات الثقة )

وسنعرض هنا الجداول الثلاثة المهمة في ، الأصلية، ونضغط بعد ذلك موافق فتظهر النتائج في نافذة المخرجات
نستطيع كتابة نموذج الانحدار المتعدد (، 12.5من جدول ) ؛تفسير النتائج المنطقي بحسب ترتيب تلك النافذة تباعا
 الموفق كالتالي:

�̂�𝑖 = 109.369 + 0.007𝑥𝑖1 − 1.203𝑥𝑖2 − 3.189𝑥𝑖3 + 3.220𝑥𝑖4     , 𝑖 = 1, 2, … , 35 

 أو بطريقة أخرى؛

̂(المقرر2)
𝑖 = 109.369 + 𝑖(المقرر3)0.007 − 1.203( لعمرا )𝑖 − 𝑖(الأسرة)3.189 +  𝑖(ساعات_الدراسة)3.220
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 ويمكن تفسير قيم معاملات الانحدار بالصورة التالية:

 2لن يؤدي لزيادة ت ذكر في درجات الطالب في المقرر 3المقرر زيادة درجة واحدة في، (�̂�1 = 0.007). 
 2ة تقريبا في درجات الطالب في المقررزيادة سنة واحدة في عمر الطالب يؤدي لانخفض قدره درجة واحد ،
(�̂�2 = −1.203.) 
  2درجات تقريبا في درجات الطالب في المقرر 3زيادة فرد واحد في أسرة الطالب يؤدي لانخفض قدره ،
(�̂�3 = −3.189.) 
  درجات تقريبا في  3زيادة ساعة واحدة في معدل ساعات المذاكرة اليومية للطالب يؤدي لارتفاع قدره

�̂�4) ،2درجات الطالب في المقرر =  في النموذج. �̂�0وذلك بإهمال قيمة الجزء المقطوع  (.3.220

"، "العمر"، "الأسرة"، 3"مقرر" على المتغيرات 2"المقرر: نتائج تقدير معالم نموذج الانحدار الخطي المتعدد للمتغير 12.5جدول 
 .و"ساعات_الدراسة"
Coefficientsa 

Model 

Unstandardized 

Coefficients 

Standardized 

Coefficients 

t Sig. 

95.0% Confidence 

Interval for B 

B 

Std. 

Error Beta 

Lower 

Bound 

Upper 

Bound 

1 (Constant) 109.369 17.876   6.118 .000 72.862 145.877 

درجة الطالب في 

 3المقرر
.007 .067 .006 .098 .923 -.130 .143 

عمر الطالب 

 بالسنوات
-1.203 .630 -.130 -1.909 .066 -2.490 .084 

عدد أفراد أسرة 

 الطالب
-3.189 .481 -.641 -6.633 .000 -4.171 -2.207 

معدل ساعات 

 الدراسة اليومية
3.220 1.128 .298 2.854 .008 .916 5.525 

a. Dependent Variable: 2درجة الطالب في المقرر  

الفرضية الصفرية التي لقبول  نتجه((، 12.5من نفس الجدول، )جدول )و دة نموذج الانحدار الموفق، ولتقييم جو 
ورفض نفس الفرضية ، 2درجة الطالب في المقررعلى  " و"العمر"3"مقرر اتتنص على عدم أهمية تأثير المتغير 

 الصفرية بالنسبة للمتغيرين "الأسرة" و"ساعات_الدراسة".

 تاجات النهائية، نكمل تحليل المخرجات، فمن فترات الثقة لمعالم النموذج نستطيع كتابة:وقبل الوثوب للاستن

 :4.171− لمتغير "الأسرة" لدينا < 𝛽3 <  بأن تقدير 95يعني أننا واثقون بنسبة %أي أننا  2.207−
درجات  4إلى  2سيتراوح في العموم بين انخفاض من  2في المقررالطالب  درجاتتأثير عدد أفراد الأسرة على 

 تقريبا.

  :0.916لمتغير "ساعات_الدراسة" يكون < 𝛽4 <  95يعني أننا واثقون بنسبة %أننا  بمعنى 5.525
 ارتفاعسيتراوح في العموم بين  2في المقررالطالب  درجاتعلى  معدل ساعات الدراسة اليوميةتأثير  بأن تقدير

 درجات تقريبا. 6إلى  درجة واحدةمن 
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غيرين التوضيحيين الآخرين فلن يتم التعليق على فترات الثقة الخاصة بمعاملات الانحدار لهما نظرا أما بالنسبة للمت
 لعدم أهميتهما في النموذج.

مشاهدة ((، يمكن 13.5من جدول قيم معامل الارتباط المتعدد ومعامل التحديد ومعامل التحديد المعدل، )جدول )
وجود علاقة قوية جدا بين المتغير التابع وباقي المتغيرات التوضيحية  أن قيمة معامل الارتباط المتعدد تدل على

 ككل.

تقريبا من الاختلاف في  89نموذج الانحدار الموفق يفسر %وبالنظر لقيمة معامل التحديد، يمكننا القول بأن 
هي نسبة ممتازة )المتغير التابع( اعتمادا على المتغيرات التوضيحية في النموذج، و  2درجات الطالب في المقرر

 وكذلك الأمر مع قيمة معامل التحديد المعدل.للنموذج، 

"، "العمر"، 3"مقررالمتغيرات " على 1"المقرر: قيم معامل التحديد لنموذج انحدار 13.5جدول 
 ."الأسرة"، و"ساعات_الدراسة"

Model Summary 

Model R R Square Adjusted R Square Std. Error of the Estimate 

1 .945a .894 .879 5.284 

a. Predictors: (Constant), 3معدل ساعات الدراسة اليومية, درجة الطالب في المقرر عمر الطالب بالسنوات, عدد  ,

 أفراد أسرة الطالب

" 2"المقرر((، فنخلص إلى أن نموذج انحدار 14.5، )جدول )الموفق نتيجة تحليل التباين لنموذج الانحدارمن وأما 
مما  value = 0-Pبقيمة احتمالية  cF  =63.015باقي المتغيرات التوضيحية هو نموذج معنوي، حيث أن  على

:𝐻0يدفعنا لرفض الفرضية الصفرية   .(نموذج الانحدار غير معنوي )

"، "العمر"، "الأسرة"، 3"مقرر" على المتغيرات 1"المقرر: جدول تحليل التباين لنموذج انحدار 14.5جدول 
 .ات_الدراسة"و"ساع

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 7037.382 4 1759.346 63.015 .000b 

Residual 837.589 30 27.920     

Total 7874.971 34       
a. Dependent Variable: 2درجة الطالب في المقرر  

b. Predictors: (Constant), عمر الطالب بالسنوات, عدد أفراد أسرة الطالب3الدراسة اليومية, درجة الطالب في المقرر معدل ساعات ,  

مر"، "الأسرة"، "، "الع3المتغيرات "مقررعلى  2وهكذا، فإنه يمكن القول بأن نموذج انحدار درجات الطلبة في المقرر
 مر""العو "3"مقرريشتمل على المتغيرين هو نموذج جيد التوفيق في العموم، ولكن يجب أن لا  و"ساعات_الدراسة"

المتغيرات  أن وهذا يعني. 2نظرا لانخفاض تأثيرهما وافتقارهما لعلاقة سببية قوية مع درجات الطلبة في المقرر
هما عدد أفراد الأسرة ومعدل ساعات الدراسة اليومية،  2الأكثر أهمية في التأثير على درجة الطالب في المقرر

التوضيحي "العمر" لم يجتز اختبار المعنوية رغم ارتباطه بالمتغير التابع بشكل معنوي عند  ولاحظ أن المتغير
 حساب معامل الارتباط.
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ولاستخدام نموذج الانحدار في التنبؤ، يمكنك التعويض بأي قيم تنبؤيه )للمتغيرات التوضيحية( في النموذج الموفق 
، ألا أنه من المنطقي إعادة توفيق النموذج أولا باستخدام 2ررللحصول على قيمة تقديرية لدرجات الطلبة في المق

في هذه المتغيرات التي أظهرت تأثيرا معنويا في النتائج السابقة بدلا من استخدام النموذج السابق في التنبؤ. 
 إعادة توفيق نموذج الانحدار الخطي المتعدد:القارئ  نقترح علىالمرحلة، 

كمتغيرات توضيحية  "الأسرة"، و"ساعات_الدراسة"تابع والمتغيرين  " كمتغير2باستخدام المتغير "مقرر .1
 وملاحظة التغير في نتائج التحليل.

" كمتغيرات تابعة تارة وتوضيحية تارة أخرى 2باستخدام متغيرات أخرى من ملف البيانات "بيانات الطلبة .2
 .1ومحاولة الوصول لنماذج جيدة

 

 البواقيتحليل تقييم فرضيات النموذج الخطي و  6.5
(Assessing Model Assumptions and Residual Analysis) 

أو كما  ديةالاعتيا ، تم عرض الفرضيات التي ترتكز عليها طريقة المربعات الصغرى (2.3.5البند )في 
 ، سنعرض بعض النقاط الهامة حول كيفية تقييمالبندي طلق عليها فرضيات نموذج الانحدار الخطي، وفي هذا 

ابتعاد قيم المتغير التابع المقدرة  مثلتبتحليل البواقي، التي  كثير منهالخطي والتي سيتعلق فرضيات النموذج ا بعض
 عن قيمه الفعلية.

 (Linearity of the Model Assumption)فرضية خطية النموذج  1.6.5

من متغيرين حيث أنه لا يمكن رسم شكل الانتشار أو خط الانحدار للنموذج الموفق عند وجود أكثر 
في تمثيل البياني(، فإننا نلجأ لرسم  (3D) توضيحيين في النموذج، )بمعنى أننا لن نستطيع تخطي الأبعاد الثلاثة

شكل الانتشار للمتغير التابع مع كل متغير توضيحي على حدة ومراقبة سلوك نقاط الانتشار، فإذا كان نمط انتشار 
)إضافة لوجود معاملات ارتباط خطي معنوية(، فإننا نستطيع  النقاط في "معظم" الأشكال يأخذ السلوك الخطي،

 نموذج الانحدار يحقق فرضية الخطية. إنالقول 

 

                                                 
 Best Model) النموذج الأفضلاختيار بما ي عرف  ، ومنهاالنماذج في مفهوم تحليل الانحدار الخطي المتعدد توجد عدة طرق لبناء 1

selectionها.( باستخدام مجموعة من المتغيرات، إلا أن المجال لا يسمح هنا بعرض 
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، وهذه تقييم فرضيات النموذج الخطي وتحليل البواقي( كتطبيق عملي على 15.5سنستخدم البيانات في جدول ) 
مسة متغيرات تمثل نتائج اختبارات تقييم البيانات تضم خ

شخصا في مركز  25لعينة مكونة من  سلوكينفسي و 
، حيث يخضع يكار دلإاو  سلوكيلتقييم اللمتخصص 

(، 4، ...، تقييم1الشخص لأربعة اختبارات مختلفة، )تقييم
ثم يتم منحه التشخيص النفسي النهائي بناء على نتائج 

ذه التقييمات الأربعة من خلال مؤشرات خاصة، وه
النهائي يتم حسابها  السلوكي التقييمات بما فيها التشخيص

 درجة. 100إلى  1على مقياس من 

وارتفاع درجة التشخيص السلوكي تدل على اقتراب الشخص 
من الوضع السلوكي والنفسي الطبيعي، وانخفاض هذه 
الدرجة ي عد مؤشرا على وجود اضطرابات سلوكية عند هذا 

 الشخص.

( في ملف 15.5ل البيانات من الجدول )سنقوم أولا بإدخا
، باسم "التشخيص السلوكي" SPSSبيانات جديد في برنامج 

وسيكون الهدف الأساسي من استخدام تحليل الانحدار 
التقييمات الأربع  تأثيردراسة كيفية الخطي لهذه البيانات هو 

وكي" سيمثل المتغير التابع في للأشخاص، بمعنى أن متغير "التشخيص_السل على التشخيص السلوكي النهائي
 ." ستكون المتغيرات التوضيحية4"، و"تقييم3"، "تقييم2"، "تقييم1النموذج، والمتغيرات "تقييم

وحيث أننا مهتمون في هذا الجزء بتقييم فرضية خطية نموذج الانحدار، سنقوم أولا بإيجاد مصفوفة معاملات 
في شريط علاقة بين المتغير التابع وبقية المتغيرات التوضيحية. ال ونوع الارتباط الخطي البسيط لمراقبة طبيعة

((. 10.5فتظهر نافذة الارتباط البسيط، )الشكل ) Analyze>Correlate>Bivariateالأوامر العلوي قم باختيار 
وسنقوم بحساب معاملات الارتباط الخطي البسيط بين كل المتغيرات، فنقوم بنقلها إلى مربع المتغيرات 

(Variables على اليمين. وحيث أن كل المتغيرات المختارة هنا هي متغيرات كمية فسنختار حساب معامل )
بيرسون فقط ثم نضغط موافق فنحصل على مصفوفة الارتباطات البسيطة بين المتغيرات الم ختارة كما يظهر في 

ت الارتباط بين المتغير وفي هذا الجدول، ستكون مراقبتنا للصف الأخير فقط، أي لمعاملا (.16.5جدول )
 حية الأربعة.المتغيرات التوضيو  "التشخيص_السلوكي"

 

 شخص. 25: نتائج تقييم نفسي لعينة من 15.5جدول 
 

التشخيص  4تقييم 3تقييم 2تقييم 1تقييم
 سلوكيال

1 36 60 50 37 38 
2 12 47 49 50 30 
3 60 57 53 53 46 
4 51 67 43 45 26 
5 50 51 45 38 30 
6 28 35 45 34 23 
7 70 27 30 24 8 
8 55 72 66 52 66 
9 62 69 56 55 54 

10 70 39 55 47 49 
11 37 31 40 38 14 
12 83 70 63 58 76 
13 90 71 46 39 44 
14 34 63 48 28 21 
15 56 52 59 59 61 
16 59 79 52 58 59 
17 54 33 50 52 50 
18 100 68 57 60 77 
19 48 75 58 45 49 
20 70 44 45 40 32 
21 24 71 41 35 17 
22 46 64 64 53 59 
23 54 23 43 30 28 
24 44 71 65 54 65 
25 41 79 47 33 33 
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 "، و"التشخيص_السلوكي".4"، "تقييم3"، "تقييم2"، "تقييم1"تقييم: مصفوفة الارتباطات البسيطة للمتغيرات 16.5جدول 
Correlations 

 التشخيص_السلوكي 4تقييم 3تقييم 2تقييم 1تقييم  

 **Pearson Correlation 1 .102 .181 .327 .514 1تقييم

Sig. (2-tailed)   .627 .387 .111 .009 

N 25 25 25 25 25 

 *Pearson Correlation .102 1 .519** .397* .497 2تقييم

Sig. (2-tailed) .627   .008 .050 .011 

N 25 25 25 25 25 

 **Pearson Correlation .181 .519** 1 .782** .897 3تقييم

Sig. (2-tailed) .387 .008   .000 .000 

N 25 25 25 25 25 

 **Pearson Correlation .327 .397* .782** 1 .869 4تقييم

Sig. (2-tailed) .111 .050 .000   .000 

N 25 25 25 25 25 

 Pearson Correlation .514** .497* .897** .869** 1 التشخيص_السلوكي

Sig. (2-tailed) .009 .011 .000 .000   

N 25 25 25 25 25 

**. Correlation is significant at the 0.01 level (2-tailed). 

*. Correlation is significant at the 0.05 level (2-tailed). 

ع وكل المتغيرات التوضيحية اختبارات الفروض الخاصة بتلك المعاملات أن العلاقة بين المتغير التابوي لاحظ من 
ن كانت علاقة P-value < 0.05هي علاقة خطية ذات معنوية، ) " 3"التشخيص_السلوكي" بالمتغيرين "تقييم(. وا 

بكثير من المتغيرين الآخرين. ولرؤية الصورة بشكل أوضح، سنقوم باستخدام التمثيل البياني  ى " ت عد أقو 4و"تقييم
 م مصفوفة شكل الانتشار.لتلك المعاملات، أي أننا سنستخد

وفي نافذة اختيار شكل  Graphs>Legacy Dialogs>Scatter/Dotباختيار  قم في شريط الأوامر العلوي 
المتغيرات ونقلها  كل باختيار قم الفرعيةنافذة وفي الالانتشار، قم باختيار شكل مصفوفة الانتشار ثم اضغط تعريف 

 ضغط موافق.ا( ثم Matrix Variablesإلى مربع متغيرات المصفوفة )

مدى قوة العلاقة ((، 21.5في مصفوفة شكل الانتشار، )شكل ) من الصف الأخير في نافذة المخرجات، سنلاحظ
إلا أنه في العموم، يمكننا القول أن  ".4" و"التقييم3الطردية بين متغير "التشخيص_السلوكي" والمتغيرين "التقييم

بط بعلاقات خطية مع المتغيرات التوضيحية، وبالتالي لا توجد مخالفة لفرضية المتغير التابع في هذا النموذج يرت
 خطية نموذج الانحدار.
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 "، و"التشخيص_السلوكي".4"، "تقييم3"، "تقييم2"، "تقييم1"تقييمللمتغيرات : مصفوفة شكل الانتشار 21.5شكل 

 

 (Non-Random Explanatory Variables) توضيحيةفرضية عدم عشوائية المتغيرات ال 2.6.5

المستخدمة لتقييم هذه الفرضية هو رسم شكل الانتشار لقيم البواقي ضد قيم كل  ليةالعم من ضمن الطرق 
، فهذا يدل على خطيا كان أو غير خطيامتغير توضيحي، فإذا أظهر الشكل سلوكا منتظما أو نمطا محددا للنقاط، 

 على عشوائية هذا المتغير وبالتالي مخالفة هذه الفرضية. ارتباط هذا المتغير التوضيحي بالخطأ العشوائي مما يدل

ولرسم شكل الانتشار المطلوب، )بين البواقي والمتغيرات التوضيحية(، يجب أولا الحصول على قيم البواقي 
 بالطريقة التالية: SPSS، وهذه القيم يمكن حسابها في 𝜀̂المقدرة من نموذج الانحدار، 

"التشخيص_السلوكي" على المتغيرات _السلوكي"، قم بتوفيق نموذج انحدار المتغير في ملف البيانات "التشخيص
، وفي نافذة Analyze>Regression>Linearاختيار "، من خلال 4"، و"التقييم3"، "التقييم2"، "التقييم1"التقييم

"، 2"، "التقييم1لتقييمالتشخيص_السلوكي" كمتغير تابع والمتغيرات "اقم بتعيين المتغير تحليل الانحدار الخطي 
 كمتغيرات توضيحية. "4"، و"التقييم3"التقييم

(، وهذه النافذة 22.5( في هذه النافذة فتظهر نافذة فرعية جديدة كما يظهر في الشكل )Saveخيار الحفظ )اضغط 
هي مخصصة في معظمها لحفظ القيم المقدرة، وحساب بعض المقاييس من نموذج الانحدار الخطي في ملف 

 بيانات كمتغيرات جديدة.ال
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 : نافذة حفظ القيم المقدرة في نموذج الانحدار الخطي.22.5شكل 

( في مربع القيم المقدرة Unstandardized) غير المعيارية 1قم باختيار حفظ قيم المتغير التابع المقدرة
(Predicted Values واختيار حفظ )لبواقي ل غير المعيارية المقدرة قيمال(Unstandardized في مربع البواقي )
(Residuals( كما يظهر في الشكل ،)ثم اضغط استمرار. وفي النافذة الأصلية لتحليل الانحدار اضغط 22.5 ،)

 موافق للتنفيذ.

ستظهر بعد ذلك النتائج في نافذة المخرجات، إلا أننا الآن لن نكون مهتمين بها حاليا نظرا لتركيزنا على استخدام 
"، RES_1قط والتي سنجد أنها قد تم إضافتها كمتغير جديد لملف البيانات "التشخيص_السلوكي" باسم "قيم البواقي ف

 (.23.5كما ي لاحظ في الشكل ) "(،PRE_1)باسم " إلى جانب قيم المتغير التابع المقدرة،

قوم بتنفيذ أربع "( مع كل متغير توضحي، أي أننا سنRES_1سنقوم الآن برسم شكل الانتشار للبواقي )المتغير "
 أشكال انتشار كل على حده.

                                                 
 ولن يتم استخدامها في التمثل البياني هنا. ،SPSSاختيار قيم المتغير التابع المقدرة لتوضيح كيفية الحصول عليها في برنامج تم  1
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: ملف البيانات "التشخيص_السلوكي" بعد إضافة قيم البواقي وقيم المتغير التابع المقدرة من 23.5شكل 

 نموذج الانحدار.

 Graphs>Legacy Dialogs>Scatter/Dotلتنفيذ شكل الانتشار، سنقوم من شريط الأوامر العلوي باختيار 
الخيارات، سنبقي على الخيار الافتراضي، وهو شكل الانتشار البسيط، ونضغط على تعريف فتظهر  وفي نافذة

 ((.2.5نافذة جديدة لاختيار المتغيرات في شكل الانتشار البسيط، كما في الشكل )

المتغير ( واختيار Y-Axis" ونقله لمربع المحور الصادي )RES_1في تلك النافذة، سنقوم باختيار متغير البواقي "
(، ثم نضغط موافق فنحصل على شكل الانتشار بين المتغيرين. X-Axis" ونقله لمربع المحور السيني )1"تقييم

فنحصل على الرسومات " 4"، و"تقييم3"، "تقييم2"تقييم لمتغيرات الثلاثة الأخرى؛ا وسنقوم بتكرار هذه الخطوة مع
 (.24.5الأربعة كما يوضح الشكل )

  

  
 ."4"، و"تقييم3"، "تقييم2"تقييم "،1"تقييم شكل الانتشار للبواقي مع المتغيرات التوضيحية: 24.5شكل 
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ونلاحظ من شكل انتشار النقاط في الرسومات الأربعة أنها تنتشر بصورة عشوائية ولا تأخذ نمط أو اتجاه معين، 
ير توضيحي وبالتالي يدل ذلك على وهذا يدل على عدم وجود علاقة، خطية أو غير خطية، بين البواقي وأي متغ

 في نموذج الانحدار الموفق. عدم عشوائية المتغيرات التوضيحيةتحقق فرضية 

 (Independence of Errors Assumption)فرضية استقلالية المتغيرات التوضيحية  3.6.5

فيها أحد  توجد عدة طرق للتحقق من هذه الفرضية، ولعل أبرزها هي توفيق نماذج انحدار خطي يكون 
هي المتغيرات  ، )باستثناء المتغير التابع الأصلي(،باقي المتغيراتو المتغيرات التوضيحية هو المتغير التابع 

. وبمراقبة نتائج توفيق هذه النماذج الجديدة، يتم تحديد المتغيرات التوضيحية التي ت ظهر التوضيحية في كل مرة
رات مرتبطة خطيا بباقي المتغيرات التوضيحية، وهو ما ي عرف بمشكلة نتائج "معنوية" كمتغيرات تابعة بأنها متغي

 ( في مفهوم تحليل الانحدار.Multicollinearity) التعدد الخطي

للبيانات "التشخيص السلوكي"، سنقوم بالتحقق من استقلالية المتغيرات التوضيحية الأربعة عن بعضها البعض عن 
جديدة يأخذ فيها كل متغير توضيحي دور المتغير التابع في كل مرة، توفيق أربعة نماذج انحدار خطي طريق 

، سنقوم في نافذة تحليل الانحدار، التي سنحصل عليها من أمر SPSSولتنفيذ ذلك في برنامج 
Analyze>Regression>Linear  3"، "تقييم2، "تقييم"1"تقييم، بوضع واحد من المتغيرات التوضيحية؛ ،"

لمتغير التابع، ووضع باقي المتغيرات، )باستثناء المتغير "التشخيص_السلوكي"(، في مربع في مربع ا "4و"تقييم
 المتغيرات التوضيحية.

( في نافذة تحليل الانحدار Statistics( فقط من خيار الإحصاءات )Model Fit)الحصول على  ثم نقوم باختيار
الأربعة، )وهي نتائج تحليل التباين  ئج تقييم النماذجالخطي لكل نموذج من النماذج الأربعة، وقد قمنا بتلخيص نتا

 (.17.5الجدول ) ومعاملات التحديد والارتباط المتعدد(، في جدول واحد هو

 من هذا الجدول، نستطيع استنتاج ما يلي:

كانت نتائج توفيقهما على باقي المتغيرات التوضيحية غير  ،"2" و"تقييم1"تقييم التوضيحيانالمتغيران  .1
على الترتيب(،  0.270و 0.121(، مصحوبة بمعاملات تحديد متدنية، )P-value > 0.05ة؛ )معنوي

وبالتالي نستطيع القول بأنهما لا يرتبطان بعلاقات خطية مع باقي المتغيرات التوضيحية، أي أنهما 
 مستقلان خطيا عنها.

ج معنوية في اعتمادهما خطيا على فقد أظهرا نتائ، "4" و"تقييم3"تقييمأما المتغيران التوضيحيان الآخران  .2
(، وهكذا 0.647و 0.668(، بمعاملات تحديد مرتفعة، )P-value = 0المتغيرات التوضيحية الأخرى، )

 فإنهما يشكلان مخالفة لفرضية الاستقلال الخطي بين المتغيرات التوضيحية في نموذج الانحدار الأصلي.
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" 4"، و"تقييم3"، "تقييم2"، "تقييم1التوضيحية "تقييمتي تكون فيها المتغيرات ال نتائج تقييم النماذج الأربعة: 17.5جدول 
 متغيرات تابعة في كل نموذج.

Model Summary   

Model R R Square 

Adjusted R 

Square 

Std. Error of 

the Estimate   
1 .348a .121 -.004 20.340   
a. Predictors: (Constant), 3قييم, ت2, تقييم4تقييم           

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1199.368 3 399.789 .966 .427b 

Residual 8688.392 21 413.733     

Total 9887.760 24       
a. Dependent Variable: 1تقييم  

b. Predictors: (Constant), 3, تقييم2, تقييم4تقييم         
Model Summary   

Model R R Square 

Adjusted R 

Square 

Std. Error of 

the Estimate   
1 .519a .270 .166 15.797   
a. Predictors: (Constant), 3, تقييم1, تقييم4تقييم           

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1936.458 3 645.486 2.587 .080b 

Residual 5240.582 21 249.552     

Total 7177.040 24       
a. Dependent Variable: 2تقييم  
b. Predictors: (Constant), 3, تقييم1, تقييم4تقييم         

Model Summary   

Model R R Square 

Adjusted R 

Square 

Std. Error of 

the Estimate   
1 .818a .668 .621 5.451   
a. Predictors: (Constant), 2, تقييم1, تقييم4تقييم           

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1258.108 3 419.369 14.116 .000b 

Residual 623.892 21 29.709     

Total 1882.000 24       
a. Dependent Variable: 3تقييم  

b. Predictors: (Constant), 2, تقييم1, تقييم4تقييم         
Model Summary   

Model R R Square 

Adjusted R 

Square 

Std. Error of 

the Estimate   
1 .805a .647 .597 6.779   
a. Predictors: (Constant), 2, تقييم1, تقييم3تقييم           

ANOVAa 

Model Sum of Squares df Mean Square F Sig. 

1 Regression 1770.482 3 590.161 12.843 .000b 

Residual 964.958 21 45.950     

Total 2735.440 24       
a. Dependent Variable: 4تقييم  

b. Predictors: (Constant), 2, تقييم1, تقييم3تقييم  

من نافذة تحليل  خطيا عن بعضها البعض اختبار استقلالية المتغيرات التوضيحية إجراءوننوه هنا إلى إمكانية 
 ,Variance Inflation Factor) معامل تضخم التباينباستخدام الانحدار، وذلك عند توفيق النموذج المطلوب، 

VIF( باسم تشخيص الار 16.5( المتوفر في خيار الإحصاءات في نافذة تحليل الانحدار، )شكل ،)) تباط الخطي
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(Collinearity Diagnostics والذي يوفر أيضا مؤشرا جيدا لمراقبة وجود مشكلة التعدد الخطي بين المتغيرات ،)
 التوضيحية.

 (Normality of Error Terms)فرضية توزع الخطأ بتوزيع طبيعي  4.6.5

-اختبار شابيروسميرنوف و -من ضمنها اختبار كولموجروف د عدة طرق للتحقق من هذه الفرضيةتوج
للتحقق من  QQ التمثيل البياني ، إضافة لإمكانية استخدامفي الفصل الثالث واللذان تم التطرق لهما سابقا ،ويلك

 توزع الخطأ طبيعيا.

البيانات "التشخيص السلوكي" قيم البواقي لنموذج الانحدار الخطي الموفق، وهكذا سنقوم ببساطة  ملف لدينا في
واختيار خيار الرسم الطبيعي مع الاختبارات  Analyze>Descriptive Statistics>Exploreباختيار أمر 

(Normality plot with tests( ضمن خيار الرسم )Plots.ثم الضغط على موافق ،) 

يمكن الاستنتاج من كلا الاختبارين أن البواقي تتبع ((، 18.5ومن الجدول الخاص باختبارات الطبيعية، )جدول )
 (.P-value > 0.05عي، )التوزيع الطبي

: اختبارات كولمجروف وشابيرو للبواقي في نموذج انحدار 18.5جدول 
 ."السلوكي_التشخيص"

Tests of Normality 

  

Kolmogorov-Smirnova Shapiro-Wilk 

Statistic df Sig. Statistic df Sig. 

 174. 25 943. *200. 25 120. البواقي
*. This is a lower bound of the true significance. 
a. Lilliefors Significance Correction 

ضافة لاختبارات الطبيعية، يمكن استخدام رسم  والذي يؤكد طبيعية توزع (، 25.5كما يظهر في شكل ) QQوا 
 .، حيث أن النقاط تقترب من الخط المستقيم بشكل كبيرالبواقي

 
 حدار "التشخيص_السلوكي".لبواقي نموذج ان QQ: رسم 25.5شكل 
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 Analyze>Descriptiveللبواقي إما باستخدامه من شريط الأدوات العلوي  QQرسم ويمكن الحصول على 

Statistics>Q-Q Plots" واختيار البواقي ،RES_1 التوزيع الطبيعي " في مربع المتغيرات، أو استخدام خيار رسم
(Normal probability plot( في خيار الرسم )Plots في نافذة تحليل الانحدار الخطي والذي سيوفر رسم )

QQ ( للبواقي المعياريةStandardized Residuals.) 

 (Homoscedasticity Assumption)تجانس تباين قيم حد الخطأ فرضية  5.6.5

للتحقق من مدى ثبات هذه الفرضية في نموذج الانحدار الخطي، سنستخدم طريقة بسيطة هي طريقة 
ار ارتباط الرتب لسبيرمان، والتي سوف تعتمد على اختبار ارتباط الرتب بين قيم البواقي المطلقة، )أي بأخذ اختب

القيمة المطلقة لها(، وقيم المتغيرات التوضيحية في نموذج الانحدار، فإذا وجدت علاقة ذات معنوية بينها دل ذلك 
 (.Heteroscedasticity) التجانس في التباين عدمعلى وجود مخالفة للفرضية، أي وجود ما يعرف بمشكلة 

في بيانات "التشخيص السلوكي"، سنقوم أولا بتعريف متغير جديد سيكون عبارة عن القيمة المطلقة لقيم البواقي، 
 وسيتم تعريف هذا المتغير كالتالي:

المتغير سنختار  وفي نافذة حساب Transform>Compute Variableفي شريط الأوامر العلوي، سنقوم باختيار 
( ومن تلك الدوال، )في المربع الأسفل Arithmetic( الدوال الرياضية )Function groupمن مجموعة الدوال )

(، ونقوم بالنقر المزدوج على الدالة، )أو سحبها بالفأرة إلى مربع الحساب Absمنها(، سنختار دالة القيمة المطلقة )
" في نطاق الدالة كما هو موضح في RES_1دخل متغير البواقي "ثم ن  ((، Numeric Expressionالرقمي )
 (.Target Variable" في المتغير المستهدف )ABS_RES(، وسنقوم بإعطائه الاسم "26.5الشكل )

 
 " في بيانات "التشخيص_السلوكي".RES_1: نافذة حساب متغير جديد، وهي القيمة المطلقة للبواقي "26.5شكل 



191 

 

افق فيتم إدراج المتغير الجديد المطلوب في جدول بيانات "التشخيص السلوكي". الآن سنقوم بعد ذلك نضغط مو 
 بتنفيذ اختبار معامل سبيرمان بين قيم البواقي المطلقة وكل متغير توضيحي في النموذج؛

 وفي نافذة الارتباط البسيط نقوم بنقل Analyze>Correlate>Bivariateفي شريط الأوامر العلوي نختار 
" إلى مربع المتغيرات، ونختار حساب معامل ABS_RES"، و"4"، "تقييم3"، "تقييم2"، "تقييم1المتغيرات "تقييم

ثم نضغط موافق فتظهر مصفوفة (، Correlation Coefficientsسبيرمان فقط من بين المعاملات الثلاثة في )
 (.19.5الارتباط البسيط كما هو في جدول )

 ."ABS_RES"، و"4"، "تقييم3"، "تقييم2"، "تقييم1"تقييمتباط البسيط بين المتغيرات مصفوفة الار : 19.5جدول 
Correlations 

 ABS_RES 4تقييم 3تقييم 2تقييم 1تقييم  

Spearman's rho 1تقييم Correlation 

Coefficient 
1.000 .030 .230 .441* .062 

Sig. (2-tailed)   .888 .268 .027 .769 

N 25 25 25 25 25 

 Correlation 2تقييم

Coefficient 
.030 1.000 .474* .336 -.104 

Sig. (2-tailed) .888   .017 .101 .622 

N 25 25 25 25 25 

 Correlation 3تقييم

Coefficient 
.230 .474* 1.000 .765** -.127 

Sig. (2-tailed) .268 .017   .000 .545 

N 25 25 25 25 25 

 Correlation 4تقييم

Coefficient 
.441* .336 .765** 1.000 .006 

Sig. (2-tailed) .027 .101 .000   .977 

N 25 25 25 25 25 

ABS_RES Correlation 

Coefficient 
.062 -.104 -.127 .006 1.000 

Sig. (2-tailed) .769 .622 .545 .977   

N 25 25 25 25 25 

*. Correlation is significant at the 0.05 level (2-tailed). 

**. Correlation is significant at the 0.01 level (2-tailed). 

ومن الصف الأخير في مصفوفة الارتباط يتضح أن كل العلاقات الثنائية بين البواقي المطلقة والمتغيرات التوضيحية 
𝐻0: 𝜌�̂�𝑋وبالتالي قبول الفرضية الصفرية ) (،P-value > 0.05هي ليست ذات معنوية، ) = ( لكل المتغيرات 0

 التوضيحية، مما يدل على تحقق فرضية تجانس تباين حد الخطأ.
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 سادسالفصل ال

 وتحليل الموثوقية اللامعلمية الاختبارات

 (Nonparametric Tests and Reliability Analysis) 

 

في الفصل الرابع، قمنا بالعديد من الاستدلالات الإحصائية حول معالم مثل الوسط الحسابي والتباين،  
أكثر، وكذلك تقدير فترات الثقة لتلك المعالم، وهذا وتم تنفيذ اختبارات لفرضيات تتناول عينة واحدة وعينتين وحتى 

( واختبارات الفروض ضمن مفهوم Parametric Estimationما يُعرف بالتقدير المعلمي ) يندرج كله تحت
)أي  البيانات . والشروط التي يعتمد عليها استخدام هذا التقدير تتمركز في الغالب على كون الإحصاء الاستدلالي

المراد اختبارها هي مسحوبة من مجتمعات تتبع توزيعا طبيعيا، إلا أن هذا الشرط أو الافتراض  (يناتالعينة أو الع
لاستخدام اختبارات أخرى لا تعتمد على التوزيع الاحتمالي  عندئذقد لا يتحقق في كثير من الحالات، لذلك نلجأ 

تسمى أحيانا بالاختبارات الحرة من ، و (Nonparametric) اللامعلميةللعينة، وهذه الاختبارات تسمى بالاختبارات 
 .(Assumption-free testsالافتراضات )

كثرة تكرارات القيم المنخفضة أو المرتفعة والذي ومن ضمن الأنماط التي قد "تُخرج" البيانات من التوزيع الطبيعي 
 عينة.يسبب التواء التوزيع يمينا أو يسارا، أو كثرة القيم المتطرفة، أو صغر حجم ال

( للبيانات، بمعنى إعطاء رتب أو قيم Rankingومعظم الاختبارات اللامعلمية ترتكز على مبدأ حساب الرتبة )
، وهكذا فإن القيم الأصغر في البيانات ستأخذ الرتب الأقل، والقيم الأكبر في للمشاهدات من الأقل إلى الأكثر

 مطلوب باستخدام الرتب المعطاة بدلا من القيم الفعلية للبيانات.، ويتم بعد ذلك إجراء الاختبار الستأخذ الرتب الأكبر
 ويمكن تصنيف الاختبارات اللامعلمية إلى ثلاثة أقسام رئيسية، بحسب طبيعة تنظيمها؛

  لعينة واحدة. اتاختبار 

  عينتين أو أكثر(مستقلةاللعينات ل اتاختبار( ،. 

  عينتين أو أكثر(للعينات المرتبطة اتاختبار( ،. 

، وكذلك قراءة SPSSذا الفصل، سنستعرض بعض أهم الاختبارات اللامعلمية وكيفية تنفيذها في برنامج وفي ه
 وتفسير النتائج المتعلقة بها.
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 (One Sample Nonparametric Tests)الاختبارات اللامعلمية لعينة واحدة  1.6

 (Chi-Square Goodness of Fit Test)اختبار مربع كاي لجودة التوفيق  1.1.6

يحتوي على تصنيفات أو تقسيمات معينة  ، )اسمي كان أو رتبي(،عند التعامل مع متغير وصفي 
(Categories،قد يكون من المفيد التعرف على النمط الذي تتبعه تكرارات كل تقسيم في هذا المتغير ،)  وما إذا

أو قد نكون مهتمين بالتعرف على  ،كانت هذه التكرارات متوزعة على التقسيمات بشكل متساوي أو غير متساوي 
التوزيع الاحتمالي الذي قد يتبعه هذا المتغير. في هذه الحالات يمكننا استخدام اختبار جودة التوفيق لمربع كاي 

 لتنفيذ المطلوب.

والمتوقعة  في المتغير (observed)لجودة التوفيق بين التكرارات المشاهدة  مربع كاي اختبار ءةإحصاعرف وتُ 
(expected) بالصيغة: هل 

𝜒𝑐
2 = ∑

(𝑜𝑖 − 𝑒𝑖)
2

𝑒𝑖

𝑘

𝑖=1

 

تقسيمات هو عدد  kو، i  للتقسيمهي قيم التكرارات المتوقعة  i، 𝑒𝑖  للتقسيمهي قيم التكرارات المشاهدة  𝑜𝑖 حيث،
 واحد.ناقصاً  تقسيمات المتغيروتكون درجات الحرية مساوية لعدد  المتغير.

لنفرض أننا في ملف بيانات "فيتامين دال"، لنأخذ المثال التالي؛  SPSSلتنفيذ اختبار جودة التوفيق في برنامج و 
 مهتمون بالتحقق ما إذا كان الأشخاص في العينة:

(، بشكل 70، وأكثر من 70إلى  30، من 30مستويات فيتامين دال الثلاثة؛ )أقل من متوزعون على  .1
 تبار الفرضية الصفرية:، أي اخ)متساوي( متقارب

  احتمالات توزع الأشخاص في مستويات فيتامين دال متساوية :H0 أو
H0: P(30 أقل من) = P(70 من 30 إلى) = P(70 أكثر من) 

(، بشكل متقارب، أي فأكثر 51، و50إلى  30، من 30الفئات العمرية الثلاثة؛ )أقل من متوزعون على  .2
 اختبار الفرضية الصفرية:

  احتمالات توزع الأشخاص في الفئات العمرية متساوية :H0 أو
H0: P(30 أقل من) = P(50 من 30 إلى) = P(51 فأكثر) 

-Analyze>Nonparametric Tests>Legacy Dialogs>Chiفنقوم في شريط الأوامر العلوي باختيار 

Square، ( قم في تلك النافذ1.6فتظهر نافذة اختبار مربع كاي كما هو في الشكل .) ة باختيار المتغيرين
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(، Test Variable List"مستويات_فيتامين_دال" و"الفئة_العمرية" ونقلهما إلى مربع قائمة متغيرات الاختبار )
 Allتساوي التوزيع في التقسيمات )وحيث أننا سنختبر تساوي توزيع الأشخاص في التقسيمات، سنبقي على خيار 

categories equal في مربع القيم المتو )( قعةExpected values.كما هو، ونضغط موافق للتنفيذ ) 

 
 : نافذة اختبار مربع كاي لجودة التوفيق، )اختبار احتمالات متساوية(.1.6شكل 

يمثلان توزيع ((، الجدولين الأولين 1.6في نافذة المخرجات ستلاحظ ظهور النتائج في ثلاثة جداول، )جدول )
( للمتغيرين "مستويات_فيتامين_دال" و"الفئة_العمرية" Residualوالفرق بينهما )التكرارات المشاهدة والمتوقعة، 

 على الترتيب. وأما الجدول الثالث فيضم نتيجة الاختبار. ومن هذا الجدول يمكن رؤية أن:
توزيع الأشخخخخخخخخخخخخخاص على مسخخخخخخخخخخخختويات  .1

فيتامين دال الثلاثة غير متسخخخخخخخخخخخخخخخاوي، 
-P)حيخخخخخخث أن القيمخخخخخخة الاحتمخخخخخخاليخخخخخخة 

value = 0.005،  وبخخخالتخخخالي نرفض
0H.) 

توزيع الأشخاص على الفئات العمرية  .2
-P)حيخخخخث أن  الثلاثخخخخة متسخخخخخخخخخخخخخخخخخخاوي،

value = 0.449،  وبخخخخخالتخخخخخالي نقبخخخخخل
0H.) 

ارتفاع  ق،، من الجدول السابولاحظ أيضا
قيم الفروقات بين القيم المشاهدة والمتوقعة 

جودة التوفيق للمتغيرين ل مربع كاي : نتائج اختبار1.6جدول 

 بار احتمالات متساوية(.، )اخت"مستويات_فيتامين_دال" و"الفئة_العمرية"

 مستويات فيتامين دال

  Observed N Expected N Residual 

 12.0 20.0 32 30أقل من 

 6.0- 20.0 14 75إلى  30من 

 6.0- 20.0 14 75أكثر من 

Total 60     
    

 فئات العمر

  Observed N Expected N Residual 

 4.0- 20.0 16 30أقل من 

 0.0 20.0 20 50إلى  30من 

 4.0 20.0 24 فأكثر 51

Total 60     
    

Test Statistics  
  فئات العمر مستويات فيتامين دال  
Chi-Square 10.800a 1.600a  
df 2 2  
Asymp. Sig. .005 .449  
a. 0 cells (0.0%) have expected frequencies less than 5. The minimum 

expected cell frequency is 20.0. 
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للمتغير "مستويات_فيتامين_دال" والذي يشكل مؤشرا أوليا على أن احتمالات توزع الأشخاص على مستويات 
 الفيتامين الثلاثة لن تكون متساوية.

توزعة على التقسيمات بشكل غير من جديد، يمكننا استخدام اختبار جودة التوفيق لاختبار ما إذا كانت التكرارات م
متساوي أي متوزعة باحتمالات غير متساوية، ولنفرض أننا نريد اختبار ما إذا الأشخاص في المثال السابق 

 ، ولتكن الفرضية المراد اختبارها هي:متوزعون على مستويات فيتامين دال باحتمالات افتراضية معينة

H0: P(30 أقل من) =0.50,  P(70 من 30 إلى) = 0.25,  P(70 أكثر من) = 0.25 

أي أننا نريد اختبار فرضية أن الأشخاص متوزعون على المستويات الثلاثة لفيتامين دال باحتمالات أو نسب هي 
 على الترتيب. 25، و25%، %50%

 Analyze>Nonparametric Tests>Legacyلتنفيذ هذا الاختبار، نقوم في شريط الأوامر العلوي باختيار 

Dialogs>Chi-Square  ،ونقله إلى "مستويات_فيتامين_دال"  يرباختيار المتغ نقومنافذة اختبار مربع كاي  وفي
 Expectedفي مربع القيم المتوقعة ) (Values) الاحتمالات باختيار قيم وسنقوم، مربع قائمة متغيرات الاختبار

values ) 0.50بحيث نكتب قيمة الاحتمال ( أولا ثم نضغط إضافةAdd وبعدها نكتب قيمة الاحتمال )0.25 
فتكون لدينا قيم الاحتمالات كما هو مبين في  ،ونضغط إضافة 0.25ونضغط إضافة وأخيرا نكتب قيمة الاحتمال 

 ونضغط موافق للتنفيذ. (،2.6الشكل )

 
 : نافذة اختبار مربع كاي لجودة التوفيق، )اختبار احتمالات غير متساوية(.2.6شكل 



197 

 

ملاحظة أن قيم الفروقات  ((، ويمكن بوضوح2.6ستظهر نتائج اختبار مربع كاي، )جدول )المخرجات،  في نافذةو 
بين القيم المشاهدة والمتوقعة هي ضئيلة، مما ينبئنا بأن توزع الأشخاص على مستويات الفيتامين ستكون على 

مما  ،(P-value = 0.875) هي ختباريمة الاحتمالية للاقأن ال الأغلب كما هو في الفرضية الصفرية، ويدعم ذلك
بحسب  0.25، و0.25، 0.50 وهي؛ يدفعنا لقبول الفرضية الصفرية القائلة بتوزع الاحتمالات بصورة غير متساوية

 ترتيب مستويات فيتامين دال.

: نتائج اختبار مربع كاي لجودة التوفيق 2.6جدول 
 وية(.)اختبار احتمالات متسا"مستويات_فيتامين_دال"، للمتغير

 مستويات فيتامين دال

  Observed N Expected N Residual 

 2.0 30.0 32 30أقل من 

 1.0- 15.0 14 75إلى  30من 

 1.0- 15.0 14 75أكثر من 

Total 60     
    

Test Statistics   
   مستويات فيتامين دال  
Chi-Square .267a   
df 2   
Asymp. Sig. .875   
a. 0 cells (0.0%) have expected frequencies less than 5. The minimum expected 

cell frequency is 15.0. 

 (Binomial Test) ذي الحديناختبار  2.1.6

اختبار ذي الحدين والذي يتم فيه اختبار ما  هو SPSSمن الاختبارات اللامعلمية المتوفرة في برنامج  
 .إذا كان متغير وصفي ثنائي، )أي له تقسيمين أو مستويين فقط(، يتبع توزيع ذي الحدين باحتمال معين

 0.30لنفس البيانات؛ "فيتامين دال"، سنقوم باختبار ما إذا كان متغير "النوع" يتبع توزيع ذي الحدين باحتمال 
نجاح(، للذكور، )احتمال ال

للإناث، )احتمال  0.70واحتمال 
الفشل(. عندها نقوم في شريط 

 الاختبار الأوامر العلوي باختيار
Analyze>Nonparametric 

Tests>Legacy 

Dialogs>Binomial ، فتظهر
نافذة الاختبار كما هو موضح في 

 (.3.6الشكل )

قم باختيار متغير "النوع" ونقله 
 Test(، ثم قم بتغيير احتمال النجاح الافتراضي )Test Variable Listبار )إلى مربع قائمة متغيرات الاخت

 
 .0.30: نافذة اختبار ذي الحدين لمتغير "النوع" باحتمال نجاح 3.6شكل 
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Proportion موافق للتنفيذ. وستحصل على نتيجة كما هو مبين في الشكل. ثم اضغط  0.30إلى  0.50( من
( P-value = 0ومن هذا الجدول يمكن ملاحظة أن )(. 3.6الاختبار في نافذة المخرجات كما يظهر في جدول )

، 0.30بالتالي نرفض الفرضية الصفرية القائلة بأن متغير "النوع" يتبع توزيع ذي الحدين باحتمال نجاح يساوي و 
 (.P = 0.300H :أو )

 ، )للبيانات "فيتامين دال"(.0.30: نتيجة اختبار ذي الحدين لمتغير "النوع" باحتمال نجاح 3.6جدول 
Binomial Test 

  Category N Observed Prop. Test Prop. Exact Sig. (1-tailed) 

 000. 3. 5. 31 ذكر Group 1 النوع

Group 2 5. 29 أنثى     

Total   60 1.0     

ولكن هذه النتيجة تعني أن احتمال النجاح وبالطبع هذا لا يعني أن متغير النوع لا يتبع توزيع ذي الحدين، 
 مع المشاهدات. ( لهذا المتغير هو غير متوافق0.30الافتراضي )

 : ملاحظة
وستجد أن نتيجة الاختبار  0.50قم بإعادة تنفيذ اختبار ذي الحدين السابق مستخدما احتمال نجاح يساوي 

 .value = 0.897-P(، لأن القيمة الاحتمالية للاختبار ستكون P = 0.500H :ستتغير إلى قبول الفرضية )

فية غير ثنائية، أي أن المشاهدات فيها تأخذ أكثر من مستويين، في كثير من الأحيان قد نتعامل مع متغيرات وص
إذا ما تم تقسيم قيم أو أننا قد نتعامل مع متغير كمي ونرغب في اختبار ما إذا كان يتبع توزيع ذي الحدين 

 المشاهدات إلى قسمين بناء على قيمة محددة، عندئذ يمكننا استخدام اختبار ذي الحدين بالصورة التالية:

"مستويات_فيتامين_دال"، والذي يأخذ  الوصفي الرتبي المتغير توزع في بيانات "فيتامين دال"، سنقوم باختبار .1
 30أقل من بتوزيع ذي الحدين عن طريق اعتبار أن الأشخاص الذين مستويات الفيتامين لديهم ثلاثة مستويات، 

إلى  30فأكثر، )وتشمل المستويين الأصليين من  30 يتبعون التقسيم الأول الجديد، والذين لديهم مستويات فيتامين
 (، يتبعون التقسيم الثاني الجديد.75، وأكثر من 75

وبالتالي سنقوم في نافذة اختبار ذي الحدين باختيار المتغير "مستويات_فيتامين_دال" ونقله إلى مربع قائمة متغيرات 
المستويين المذكورين أعلاه، سنقوم باختيار نقطة الفصل  الاختبار ولإعادة تقسيم المتغير ذو الثلاثة مستويات إلى

(Cut point( في مربع تعريف المستويين الثنائيين )Define Dichotomy ثم ندخل القيمة ،)والتي ترمز ) 1
وسنبقي قيمة الاحتمال . ( كقيمة للفصل بين المستويات30للأشخاص الذين لديهم مستويات فيتامين أقل من 

 .ثم نضغط موافق (،4.6كما هو موضح في الشكل ) ،0.50( عند القيمة Test Proportionالاختبارية )
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 .0.50باحتمال نجاح " مستويات_فيتامين_دال": نافذة اختبار ذي الحدين لمتغير 4.6شكل 

( P-value = 0.699ونلاحظ أن )((، 4.6وفي نافذة المخرجات، ستظهر نتيجة اختبار ذي الحدين، )جدول )
تالي نقبل الفرضية الصفرية القائلة بأن متغير "مستويات_فيتامين_دال" يتبع توزيع ذي الحدين باحتمال نجاح وبال

وهكذا يمكن القول بأن احتمال أن يكون مستوى فيتامين دال لأي شخص  (.P = 0.0H :05، أو ).050يساوي 
 .0.50فأقل يساوي  30هو 

 ، )للبيانات "فيتامين دال"(.0.50" باحتمال نجاح مستويات_فيتامين_دال": نتيجة اختبار ذي الحدين لمتغير 4.6جدول 
Binomial Test 

  Category N Observed Prop. Test Prop. 

Exact Sig. 

(2-tailed) 

مستويات فيتامين 

 دال

Group 1 <= 1 32 .53 .50 .699 

Group 2 > 1 28 .47     

Total   60 1.00     

بيانات "فيتامين دال"، سنقوم باختبار توزع المتغير الكمي "العمر"، بتوزيع ذي الحدين عن طريق . من جديد في 2
 45أكبر من يتبعون التقسيم الأول الجديد، والذين أعمارهم  سنة فأقل 45اعتبار أن الأشخاص الذين أعمارهم هي 

 يتبعون التقسيم الثاني الجديد. سنة

تقسيم ول" ونقله إلى مربع قائمة متغيرات الاختبار العمرلحدين باختيار المتغير "في نافذة اختبار ذي ا الآن سنقوم
( في مربع تعريف المستويين الثنائيين Cut pointسنقوم باختيار نقطة الفصل ) الكمي إلى مستويينالمتغير 

(Define Dichotomy ثم ندخل القيمة ،)الاختبارية  . وسنبقي قيمة الاحتمالالأعماركقيمة للفصل بين  45
(Test Proportion عند القيمة )ثم نضغط موافق.0.50 ، 

( وبالتالي نقبل P-value = 0.897((، أن )5.6في نافذة المخرجات، تُظهر نتيجة اختبار ذي الحدين، )جدول )
القول  . وهكذا يمكن0.50الفرضية الصفرية القائلة بأن متغير العمر يتبع توزيع ذي الحدين باحتمال نجاح يساوي 

 .0.50فأقل يساوي  45بأن احتمال أن يكون عمر أي شخص هو 
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 ، )للبيانات "فيتامين دال"(.0.50: نتيجة اختبار ذي الحدين لمتغير "العمر" باحتمال نجاح 5.6جدول 
Binomial Test 

  Category N Observed Prop. Test Prop. Exact Sig. (2-tailed) 

 Group 1 <= 45 29 .48 .50 .897 العمر

Group 2 > 45 31 .52     

Total   60 1.00     

 

 : ملاحظة
، سنة كقيمة للفصل بين المستويين 60قم بإعادة تنفيذ اختبار ذي الحدين السابق لمتغير العمر مستخدما القيمة 

حتمالية (، لأن القيمة الاP = 0.500H :) الصفرية الفرضية رفضوستجد أن نتيجة الاختبار ستتغير إلى 
 .P-value = 0.006للاختبار ستكون 

 (Runs Test)الدورات اختبار  3.1.6

( هو اختبار لا معلمي Wald-Wolfowitz runs testولفويتز للدورات )-اختبار الدورات أو اختبار والد
ار الدورات يهدف للتحقق من مدى عشوائية أو استقلالية المشاهدات المتتالية ضمن متغير ما. بمعنى آخر، اختب

وتكون الفرضية الصفرية التي يتم  قد يساعد الباحث في التحقق من عشوائية المعاينة التي تمت من المجتمع.
 اختبارها هي: كل مشاهدة في متتالية العينة قد تم سحبها بصورة مستقلة من نفس المجتمع.

)+( لقيم المشاهدات الأكبر من قيمة  جبةمو  على إعطاء إشارة من الناحية النظرية ويعتمد تطبيق اختبار الدورات
معينة، )والتي يمكن أن تكون قيمة الوسط الحسابي أو الوسيط أو المنوال أو أي قيمة أخرى يحددها المستخدم(، 

ثم يتم حساب عدد الدورات عن طريق حساب عدد ( للقيم الأقل من تلك القيمة المحددة. -) السالبة وا عطاء الإشارة
شارات الموجبة والسالبة، ويتم بعد ذلك مقارنة عدد الدورات المحسوبة من المشاهدات بعدد الدورات التغيرات في الإ

 المتوقع والذي يتبع، تحت الفرضية الصفرية، توزيعا طبيعيا تقريبا.

، نقوم بفتح ملف البيانات "فيتامين دال" ثم نختار من شريط الأوامر SPSSولتطبيق اختبار الدورات في برنامج 
فتظهر نافذة اختبار الدورات، قم  Analyze>Nonparametric Tests>Legacy Dialogs>Runsالعلوي 

في تلك النافذة باختيار المتغيرين "العمر" و"مستويات_فيتامين_دال" على سبيل المثال وانقلها إلى مربع قائمة 
كما يظهر في  (Cut Pointقطع )من مربع قيمة ال 1( فقطMeanمتغيرات الاختبار، ثم اختر الوسط الحسابي )

 (، ثم ضغط موافق.5.6الشكل )

                                                 
ثلاثة خيارات أساسية لقيم القطع هي الوسط الحسابي، الوسيط، والمنوال، إضافة للقيمة التي يحددها المستخدم  SPSSيوفر برنامج  1
(Custom وننوه هنا إلى أن استخدام قيم الوسيط و/أو المنوال قد لا يكون ملائما في بعض الحالات، خاصة في المتغيرات التي تأخذ ،)

 ائية.قيم ثن
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 "العمر" و"مستويات_فيتامين_دال".: نافذة اختبار الدورات للمتغيرين 5.6شكل 

ونتجه منها لرفض الفرضية الصفرية ((، 6.6ستظهر بعد ذلك النتائج للمتغيرين في نافذة المخرجات، )جدول )
لية في متغير العمر قد تم سحبها بصورة مستقلة من المجتمع، بمعنى أن نتيجة اختبار القائلة بأن المشاهدات المتتا

  يفترض أن أعمار الأشخاص المتتالية في العينة لم يتم جمعها بصورة عشوائية.الدورات 

 "العمر" و"مستويات_فيتامين_دال".: نتائج اختبار الدورات للمتغيرين 6.6جدول 
Runs Test 

 ات فيتامين دالمستوي العمر  

Test Valuea 47.57 1.70 

Cases < Test Value 32 32 

Cases >= Test Value 28 28 

Total Cases 60 60 

Number of Runs 23 32 

Z -2.058 .296 

Asymp. Sig. (2-tailed) .040 .767 

a. Mean 

( المتتالية في متغير مستويات فيتامين دال وعلى النقيض، نميل لقبول الفرضية القائلة بأن المشاهدات )التقسيمات
 هي مستقلة، )عشوائية في تسلسلها في العينة(.

 : ملاحظة
قم بإعادة تنفيذ اختبار الدورات السابق لمتغيرات أخرى سواء في نفس ملف البيانات أو ملف آخر مستخدما قيم 

 النتائج. قطع متنوعة؛ قيمة الوسيط، المنوال، وقيم أخرى، ولاحظ الفروقات بين
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 (One-Sample Kolmogorov-Smirnov Test) سميرنوف لعينة واحدة-كولمجروفاختبار  4.1.6

سميرنوف لاختبار توزع المتغير )أو العينة( بتوزيع طبيعي، -تناولنا فيما سبق استخدام اختبار كولمجروف 
ة المتغير الكمي للتوزيع الطبيعي أو مشابه حيث أننا سنقوم باستخدام هذا الاختبار للتحقق من تبعي هنا والأمر

(، وهي التوزيعات Exponential(، أو التوزيع الأسي )Poisson(، أو توزيع بواسون )Uniformالتوزيع المنتظم )
 .SPSSرنامج بفي  لعينة واحدة سميرنوف-التي يوفرها اختبار كولمجروف

لي )التراكمي( الفعلي للمتغير بالتوزيع الاحتمالي سميرنوف على مقارنة التوزيع الاحتما-ويعتمد اختبار كولمجروف
المطلوب )المتوقع(، وكلما انخفضت قيمة احصاءة الاختبار )اقتربت من الصفر( كلما دل ذلك على اقتراب التوزيع 

ر وتكون الفرضية الصفرية للاختبار أن المتغي الاحتمالي الفعلي للمتغير من التوزيع الاحتمالي المطلوب مقارنته به.
 يتبع التوزيع الاحتمالي المفترض، )الطبيعي، المنتظم، ...(.

وبالتالي قم في شريط للتحقق من التوزيع الاحتمالي لبعض المتغيرات، سنستخدم ملف البيانات "بيانات الطلبة" 
، Analyze>Nonparametric Tests>Legacy Dialogs>1-Sample K-Sالأدوات العلوي باختيار 

"، 3المقرر"، "1المقرر(. قم في تلك النافذة باختيار المتغيرات؛ "6.6تبار، كما يوضح الشكل )فتظهر نافذة الاخ
مربع قائمة متغيرات الاختبار. ولنفرض أننا نريد اختبار ما إذا كان كل  " على سبيل المثال، ثم انقلها إلىالفصلو"

( ومنتظم Normal، لذلك سنقوم باختيار طبيعي )متغير من هذه المتغيرات يتبع التوزيع الطبيعي أو التوزيع المنتظم
(Uniform( من مربع التوزيع الاحتمالي للاختبار )Test Distributionكما يوضح الشكل ) ثم نضغط موافق ،

 .للتنفيذ

 

 سميرنوف لعينة واحدة، )للبيانات "معدلات الطلبة"(.-: نافذة اختبار كولمجروف6.6شكل 
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النتائج موضحة في جدولين؛ الأول خاص بنتائج المقارنة بالتوزيع الطبيعي، )لكل في نافذة المخرجات، ستكون 
ونلاحظ من الجدولين،  متغير من المتغيرات الثلاثة المختارة(، والثاني خاص بنتائج المقارنة بالتوزيع المنتظم.

 ((، ما يلي:7.6)اللذين قد تم عرضهما في جدول واحد هو جدول )

في اختبار التوزيع  P-value = 0.200يتوزع بتوزيع طبيعي تقريبا، ) 1في المقرر المتغير درجات الطلبة .1
 في اختبار التوزيع المنتظم(. P-value = 0.029الطبيعي(، ولا يتوزع بالتوزيع المنتظم، )

في اختبار التوزيع الطبيعي(،  P-value = 0لا يتوزع بتوزيع طبيعي، ) 3المتغير درجات الطلبة في المقرر .2
 في اختبار التوزيع المنتظم(. P-value = 0يتوزع بالتوزيع المنتظم، ) ولا

ن كانت القيمة الاحتمالية للاختبار  يتوزع بتوزيع طبيعي ترتيب الفصل الدراسي للطالبالمتغير  .3 تقريبا وا 
م، في اختبار التوزيع الطبيعي(، ويتوزع بالتوزيع المنتظ P-value = 0.060، )0.05قريبة جدا من القيمة 

(P-value = 0.751 )لذلك نتجه لاعتباره أقرب للتوزيع المنتظم.في اختبار التوزيع المنتظم ، 

للمقارنة بالتوزيع الطبيعي والتوزيع  عينة واحدةل سميرنوف-كولمجروف: نتائج اختبار 7.6جدول 
 (.للبيانات "معدلات الطلبة""، و"الفصل"، )3"، "المقرر1"المقررللمتغيرات  المنتظم،

One-Sample Kolmogorov-Smirnov Test 

  

درجة الطالب 

 1في المقرر

درجة الطالب 

 3في المقرر

ترتيب الفصل 

 الدراسي للطالب

N 35 35 35 

Normal 

Parametersa,b 

Mean 71.31 55.34 5.06 

Std. Deviation 15.605 14.289 1.846 

Most 

Extreme 

Differences 

Absolute .114 .235 .145 

Positive .075 .235 .145 

Negative -.114 -.129 -.124 

Test Statistic .114 .235 .145 

Asymp. Sig. (2-tailed) .200c,d .000c .060c 

a. Test distribution is Normal. 

b. Calculated from data. 

c. Lilliefors Significance Correction. 
d. This is a lower bound of the true significance.      

 

One-Sample Kolmogorov-Smirnov Test 2 

  

درجة الطالب 

 1في المقرر

درجة الطالب 

 3في المقرر

ترتيب الفصل 

 الدراسي للطالب

N 35 35 35 

Uniform 
Parametersa,b 

Minimum 35 27 2 

Maximum 94 95 8 

Most 

Extreme 

Differences 

Absolute .246 .400 .114 

Positive .029 .400 .095 

Negative -.246 -.150 -.114 

Kolmogorov-Smirnov Z 1.455 2.364 .676 

Asymp. Sig. (2-tailed) .029 .000 .751 

a. Test distribution is Uniform. 

b. Calculated from data. 
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 مستقلتين الاختبارات اللامعلمية لعينتين 2.6
(Nonparametric Tests for Two Independent Samples) 

 لية في منطقة الاختبارات اللامعلمية لعينتين مستقلتين:الاختبارات التا SPSSيوفر برنامج  

 W (Mann-Whitney U and Wilcoxonوويلكوكسون لمجموع الرتب  Uويتني -مان اختبارات .1

rank sum W Tests). 

 .Z (Kolmogorov-Smirnov Z Test)سميرنوف -كولمجروف اختبار .2

 .(Wald-Wolfowitz Runs Testولفويتز للدورات )-والداختبار  .3

 .(Moses Extreme Reactions Testموسز للردود المتطرفة )اختبار  .4

لتساوي متوسطي المجتمع، إذا يقوم باختبار الفرضية  tويتني "النسخة" اللامعلمية من اختبار -يُعد اختبار مان
سحوبتين من القائلة بتساوي توزيعي عينتين مستقلتين، أو بمعنى آخر، يقوم الاختبار بالتحقق من أن العينتين م

أي أن  ويتني لاختبار عينتين.-مجتمعين متماثلين. ويُعتبر اختبار ويلكوكسون لمجموع الرتب مكافئ لاختبار مان
 .0H:العينتين لهما نفس التوزيع كل من الاختبارين يقوم باختبار الفرضية الصفرية: 

ويقوما باختبار نفس الفرضية لهما سابقا،  فقد تم التطرق  ولفويتز للدورات-والدو  سميرنوف-كولمجروفوأما اختباري 
 ق التعامل مع كل عينة أو مجموعة على حده ثم مقارنة النتائج.يالصفرية أعلاه عن طر 

، فيقوم باعتبار أن العينة أو المجموعة الأولى من المشاهدات هي مجموعة موسز للردود المتطرفةبالنسبة لاختبار 
(، ثم يقوم بدمج Experimental groupينة الثانية هي مجموعة التجربة )( واعتبار العControl groupالتحكم )

 العينتين وا عطاء رتب لكل المشاهدات فيهما وتنفيذ الاختبار.

في  ، والذي سيكون المثال التطبيقي لناولتطبيق هذه الاختبارات، قم بفتح ملف البيانات "المقابلات الشخصية"
 Analyze>Nonparametric Tests>Legacyر العلوي باختيار ثم قم في شريط الأوام. SPSSبرنامج 

Dialogs>2 Independent Samples( في تلك النافذة، قم 7.6، فتظهر نافذة الاختبار كما هو في الشكل .)
بنقل المتغير "نتائج_المقابلات" إلى مربع قائمة متغيرات الاختبار، ونقل متغير "الشركة" إلى مربع متغير التصنيف 

(Grouping Variable.) 
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 .لبيانات "المقابلات الشخصية"لملف ا: نافذة اختبار عينتين مستقلتين في الاختبارات اللامعلمية، 7.6شكل 

في النافذة الفرعية التي  2و  1وأدخل القيم  (Define Groupsبعد ذلك اضغط على خيار تعريف المجموعات )
( على التوالي، ثم اضغط Group 2( والمجموعة الثانية )Group 1ستظهر في مربعي المجموعة الأولى )

 استمرار.

 مستقلتين، ما قمنا به حتى الآن هو تعريف مشاهدات المتغير "نتائج المقابلات" كمتغير يضم مجموعتين أو عينتين
كون اختبار ، والهدف سي2، والعينة الثانية هي نتائج مقابلات الشركة 1العينة الأولى هي نتائج مقابلات الشركة 

:𝐻0ما إذا كانت كل من العينتين لهما نفس التوزيع أو اختبار ) 𝜇1 = 𝜇2)  باستخدام الاختبارات اللامعلمية لعينتين
-إضافة لاختبار مان Zسميرنوف -((، قم باختيار اختبار كولموجروف7.6في نافذة الاختبار، )شكل ) مستقلتين.
 .الافتراضي ثم اضغط موافق Uويتني 

والذي سيظهر معه نتيجة  ويتني-في نافذة المخرجات، سنحصل على نتائج الاختبارين، بالنسبة لاختبار مانو 
(، نتجه لقبول الفرضية الصفرية القائلة P-value > 0.05ومن هذه النتائج، )((، 8.6، )جدول )اختبار ولكوكسون 

 ين متوافقة )متكافئة(.بتساوي توزيع العينتين، بمعنى أن نتائج المقابلات في الشركت

 .للبيانات "المقابلات الشخصية" لعينتين مستقلتين، وتني وولكوكسون -: نتائج اختبار مان8.6جدول 
Test Statisticsa 

 نتائج_المقابلات  

Mann-Whitney U 195.500 

Wilcoxon W 405.500 

Z -.122 

Asymp. Sig. (2-tailed) .903 

Exact Sig. [2*(1-tailed Sig.)] .904b 
a. Grouping Variable: الشركة 
b. Not corrected for ties. 
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القيمة  ((، حيث أن9.6سميرنوف، )جدول )-ونلاحظ أن نفس النتيجة قد تم الوصول إليها من اختبار كولمجروف
 (.P-value > 0.05) الاحتمالية

 .للبيانات "المقابلات الشخصية" سميرنوف لعينتين مستقلتين،-: نتائج اختبار كولموجروف9.6جدول 
Test Statisticsa 

 نتائج_المقابلات  

Most Extreme Differences Absolute .100 

Positive .100 

Negative -.100 

Kolmogorov-Smirnov Z .316 

Asymp. Sig. (2-tailed) 1.000 

a. Grouping Variable: الشركة 

 

 لعدة عينات مستقلةالاختبارات اللامعلمية  3.6
(Nonparametric Tests for Several Independent Samples) 

، أي أنها تختبر تساوي عدة في اتجاه واحد هذه الاختبارات تعادل في أهدافها اختبار تحليل التباين 
-كروسكل ات، أو تكافؤ توزيع عدة متغيرات. ومن أهم الاختبارات اللامعلمية لعدة عينات مستقلة اختبارمتوسط

 والس واختبار الوسيط.

 (Median test)واختبار الوسيط  H (Kruskal-Wallis H test)والس -اختبار كروسكل 1.3.6

أو  ،حيث أنه يختبر تساوي عدة متوسطات Uوتني -والس امتدادا لاختبار مان-يُعتبر اختبار كروسكل 
تطابقة التوزيع. وكذلك اختبار الوسيط الذي العينات المستقلة هي مسحوبة من مجتمعات م يختبر ما إذا كانت

 بين توزيعات المتغيرات محل الاختبار. الاختلافاتيتحقق من 

، حيث أننا سنقوم باختبار الفرضية SPSSلتنفيذ هذه الاختبارات، قم بفتح ملف البيانات "فيتامين دال" في برنامج 
شخاص هي متساوية في الفئات العمرية الثلاثة؛ )أقل مستويات فيتامين دال لدى الأ معدلات الصفرية القائلة بأن

:𝐻0 الفرضية الصفرية اختبارأي أننا سنقوم بفأكثر(،  51(، و)50إلى  30(، )من 30من  𝜇1 = 𝜇2 = 𝜇3 
 .بصورة لامعلمية

 Analyze>Nonparametric Tests>Legacy Dialogs>kفي شريط الأوامر العلوي قم باختيار 
Independent Samples ، (.(8.6، )شكل )المطلوبة نافذة الاختبارفتظهر 
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 : نافذة اختبار عدة عينات مستقلة في الاختبارات اللامعلمية، )للبيانات "فيتامين دال"(.8.6شكل 

غير في تلك النافذة، سنقوم باختيار المتغير الكمي "فيتامين_دال" ونقله لمربع قائمة متغيرات الاختبار، واختيار المت
( Define Rangeضغط على أمر تعريف المدى )نالوصفي "الفئة_العمرية" ونقله لمربع متغير التقسيم. بعد ذلك 

لتقسيمات المتغير الوصفي ( Maximum( والقيمة الكبرى )Minimumوالذي يتطلب إدخال القيمة الصغرى )
 . ثم نضغط استمرار.3و 1"الفئة_العمرية"، وهما القيمتان 

والنتيجة الأولى، )التي ط على موافق في نافذة الاختبار الرئيسية ستظهر النتائج في نافذة المخرجات. وبعد الضغ
والس ويظهر في الجدول الفرعي الأول عدد المشاهدات -اختبار كروسكال((، هي نتيجة 10.6تظهر في جدول )

الثاني فيشمل نتيجة الاختبار، وحيث في كل تقسيم أو مجموعة، ومتوسط الرتب لكل مجموعة. وأما الجدول الفرعي 
:𝐻0( نستطيع الحكم بقبول الفرضية الصفرية P-value = 0.138أن القيمة الاحتمالية ) 𝜇1 = 𝜇2 = 𝜇3 ،

 بمعنى أننا نعتقد بأن مستويات فيتامين دال متكافئة في الفئات العمرية الثلاثة للأشخاص.

 س لثلاثة عينات مستقلة، للبيانات "فيتامين دال".وال-لا: نتائج اختبار كروسك10.6جدول 
Ranks 

 N Mean Rank فئات العمر

 32.16 16 30أقل من  فيتامين_دال

 35.48 20 50إلى  30من 

 25.25 24 فأكثر 51

Total 60   
    

   

Test Statisticsa,b   
   فيتامين_دال  
Chi-Square 3.954   
df 2   
Asymp. Sig. .138   
a. Kruskal Wallis Test 
b. Grouping Variable: فئات العمر 
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 = P-valueفالنتيجة هي العكس، حيث أن القيمة الاحتمالية )((، 11.6نتيجة اختبار الوسيط، )جدول ) أماو 

(، مما يعني رفض الفرضية الصفرية، أي أنه بحسب اختبار الوسيط يوجد على الأقل متوسطان غير 0.003
 اويان.متس

 : نتائج اختبار الوسيط لثلاثة عينات مستقلة، للبيانات "فيتامين دال".11.6جدول 
Frequencies 

  

 فئات العمر

 فأكثر 51 50إلى  30من  30أقل من 

 Median 9 14 5 < فيتامين_دال

<= Median 7 6 19 
         
Test Statisticsa    

    فيتامين_دال  
N 60    
Median 29.00    
Chi-Square 11.401b    
df 2    
Asymp. Sig. .003    
a. Grouping Variable: فئات العمر 

b. 0 cells (0.0%) have expected frequencies less than 5. The minimum expected cell frequency is 7.5. 

ساب قيمة إحصاءة الاختبار لكل منهما، ويعود الحكم وهذا الاختلاف في نتيجة الاختبارين يعود لاختلاف طبيعة ح
النهائي للباحث الذي قد يقوم بتنفيذ اختبارات مقارنة متعددة لكل متغيرين على حدة للحصول على فهم أعمق لتوزع 

 المشاهدات في كل متغير.

 (Nonparametric Tests for Two Paired Samples)الاختبارات اللامعلمية لعينتين مرتبطتين  4.6

 كما هو الحال مع الاختبارات اللامعلمية المتعلقة بالعينات المستقلة، فإن اختبارات العينات المرتبطة 
أربعة اختبارات غير  SPSSويوفر برنامج ما إذا كانت العينتين أو المتغيرين يتبعان نفس التوزيع. تختبر  لعينتين

:𝐻0الصفرية  معلمية بالنسبة للعينات المرتبطة لاختبار الفرضية 𝜇1 = 𝜇2 ويتم استخدام هذه الاختبارات بحسب .
 طبيعة المتغيرات المراد اختبارها، وسنقوم باستعراضها فيما يلي:

 ذات الإشارات لرتبلولكوكسون اختبار الإشارة و  اختبار 1.4.6
(Sign and Wilcoxon Signed-Rank Tests) 

عامل مع عينات مرتبطة كمية، حيث يقوم اختبار الإشارة بحساب يتم استخدام هذين الاختبارين عند الت 
ذا كان المتغيران  الفروقات بين المتغيرين ثم تصنيفها إلى فروقات موجبة، سالبة، ومتعادلة )أي لا توجد فروقات(. وا 

 .لهما نفس التوزيع، فإن عدد الفروقات الموجبة والسالبة سيكون متقارب
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مقدار  ، فيُعد أفضل من اختبار الإشارة نظرا لأنه يأخذ في الاعتبارب ذات الإشاراتولكوكسون للرتأما اختبار و 
الفروقات بين المتغيرين إلى جانب إشارات الرتب، وبالتالي فإن إحصاءة الاختبار ستشمل على معلومات أكثر عن 

 المتغيرين.

انات "عينات ضغط الدم"، حيث أننا باستخدام ملف البي SPSSولنقم الآن بتطبيق هذين الاختبارين في برنامج 
سنختبر ما إذا كانت قياسات ضغط الدم للمرضى قبل تناول الدواء الموسع للأوردة مقاربة للقياسات بعد تناول 

 في الفصل الرابع لاختبار نفس الفرضية الصفرية السابقة tقد تم استخدام اختبار نذكر القارئ هنا إلى أنه الدواء. و 

:𝐻0؛ معلميةللمتغيرين بصورة  𝜇𝐷 = 0. 

 Analyze>Nonparametric Tests>Legacy Dialogs>2 Relatedفي شريط الأوامر العلوي قم باختيار 

Samples ،( 9.6وفي نافذة الاختبار، الموضحة في شكل ،)ونقله إلى مربع أزواج 1قم باختيار المتغير "عينة "
 " ونقله إلى نفس المربع لتكوين زوج الاختبار.2المتغير "عينة ( ثم اختيارTest Pairsالمتغيرات في الاختبار )

(، قم باختيار كل من اختبار ولكوكسون للرتب ذات الإشارات Test Typeبعد ذلك، وفي مربع نوع الاختبار )
(Wilcoxon( واختبار الإشارة )Sign.ثم اضغط موافق ،) 

 

"، )للبيانات 2" و"عينة1رات اللامعلمية، للمتغيرين "عينة: نافذة اختبار عينتين مرتبطتين في الاختبا9.6شكل 
 "عينات ضغط الدم"(.

يمكن في ((، 12.6في نافذة المخرجات ستظهر نتيجة الاختبارين، ومن النتيجة الأولى، )الموضحة في جدول )
متوسطات الرتب، )الموجبة، السالبة، والمتعادلة(، ومجموع هذه الرتب. وأما نتيجة الجدول الفرعي الأول ملاحظة 

(، فتظهر في الجدول الفرعي الثاني، والتي تقترح قبول الفرضية الصفرية القائلة P-value = 0.474الاختبار، )
 ول الدواء وبعد تناوله.بعدم وجود فرق معنوي بين العينتين، بمعنى عدم وجود فرق في قياسات ضغط الدم قبل تنا
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 "، )للبيانات "عينات ضغط الدم"(.2" و"عينة1للمتغيرين "عينة، ولكوكسون للرتب ذات الإشاراتنتائج اختبار  :12.6 جدول
Ranks 

  N Mean Rank Sum of Ranks 

 -ضغط الدم بعد استخدام الدواء 

 ضغط الدم قبل استخدام الدواء

Negative Ranks 5a 9.50 47.50 

Positive Ranks 10b 7.25 72.50 

Ties 0c     

Total 15     

a.  ضغط الدم قبل استخدام الدواء >ضغط الدم بعد استخدام الدواء 
b.  ضغط الدم قبل استخدام الدواء <ضغط الدم بعد استخدام الدواء 

c. ضغط الدم بعد استخدام الدواء = ضغط الدم قبل استخدام الدواء      
    

Test Statisticsa    

  

 -ضغط الدم بعد استخدام الدواء 

    ضغط الدم قبل استخدام الدواء
Z -.716-b    
Asymp. Sig. (2-tailed) .474    
a. Wilcoxon Signed Ranks Test 
b. Based on negative ranks. 

 في الفصل الرابع. tدام اختبار وهذه النتيجة هي مطابقة لما تم التوصل إليه لنفس المتغيرين باستخ

-P) تساوي الاحتمالية  ة((، والخاصة بنتيجة اختبار الإشارة، نجد أن القيم13.6جدول )في ومن النتيجة الثانية، )

value = 0.302الصفرية، وبالتالي نرى بأن نتيجة اختبار الإشارة متوافقة مع نتيجة  ة(، وبالتالي نقبل الفرضي
 ب ذات الإشارات.اختبار ولكوكسون للرت

 "، )للبيانات "عينات ضغط الدم"(.2" و"عينة1للمتغيرين "عينة الإشارة: نتائج اختبار 13.6جدول 
Frequencies 

  N 

 Negative Differencesa 5 ضغط الدم قبل استخدام الدواء -ضغط الدم بعد استخدام الدواء 

Positive Differencesb 10 

Tiesc 0 

Total 15 

a.  ضغط الدم قبل استخدام الدواء >ضغط الدم بعد استخدام الدواء 

b.  ضغط الدم قبل استخدام الدواء <ضغط الدم بعد استخدام الدواء 

c. ضغط الدم بعد استخدام الدواء = ضغط الدم قبل استخدام الدواء    
  

Test Statisticsa  

  

 -ضغط الدم بعد استخدام الدواء 

  استخدام الدواءضغط الدم قبل 
Exact Sig. (2-tailed) .302b  
a. Sign Test 

b. Binomial distribution used. 

 (McNemar Test) ماك نيمر اختبار 2.4.6

يُستخدم اختبار ماك نيمر مع المتغيرات الوصفية ثنائية القيم، حيث يقوم بتحديد ما إذا كان معدل  
ل، أي قبل حدوث التغير( هو مساوي لمعدل الاستجابة النهائية )في المتغير الاستجابة الأولية )في المتغير الأو 

، فإذا كانت نتيجة الاختبار تتضمن المساواة، فهذا يدل على عدم حدوث تغير في الثاني، أي بعد حدوث التغير(
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عنوي بين وسطي الاستجابة من المتغير الأول إلى المتغير الثاني، أو بمعنى أبسط هذا يدل على عدم وجود فرق م
 المجتمعين محل الدراسة.

بتعريف متغيرين وصفيين ثنائيين جديدين في ملف البيانات السابق "عينات ضغط أولا لتطبيق هذا الاختبار، سنقوم 
" بحيث يأخذ كل من المتغير الأول الجديد، 2" و"عينة1هما تحويل من المتغيرين الكميين الأصليين "عينةالدم"، 

فأقل،  120للقيم  1_ثنائي"(، القيمة 2_ثنائي"(، والمتغير الثاني الجديد، )وليكن اسمه "عينة1ينة)وليكن اسمه "ع
إعادة ترميز في متغير جديد . ويتم تعريف المتغيرين الجديدين باستخدام أمر 120للقيم الأكثر من  2والقيمة 

(Recode in Different Variables( في أمر تحوير )Transform في شريط ) الأوامر العلوي كما وضحنا
 في الفصول السابقة.

 Analyze>Nonparametric Tests>Legacy Dialogs>2الآن وفي شريط الأوامر العلوي بعد اختيار 

Related Samplesثنائي" ونقلهما إلى مربع أزواج المتغيرات 2_ثنائي" و"عينة1، نقوم باختيار المتغيرين "عينة_
كما يوضح  (،Test Typeمربع نوع الاختبار )في  فقط ثم اختيار اختبار ماك نيمر (،Test Pairsفي الاختبار )

 (، ثم نضغط موافق.10.6الشكل )

 

 ._ثنائي"2_ثنائي" و"عينة1في الاختبارات اللامعلمية، للمتغيرين "عينة ماك نيمر: نافذة اختبار 10.6شكل 

رعي الأول على مصفوفة تصنيف القيم الثنائية في ((، سيحتوي الجدول الف14.6)جدول )في نافذة المخرجات، 
وجود حالة واحدة فقط مختلفة في التصنيف بين المتغيرين. أما نتيجة الاختبار في الجدول ونلاحظ المتغيرين، 

 (.P-values = 1الفرعي الثاني فهي تبين عدم وجود تغير يُذكر قبل استخدام الدواء وبعده، )
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 ._ثنائي"2_ثنائي" و"عينة1للمتغيرين "عينة ماك نيمر: نتائج اختبار 14.6جدول 
 _ثنائي2_ثنائي & عينة1عينة

 _ثنائي1عينة

 _ثنائي2عينة

 120أكثر من  فأقل 120

 0 3 فأقل 120

 11 1 120أكثر من 
   

  

Test Statisticsa  
  _ثنائي2_ثنائي & عينة1عينة  
N 15  
Exact Sig. (2-tailed) 1.000b  
a. McNemar Test 

b. Binomial distribution used. 

 

 (Marginal Homogeneity Test) التجانس الهامشي اختبار 3.4.6

 ، والذي يعتمد على توزيع مربع كاي،يمكن اعتبار اختبار التجانس الهامشي للمتغيرات ذات القيم المتعددة 
ا يبحث عن حدوث تغير في الاستجابة من المتغير حيث أنه أيضامتدادا لاختبار ماك نيمر للمتغيرات الثنائية، 

 الأول )قبل( إلى المتغير الثاني )بعد(.

وكما قمنا في البند السابق بتعريف متغيرين ثنائيين جديدين، سنقوم هنا بتعريف متغيرين ثلاثيي )متعددي( القيمة، 
" 2" و"عينة1الكميين الأصليين "عينةفي ملف البيانات السابق "عينات ضغط الدم"، وسيكونا تحويل من المتغيرين 

_ثلاثي"(، والمتغير الثاني المتعدد، )وليكن اسمه 1بحيث يأخذ المتغير الأول المتعدد، )وليكن اسمه "عينة
. 140للقيم الأكثر من  3، والقيمة 140إلى  121للقيم من  2فأقل، والقيمة  120للقيم  1_ثلاثي"(، القيمة 2"عينة

( Transformأمر إعادة ترميز في متغير جديد في أمر تحوير ) نفس الجديدين باستخدام ويتم تعريف المتغيرين
 في شريط الأوامر العلوي.

 Analyze>Nonparametric Tests>Legacy Dialogs>2الآن في شريط الأوامر العلوي بعد اختيار 

Related Samplesلهما إلى مربع أزواج المتغيرات _ثلاثي" ونق2_ثلاثي" و"عينة1، قم باختيار المتغيرين "عينة
(، كما Test Type(، ثم اختيار اختبار التجانس الهامشي فقط في مربع نوع الاختبار )Test Pairsفي الاختبار )

 (، ثم نضغط موافق.11.6يوضح الشكل )
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 ".ثلاثي_2و"عينة "ثلاثي_1في الاختبارات اللامعلمية، للمتغيرين "عينة التجانس الهامشي : نافذة اختبار11.6شكل 

(، الذي يحتوي على نتائج الاختبار في نافذة المخرجات، يتبين لنا من القيمة الاحتمالية 15.6من الجدول )
(، اتجاهنا لقبول الفرضية الصفرية القائلة بعدم حدوث تغير معنوي في قياسات P-values = 0.317للاختبار، )

 ستخدامه.ضغط الدم للمرضى قبل استخدام الدواء وبعد ا

 ._ثلاثي"2_ثلاثي" و"عينة1للمتغيرين "عينة التجانس الهامشي: نتائج اختبار 15.6جدول 
Marginal Homogeneity Test 

 _ثلاثي2_ثلاثي & عينة1عينة  

Distinct Values 3 

Off-Diagonal Cases 1 

Observed MH Statistic 2.000 

Mean MH Statistic 1.500 

Std. Deviation of MH Statistic .500 

Std. MH Statistic 1.000 

Asymp. Sig. (2-tailed) .317 

، ولكوكسون للرتب ذات الإشاراتوخلاصة القول هنا، أن الاختبارات الأربعة اللامعلمية؛ اختبار الإشارة، اختبار 
باختلاف  بمثالنا المُستخدَم،، فيما يتعلق أظهرت نفس النتيجةاختبار ماك نيمر، واختبار التجانس الهامشي كلها 

 طبيعة المتغيرات المستخدمة في الاختبار؛ كمية، ثنائية، ومتعددة.

 (Nonparametric Tests for Several Paired Samples)الاختبارات اللامعلمية لعدة عينات مرتبطة  5.6

مقارنة توزيع عينتين مرتبطتين كما هو الحال مع الاختبارات السابقة، فإن هذه الاختبارات اللامعلمية تقوم ب 
عينة مرتبطة تقوم باختبار الفرضية  k لثلاثة اختبارات غير معلمية بالنسبة  SPSSويتوفر في برنامج أو أكثر، 
:𝐻0الصفرية  𝜇1 = 𝜇2 = ⋯ = 𝜇𝑘:وسنقوم باستعراض هذه الاختبارات فيما يلي . 
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 (Friedman test)اختبار فريدمان  1.5.6

كما يُطلق عليه أحيانا، اختبارا مكافئا  ANOVAعتبار اختبار فريدمان، أو اختبار فريدمان يمكن ا  
(، وذلك بالنسبة لكل kللمتغيرات، )والتي عددها  kإلى  1لتحليل التباين في اتجاهين، حيث يقوم بإعطاء رتب من 

تب ستوزع على المشاهدات في كل الر  مشاهدة في العينة. فإذا كانت المتغيرات موجودة في الأعمدة، فهذا يعني أن
 من هذه الرتب. والتي تعتمد على توزيع مربع كاي، ،، ثم يتم حساب قيمة إحصاءة الاختبارصف

قاموا  )بالكيلوجرام( أشخاص 10يمثل أوزان والذي  (،16.6في جدول ) ولتطبيق اختبار فريدمان لنأخذ المثال التالي
و نظام غذائي يعتمد على خفض نسبة الكربوهيدرات ه(، Keto Dietبتطبيق النظام الغذائي المعروف باسم الكيتو )

، وذلك لمدة أربعة هون مقابل الاعتماد على عنصر الد
 أشهر متواصلة.

وبالتالي يمكن اعتبار أن أوزان هؤلاء الأشخاص في 
الأشهر الأربعة هي عينات أو متغيرات مرتبطة 
وليست مستقلة، لأن وزن الشخص في كل شهر يتعلق 

خلال فترة تطبيق  لشهر اللاحقبالشهر السابق وا
وسيكون الهدف هنا هو استخدام اختبار  .الحمية

للتحقق من وجود تغير في فريدمان للعينات المرتبطة 
 أوزان هؤلاء الأشخاص خلال الأشهر الأربعة.

 

 باسم "نظام الكيتو"، بحيث SPSS( في ملف بيانات جديد في برنامج 16.6سنبدأ بإدخال المتغيرات في جدول )
 يمثل كل شهر متغير، )بنفس الاسم(.

 Analyze>Nonparametric Tests>Legacy Dialogs>kالآن وفي شريط الأوامر العلوي قم باختيار 

Related Samples ، مربع متغيرات الاختبار قم باختيار المتغيرات الأربعة ونقلها إلى وبعد ظهور نافذة الاختبار
(Test Variablesوستجد أن الخيار ،) ( 12.6الافتراضي في النافذة هو اختبار فريدمان، كما يظهر في الشكل.) 

 قم بعدها بالضغط على موافق لتنفيذ الاختبار.

 أشخاص في أربعة 10: أوزان 16.6جدول 
 أشهر أثناء تطبيق نظام الكيتو الغذائي.

 1الشهر 2الشهر 3الشهر 4الشهر
86 84 90 75 
81 80 83 75 
98 95 89 74 
77 75 80 69 
75 70 73 65 
75 80 77 68 
80 86 79 70 
82 80 79 71 
81 83 81 64 
90 88 91 73 
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 ."نظام الكيتو"الاختبارات اللامعلمية، لمتغيرات ملف البيانات في  عدة عينات مرتبطة: نافذة اختبار 12.6شكل 

ي نافذة المخرجات، ونلاحظ وجود قيم متوسطات الرتب لكل متغير ( يمثل النتائج التي ستظهر ف17.6الجدول )
الصفرية  ةأما الجدول الفرعي الثاني فتظهر فيه نتائج الاختبار ومنه نتجه لرفض الفرضيفي الجدول الفرعي الأول، 

𝐻0: 𝜇
الشهر1 = 𝜇

الشهر2 = 𝜇
الشهر3 = 𝜇

الكيتو الغذائي سيغير من ، وبالتالي يمكننا القول بأن اتباع نظام الشهر4

 .التغير بنقصان الوزن(هذا لا يعني بالضرورة ، )لكن خلال الأشهر المتتالية )ملحوظة( الوزن بصورة معنوية

 : نتائج اختبار فريدمان لمتغيرات17.6جدول 
 ملف البيانات "نظام الكيتو".

Ranks 

  Mean Rank 

 1.00 1الشهر

 3.05 2الشهر

 2.80 3الشهر

 3.15 4الشهر
  
 

Test Statisticsa 

N 10 

Chi-Square 18.576 

df 3 

Asymp. Sig. .000 
a. Friedman Test 

 W (Kendall's W test)كيندل اختبار  2.5.6

(، Coefficient of Concordance) معامل للتوافقبمثابة  Wيمكن اعتبار إحصاءة اختبار كيندل  
فمثلا، إذا تم سؤال . ةمعين اتوتين على موضوعحيث أنه يستخدم تحديدا للتحقق من مدى اتفاق آراء المص

لأحدى  متعاقبة )والتي ستمثل المتغيرات( أداء أربعة حكوماتعن رأيهم في  )المشاهدات( مجموعة من الأشخاص
 هو الاختبار الأنسب للتحقق من مدى توافق آراءهم. Wاختبار كيندل الدول، عندها يكون 
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مية، فإن هذا الاختبار يعتمد على الرتب التي يتم تعيينها للقيم، حيث يقوم وكما هو الحال مع الاختبارات اللامعل
، )والتي تعني عدم 0ما بين القيمة  Wالاختبار بأخذ مجموع الرتب لكل متغير، وستتراوح قيمة إحصاءة كيندل 

 ، )والتي تعني التوافق التام في الآراء(.1وجود أي توافق في الآراء(، والقيمة 

هن حول مستحضرات تم سؤالهن عن آراء سيدة 12تقييمات  يمثل (، والذي18.6ولنأخذ المثال التالي في جدول )
، فقمن بتقييم كل مستحضر على Johnson، وNivea ،La Roche من ثلاثة شركات شهيرة هي لتفتيح البشرة
 (.تيبعلى التر  الأفضل التقييم إلى الأسوأ التقييم )أي من ،10إلى  1مقياس من 

وسيكون الهدف هنا هو التحقق من مدى توافق آراء هذه العينة من 
وسنقوم بإدخال المتغيرات في جدول  حول الشركات الثلاثة. السيدات

باسم "شركات  SPSS( في ملف بيانات جديد في برنامج 18.6)
 التجميل"، بحيث تمثل كل شركة متغير وبنفس الاسم.

 Analyze>Nonparametricفي شريط الأوامر العلوي قم باختيار 

Tests>Legacy Dialogs>k Related Samples وبعد ظهور ،
باختيار المتغيرات الثلاثة ونقلها إلى مربع متغيرات  نافذة الاختبار قم

(. قم 13.6(، كما يظهر في الشخخخخخخخخخخخخكل )Test Variablesالاختبار )
ويمكننخخخا إبقخخخاء خيخخخار اختيخخخار اختبخخخار )، Wبخخخاختيخخخار اختبخخخار كينخخخدل 

 ، ونقوم بعدها بالضغط على موافق.(فريدمان موجودا لمقارنة النتائج

 

 عينات مرتبطة في الاختبارات اللامعلمية، لمتغيرات ملف البيانات "شركات التجميل".: نافذة اختبار عدة 13.6شكل 

(، ونلاحظ 19.6أولا، والتي تُعرض في جدول ) Wوفي نافذة المخرجات، سنبدأ بالتعليق على نتيجة اختبار كيندال 
مما يدل على  0.539ساوي من نتيجة الاختبار في الجدول الفرعي الثاني أن معامل أو إحصاءة كندل للتوافق ت

 حول ثلاثة سيدة 12آراء : 18.6جدول 
 .(10إلى  1، )من مستحضرات لتفتيح البشرة

Johnson La Roche Nivea 
4 9 3 
3 8 5 
2 9 2 
3 10 4 
1 7 1 
1 8 6 
3 9 7 
5 10 1 
6 10 2 
8 8 5 

10 7 5 
9 8 6 
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وجود اختلاف في آراء السيدات في العينة حول مستحضرات تفتيح البشرة في الشركات الثلاثة، ويؤكد هذا الاستنتاج 
( فيمثل متوسطات 19.6(. وأما الجدول الأول الفرعي في جدول )P-value = 0.002القيمة الاحتمالية للاختبار )

 الثلاثة.الرتب في المتغيرات )الشركات( 

 لمتغيرات W: نتائج اختبار كيندل 19.6جدول 
 ملف البيانات "شركات التجميل".

Ranks 

  Mean Rank 

Nivea 1.42 

La_Roche 2.79 

Johnson 1.79 
  
 

Test Statistics 

N 12 

Kendall's Wa .539 

Chi-Square 12.933 

df 2 

Asymp. Sig. .002 
a. Kendall's Coefficient of Concordance 

القائلة بتساوي أو توافق  الصفرية ة(، نرى بأننا نتجه لرفض الفرضي20.6ومن الجدول الفرعي الثاني، في جدول )
:𝐻0 آراء السيدات؛ 𝜇𝑁𝑖𝑣𝑒𝑎 = 𝜇𝐿𝑎_𝑅𝑜𝑐ℎ𝑒 = 𝜇𝐽𝑜ℎ𝑛𝑠𝑜𝑛 ، وبالتالي يمكن رؤية توافق الاستنتاجات لكلا
 الاختبارين.

 : نتائج اختبار فريدمان لمتغيرات20.6جدول 
 ملف البيانات "شركات التجميل".

Ranks 

  Mean Rank 

Nivea 1.42 

La_Roche 2.79 

Johnson 1.79 
  
 

Test Statisticsa 

N 12 

Chi-Square 12.933 

df 2 

Asymp. Sig. .002 
a. Friedman Test 

 Q (Cochran's Q test)كوكران اختبار  3.5.6

مطابقا لاختبار فريدمان، إلا أنه يتعامل مع قيم المتغيرات الثنائية، ويمكن أيضا  Qاختبار كوكران يُعد  
ولتطبيق هذا الاختبار، لنفرض  .عينة kالنظر إلى هذا الاختبار على أنه امتداد لاختبار ماك نيمر عند التعامل مع 

(، قد تم تسجيلها بإجابات جيد أو سيئ على مستحضرات (18.6أن آراء السيدات في المثال السابق، )في جدول )
 (.21.6الشركات الثلاثة، أي أنها أصبحت إجابات ثنائية، كما يظهر في الجدول )
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عندها سنقوم بإدراج المتغيرات الثلاثة في نفس ملف البيانات السابق "شركات التجميل" بالأسماء الجديدة التي  
للإجابة  1ين القيمة ، بحيث يتم تعيتظهر في الجدول
، مع مراعاة تعريف للإجابة "جيد" 2"سيئ"، والقيمة 

( في نافذة عرض Valuesالمشاهدات في عامود القيم )
 ( في ملف البيانات.Variable Viewالمتغيرات )

 Analyzeفي شخخخخخخخخخخخخخخريط الأوامر العلوي سخخخخخخخخخخخخخخنقوم باختيار 

>Nonparametric Tests> Legacy Dialogs> k 

Related Samples وفي نخخافخخذة الاختبخخار نقوم بخخاختيخخار ،
، Nivea_bi ،La_Roche_biالخخخمخخختخخخغخخخيخخخرات الخخخثخخخلاثخخخخخخخة؛ 

ونقلهخخخخخخخا إلى مربع متغيرات الاختبخخخخخخخار  Johnson_biو
(Test Variables( كما يظهر في الشخخخخخخكل ،)14.6 .) ثم

(، ثم Cochran's Q) Qبخخخخاختيخخخخار اختبخخخخار كوكران  نقوم
 ضغط على موافق.ن

 

 

 بار عدة عينات مرتبطة في الاختبارات اللامعلمية، للمتغيرات الثنائية.: نافذة اخت14.6شكل 

(، ويوضح الجدول الفرعي الأول 22.6وفي نافذة المخرجات، سنحصل على النتائج المطلوبة، والتي يمثلها جدول )
ل على أي ( لم تحصLa_Roche( للشركات الثلاثة، ولاحظ منها أن الشركة )2( وجيد )1تكرار الإجابات بسيئ )

 .السيدات عينةرأي "سيئ" في 

 

 حول ثلاثة سيدة 12: آراء 21.6جدول 
 .، )جيد/سيئ(مستحضرات لتفتيح البشرة

Johnson_bi La_Roche_bi Nivea_bi 
 سيئ جيد سيئ
 سيئ جيد سيئ
 سيئ يدج سيئ

 سيئ جيد سيئ

 سيئ جيد سيئ

 جيد جيد سيئ
 جيد جيد سيئ
 سيئ جيد سيئ

 سيئ جيد جيد

 سيئ جيد جيد

 سيئ جيد جيد

 جيد جيد جيد
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 : نتائج اختبار فريدمان لمتغيرات22.6جدول 
 ملف البيانات "شركات التجميل".

Frequencies 

  

Value 

1 2 

Nivea_bi 9 3 

La_Roche_bi 0 12 

Johnson_bi 8 4 
   

  

Test Statistics  
N 12 

 
Cochran's Q 13.273a 

 
df 2 

 
Asymp. Sig. .001 

 
a. 1 is treated as a success.  

في الجدول الفرعي الثاني وجود اختلاف في آراء السيدات حول مستحضرات  Qوتُظهر نتيجة اختبار كوكران 
تقودنا لرفض الفرضية (، P-value = 0.001التجميل في الشركات الثلاثة، حيث أن القيمة الاحتمالية للاختبار )

:𝐻0الصفرية  𝜇𝑁𝑖𝑣𝑒𝑎_𝑏𝑖 = 𝜇𝐿𝑎_𝑅𝑜𝑐ℎ𝑒_𝑏𝑖 = 𝜇𝐽𝑜ℎ𝑛𝑠𝑜𝑛_𝑏𝑖. 

 

 (Reliability Analysis)تحليل الموثوقية  6.6

المستخدمة في التحليل  الدراسة بيانات يصعب على الباحث التأكد من أن من الدراسات قد كثيرفي  
ي تعتمد على إجابات الأشخاص عن مجموعة الإحصائي هي بيانات تمثل الواقع الحقيقي، وخاصة تلك البيانات الت

والتي يرتكز معظمها على أسئلة  (،Questionnaires) الاستبياناتمن الأسئلة المتعلقة بآرائهم وأشهرها أسئلة 
 المتعددة؛ الثنائية، الثلاثية، الخماسية، والسباعية. (Likert) ليكارت

عدم وذلك لعدة أسباب منها  ات )بيانات( غير صحيحةيُعطي إجابقد  أو المستهدف من الاستبيان المجيبإذ أن 
يدا أو قد لا يفهم التعليمات فهما إجابة السؤال أو الفقرة فيجيب بالتخمين، أو قد لا يركز في الأسئلة جمعرفته ب
ا، أو قد يخشى قول الصدق، أو قد يشعر أن السؤال أو الفقرة شخصي جدًا في طبيعته، وغيرها من صحيح

أخطاء وتقدير  مصداقية الإجابات على الاستبيانالتأكد من مدى  في كثير من الدراساتك لابد الأسباب، لذل
 .الاستجابة
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 وتوجد عدة طرق لقياس مدى صدق وثبات الاستبيان، وسنتطرق لأهم ثلاثة منها؛

 (Cronbach's Alpha Coefficient)الفا  كرونباخ ثبات معامل 1.6.6

 Internal Consistency) الداخلي ثباتالمن أشهر مقاييس  ألفا كرونباخ ثبات معامل يعد

Reliability) الداخلية بين إجابات الأسئلة في الاستبيان  الاختلافات )التباينات(لاستبيان، ويعتمد على حساب ل
 استخدام الصيغة التالية: من خلال

α =
𝑘

𝑘 − 1
(1 −

∑ 𝑆𝑖
2𝑘

𝑖=1

𝑆2
) 

 حيث

𝑘 تبيان،= عدد أسئلة الاس 𝑆𝑖
وارتفاع قيمة  جميع الأسئلة. لإجاباتالتباين =  i ، 𝑆2لإجابات السؤال  التباين=  2
 ارتفاع درجة ثبات أو موثوقية إجابات المستهدفين على الاستبيان.المعامل يُعتبر مؤشرا على 

 (Split-Half Reliability Coefficient) النصفية التجزئة ثباتمعامل  2.6.6

 باحس ثم ،متساويين جزأين إلى )المتغيرات( الاستبيان أسئلة تجزئة المعامل على اهذحساب يعتمد 
ويُعرف أيضا  أو الموثوقية معامل الثباتحساب  ثم ،(rء، )وليكن جز  مجاميع المتغيرات في كل بين الارتباط
 :كالتالي (Spearman-Brown) براون -سبيرمان بمعامل

𝑆𝑝𝑒𝑎𝑟𝑚𝑎𝑛 − 𝐵𝑟𝑜𝑤𝑛 𝐶𝑜𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑡 =
2 𝑟

1 + 𝑟
  

 وكلما كانت قيمة معامل الثبات أكبر كلما دل ذلك على ثبات وصدق إجابات المستهدفين.

 (Guttman Coefficient) مانتجو  ثبات معامل 3.6.6

حساب تباين الإجابات  الاستبيان إلى نصفين متساويين ثم أسئلةتجزئة على  أيضا هذا المعامل يعتمد
𝑆1 ،حدة علىي كل نصف ف

𝑆1و 2
وتكون صيغة  ،𝑆2 ي لجميع إجابات الاستبيانلحساب التباين الك يتم ثم، 2

 معرفة بالصورة التالية:لثبات جوتمان ل معامل حساب

𝐺𝑢𝑡𝑡𝑚𝑎𝑛 𝐶𝑜𝑒𝑓𝑓𝑖𝑐𝑖𝑒𝑛𝑡 = 2 (1 −
𝑆1

2 + 𝑆2
2

𝑆2
) 

والقيمة المرتفعة للمعامل تدل على ثبات أفضل خ ألفا، ويمكن اعتبار معامل جوتمان حالة خاصة من معامل كرونبا
 .على الاستبيان للإجابات
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شخص، حيث  100أسئلة تم توزيعه على عينة مكونة  10لنأخذ الآن المثال التالي لاستبيان افتراضي يتضمن 
 :مومبجودة المنتجات الغذائية العربية والأجنبية في العالمتعلقة  استجابة هؤلاء الأشخاص للأسئلة التاليةتمثل 

 المنتجات الغذائية العربية كلها متشابهة.  :1س
 يفضل دائما شراء المنتجات الغذائية الأجنبية. :2س
 المنتجات الغذائية العربية لا تتوفر فيها الجودة القياسية. :3س
 المنتجات الغذائية الأجنبية دائما ممتازة في جودتها. :4س
 الغ فيه.المنتجات الغذائية العربية سعرها مب :5س
 ضارة. حافظةالمنتجات الغذائية العربية تحتوي دائما على مواد  :6س
 مصانع المنتجات الغذائية العربية لا تهتم بآراء المستهلكين. :7س
 المنتجات الغذائية الأجنبية ليست دائما الأجود. :8س
 المنتجات الغذائية الأجنبية تفتقد لذوق المستهلك العربي. :9س
 ب تقليص استيراد المنتجات الغذائية الأجنبية.يج :10س

جابة كل سؤال كانت على  في  تعني غير موافق على الإطلاق تدرجا 1، بحيث أن القيمة 9إلى  1مقياس من وا 
جابات المستهدفين من هذا الاستبيان هي مبينة فيوالتي تعني موافق بشدة.  9إلى القيمة  رأي الشخص الجدول  وا 

باسم "استبيان المنتجات  SPSS(، والتي سنقوم بإدراجها في ملف بيانات جديد في برنامج 23.6جدول ) التالي،
وسيكون الهدف هو استخدام بعض مؤشرات تحليل الموثوقية للتحقق من مدى موثوقية أو ثبات إجابات  الغذائية".

( Labelبتعريف المتغيرات )لخاص وسنقوم بكتابة أسئلة الاستبيان في العامود ا العينة المستهدفة من الاستبيان.
 في ملف البيانات لمزيد من التوضيح أثناء تفسير النتائج التي سنحصل عليها لاحقا من تحليل الموثوقية.

 أسئلة في استبيان حول جودة المنتجات الغذائية العربية والأجنبية. 10شخص على  100إجابات عينة من : 23.6جدول 
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5 6 5 7 5 8 5 7 7 4  7 7 5 7 4 3 8 9 9 7 

4 3 4 5 5 4 4 4 2 4  3 4 6 3 4 4 4 4 4 4 

4 4 3 5 7 5 3 5 5 3  3 5 5 4 5 4 5 6 6 7 

4 3 6 5 4 2 5 3 6 4  6 6 4 4 5 5 7 6 7 5 

4 6 7 5 5 3 4 5 5 2  3 3 4 4 7 3 3 4 2 5 

5 6 6 8 4 5 6 7 7 7  4 5 5 5 4 4 4 5 4 5 

5 5 5 5 6 6 5 5 5 5  4 3 4 2 3 4 4 3 3 4 

4 3 2 5 5 5 3 2 4 3  6 6 4 5 4 5 5 6 7 7 

4 4 5 3 7 4 4 5 5 4  5 4 5 5 7 2 5 5 5 5 

4 3 5 3 1 3 4 5 6 4  5 5 6 5 6 3 4 5 6 4 

6 6 7 6 5 5 7 7 4 6  2 2 4 3 6 6 3 3 3 4 

2 4 3 1 4 4 5 4 2 1  5 4 5 5 2 6 5 3 5 5 

4 3 3 3 6 6 5 4 4 4  4 7 7 5 4 7 6 4 6 4 

5 6 5 4 3 3 5 5 3 6  4 7 4 6 7 3 4 7 5 3 

7 5 7 7 5 4 6 2 4 5  6 6 6 4 3 6 6 7 6 4 

4 3 2 3 4 4 4 3 5 3  5 5 5 4 4 4 4 5 5 5 

4 5 5 4 3 4 5 5 4 3  5 4 6 4 6 5 4 5 4 5 

4 6 5 2 4 5 6 5 5 6  5 3 4 6 3 5 5 7 5 6 
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فتظهر نافذة التحليل كما  Analyze>Scale>Reliability Analysisفي شريط الأدوات العلوي، قم باختيار 
 (.Items(. قم أولا باختيار كل المتغيرات العشرة ونقلها إلى مربع المواد أو المتغيرات )15.6هو موضح في الشكل )

 

 : نافذة تحليل الموثوقية لمتغيرات ملف البيانات "استبيان المنتجات الغذائية".15.6شكل 

 أسئلة في استبيان حول جودة المنتجات الغذائية العربية والأجنبية. 10شخص على  100: إجابات عينة من 23.6جدول )تابع( 

6 6 5 6 5 6 6 5 7 8  5 3 3 3 4 6 3 2 3 5 

5 4 5 5 4 8 6 5 5 4  4 5 5 5 3 4 4 5 5 5 

5 3 4 3 5 6 3 4 5 3  3 5 5 5 3 7 5 6 6 5 

4 5 5 5 3 3 4 4 3 4  5 5 5 4 4 4 4 4 9 5 

5 4 5 2 6 5 4 6 4 4  3 4 4 6 3 3 3 3 4 2 

6 6 4 5 4 4 4 6 3 5  2 3 5 5 5 3 1 6 5 3 

4 4 4 4 4 5 6 5 3 4  2 2 5 4 5 3 4 4 3 2 

5 7 4 5 5 7 7 6 3 4  5 4 6 4 7 7 5 4 5 4 

6 4 5 6 3 3 4 3 6 5  6 6 7 5 5 4 4 4 6 5 

6 6 6 4 8 5 6 6 4 5  3 4 6 7 5 4 5 6 6 5 

3 5 4 3 3 5 6 4 4 5  3 5 3 3 5 5 5 5 4 5 

7 4 5 4 7 5 7 5 4 4  2 4 3 3 7 3 4 4 3 3 

1 2 2 3 3 2 2 2 3 1  5 5 4 5 1 5 3 6 4 6 

7 6 7 7 4 4 5 5 6 5  6 7 6 5 5 8 3 5 6 6 

5 5 4 6 6 5 5 6 6 6  4 4 5 6 8 3 3 5 3 5 

6 7 7 4 6 3 8 7 5 6  6 5 6 4 4 4 5 6 5 6 

5 6 6 4 4 7 6 6 5 6  2 3 3 2 6 2 1 4 3 3 

3 5 5 3 5 3 4 4 6 3  5 6 4 5 3 4 6 6 5 5 

7 6 7 6 6 6 6 7 6 4  7 5 6 6 5 3 7 5 4 5 

3 4 5 2 3 6 4 4 3 4  5 4 4 5 5 5 5 6 4 8 

4 4 3 3 4 5 2 1 4 1  4 5 5 5 4 3 6 4 6 4 

6 6 5 5 3 6 5 4 7 5  3 4 4 4 5 7 6 4 3 3 

4 5 5 5 6 3 6 4 4 5  2 4 4 5 4 4 3 6 5 5 

4 5 4 3 2 4 5 5 5 5  4 4 5 4 3 6 4 3 2 2 

4 5 2 3 3 2 3 4 2 4  6 6 3 7 6 3 4 5 6 7 

6 7 7 5 5 6 6 5 5 5  4 6 6 4 4 3 6 5 6 4 

6 6 3 3 5 7 4 6 5 6  6 5 5 5 6 6 4 7 6 3 

6 6 6 5 5 4 5 5 6 5  3 5 5 5 5 6 5 5 3 4 

3 4 2 2 4 7 3 3 3 3  6 5 4 6 1 4 5 5 4 4 

4 4 2 4 5 3 5 2 4 4  5 3 5 5 6 6 4 3 4 2 

8 7 6 5 3 2 7 5 4 5  3 4 4 5 6 6 4 5 4 5 

1 4 1 5 4 4 3 3 5 3  6 6 7 5 7 5 6 7 6 6 
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( في أعلى اليمين فتظهر النافذة الفرعية الخاصة به، Statisticsخيار الإحصاءات )قم بالضغط على بعد ذلك 
 Scale if itemوفي تلك النافذة قم باختيار خيار المقياس عند حذف المتغير ) (.16.6كما يوضح الشكل )

deleted( في مربع الإحصاءات الوصفية )Descriptive for.) 

 

 ءات في تحليل الموثوقية.: نافذة اختيار الإحصا16.6شكل 

ونلفت نظر المستخدم هنا إلى إمكانية اختيار عرض عدة نتائج مثل مصفوفة الارتباطات والتغايرات من مربع 
(، وعرض المتوسطات والتباينات وغيرها من مربع الملخصات Inter-Itemالعلاقات بين المتغيرات )

(Summaries.) 

، سنبقي على الخيار ستمرار للعودة للنافذة الرئيسية، وفي تلك النافذةسنكتفي بخيارنا الحالي الآن ونضغط ا
ضغط ن (، وهو معامل كرونباخ ألفا، ثمModelالافتراضي لطريقة حساب معامل الموثوقية في مربع النموذج )

 موافق فتظهر النتائج المطلوبة في نافذة المخرجات.

ستثناة، والجدول الثاني في نافذة المخرجات، )جدول عدد المشاهدات المستخدمة والموالجدول الأول يوضح 
تدل على  (α = 0.799((، يعرض قيمة معامل كرونباخ ألفا في الجدول الفرعي الأول وهي قيمة جيدة )24.6)

 .ثبات الإجابات في الاستبيان
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حصاءات 24.6جدول   ت الغذائية".المتغيرات لملف بيانات "استبيان المنتجا: نتائج معامل كرونباخ ألفا وا 
Reliability Statistics    

Cronbach's Alpha N of Items    
.799 10    

 

Item-Total Statistics 

  

Scale Mean 

if Item 

Deleted 

Scale Variance 

if Item Deleted 

Corrected Item-

Total Correlation 

Cronbach's Alpha 

if Item Deleted 

لعربية كلها المنتجات الغذائية ا

 متشابهة
41.70 53.889 .655 .759 

يفضل دائما شراء المنتجات 

 الغذائية الأجنبية
41.46 55.625 .670 .760 

المنتجات الغذائية العربية لا 

 تتوفر فيها الجودة القياسية
41.50 56.879 .549 .773 

المنتجات الغذائية الأجنبية دائما 

 ممتازة في جودتها
41.72 58.204 .485 .780 

المنتجات الغذائية العربية سعرها 

 مبالغ فيه
41.61 66.261 .060 .829 

المنتجات الغذائية العربية تحتوي 

 ضارة افظةحدائما على مواد 
41.65 64.210 .143 .820 

مصانع المنتجات الغذائية العربية 

 لا تهتم بآراء المستهلكين
41.55 56.028 .587 .768 

الأجنبية ليست  المنتجات الغذائية

 دائما الأجود
41.42 54.973 .619 .764 

المنتجات الغذائية الأجنبية تفتقد 

 لذوق المستهلك العربي
41.53 56.716 .514 .776 

يجب تقليص استيراد المنتجات 

 الغذائية الأجنبية
41.75 55.927 .568 .770 

ئية لمتغيرات )أسئلة( الاستبيان فيمكن الاستفادة وأما الجدول الفرعي الثاني، والذي يمثل بعض المقاييس الإحصا
منه بصورة خاصة للتحقق من الأسئلة )أو بمعنى آخر إجابات المستهدفين( التي وجودها يقلل من مدى ثبات 

إلى  لأولفي العامود ا بحذفها، وهذا يمكن مراقبةالاستبيان، وهذه الأسئلة هي التي ترتفع قيمة معامل كرونباخ ألفا 
 .(Cronbach's Alpha if Item Deletedمن هذا الجدول ) اليمين

المنتجات الغذائية العربية ( والسادس )المنتجات الغذائية العربية سعرها مبالغ فيهنلاحظ أن السؤالين الخامس )و 
ة؛ ( إذا ما تم حذفهما فإن قيمة معامل كرونباخ ألفا سوف ترتفع بصورة ملحوظضارة حافظةتحتوي دائما على مواد 

( على الترتيب، إلى جانب كون معاملي الارتباط بين هذين السؤالين والأسئلة ككل هما الأدنى 0.820( و)0.829)
 ( على الترتيب.0.143( و)0.060مقارنة بباقي معاملات الارتباط في العامود الثاني إلى اليمين، )

ا على الأقل(، إذا ما رغب الباحث برفع لذلك قد يكون من الموصى به أحيانا حذف هذين السؤالين، )أو إحداهم
 مستوى موثوقية أو ثبات الاستبيان، وبالتالي رفع القيمة العلمية للدراسة ككل.

ومعامل جوتمان ضمن التجزئة النصفية ومعامل كرونباخ  معامل ثبات التجزئة النصفيةيمكننا استخدام من جديد، 
 مدى ثبات أسئلة الاستبيان.ألفا ضمن التجزئة النصفية لمزيد من التحقق حول 
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، وفي نافذة التحليل Analyze>Scale>Reliability Analysisفي شريط الأدوات العلوي، قم من جديد باختيار 
وهنا يمكننا الاستغناء عن اختيار (، Itemsاختيار كل المتغيرات العشرة ونقلها إلى مربع المواد أو المتغيرات )ب قم

( حيث أنه قد Statistics( في خيار الإحصاءات )Scale if item deletedغير )خيار المقياس عند حذف المت
( كطريقة Split-half) التجزئة النصفية في ثباتتم التطرق إليه في النتيجة السابقة. نقوم بعدها باختيار طريقة ال

 (، ثم نضغط موافق.Modelحساب معامل الموثوقية في مربع النموذج )

نلاحظ قيم معاملات الموثوقية وهي (، 25.6من الجدول الثاني، والموضح هنا في جدول ) وفي نافذة المخرجات،
( الخمسة أسئلة الأولى في الاستبيان، والجزء الثاني Part 1معروضة بالترتيب التالي، )حيث يمثل الجزء الأول )

(Part 2؛)الخمسة أسئلة المتبقية من السؤال السادس وحتى العاشر ) 

  ( على الترتيب 0.673( و)0.662ونباخ ألفا للجزء الأول والثاني من المتغيرات وهي )قيم معامل كر
 ((.24.5للأسئلة ككل، )جدول ) اونلاحظ أنها أضعف من قيمة المعامل ألف

 ( ويُعد مقبولا إلى حد ما، وأما معامل 0.659فهو ) جزء معامل الارتباط بين مجاميع المتغيرات في كل أما
 ( ويُعتبر جيدا.0.794فهو )براون -سبيرمانأو معامل ة النصفية معامل ثبات التجزئ

 ( ،0.794والمعامل الأخير في الجدول وهو معامل جوتمان ،) جيدا.أيضا يُعد 

 لمتغيرات ملف البيانات "استبيان المنتجات الغذائية". طريقة الثبات في التجزئة النصفية: نتائج 25.6جدول 
Reliability Statistics 

Cronbach's Alpha Part 1 Value .662 

N of Items 5a 

Part 2 Value .673 

N of Items 5b 

Total N of Items 10 

Correlation Between Forms .659 

Spearman-Brown Coefficient Equal Length .794 

Unequal Length .794 

Guttman Split-Half Coefficient .794 

a. The items are:  المنتجات الغذائية العربية كلها متشابهة, يفضل دائما شراء المنتجات الغذائية الأجنبية, المنتجات الغذائية العربية لا

ة في جودتهاتتوفر فيها الجودة القياسية, المنتجات الغذائية الأجنبية دائما ممتاز  .المنتجات الغذائية العربية سعرها مبالغ فيه ,

b. The items are:  ضارة حافظةالمنتجات الغذائية العربية تحتوي دائما على مواد مصانع المنتجات الغذائية العربية لا تهتم بآراء  ,

تيراد المستهلكين, المنتجات الغذائية الأجنبية ليست دائما الأجود, المنتجات الغذائية الأجنبية تفتقد لذوق المستهلك العربي, يجب تقليص اس

الغذائية الأجنبيةالمنتجات  . 

شخص تُعد جيدة الثبات  100وهكذا نخلص إلى أن الإجابات على أسئلة الاستبيان بالنسبة لهذه العينة المكونة من 
أو الموثوقية من خلال نتائج المقاييس السابقة، مع الأخذ بالاعتبار حذف السؤال الخامس أو السادس أو كلاهما 

 تبيان.الاس أو موثوقية إذا ما أردنا رفع درجة ثبات
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 ملحقال

 ملفات البيانات المستخدمة في الكتاب

 

في  اسم ملف البيانات م
SPSS 

 الصفحة تعريف ملف البيانات

 1مثال .1
بعشرة أطفال في إحدى المؤسسات التعليمية في مرحلتي رياض  بيانات خاصة

 وعمره )بالكجم( الأطفال والابتدائية، وتشمل ثلاثة متغيرات هي وزن الطفل
 وجنسه. )بالسنوات(

9 

 بيانات الطلبة .2

 هي: درجةطالبا جامعيا مقاسة لثمانية متغيرات  35ب المشاهدات الخاصة 
 الطالب درجة ،2المقرر في الطالب درجة درجة(، 100)من  1المقرر في الطالب

 الدراسي الفصل ترتيب الطالب، جنس ،(بالسنوات) الطالب عمر ،3المقرر في
 .الطالب منزل في الحجرات عددو  الطالب، أسرة أفراد عدد للطالب،

18 

 26 .الطالب جنس بحسب مصنفة 1المثال بيانات 2مثال .3
 26 الطالب ثم عمره. جنس بحسب مصنفة 1بيانات المثال 3مثال .4

 الاجتماعي التواصل تطبيقات .5
 أمام( √) إشارة ضع: "التالي المطلوب على ردا شخص 12 من مكونة عينة آراء

شارة تستخدمها التي التطبيقات  وهذه". تستخدمها لا التي التطبيقات أمام)×(  وا 
نستجرام فايبر، واتساب، فيسبوك، هي؛ التطبيقات  .وا 

27 

 37 طالب. 15 من لعينة العلمي والقسم الدراسي بيانات تمثل التقدير 4مثال .6

 أسعار النفط .7
 سنوات لخمسة الأمريكي بالدولار برنت لمزيج الشهرية العالمية النفط أسعار

 افتراضية.
39 

 5مثال .8
 مرتب هي متغيرات ثلاثة تضم الشركات إحدى موظفي من بعدد خاصة بيانات

 .الليبي بالدينار السنوي  والخصم والعلاوة الموظف
42 

9. car_insurance_claims 

 128 من لعينة متغيرات خمسة على تحتوي  SPSS برنامج أمثلة من بيانات
 المؤمّن عمر: هي والمتغيرات السيارات، على التأمين شركات إحدى في شخصا
 السيارة عمر السيارة، تصنيف فئة عمرية، فئات ضمن بالسنوات السيارة على

 مبالغ عددو  بالدولار، الشركة قِبل من المدفوعة التأمين قيمة معدل بالسنوات،
 .المدفوعة التأمين

50 
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 أقسام كلية العلوم .10
 لعام بنغازي  بجامعة العلوم كلية في أقسام خمسة في والإناث الذكور الطلبة أعداد

 56 والنبات. الكيمياء، الفيزياء، الإحصاء، ، والأقسام هي: الرياضيات،2012

 المأكولات المفضلة .11
المفضلة، )مثلجات، لحوم حمراء،  وجباتهم حول الأشخاص من مجموعة آراء

 61 المختلفة. المطاعم من سلطات، دجاج، بيتزا(،

 مقاومة المعدن .12
 جدران بناء في يستخدم جديد، معدن إضافة وبعد قبل المعادن خليط مقاومة نتائج

 80 .أشهر ثمانية فترة خلال العسكرية، المنشئات

 معدلات الطلبة .13

 بنغازي  بجامعة العلوم كلية في القدامى الطلبة من طالبا 90 من مكونة عينة
 الطالب، معدل وتشمل وفيزياء(، إحصاء، رياضيات،) التخصص؛ بحسب مقسمة

 الفصول وعدد الطالب، جنس ،(درجة 4.00 إلى 0.00 من مقياس على)
 .الطالب أنجزها التي الدراسية

85 

 المقابلات الشخصية .14
 قسم في للعمل شخصية مقابلات أجروا شخصا 20 عليها حصل التي النتائج
 110 .(درجة 100 من التقييم) شركتين، في البشرية الموارد

 عينات ضغط الدم .15
 إعطاؤهم وبعد قبل المستشفيات إحدى في مريضا 15 من لعينة الدم ضغط قياس
 112 .الدموية للأوردة موسع تجريبي دواء

 حنأسعار الشوا .16
 متاجر ثلاثة في الليبي بالدينار النقالة الهواتف شواحن من أنواع 10 أسعار

 114 مختلفة.

 مستوى الأرق  .17
 الحديد مصانع أحد في عامل 90 من مكونة لعينة الأرق  ومستوى  الإنتاج مستوى 

 118 والصلب.

 فيتامين دال .18
 إضافة شخصا 60 من مكونة عينة وأعمار( Vit. D) دال فيتامين معدلات
ناث ذكور لتصنيفهم  121 .وا 

 أطوال الأطفال .19
 مجموعات، خمسة إلى تقسيمهم تم )بالسنتيمتر( طفلا 20 من مكونة عينة أطوال
 كل وبداخل الحليب، أنواع من 5من ضمن  محدد نوع إعطاؤها تم مجموعة كل

 دال. فيتامين من أنواع 4 اعتماد تم الخمسة المجموعات هذه من مجموعة
141 

 2الطلبة بيانات .20
 الدراسة ساعات عدد ملف بيانات الطلبة مضافا إليه متغير جديد يمثل معدل

 148 للطالب. اليومية

 الغذائية المنتجات استبيان .21
 ويتضمن شخص، 100 مكونة عينة على توزيعه تم أسئلة 10 يتضمن استبيان
 العربية الغذائية المنتجات بجودة متعلقة لأسئلة الأشخاص هؤلاء استجابة
 العموم. في والأجنبية

221 
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